General Overview

What is Scriptcase?

Scriptcase is a complete development tool, with a friendly web interface. A low-code environment that creates PHP applications high-speed and with quality was built to save time, reduce costs, gain productivity, and to integrate the devel
create many types of applications like Grids, Charts, Forms, Calendars, and many other applications . It also offers an IDE integrated for you to customize applications or even to create using only codes.

You can divide Scriptcase environment into 3 parts: RAD (Rapid Application Development), Scriptcase environment tools and Code editors.
e AD (Rapid Application Development): Within Scriptcase, you can find some ready-to-use applications as well as complete system templates. You can see a sample of all applications accessing our website  here.

e criptcase environment tools: You have available plenty of tools to assist your development within Scriptcase, such as Database Manager, SQL Builder, Data dictionary, CSV, XLS and Access converters, Documentation Creator, Therr
Manager, Tasks Manager, and Key Shortcuts.

o ode editors: Besides the ready-to-use applications, templates, and tools, you can also customize or create your application using the editors, they work like an IDE integrate into Scriptcase. Within the editors, you can add your syst:
third-party libraries and components, APIs, and Scriptcase internal functions (macros). The editors are compatible with PHP, JavaScript, CSS, and HTML, and you can also use Emmet Shortcuts.

How does Scriptcase work?

Scriptcase works generating web applications in PHP and always relating the content with the most used databases on the market. Installing on a web server, Scriptcase can be accessed simultaneously by many developers through the bi
development. The source code is in PHP, and it works independently of the tool. Once you finish your project on Scriptcase, you can deploy it anywhere with a WEB server that allows you work with PHP. You do not need a license to run t
provides a “Production environment” where you can manage the libraries, connections, and deployed applications. Learn more about the deployment here.

Which source code is generated?

Scriptcase generates (PHP, JavaScript, and HTML) source code. The generated code is independent of the tool, and you can deploy it on a web server with PHP enabled. The PHP language is free (GNU), and you can use on any operating s
processes work on the Server.

What are the supported databases?

Scriptcase connects to the leading relational databases: Oracle, MS-SQL Server, DB2, MySQL, Informix, PostgreSQL, Access, InterBase, FireBird, Progress, and others ODBC or OLEDB patterns.

What are the requirements to run ScriptCase?

Awebserver (Apache, IIS, Sambar, Abyss, PWS, Xitami) that is enabled to run PHP 8.1 Scripts and lonCube Loader.



Accessing Scriptcase

Access to Scriptcase must be done through a browser of your choice. The tool is compatible with the most used browsers.

To access, we must inform in the address bar of the browser: Server IP:+port+Scriptcase folder name

Example of access when performing local installation

e 27.0.0.1:8092/scriptcase
o ocalhost:8092/scriptcase

Example of access when performing installation on a server
o 80.204.163.144:8092/scriptcase/
e ysc.domain.net/scriptcase/

Compatible browsers

@ Chrome  Any version
@ Firefox  Version 4 or higher
2 Edge Any version
Q Opera Version 9 or higher

@ Safari Version 5.2 or higher

Login screen

USER

admin

PASSWORD
1

) Keep me loegged in Forgot your password?

5

In addition to the User and Password fields, the login screen has some resources. Keep me signed in, Forgot your password? and the Interface language selection.

Keep me logged in
This option allows the browser to store the cookie and remain connected to your account when you close the browser tab where Scriptcase is open, and come back later without the need to log in again.

The cookie storage time is defined by accessing the menu Settings > Administration in the option Time to expire the login cookie (days)

Forgot your password?
Allows recovery of the Scriptcase access password. For this option to work correctly, it is necessary to configure the SMTP in the tool settings.

It is recommended that this configuration be performed on the first accesses.
Check here how to perform this configuration. Check here some SMTP options.
Interface Language Selection

Allows you to set the Scriptcase interface language.

Below are the available options.

The Portuguese language is only available in pt_br installers

Related Links »

Related video >



General Overview

o criptCase installer includes PHP 8.1, Apache 2.4.53, and SourceGuardian.
e heinstallation process is described according to the Operating System.

Installing ScriptCase is not complicated, select your operating system below, follow the tutorial, and in a few steps, you get to install and start using ScriptCase. If you need any assistance, please contact our technical support  here.




Installer for Windows

The Scriptcase installer installs Apache, PHP and Scriptcase on your operating system.

I The Scriptcase installer does not include a database.

Prerequisites

To download the Scriptcase Installer, go to our download page clicking here.

Check the list of supported operating systems:

Windows Windows Server
Windows 11 Windows Server 2022
Windows 10 Windows Server 2019
Windows 8.1 Windows Server 2016
Windows 8 Windows Server 2012 R2
Windows 7 SP1 Windows Server 2012

Windows Vista SP2

| Ifyou would like to install the Scriptcase in the Windows 7 SP1 check if these libraries are installed: Visual C ++ Redistributable Packages for Visual Studio (2010, 2012, 2013, 2015 e 2017) x86 e x64

Choosing settings in the Installer

Installing Scriptcase with PHP 8.1 will not conflict with an existing Scriptcase installation using PHP 7.0 or PHP 7.3. The new Installer configures an Apache service (ApacheScriptcase9php81) with a different port (8092) than the inst.

Will be automatically installed on the operating system:

pache Web Server v2.4.53.

HP 8.1 with extensions MBSTRING, ZIP, BCMATH and GD enabled.
ourceGuardian 13.0.3.

criptcase 9.8.

® o 0o o

Before proceeding with the installation, it is recommended not to have any other web environments installed (such as WampServer, XAMPP, Zend Server, etc.) on your operating system.

1 - Choose the installation language.
% Language Selection - m} X

Plesse select the installation language

English - English v

oK Cancel

Language

You can select the language that will be displayed in the installation process. This step does not select the Scriptcase interface language, only the installer language.
Click Ok to continue.

2 - Click “Next” to continue.

45 Setup - X
Setup - Scriptcase 9 - PHP 8.1
Welcome to the Scriptcase 3 - PHP 8.1 Setup Wizard.
< Back Next > Cancel

3 - Read and accept the terms of the license agreement.



4y Setup - X
License Agreement <

Please read the following License Agreement. You must accept the terms of this
agresment before continuing with the installation.

Znd-User License Agreement for ScriptCase ("Software”)

|copyright (o) 1837-2020 Netmake Ltda. All rights reserved

© | accept the agreement
Do you accept this license? RS
(O ldo not accept the agreement

< Back Mext > Cancel

Click Next to continue.
4 - Enter the installation directory.

The default installation path is “C:\Program Files\NetMake\v9-php73”. It is not recommended to make any changes to this path unless it is necessary.

5 Setup — X
Installation Directory <

Please specify the directory where Scriptcase 9 - PHP 8.1 will be installed

Installation Directory  rogram Files\NetMakelwd-php81 £

< Back Next > Cancel

Installation directory

In this option, you can set the installation path.

T This button lets you select the installation folder or create a new one.

Click Next to continue.

5 - Configure Scriptcase Apache.

* Setup - %
Apache Configuration <

Please type the configuration to apache service

Port 8092

Email om
Apache Domain Samples

PHP Timezone

America/Recife

< Back Next > Cancel

Port

Here will define in which port the Scriptcase Apache service will run on. We recommend using the value set in this installation. (8092).

Admin Email
You can configure Apache administrator email for better control of your environment. This setting serves as information when a server error occurs. A message will appear along with the administrator email to be contacted.

Internal Server Error

The server encountered an internal error or misconfiguration and was unable to complete your request,

Please contact the server admi affroota Jto inform them of the time this error aceurred, and the actions you
performed just before this error.

More information about this error may be available in the server eror log

Apache Domain



The Apache domain must be set here. We do not recommend making any changes to the default value.

PHP TimeZone

In this option, you can set your PHP TimeZone. It is recommended to select the option corresponding to your time zone. You can check the list of available TimeZones here.
Click Next to continue.

6 - Clicking “Next” will start the installation process.

P(, Setup — x
Ready to Install <

Setup is now ready to begin installing Scriptcase 9 - PHP &.1 on your computer.

< Back Next > Cancel

Wait until all components are installing and the environment is set up.

< = -

Installing
Unpacking files

< Back Next > Cancel

7 - Allow Apache to run on private and public networks (Firewall).

Security Alert

Windows Defender Firewall h; ome features of this
app

Windows Defender Firewall has blocked some features of Apache HTTP Server on all public and

private networks,
Name: Apache HTTP Server
Publisher:  Apache Software Foundation
Path: C:\program filesInetmake'\componentstapache bin
exe

Allow Apache HTTP Server to communicate on these networks:
Private networks, such as my home or work network.

Public networks, such as those in airports and coffee shops (not recommended
because these networks often have lttle or no security)

What are the risks of allowing an app through a firewall?

=

NOTE: You must check both options to allow Scriptcase Apache to run on the operating system.

8 - Complete the installation.

Completing the Scriptcase 9 - PHP 8.1 Setup Wizard
Setup has finished installing Scriptcase 9 - PHP 8.1 on your
computer.

@ Open README
© Open Scriptcase 9 - PHP 2.1

< Back Finish Cancel

Open README



When you click Finish, you will be directed to a “Read Me" page with all the necessary initial information and useful links.

https://www.scriptcase.net/readme/

Open Scriptcase 9

Clicking “Finish”, will open Scriptcase in your default browser.

Access Scriptcase

1 - To access the Scriptcase you can use the shortcut created after installation or access using the browser.
Example to access on the local install

® 27.0.0.1:8092/scriptcase
o ocalhost:8092/scriptcase

Example to access on the server install

® 80.204.163.144:8092/scriptcase/
e  ysc.domain.net/scriptcase/

2 - After accessing the Login page, you must enter the username and password to proceed to your development environment.

PASSWORD

[ Keep me logged in Forgot your password?

LOGIN EE English v

To access for the first time please use [admin / admi
“Your trial will expire in 20 days.

After finishing the installation, you can use the version free of charge for a period of 20 days and you will have access to technical support via chat to help you during the evaluation. If you already have a serial, ~ see how to register )

User

In this field, you must enter the user to login to Scriptcase. By default, the useris admin.

Password

In this field, you must enter the password to login to Scriptcase. By default, the password is admin.

Keep me logged in

This option keeps the user logged in until they log out through the Scriptcase interface.

Forgot your password?

This option makes it possible it is possible to recover the password to access Scriptcase. This feature is only available after configuring SMTP in Scriptcase settings. See how to set the SMTP



Installer for Linux

The Scriptcase installer installs Apache, PHP and Scriptcase on your operating system. The installer does not include a database.

Prerequisites

To download the Scriptcase Installer, go to our download page clicking here.

| If the database used to create the projects is Oracle, we recommend performing the manual installation of Scriptcase.

Listed below are the operating systems approved for Scriptcase use. Check the list of supported distros:

ebian 8 or higher version

buntu 18.04 or higher version

HEL 7 or higher version

entOS 7 or higher version

edora 30 or higher version

anjaro Linux 19 or higher version
inux Mint 18.04 or higher version
penSuse Leap 15.1 or higher version

® 0 0 0 0 0 0 0

NOTE: Before proceeding with the installation, it is recommended not to have any other web environments installed (such as LAMP, Zend Server, etc) on your operating system. It is recommended to have some basic knowledge oi
Terminal (Shell).

This documentation will describe Scriptcase installation in 3 simple steps:

1 - Run Scriptcase Installer.
2 - Choose installer settings.
3 - Run Scriptcase.

Running Scriptcase Installer

1 - Browse to the directory where the installer is located.
Before we can run the Scriptcase installer, we need to access the folder where the installer file is located using the cd command.

Example: sudo cd /home/your_user/Downloads

$ cd /hom uan12/Downloads/

NOTE: Scriptcase installer requires administrative permissions to make changes to your machine. We will have to use the  sudo command to run the installer.

2 - Grant permission to the installer file and run it.
For you to runthe chmod command that changes the permissions of a file or directory, you must also run the ~ sudo command.

Example: sudo chmod +x scriptcase_linux_installer_x86_64_en_us_v9.8.000-php81.run

$ sudo chmod +x scriptcase_linux_installer_x86_64_en us v9.8.860-php8.1.run [ ]

The chmod + x command is used to make the installer .run file executable.
3 - Run the Installer file.

Example: sudo ./scriptcase_linux_installer_x86_64_en_us_v9.8.000-php81.run

$ sudo ./scriptcase linux installer x86 64 en us v9.8.800-php8.1.run |:|

Choosing the Installer settings

NOTE: Installing Scriptcase with PHP 8.1 will not conflict with an existing Scriptcase installation with PHP 7.0 or 7.3. The Installer configures an Apache service (apachesc9php81) with a different port (8092) than the installer with Pk

Will be automatically installed on the operating system:

pache Web Server v2.4.53.

HP 8.1 with extensions MBSTRING, ZIP, BCMATH and GD enabled.
ourceGuardian: 13.0.3.

criptcase 9.8.

o o 0o 0

1 - Choose the installation language.

n x

nguage Selecl
Please select the installation language

English - English -

OK Cancel

Language
You can select the language that will be displayed in the installation process. This step does not select the Scriptcase interface language, only the installer language.
Click Ok to continue

2 - Click “Next” to continue.



Cancelar

3 - Read and accept the terms of the license agreement.

ngar Cancelar

Click Next to continue.
4 - Enter the installation directory.

The default installation path is “/opt/NetMake/v9-php81”. It is not recommended to make any changes to this path unless it is necessary.

Cancelar

Installation Directory

In this option, you can set the installation path.

& |: This button lets you select the installation folder or create a new one.

Click Next to continue.

5 - Configure Scriptcase Apache.



Port

Here will define in which port the Scriptcase Apache service will run on. We recommend using the value set in this installation (8092).

Admin Email

You can configure Apache administrator email for better control of your environment. This setting serves as information when a server error occurs. A message will appear along with the administrator email to be contacted.

Internal Server Error

The server encountered an internal error or misconfiguration and was unable to complete your request

Please contact the server administrator ag root alhost

performed just before this error.

form thems of the time this error oceurred, and the actions you

More information about this error may be available in the server error log

Apache Domain

The Apache domain must be set here. We do not recommend making any changes to the default value.

PHP TimeZone

In this option, you can set your PHP TimeZone. It is recommended to select the option corresponding to your time zone. You can check the list of available TimeZones here.
Click Next to continue.

6 - Clicking “Next” will start the installation process.

Installing

Unpacking files
8%

InstallBuilder

8 - Complete the installation.



View the “Read Me" file

Clicking finish you will be redirected to the “Read Me” page with all the necessary initial information and useful links.

README

gthe installer for windos

f you have any install

2. Learn yourself howto use ScriptCase

wwScriptcase et /scriptcasesamples/

youareafree trial user a

Open Scriptcase 9

Clicking “Finish”, will open Scriptcase in your default browser.

Access the Scriptcase

1 - To access your Scriptcase, you need to open your browser and enter the local IP or domain of the ported server you selected in the Apache setup.
Example 1: http://127.0.0.1:8092/scriptcase

Example 2: https://yourdomain.com:8092/scriptcase

2 - Login to Scriptcase

After accessing the Login page, you must enter the username and password to proceed to your development environment.

PASSWORD

[ Keep me logged in Forgot your password?

LOGIN EE English v

To access for the first time please use [admin / admi
“Your trial will expire in 20 days.

User

In this field, you must enter the user to login to Scriptcase. By default, the user is admin.



Password

In this field, you must enter the password to login to Scriptcase. By default, the password is admin.

Keep me logged in

This option keeps the user logged in until they log out through the Scriptcase interface.

Forgot your password?

IMPORTANT: Password recovery will only be possible if you have configured your SMTP information. To access our documentation showing how to perform this configuration click  here.

By clicking on this option, it is possible to recover the password of the informed user. An email will be sent to the user so they can access the recovery steps.

Need to register your Scriptcase?
You can access our knowledge base to understand all the steps for registering a Scriptcase license.



Installer for macOS

The Scriptcase installer installs Apache, PHP and Scriptcase on your operating system.

I The Scriptcase installer does not include a database.

Prerequisites

To download the Scriptcase Installer, go to our download page clicking here.

| IMPORTANT: The Scriptcase installer is a .app file. To run the file, you will need to press and hold the cntrl key, mouse/touchpad right-click, and then click Open to authenticate as an administrator and install Scriptcase.

Listed below are the macOS versions approved for Scriptcase use. Check the list of supported versions:

Mac0S 12.0

Mac0s 11.0

Mac0s 10.15

MacOS v10.14

MacOS v10.13

MacOS v10.12

0SXv10.11

“Monterey”
“Big Sur”
“Catalina”
“Mojave”
“High Sierra”
“Sierra”

“El Capitan”

| Before proceeding with the installation, it is recommended not to have any other web environments installed (such as MAMP, Zend Server, etc) on your operating system.

Choosing settings in the Installer

Installing Scriptcase with PHP 8.1 will not conflict with an existing Scriptcase installation using PHP 7.0 or PHP 7.3. The new Installer configures an Apache service (ApacheScriptcase9php81) with a different port (8092) than the inst.

Will be automatically installed on the operating system:

® o o o

pache Web Server v2.4.53.

HP 8.1 with extensions MBSTRING, ZIP, BCMATH and GD enabled.
ourceGuardian 13.0.3.

criptcase 9.

1 - Choose the installation language.

@® O @ Language Selection

Please select the installation language

English - English
Cancel 0K
Language

You can select the language that will be displayed in the installation process. This step does not select the Scriptcase interface language, only the installer language.

Click Ok to continue

2 - Click “Next” to continue.

Setup

Setup - Scriptcase 9 - PHP 8.1

Welcome to the Scriptcase 8 - PHP 8.1 Setup Wizard.

Cancel <Back | MNext> |

3 - Read and mark | accept the agreement.

Click Next to continue.



®a Setup
License Agreement <

Please read the following License Agreement. You must accept the terms of this
before ing with the i i

End-User License Agreement for ScriptCase ("Software")

1D 1 accept the agreement
I do not accept the agreement

Do you accept this license?

InstallBuilder

Cancel < Back Next >

4 - Enter the installation directory.

The default installation path is “/Applications/Scriptcase/v9-php81”. It is not recommended to make any changes to this path unless it is necessary.
[ XS] Instalagdo

Diretério de Instalagao <

Please specify the directory where Scriptcase 9 will be installed.

Installation Directory Applications/Scriptcase/ve-php81 e

InstallBuilder

Cancel <Back | Next> |

Installation directory

In this option, you can set the installation path.

o . . .
T . This button lets you select the installation folder or create a new one.

Click Next to continue.

5 - Configure Scriptcase Apache.

[ XS] Setup
Apache Configuration <

Please type the configuration to apache service

Port  [5092 |

PHP Timezone

o

America/Recife

InstallBuilde

Cancel < Back Next >

Port
Here will define in which port the Scriptcase Apache service will run on. We recommend using the value set in this installation (8092).

PHP TimeZone
In this option, you can set your PHP TimeZone. It is recommended to select the option corresponding to your time zone. You can check the list of available TimeZones here.

Click Next to continue.

6 - Clicking “Next” will start the installation process.



® 0 Setup

Ready to Install <

Setup is now ready to begin installing Scriptcase 9 - PHP 8.1 on your computer.

Cancel <Back || Next> |

Wait until all components are installing and the environment is set up.

[ X Setup
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Installing
Unpacking files

Cancel < Back Next >

7 - Complete the installation.

‘'® Setup.

Completing the Scriptcase 9 - PHP 8.1 Setup Wizard
Setup has finished installing Scriptcase 9 - PHP 8.1 on your
computer.

@ Open README
@ Open Scriptcase 9- PHP 8.1

Cancel < Back . Finish |

Open README

When you click Finish, you will be directed to a “Read Me" page with all the necessary initial information and useful links.

https://www.scriptcase.net/readme/

Open Scriptcase 9

Clicking finish “Finish” will open Scriptcase in your default browser.

Access Scriptcase

1 - To access the Scriptcase you can use the shortcut created after installation or access using the browser.
Example to access on the local install

® 27.0.0.1:8092/scriptcase
o ocalhost:8092/scriptcase

Example to access on the server install

e 80.204.163.144:8092/scriptcase/
e  ysc.domain.net/scriptcase/

2 - After accessing the Login page, you must enter the username and password to proceed to your development environment.



PASSWORD

[0 Keep me logged in Forgot your password?

EE English v

for the first time please use (admin / admi
Your trial will expire in 20 days.

After finishing the installation, you can use the version free of charge for a period of 20 days and you will have access to technical support via chat to help you during the evaluation. If you already have a serial, ~ see how to register )

User

In this field, you must enter the user to login to Scriptcase. By default, the useris  admin.

Password

In this field, you must enter the password to login to Scriptcase. By default, the password is admin.

Keep me logged in

This option keeps the user logged in until they log out through the Scriptcase interface.

Forgot your password?

This option makes it possible it is possible to recover the password to access Scriptcase. This feature is only available after configuring SMTP in Scriptcase settings. ~See how to set the SMTP



Installing PHP 8.1 - Windows

This documentation will walk you through the steps necessary to install PHP 8.1, Apache 2.4, and Scriptcase manually. When performing this type of installation, you are responsible for configuring your entire environment as well as dat

| You can install the Scriptcase with PHP 7.3 or PHP 7.0: See how to install with PHP 7.3 See how to install with PHP 7.0

Listed below are all the supported operating systems as well as the libraries that are required to function on a particular system.
Check the list of supported operating systems:

indows 7 SP1 or Higher

indows Vista SP2 or Higher

indows Server 2012 or Higher
indows Server 2012 R2 SP1 or Higher

| For Windows 7 SP1, you must verify if the system has the following items installed: Visual C++ Redistributable Packages for Visual Studio (2008, 2010, 2012, 2013, 2015) x86 and x64.

Prerequisites

Ifyou already have a Web Server with Apache and PHP 8.1 configured, just go to How to  Enable SourceGuardia Loader and proceed to manual installation.

To proceed with the installation, you need to download some files.
Check below for the files you will need:

HP 8.1 NTS (x86 or x64) : Click Here

pache 2.4 (x86 or x64) : Click Here

od_Fcgi (x86 or x64): Click Here

ourceGuardian Loader 13.0.3 for Windows (x86 or x64): Click Here
criptcase (.zip): Click Here

NOTE: Before proceeding with the installation, it is recommended not to have any other web environments installed (such as WampServer, XAMPP, Zend Server, etc.) on your operating system.

Below are the actions required after downloading the items specified above::
1 - Unzip the PHP and Apache files in separate folders on your operating system’s C: drive.

2 - Rename the PHP folder to php. The result should be like this:

Name Date modified Type Size
[ Apache24 File folder |
Perflogs File folder
[ phe File folder |
. Program Files File folder
| Program Files (26) File folder
| Users File folder
webserver File folder
. Windows File folder

W mod fiiterso

Configure the Apache environment

Listed below are the steps required to configure apache manually. Follow the steps correctly to avoid problems installing and starting the service.

I NOTE: Since PHP and Apache folders are at the same directory level (C;) You do not need to enter the root folder in directives that require you to enter isolated paths or points to a specific file.

1 - Edit the httpd.conf file located in the C:\Apache24\conf\ folder using a text editor in Administrator mode, so that any changes you make are saved.

B charset.conv

B httpd.conf
W magic

B mimetypes

2 - Add the content below after the #LoadModule xml2enc_module modules/mod_xml2enc.so line:



LoadModule fcgid_module modules/mod_fcgid.so
FcgidlInitialEnv PHPRC "/php"

FcgidInitialEnv PHP_FCGI_MAX_REQUESTS "100000"
FcgidlOTimeout 1800

FcgidBusyTimeout 1800

FcgidConnectTimeout 1800
FcgidMaxRequestLen 1073741824
FcgidMaxRequestsPerProcess 10000
FcgidOutputBufferSize 4000
FcgidProcessLifeTime 3600

Timeout 1024

KeepAlive On

KeepAliveTimeout 50

MaxKeepAliveRequests 500

AddHandler fcgid-script .php

FcgidWrapper "/php/php-cgi.exe" .php

Example:

LoadModule fcgid_mo ules/mod_fcgid
FcgidInitialEnv PHP -

AddHandler fcgid-script .php
FcgidWrapper “/php/php-cg " .php

<IfModule unixd module>

WARNING: This setting will only work if you have copied the mod_fcgid.so file to the C:|Apache24\modules folder as previously instructed.

3-Search for #ServerName www.example.com:80 and change this lineto ServerName localhost:80 .

In this tutorial apache is configured with port 80. To define another port it is necessary to change the value informed in ServerName, for example (localhost:8092). Also, you will need to change the Listen , for example (Listen 809.
that the port is not being used by another service

4 - Change the contents of the Directorylndex directive by adding the following contents to the directive line:: index.php index.phtml .

Example:

<IfModule dir_module>
DirectoryIndex index.html index.php index.phtml
</IfModule>

<IfModule dir module>

DirectoryIndex index.html index.php index.phtml
</IftModule>

5 - Set the ${SRVROOT} variable with your Apache folder path:
Search for the Define SRVROOT and edit it as follows:
Define SRVROOT "/Apache24"

6 - Add the Options ExecCGI command below the Require all granted line in the <Directory "${SRVROOT}/htdocs"> directive.

#

Require all granted
Options ExecCGl
</Directory>

Example:

options Ind

7 - Search for the <IfModule mime_module> directive and add the content below above this directive:

<Directory "/php">
#
AllowOverride None
Options None
Require all granted
#

</Directory>

Example:



<Directory “/php”>

</Directory>

<Iftodule mime module>

After performing all these procedures, save the httpd.conf file to proceed with Apache installation and startup and PHP configuration.

Install and start Apache

Now that you have set up your apache service, all you have to do is install and start it. Below are the steps that must be followed to successfully complete this process.

1 - Run the Command Prompt (CMD) with Administrator privileges:

= 0 [:=] Filters
A Best match
]
@ Command Prompt
9 Desktop app
Documents Run as administrator
Command line Opt Open file location
Search suggestions Pin to Start
Pin to taskbar
£ command - search
Store
&
-
&

2 - Go to the Apache bin folder to install the httpd.exe executable file:
cd C:\Apache24\bin\httpd.exe
3 - Install Apache with the command below:
httpd.exe -k install
Wait for the message “The ‘Apache2.4’ service is successfully installed.” to proceed.
4 - Start the Apache service and verify if it is working.

Use the httpd.exe -k start to start your Apache service.

5 - Grant execution permission to Apache on your Firewall:

Select the two options available to grant permission, so Apache can function properly.

@ ‘Windows Firewall has blocked some features of this app

Windows Frewall has blocked some features of Apache HTTP Server on all public and private

etworks
Name: Apache HTTP Server
Publisher:  Apache Software Foundation
Path: Ciiapache24\bin'httpd exe

Allows Apache HTTP Server to communicate on these networks:
Private networks, such as my home or work network

Public networks, such s those in airports and coffee shops (not recommendid
because these networks often have lttle or no security)

What are the risks of sllowing an app through a firewall?

Allow access Cancel

6 - Check if Apache is active.
To verify that the service is active, simply visit the Apache test page in your browser. You can do it in two ways:

127.0.0.1 or localhost

It works!



Configure the PHP 8.1

With Apache active and functional, you now need to define and configure the PHP.ini file so those database extensions and libraries are available for use by Scriptcase.

1 - Access the PHP folder in  C:\ and rename the php.ini-development file to php.ini.

[ php.exe
B php.qif
A php.ini

W php-in-production

19/11/2019 11:54
11:54

2 - Access the php.ini file with a text editor using Administrative privileges and search for the ;extension_dir = "ext" directive.

Assign value “C:\php\ext” to this directive and remove ;.

Example:

extension_dir = "C:\php\ext"

3 - Enable the extensions listed below, by uncommenting them (Remove the semicolon ; at beginning of line).

Default Extensions

® extension=bz2

e extension=curl

® extension=gd2

® extension=gettext
® extension=imap

® extension=Idap

® extension=fileinfo
® extension=mbstring
® extension=openssl|
® extension=exif

® extension=xs|

® extension=soap

Database Extensions:

Extensions

extension=mysqli

extension=odbc

extension=pdo_mysql

extension=pdo_odbc

extension=pdo_pgsql

extension=pdo_sqlite

extension=pgsql

Driver enabled in Scriptcase

MySQLi

DB2 ODBC GENERIC, DB2 ODBC GENERIC 6, Generic ODBC, MS Access ODBC, MS SQL Server ODBC, Oracle ODBC, Progress
MySQL PDO

DB2 PDO ODBC, Progress PDO ODBC, Sybase PDO ODBC

PostgreSQL PDO

SQLite PDO

PostgreSQL 6.3 or below, PostgreSQL 6.4 or above, PostgreSQL 7 ou Acima

NOTE: Some database extensions will depend on third party drivers to be enabled. Click here to access configuration instructions for your desired database.

4 - Set the recommended minimum value of these PHP directives listed below for Scriptcase to work proprely. Search for the directives and assign the value according to this example:

® max_execution_time = 3600

® max_input_time = 3600

® max_input_vars = 10000

® memory_limit = 1024M

® post_max_size = 1024M

® upload_max_filesize = 1024M

e max_file_uploads = 200

® short_open_tag = On

IMPORTANT: By default PHP can disable some functions that are important for Scriptcase to function properly. Search for the disable_functions directive and make sure it is as follows: disable_functions=

function properly.

. Click here to access the

5 - Set up PHP TimeZone according to your region. You must use the value available in  PHP documentation. Search for the date.timezone line, uncomment it and edit it according to the selected TimeZone:

Example:

date.timezone = America/Recife

6 - Set the folder where temporary files will be stored. Search for the ;session.save_path line, uncomment it, and enter the path to your temporary folder.

Example:

session.save_path = "C:\Windows\Temp"



7 - Save all changes made to the php.ini file.
8 - Restart the Apache service using the Command Prompt (CMD) with Administrator privileges the following command:

C:\Apache24\bin\httpd.exe -k restart

9 - Verify changes made through the info.php file. You need to create this file and place it in the  C:\Apache24\htdocs directory with the following content:

<?php
phpinfo();
7>

After this, check the generated page in your browser by going to the URL  127.0.0.1/info.php .

@® 127.0.0.1finfo.php

PHP Version 8.1.9

System Windows NT NETMAKE-#
Build Date Aug 2 2022 14:14:30
Build System Microsoft Windows Server
Compiler Visual C++ 2019
Architecture x64

NOTE: For more information about the phpinfo() function, check the documentation do PHP.

Enabling the SourceGuardian Loader

Before you start the Scriptcase installation, you need to enable the loader responsible for encrypting Scriptcase in PHP. Follow the steps below to perform this action successfully.

1 - Extract the SourceGuardian Loader file downloaded at the beginning of this documentation.
If you haven't downloaded it yet click here and download the file according to the architecture used.
2 - Copy the ixed.8.1.win file and paste it into the PHP extensions directory ~C:\php\ext .
[ ixed.&.1win

[2] php_bz2.dil

[%] php_com_dotnet.dll

| QAT N200/NT 1140

3 - Edit the php.ini file and below the last line enter the path to the extension within the  zend_extension parameter:
Example:
[SourceGuardian] zend_extension=C:\php\ext\ixed.8.1.win

;ffi.enable=pre

; List of headers files to preload, w
;E£fi preload=

d patterns allowed.

[SourceGuardian] zend extension=C:\php\ext\ixed.8.1 .wid

4 - Restart the Apache service using the Command Prompt (CMD) with Administrator privileges the following command:

C:\Apache24\bin\httpd.exe -k restart

Manual Scriptcase Installation

Listed below are the steps needed to do a Scriptcase manual installation. To do the steps, it is needed that you have a web server configured in your machine .

1 - Download the Scriptcase (.zip) directly from the download page from our website.

2 - Extract the .zip file and rename the extracted folder to scriptcase .



3 - Move the scriptcase to your server root. Depending of your operating system and the installation the path can be different from the example. However, by default the paths are:
Windows Server

C:\Apache24\htdocs\  Apache

C:\inetpub\wwwroot\ 11S
Linux Server
Ivar/www/html/ Linux Local

/home/$(whoami)/public_html/ Linux Server

macOS Server
/Library/WebServer/Documents  Apache

4 - Access the Scriptcase using your browser:
127.0.0.1/scriptcase

e  ydefault the selected language is English.

Installation - Inifiafing

STEPS
Welcome to ScriptCase!
Initiating
This wizard will guide you in the installation and configuration process of ScriptCase.
PHP Extensions You will, step by step, be guided on all the stages necessary to adjust its environment to run the ool correctly.

Sysiemibolders Select the language that will be used during this installation
Database English T
ScriptCase Tables

ser (=]

Finishing

5 - Check the extensions required for Scriptcase to function and database connection modules that are enabled.

Check if the necessary PHP extensions are loaded.

Required Extensions. Action.
@ oo This extension is used to create charts and manipulate images
@ MBSTRING  This extension is used to convert special chars
The SimpleXML extension provides a very simple and easily usable toolset to
@ SimpleXML  convert XML to an object that can be processed with normal property selectors
and array iterators.
@ o This extension is used to create and extract files from a ZIP archive
@ ZLIB This extension is used to exiract files from a ZIP archive
@ Json This extension implements the data interchange format JavaScript Object
Notation (JSON).
Database Exiensions. Action.
com_dotnet Generic ADO, MS Access ADC, MS SQL Server ADO
ibm_db2 DB2, DB2 ODEC NATIVE Enable.
interbase Firebird, Interbase 8, Interbase 6.5
mssql MS SQL Server 7 Enable
mysql MaxSQL, MySQL (Non-Transactional), MySQL (Transactional} Enable.
mysqli MySaLi
oci8 Oracle 8, Oracle 8 Portable, Oracle 8.0.5

DB2 ODBC GENERIC, DB2 ODBC GENERIC &, Generic ODBC, MS Access

00000 0000000

odbe ODBC, MS SQL Server 0DBC, Oracle ODBC, Progress

oracle Oracle 7 Enable.
pdo_dbli  Sybase PDO DELIB

pdo_firebird  Firebird PDO

pdo_ibm PDO IEM Enable
pdo_informix Informix PDO Enable.

Typical Installation

Check the steps below to complete the manual installation of Scriptcase in a typical way.

| NOTE: By selecting this installation, Scriptcase will set your environment by default. Defining the installation database and the login user in Scriptcase.

® Typical Installation:
Scriptcase will install everything automatically.

O customized Installation:
'You could choose on which database you wish to install ScriptCase and the default username and password to access it.

After clicking proceed, you will be redirected to the Scriptcase Login page.



PASSWORD

[0 Keep me logged in Forgot your password?

=

To access for the first ime please use [adi
Your trial will expire in 20 day:

User

In this field, it is necessary to inform the user to login to Scriptcase. By default, the useris  admin.

Password

In this field, you must enter the password to login to Scriptcase. By default, the password is admin.

Keep me connected

This option keeps the user logged in until they log out through the Scriptcase interface.

Forgot your password?

By clicking this option, it is possible to recover the password of the informed user. An email will be sent to the user in question so they can access the recovery steps.

Important: You can only perform password recovery if you have configured your SMTP information. To access our documentation showing how to perform this configuration click  here.

Custom Installation

Check the steps below to complete the manual installation of Scriptcase in a custom manner.

NOTE: By selecting this installation, you will be responsible for setting up your environment. Defining the installation database and the login user for Scriptcase.

O Typical Installation:
Scriptcase will install everything automatically.

@® customized Installation:
You could choose on which database you wish to install ScriptCase and the default userame and password to access it

1- Verify that the directories required by Scriptcase have the correct permissions. If any directory listed does not have the active check icon ¥, correct permission for this directory.

n - System Fold

ScriptCase performs many operations with files. It is necessary that some
Initiating directories have the write permission set. Make sure the ScripiCase's

directories have the necessary autherization and correct the problem
PHP Extensions

v C:/Apache24/htdocsiscripicasesapp/

System Folders ‘¥ C:/Apache24/htdocsiscriptcaseicont/
¥ C:JApache24/htdocsiscriptcasefbackup!
Database W Ci/Apach: '
W CApache2s
ScripiCase Tables v G he24

' C:JApache24/htdocsiscriptcaseffile/doc!
¥ C:JApache24/htdocsiscriptcaseffile/img/
W CiApache24/tdocsiscriptcase/iog!
v C:/Apache24/htdocsiscriptcasetmp/

User

Finishing

Click proceed to proceed with the installation process .

2- Choose the database where the Scriptcase database will be installed. By default, Scriptcase recommends that it be installed with the  SQLite database.



<y Installation - Datab

STEPS

SeriptCase stores its applications data in a databaze. You must chooze the
Initiating connection parameters for ScriptCase to be able to connact to this database.
PHP Extensions DBMS v

System Folders
4 We recommend to use SQLIte &5 your main ScriptCase database

Using SQLite, you ensure a greater reliability in ScriptCase features, including
Automatic Backup of your projects and applications

If you want to install ScriptCase in another database,

ScripiCase Tables be aware that the Automatic Backup ScriptCase will not consider your projects
and most of the data related to it

User
Change Database
Finishing

Database

e ou can change the default database by clicking the Change Database button. By clicking this option you will need to set the following options:

<y Installation - Database

STEPS
ScriptCase stores its applications data in a database. You must choose the
Initiating connection parameters for ScriptCase 1o be able ta connact to this database
PHP Extensions DBMS | mMysoL PDO v
System Folders Server | 192.163.254 1713308
User root
Database
Password|
ScriptCase Tables Database| scripicase
User

We recommend to use SQLite as your main ScripiCase dalabase.

Using SQLite, you ensure a greater reliability in ScriptCase features, including
Finishing Automatic Backup of your projecis and applications

I you want te install ScriptCase in another database,

be aware that the Automalic Backup ScriptCase will not consider your projecis
and most of the data related to it

DBMS

In this option, you will select the Driver to connect to your database.

Server

In this option, you will inform the server to connect to the desired database.

User

You need to inform a user who has access to the database you want Scriptcase to be installed on.

Password

You must enter the authentication password corresponding to the entered user.

Database

You must enter the name of the database where Scriptcase will be installed.
Example:
scriptcase

Clique em prosseguir para avangar no processo de instalagao.

3 - Verifique se a criacdo das tabelas da base de dados do Scriptcase ocorreu com sucesso. As tabelas serdo marcadas com o icone de sucesso ¥ na lateral.

n :: ScriptCase Tables

STEPS
ot ScriplCase uses fables on a database to store the applcations development data.
nitiating
W sc_tbprj Projects table
PHP Extensions ¥ sc_tbusu User Table.
W sc_tbgroup  Groups fable
Sistan B W sc_tbuser_groupRelationship table for users and groups
Database W sc_tbati User Status Table.
W sc_tbapl Appiication Table:
ScriptCase Tables W sc_tbemp Fiekds Tabl.
W sc_tblog Table of Iog schemes
ot W sc_tblog_apl  Applcations Backup Table.
Wsc_tblog_cmp  Backup Table of fieds
Finishing ¥ sc_tbrep Data Dictionary Table.

¥ sc_tbrep_tables Data Dictionary(Tables) Table’
¥ sc_tbrep_fields Data Dictionary(Fields) Table’

¥ sc_tbconex Connections Table.
¥ sc_thsess Session table
Wsc_tbversao  Project Version Table
¥ sc_tbevt Events Table

W se_iblog_evt  Events Backup Table.
¥ sc_tbtrans Transactions Table.

¥ sc_tbtodo Task list table

W'sc_tbmsg Table of messages between users.

All ScriptCase tables are aready created

Next »

Click proceed to proceed with the installation process.

-__Set the default user who will have access to Scriptcase.



The aceess to ScripiCase is made through a user/password system. To access it for the first time,

Iniiating a user will be created with admin privieges. This wil alow you to log on the system and ereate new users.
PHP Extensions
Login admin
System Folders
Password.
Database Confirmation
ScriptCase Tables
- [ |
Finishing
Login

In this option, you will enter the default Scriptcase User Login.

Password

In this option, you must enter the password that will correspond to the user informed.

Confirmation

You must repeat the previously entered password for successful user creation.
Click proceed to proceed with the installation process.

5 - Complete Scriptcase custom installation on your web server.

Finishing
STEPS
SeriptCase is now configured and ready to start
Initiating
PHP Extensions Ay Installation Complete.
Congratulations! SeriptCase was successfully installed on your web server. Click on the “Ne:xt
System Folders button to proceed to login page.
Database
User
Finishing

After clicking proceed, you will be redirected to the Scriptcase Login page.

PASSWORD

[0 Keep me logged in Forgot your password?

EE English v

for the first time please use ‘ idmin / admi
Your trial will expire in 20 days.

User

In this field, it is necessary to inform the user to login to Scriptcase. By default, the useris  admin.

Password

In this field, you must enter the password to login to Scriptcase. By default, the password is admin.

Keep me connected

This option keeps the user logged in until they log out through the Scriptcase interface.

Forgot your password?

By clicking this option, it is possible to recover the password of the informed user. An email will be sent to the user in question so they can access the recovery steps.



l Important: You can only perform password recovery if you have configured your SMTP information. To access our documentation showing how to perform this configuration click  here.

10



Installing PHP 8.1 - Linux

This documentation will teach all the steps necessary for the installation of the PHP 8.1, Apache 2.4 and the Scriptcase using the manual installation in the Linux environment. Doing this kind of installation you will be responsible for cor
the database extensions as well.

Listed below are the operational systems approved for the Scriptcase usage. Only these distributions below and their derivatives are approved for the Scriptcase installation.
Check the list of the supported operating systems:

e edHat
e  ebian\Ubuntu
e use\OpenSuse

NOTE: In case you need to make a manual installation of the Scriptcase using PHP 7.3 in Linux, access the documentation in our knowledge base.

Prerequisites

WARNING: If you already have a Web Server with Apache and PHP 8.1 configured, just go to the SourceGuardian configuration and proceed to manual installation.

To proceed with the installation, you will need to download some files.
Necessaries Files:

e ourceGuardian for Linux (x86 ou x64) : Click Here
e criptcase (.zip): Click Here

| NOTE: Before continue with the installation is recommended that you do not have any other web environment (as XAMP, Zend Server, etc) installed in your operational system. It is recommended to know Linux/Unix environment

Configuring the PHP - Ubuntu 22.04\Debian 10

Listed below are the necessaries commands for the manual installation of the PHP in the Ubuntu 22.04 or Debian 10. Check correctly the name of the packages in your terminal.
1 - Before run any other command, update your operating system with the following commands:

sudo apt-get update
sudo apt-get upgrade

2 - Run the command sudo apt-get install php8.1 to install the PHP 8.1. After that, accept the dependencies installation.
If you are using any Ubuntu version before 19.10, it's necessary to add a repository in your operating system to access the PHP 8.1 packages. See how you can do it below:

sudo add-apt-repository ppa:ondrej/php
sudo apt-get update

If you are using any Debian version before Debian 10, it's necessary to add a repository in your operating system to access the PHP 8.1 packages. See how you can do it below:
sudo apt -y install Isb-release apt-transport-https ca-certificates

sudo wget -O /etc/apt/trusted.gpg.d/php.gpg https://packages.sury.org/php/apt.gpg
echo "deb https://packages.sury.org/php/ $(Isb_release -sc) main" | sudo tee /etc/apt/sources.list.d/php8.1.list

sudo apt-get update

sudo apt-get install php8.1
Example:

apt-get install php8.1

adiclona
apache2 apache
libaprutili-1d

1 libapr1 libaprutili libaprutili-dbd-sqlitd
1- <

em disco sera

3 - Check the PHP version running the command: php -v
Example:
S php -v

PHP 8.1.8 (cli) (built: Jul 11 2622 08:29:57) (NTS)
Copyright (c) The PHP Group

Zend Engine v4.1.8, Copyright (c) Zend Technologies
with Zend OPcache v8.1.8, Copyright (c), by Zend Technologies

4 - Now, install all the extensions below that are required by Scriptcase:
Default Extensions:

® sudo apt-get install php8.1-curl

® sudo apt-get install php8.1-gd

® sudo apt-get install php8.1-bcmath
® sudo apt-get install php8.1-cgi

® sudo apt-get install php8.1-ldap

® sudo apt-get install php8.1-mbstring
® sudo apt-get install php8.1-xml

® sudo apt-get install php8.1-soap

® sudo apt-get install php8.1-xsl

® sudo apt-get install php8.1-zip

Database Extensions:



Extension Driver enabled in Scriptcase

sudo apt-get install php8.1-pgsql PostgreSQL PDO, PostgreSQL 6.3 or below, PostgreSQL 6.4 or above, PostgreSQL 7 or above
sudo apt-get install php8.1-mysql MySQLi, MySQL PDO
sudo apt-get install php8.1-sqlite3 SQLite PDO

sudo apt-get install php8.1-interbase Firebird, Interbase 6, Interbase 6.5, Firebird PDO
sudo apt-get install php8.1-odbc DB2 ODBC GENERIC, DB2 ODBC GENERIC 6, Generic ODBC, MS Access ODBC, Oracle ODBC, Progress, DB2 PDO ODBC, Progress PDO ODBC, Sybase PDO ODBC

sudo apt-get install php8.1-sybase DBLIB, Sybase PDO DBLIB

NOTE: Some database extensions will depend on third party drivers to be enabled. Click here to access the setup instructions for your database.

5 - Access the php.ini file in the directory /etc/php/8.1/apache2/ and set the recommended values for the PHP directives listed below required by the Scriptcase.
Search for theses directives and set the values as the example:

max_execution_time = 3600
max_input_time = 3600

max_input_vars = 10000

memory_limit = 1024M
post_max_size = 1024M
upload_max_filesize = 1024M
max_file_uploads = 200

® o o 0 0 0 o o

short_open_tag = On

6 - By default, the PHP disable some functions that are required by the Scriptcase. Click here to access the list of these functions.
e hange the line disable_functions as the example below:

disable_functions =

Example:

; This directive allows you to disable certain functions for security reasons.
ves a comma-delimited list of function names.

hp.net/disable-functions
functions =

7 - Set up the PHP TimeZone according your region. Must use the values available in the PHP documentation. Search for the line date.timezone in your php.ini, uncomment and edit according with the TimeZone selected.
Example:
date.timezone = America/Recife
8 - Set up the folders that will store the temporary files. Search for the line ;session.save_path , uncomment and set the path to your temporary folder.
Example:
session.save_path = "/tmp"
9 - Save all the changes made and restart the Apache service using the following command:
sudo service apache2 restart
10 - Check if the changes were made using the file info.php. You will need to create this file and place it in the  /var/www/html/ path with the following content.
<?php
phpinfo();
7>

After that, check using your browser the page generated accessing the URL  127.0.0.1/info.php .

C @ 127.00.1/infophp

hp
System Linux netmake-Vostro-3560 5.13 0-52-genenc #50~20.04.1-Ubuntu SMP Thu Jun 16 21:21:28 UTC 2022 xB6_64
Build Date Jul 11 2022 08:29:57
Linux
Server API Apache 2.0 Handler

I NOTE: For more information about the phpinfo(), check the PHP documentation.

Enabling the SourceGuardian

Before starting the Scriptcase installation, you need to enable the loader used for the Scriptcase encryption in your PHP. Follow the steps below showing how to dot it.
1 - Access the Downloads folder and extract the file downloaded referent to the SourceGuardian at the beggining of this documentation.
Example:
cd /home/User/Downloads
sudo chmod 777 loaders.linux-x86_64.zip && unzip loaders.linux-x86_64.zip
2 - Copy the file ixed.8.1.lin and past in the extension_dir directory of your PHP. We will use the path /usr/lib/php/20210902 for this example.

Example:



Ubuntu 22.04\Debian 10
Jusr/lib/php/20180731
sudo cp ixed.8.1.lin /usr/lib/php/20210902

3 - Edit the php.ini file and below the last line set the path to the extension in the  zend_extension parameter:

Example:

"fusr/1ib/php/20210902/ixed.8.1.1in"

Ubuntu 22.04\Debian 10
/etc/php/8.1/apache2/

sudo nano /etc/php/8.1/apache2/php.ini
zend_extension = "/usr/lib/php/20210902/ixed.8.1.lin"

4 - Restart the Apache service using the following command:
Ubuntu 22.04\Debian 10

sudo service apache2 restart sudo systemctl restart httpd

Scriptcase Manual Installation

Listed below are the steps needed to do a Scriptcase manual installation. To do the steps, i

s needed that you have a web server configured in your machine .

1 - Download the Scriptcase (.zip) directly from the download page from our website.

2 - Extract the .zip file and rename the extracted folder to scriptcase .

3 - Move the scriptcase to your server root. Depending of your operating system and the installation the path can be different from the example. However, by default the paths are:

Windows Server

C:\Apache24\htdocs\  Apache

C:\inetpub\wwwroot\ 1S
Linux Server
Ivar/www/html/ Linux Local

/home/$(whoami)/public_html/ Linux Server

macO0S Server
/Library/WebServer/Documents Apache

4 - Access the Scriptcase using your browser:
127.0.0.1/scriptcase

e ydefault the selected language is English.

Installation = Inifia

STEPS
Welcome to ScriptCase!
Initiating
This wizard will guide you in the installation and configuration process of ScriptCase.
PHP Extensions ‘Youwill, step by step, be guided on all the stages necessary to adjustits environment to run the tool correctly.

RE L Select the language that will be used during this installation
Database English A
ScriptCase Tables

ser (=]

Finishing

5 - Check the extensions required for Scriptcase to function and database connection modules that are enabled.



Check if the necessary PHP extensions are loaded.

Required Extensions. Action.
@ oo This extenzion is used to create charts and manipulats images
& MBSTRING  This extension is used to convert special chars

The SimpleXML extension provides a very simple and easily usable toolset to

& SimpleXML  convert XML to an object that can be processed with normal property selectors
and array iterators

@ zr This extension is used to create and extract files from a ZIP archive
@ ze This extension is used to extract files from a ZIP archive
) t
@ uson This extension impl the data format Object

Notation (JSON).

Database Exiensions. Action.

6 com_dotnet Generic ADO, MS Access ADO, MS SQL Server ADO

&  ibm_db2 DBZ, DB2 ODBC NATIVE Enable
e inferbase Firebird, Interbase 6, Interbase 6.5

& mssq MS SQL Server 7 Enable
& mysal MaxS0L, MySQL (Non-Transactional), MySQL (Transactional} Enable.
@ mysqi MySQLi

e oci8 Oracle 8, Oracle 8 Portable, Oracle 8.0.5

6 odbc DB2 ODBC GENERIC, DB2 ODBC GENERIC 8, Generic ODBC, MS Access

ODBC, MS SQL Server ODBC, Oracle ODBC, Progress
€& orace Qracle 7 Enable.
@  pdo_dvlip Sybase PDO DBLIB
@ pdo_firebird  Firebird PDO
& pdo_ibm PDO IBM Enable
€  pdo_informix  Informix PDO Enable.

Typical Installation

Check the steps below to complete the manual installation of Scriptcase in a typical way.

l NOTE: By selecting this installation, Scriptcase will set your environment by default. Defining the installation database and the login user in Scriptcase.

© 1ypical Installation:
Scriptcase will install everything automatcally.

Customized Installation:
You could choose on which database you wish to install ScriptCase and the default usemame and password to access
it

After clicking proceed, you will be redirected to the Scriptcase Login page.

PASSWORD

[ Keep me logged in Forgot your password?

EE English v

To access for the first time please use [ admin / admi
Your trial will expire in 20 days.

User

In this field, it is necessary to inform the user to login to Scriptcase. By default, the useris admin.

Password

In this field, you must enter the password to login to Scriptcase. By default, the password is admin.

Keep me connected

This option keeps the user logged in until they log out through the Scriptcase interface.

Forgot your password?



By clicking this option, it is possible to recover the password of the informed user. An email will be sent to the user in question so they can access the recovery steps.

Important: You can only perform password recovery if you have configured your SMTP information. To access our documentation showing how to perform this configuration click  here.

Customized Installation

Check the steps below to complete the manual installation of Scriptcase in a custom manner.

NOTE: By selecting this installation, you will be responsible for setting up your environment. Defining the installation database and the login user for Scriptcase.

Typical Installation:
Scriptcase will install everything automatically.

© cusiomized installation:
You could cnoose on which database you wish 10 install ScripiCase and the default usemame and password to access
i

1- Verify that the directories required by Scriptcase have the correct permissions. If any directory listed does not have the active check icon ¥, correct permission for this directory.

SeriptCase performs many operations with files. Itis

Initiating necessary that some directories have the write permission
sel. Make sure the SeripiCase’s directories have the

PHP Extensions necessary authorization and correct he problem.

System Folders ¥ arhwwintmiscripteasesapp/
W Narwawhtmiiscriptcaselcont/

Database ¥ Warhwwhtmiiscriptcaselbackup!

v Narhwwwinimiiscriptcaseideveliconfigrp!
ScriptCase Tables v

W Narhwawmtmiscriptcaseidevelcontiusi/
User v varhwwwintmiiscriptcasedfileidoc!
¥ Narmwwwintmiiscriptcasedfilefimg!
W Narwaw/htmiiscriptcasesog/
W Narhwswhtmiiscriptcaseftmp/

Finishing

Click proceed to proceed with the installation process .

2- Choose the database where the Scriptcase database will be installed. By default, Scriptcase recommends that it be installed with the  SQLite database.

<y Installation :: Datab

STEPS
» ScriptCase stores its applications data in a database. You must choose the
Initiating connection parameters for ScriptCase to be able to connect to this database.

PHP Extensions DBMS v

System Fold
YEENIOCSIE We recommend to use SQlLite as your main ScriptCase database

Using SQLite, you ensure a greater reliability in ScripiCase features, including
Automatic Backup of your projects and appiications

) If you want to nstall ScriptCase in another database,

ScripiCase Tables be aware that the Automatic Backup ScriptCase will not consider your projects
and most of the data related o it

User
Change Database
Finishing

Database

e ou can change the default database by clicking the Change Database button. By clicking this option you will need to set the following options:

<) Installation : Database

STEPS
o ScriptCase stores its applications data in a database. You must choose the:
Initiating connection parameters for ScriptCase to be able to connect to this database
PHP Extensions pems | mysaL poo -

System Folders Server | 192.168.254 1713306
User | root

Database
Password

ScripiCase Tables Database| scriptcase

User

We recommend to use SQLite as your main ScriptCase database.

Using SQLite, you ensure & greater reliability in ScriptCase faatures, including
Finishing Automatic Backup of your projects and applications

It you want to install ScriptCase in another database,

be aware that the Automatic Backup ScriptCase will not consider your projects
and most of the data related to it

DBMS

In this option, you will select the Driver to connect to your database.

Server

In this option, you will inform the server to connect to the desired database.

User



You need to inform a user who has access to the database you want Scriptcase to be installed on.

Password

You must enter the authentication password corresponding to the entered user.

Database

You must enter the name of the database where Scriptcase will be installed.
Example:
scriptcase

Clique em prosseguir para avangar no processo de instalagao.

3 - Verifique se a criagdo das tabelas da base de dados do Scriptcase ocorreu com sucesso. As tabelas serdo marcadas com o icone de sucesso ¥ na lateral.

n :: ScripiCase Tables

STEPS
i ScripiCase uses fables on a database to store the applcations development data.
nitating

¥ sc_tbprj Projects table
PHP Extensions ¥ sc_tbusu User Table.

Wsc_ibgroup  Groups fable

Sysleribokicrs) W sc_tbuser_groupRelationship table for users and groups

¥ sc_thati User Status Table.
Dalab ey W sc_thapl Application Table.
ScriptCase Tables W sc_tbemp Fields Table.

W se_tblog Table of log schemes
User ‘¥'sc_tbiog_apl  Applications Backup Table.

¥’sc_tbiog_cmp  Backup Table of fields.
Finishing ¥ sc_tbrep Data Dictionary Table.

W sc_tbrep_tables Data Dictionary(Tables) Table;
W sc_tbrep_fields Data Dictionary(Fields) Tabie’,

¥ sc_tbeonex Connections Table.
Wsc_tbsess Session table

Wsc toversac  Project Version Table,
sc_thevt Events Table.

¥sc_tblog_evt  Events Backup Table.
Wsctbtrans  Transactions Table.

Wsc_thtodo Task list table:

¥ sc_tbmsg Table of messages between users

All SeriptCase tables are already created

Next »

Click proceed to proceed with the installation process.

_4-__ Set the default user who will have access to Scriptcase.

STEPS
The access to ScriptCase is made through a user/passviord system. To acoess i for the first fime,
it a user wil be created with admin privieges. This wil alow you 1o I6g on the system and create new sers,
PHP Extensions
Login agmin
System Folders
Password.
B Confirmation.
ScriptCase Tables
- Cea
Finishing
Login

In this option, you will enter the default Scriptcase User Login.

Password

In this option, you must enter the password that will correspond to the user informed.

Confirmation

You must repeat the previously entered password for successful user creation.
Click proceed to proceed with the installation process.

5 - Complete Scriptcase custom installation on your web server.

STEPS
ScriptCase is now configured and ready to start

Iniiating

PHP Exiensions A\ Installation Complete.
Congratulations! SeriptCase was successfully installed on your web server. Cick on the “Next”

System Folders button to proceed to legin page.

Database

SrplCa Tabks [ e |

User

Finishing

After clicking proceed, you will be redirected to the Scriptcase Login page.



PASSWORD

[0 Keep me logged in Forgot your password?

EE English v

for the first time please use (admin / admi
Your trial will expire in 20 days.

User

In this field, it is necessary to inform the user to login to Scriptcase. By default, the useris  admin.

Password

In this field, you must enter the password to login to Scriptcase. By default, the password is admin.

Keep me connected

This option keeps the user logged in until they log out through the Scriptcase interface.

Forgot your password?

By clicking this option, it is possible to recover the password of the informed user. An email will be sent to the user in question so they can access the recovery steps.

Important: You can only perform password recovery if you have configured your SMTP information. To access our documentation showing how to perform this configuration click  here.

Do you need to register your Scriptcase?
You can access our knowledge base to understand all the steps to register the Scriptcase serial.



Installing PHP 8.1 - macOS

This documentation will cover how installing PHP 8.1 and ScriptCase manually on macOS. Performing this type of installation is your responsible for configuring your entire environment as well as database extensions.

Listed below are versions of macOS approved for use by Scriptcase.

Our supported versions:
Mac0s 12.0 “Monterey”
Mac0s 11.0 “Big Sur”

MacOs 10.15 “Catalina”
MacOSv10.14  “Mojave”
MacOSv10.13  “High Sierra”
MacOSv10.12  “Sierra”

0SXv10.11 “El Capitan”

You can install the Scriptcase with PHP 7.3 or PHP 7.0:

See how to install with PHP 7.3 See how to install with PHP 7.0

Requirements

Ifyou already have a Web Server with Apache and PHP 8.1 configured, just go to the SourceGuardia configuration and proceed to manual installation.

To proceed with the installation, you need to download some files.

Required Files:

® ourceGuardian Loader 13.0.3 for macOS - macOS: Click here

e  criptcase (.zip): Click here

| Before proceeding with the installation it is recommended not to have any other web environments (such as XAMP, Zend Server, etc.) installed on the operating system. dge of Unix envii Is rec

PHP configuration

Listed below are the commands required for the manual installation of PHP 8.1 on macOS. Check the package naming on your macOS terminal correctly.
1- You'll need to install Homebrew to be able to access PHP 8.1 and other packages. Install Brew with the following commands in the macOS terminal:
/bin/bash -c "$(curl -fsSL https://raw.githubusercontent.com/Homebrew/install/HEAD/install.sh)"

2 - Inthe macOS terminal, execute brew update to update Brew.

3 - Use the command brew install shivammathur/php/php@8.1 for installing PHP 8.1.

4 - After the installation proccess completes, execute brew info php@8.1 to get the information that we need to proceed with environment setting up.

php: stable 8.1.9 (bottled), HEAD
General-purpose scripting language
https://www.php.net/
Jopt/homebrew/Cellar/php/8.1.9 (513 files, 81.7MB) *
Poured from bottle on 2022-08-17 at 09:01:50
From: https://github.com/Homebrew/homebrew-core/blob/HEEAD/Formula/php.rb
License:r PHP-3.01
Dependencies
. pkg-config
v, apr-util v, argon2 v, aspell v, autoconf v, curl v, freetds -, gd v, gettext v, gmp v, icudc v,
libpg v, libsodium v, libzip v, oniguruma », cpenldap v, openssl@l.l v, pcre2 v, sqlite v, tidy-html5 v,

options
~~HEAD
Install HEAD version
Caveats
To enable PEP in Apache add the following to httpd.conf and restart Apache:
LoadModule php module /opt/homebrew/opt/php/lib/httpd/modules/1ibphp.so

<FilesMatch \.php§>
SetHandler application/x-httpd-php
</FilesMatch>

Finally, check DirectoryIndex includes index.php
DirectoryIndex index.php index.html

The php.ini and php-fpm.ini file can be found in:
/opt/homebrew/etc/php/8.1/

5 - You need to configure Apache so that PHP 8.1 that was installed in the previous steps will be used as default on your system.

ded to use terr

To use PHP on MacOS native Apache, we will need to create a certificate that authorizes its use. Until Monterey this process was optional, but now PHP Code Signed is required. Follow this post to do the  code signing

5.1 - Edit the Apache file httpd.conf , find the “Loadmodule” line block and add the line according to your equipment:
Exemple:
sudo nano /etc/apache2/httpd.conf

Chip Intel
LoadModule php_module /usr/local/opt/php@8.1/lib/httpd/modules/libphp.so

Chip da Apple
LoadModule php_module/opt/homebrew/opt/php@8.1/lib/httpd/modules/libphp.so

At the end of the file add:



<FilesMatch .php$>
SetHandler application/x-httpd-php
</FilesMatch>

6 - Add path to PHP 8.1 module installed after last line LoadModule in httpd.conf.
Exemple:

LoadModule php_module /usr/local/opt/php@8.1/lib/httpd/modules/libphp.so

#LoadModule rewrite module libexec/apache2/mod rewrite.so
#PHP was deprecated in macOS 11 and removed from macOs 12
#LoadModule perl module libexec/apache2/mod_perl.so
LoadModule hfs_apple module libexec/apache2/mod hfs_apple.so

LoadModule php module /opt/homebrew/opt/php@8.1/1ib/httpd/modules/libphp.so "PHEP 81"

After performing this action, save the file and restart the apache service.

sudo apachectl restart
7 - Add the path to the installation of PHP 8.1 in the ~ /.zshrc file with the following commands:

echo 'export PATH="/opt/homebrew/opt/php@8.1/bin:$PATH"' >> ~/.zshrc echo 'exportPATH="/opt/homebrew/opt/php@8.1/sbin:$PATH"" >> ~/.zshrc
8 - Edit the file ~/.bash_profile and add PHP 8.1 path with these following commands:

echo 'export PATH="/opt/homebrew/opt/php@8.1/bin:$PATH"'

9 - Verify PHP version by running command: php -v

Exemple:

qascriptcase@MacBook-Air-de-scriptcase ~ % php -v
PHP B8.1.9 (cli) (built: Aug 4 2022 05:22:38) (NTS)
Copyright (c) The PHP Group

Zend Engine v4.1.9, Copyright (c) Zend Technologies
with Zend OPcache v8.1.9, Copyright (c), by Zend Technologies

10 - Access the php.ini file in the directory. /opt/homebrew/etc/php/8.1/ and set the recommended minimum value correctly of these PHP directives listed below for Scriptcase work properly.
Search for the directives and assign the value according to this example:

max_execution_time = 3600
max_input_time = 3600
max_input_vars = 10000
memory_limit = 1024M
post_max_size = 1024M
upload_max_filesize = 1024M
max_file_uploads = 200

short_open_tag = On

11 - By default, PHP disables some functions that are important to Scriptcase. Click here to access the necessary functions list for ScriptCase
e hange item line disable_functions as example below:

disable_functions =

Exemple:

; This directive allows you to disable certain functions for security reasons.
It receives a comma-delimited list of function names.

http hp.net/disable-functions
Hisable_functions =

12 - Set PHP TimeZone according to your region. Use the value available in the PHP documentation. Searh for date.timezone in your php.ini file, uncomment it and edit according to the selected TimeZone.
Exemple:

date.timezone = America/Recife

13- Set the folder where temporary files will be stored. search for ;session.save_path , uncoment it and inform your temporary folder path.

Exemple:

session.save_path = "/tmp"

14 - Save all modifications made and restart the Apache service using the following command in terminal:

sudo apachect! restart

15 - Verify changes made through the file info.php. You need to create this file and put it in the directory. /Library/WebServer/Documents/ with the following content:

<?php
phpinfo();
7>

After that, check in your browser the page generated by accessing the URL 127.0.0.1/info.php .

System Darwin Mac-mini-de-Netmake local 19.0.0
rootxnu-6153.11.26~2/RELEASE_X86_6:

Build Date Nov 29 2019 20:06:07

Configure Command *.Iconfigure’ -prefix=fusr/local/Cellar/phpg

sysconfdir=/usr/lecaletc/php/7.3" —-with-ct

NOTE: For more information about the function phpinfo(), verify our PHP documentation.




Enable SourceGuardian Loader

Before you start installing Scriptcase, you need to enable the loader responsible for encrypting Scriptcase in PHP. Follow the steps below to perform this action successfully.

1 - Access the Downloads folder and extract the downloaded file referring to  SourceGuardian Loader at the beginning of this documentation.
Ifyou have not yet downloaded the SourceGuardian Loader click here and download the file according to the architecture used.

Exemple:

cd /Users/usuario/Downloads

sudo chmod 777 loaders.macosx-arm64.zip && unzip loaders.macosx-armé4.zip

cd loaders.macosx-arm64
2 - Copy the file ixed.8.1.dar and paste it into your PHP extension_dir directory. We'll use /opt/homebrew/lib/php/pecl/20210902 for this example.
Exemple:

sudo cp ixed.8.1.dar /opt/homebrew/lib/php/pecl/20210902
3 - Edit the php.ini file and below the last line enter the path to the extension within the parameter  zend_extension :

Exemple:

sudo bash -c 'echo "zend_extension=/opt/homebrew/lib/php/pecl/20210902/ixed.8.1.dar" > /opt/homebrew/etc/php/8.1/conf.d/sourceguardian.ini'
4 - Restart the Apache service with the following terminal command:

sudo apachectl restart

Manual ScriptCase installation

Listed below are the steps needed to do a Scriptcase manual installation. To do the steps, it is needed that you have a web server configured in your machine .

1 - Download the Scriptcase (.zip) directly from the download page from our website.

2 - Extract the .zip file and rename the extracted folder to scriptcase .

3 - Move the scriptcase to your server root. Depending of your operating system and the installation the path can be different from the example. However, by default the paths are:

Windows Server

C:\Apache24\htdocs\  Apache

C:\inetpub\wwwroot\ 1S
Linux Server
Ivar/www/html/ Linux Local

/home/$(whoami)/public_html/ Linux Server

macOS Server
/Library/WebServer/Documents  Apache
4 - Access the Scriptcase using your browser:

127.0.0.1/scriptcase

o  ydefault the selected language is English.

Installation - Inifiafing

STEPS
Welcome to ScriptCase!
Initiating
This wizard will guide you in the installation and configuration process of ScriptCase.
PHP Extensions You will, step by step, be guided on all the stages necessary to adjust its environment to run the ool correctly.

Sysiemibolders Select the language that will be used during this installation

Database English M

ScriptCase Tables
ser (=]

Finishing

5 - Check the extensions required for Scriptcase to function and database connection modules that are enabled.



Check if the necessary PHP extensions are loaded.

Required Extensions. Action.
@ oo This extenzion is used to create charts and manipulats images
& MBSTRING  This extension is used to convert special chars

The SimpleXML extension provides a very simple and easily usable toolset to

& SimpleXML  convert XML to an object that can be processed with normal property selectors
and array iterators

@ zr This extension is used to create and extract files from a ZIP archive
@ ze This extension is used to extract files from a ZIP archive
) t
@ uson This extension impl the data format Object

Notation (JSON).

Database Exiensions. Action.

6 com_dotnet Generic ADO, MS Access ADO, MS SQL Server ADO

&  ibm_db2 DBZ, DB2 ODBC NATIVE Enable
e inferbase Firebird, Interbase 6, Interbase 6.5

& mssq MS SQL Server 7 Enable
& mysal MaxS0L, MySQL (Non-Transactional), MySQL (Transactional} Enable.
@ mysqi MySQLi

e oci8 Oracle 8, Oracle 8 Portable, Oracle 8.0.5

6 odbc DB2 ODBC GENERIC, DB2 ODBC GENERIC 8, Generic ODBC, MS Access

ODBC, MS SQL Server ODBC, Oracle ODBC, Progress
€& orace Qracle 7 Enable.
@  pdo_dvlip Sybase PDO DBLIB
@ pdo_firebird  Firebird PDO
& pdo_ibm PDO IBM Enable
€  pdo_informix  Informix PDO Enable.

Typical installation

Check the steps below to complete the manual installation of Scriptcase in a typical way.

l NOTE: By selecting this installation, Scriptcase will set your environment by default. Defining the installation database and the login user in Scriptcase.

(® Typical Installation:
Scriptcase will install everything automatically.

O customized Installation:
'You could choose on which database you wish to install ScriptCase and the default usemname and password to access it.

After clicking proceed, you will be redirected to the Scriptcase Login page.

PASSWORD

[0 Keep me logged in Forgot your password?

EE English v

To access for the first ime please use [admin / admi
“Your trial will expire in 20 days.

User

In this field, it is necessary to inform the user to login to Scriptcase. By default, the useris admin.

Password

In this field, you must enter the password to login to Scriptcase. By default, the password is admin.

Keep me connected

This option keeps the user logged in until they log out through the Scriptcase interface.

Forgot your password?



By clicking this option, it is possible to recover the password of the informed user. An email will be sent to the user in question so they can access the recovery steps.

Important: You can only perform password recovery if you have configured your SMTP information. To access our documentation showing how to perform this configuration click  here.

Custom installation

Check the steps below to complete the manual installation of Scriptcase in a custom manner.

NOTE: By selecting this installation, you will be responsible for setting up your environment. Defining the installation database and the login user for Scriptcase.

O Typical Installation:
Scriptcase will install everything automatically.

® customized Installation:
'You could choose on which database you wish to install ScriptCase and the default username and password to access it

1- Verify that the directories required by Scriptcase have the correct permissions. If any directory listed does not have the active check icon ¥, correct permission for this directory.

<> Instalagio - Diretorios do Sistema

PASSOS

~ O ScriptCase realiza diversas operacies em arquive. Para isto, &
Inicializacao necessario que alguns diretbrios tenham a permissdo de escrita
liberada
Extensbes do PHP
Verifique se algum dos diretérios usados pelo ScripiCase nio possui

Diretorios do Sistema a autorizacdo necessaria e corrija o problema
Banco de Dados ¥ L
Vi
Tabelas do ScriptCase ¥ L ¥,
¥ iLibrary
Usudrio W L
B W L
Finalizagio v iLibrary
W iLibrary
¥ L
VL

Prosseguir »

Clique em prosseguir para avangar no processo de instalagdo.

2- Choose the database where the Scriptcase database will be installed. By default, Scriptcase recommends that it be installed with the  SQLite database.

<
STEPS

ScriptCase stores its applications data in a database. You must choose the
Initiating connection parameters for ScriptCase to be able to connect to this database.
PHP Extensions DBMS V

System Folders
4 We recommend to use SQLIte &5 your main ScriptCase database

Using SQLite, you ensure a greater reliability in SeriptCase featurss, including
Automatic Backup of your projects and applications

If you want to install ScriptCase in another database,

be aware that the Automatic Backup ScriptCase will not consider your projects
and most of the data related to it

Database
ScriptCase Tables

User

“hange Database

Finishing

e ou can change the default database by clicking the Change Database button. By clicking this option you will need to set the following options:

<> Installation :: Database

STEPS
o ScriptCase stores its applications data in a database. You must choose the
Initiating connection parameters for ScripiCase to be able to connect to this database
PHP Extensions bems | mysat poo -
System Folders Server | 192 168254 171:3306
User root
Database
Password s
ScriptCase Tables Database| scriptcase
Usey ‘We recommend to use SQLite as your main ScriptCase database.
Using SQLite, you ensure a greater reliability in ScripiCase features, including
Finishing Automatic Backup of your projects and applications
If you want to install ScriptCase in another database,
be aware that the Automatic Backup ScripiCase will not consider your projects
and most of the data related to it
DBMS

In this option, you will select the Driver to connect to your database.

Server

In this option, you will inform the server to connect to the desired database.



User

You need to inform a user who has access to the database you want Scriptcase to be installed on.

Password

You must enter the authentication password corresponding to the entered user.

Database

You must enter the name of the database where Scriptcase will be installed.
Example:
scriptcase

Clique em prosseguir para avangar no processo de instalagao.

3 - Verifique se a criagdo das tabelas da base de dados do Scriptcase ocorreu com sucesso. As tabelas serdo marcadas com o icone de sucesso ¥’ na lateral.

istallation :: ScripiCase Tables

STEPS
i ScripiCase uses fables on a database to store the applcations development data.
nitating

¥ sc_tbprj Projects table
PHP Extensions ¥ sc_tbusu User Table.

¥scibgroup  Groups fable

Sysleribokicrs) W sc_tbuser_groupRelationship table for users and groups

¥ sc_tbati User Status Table.
Dalab ey W sc_tbapl Application Table.
ScriptCase Tables W sc_tbemp Fields Table.

W se_tblog Table of log schemes
user W se_tblog_apl  Appications Backup Table:

W sc_tblog_emp  Backup Table of fields.
Finishing ¥'sc_tbrep Data Dictionary Table.

W sc_tbrep_tables Data Dictionary(Tables) Table;
W sc_tbrep_fields Data Dictionary(Fields) Tabie’,

¥ sc_tbeonex Connections Table.
¥sc_thsess Session table
sctbversao  Project Version Table.
sc_thevt Events Table.

¥sc_tblog_evt  Events Backup Table.
Wsctbrans  Transactions Table.

Wsc_thtodo Task list table:

¥ sc_tbmsg Table of messages between users

All SeriptCase tables are already created

Next »

Click proceed to proceed with the installation process.

_4-__Set the default user who will have access to Scriptcase.

STEPS
The aceess to ScripiCase is made through a user/password system. To access it for the first time,
Initiating @ user will be created with admin privieges. This will allow you 1o log on the System and create new Users.
PHP Extensions
Login admin
System Folders.
Password.
Database Confirmation.]
ScripiCase Tables
s [ec |
Finishing
Login

In this option, you will enter the default Scriptcase User Login.

Password

In this option, you must enter the password that will correspond to the user informed.

Confirmation

You must repeat the previously entered password for successful user creation.
Click proceed to proceed with the installation process.

5 - Complete Scriptcase custom installation on your web server.

STEPS
ScriptCase is now configured and ready to start

Iniiating

PHP Exiensions A\ Installation Complete.
Congratulations! SeriptCase was successfully installed on your web server. Cick on the “Next”

System Folders button to proceed to legin page.

Database

SerpiCa Tabk [ e |

User

Finishing

After clicking proceed, you will be redirected to the Scriptcase Login page.



PASSWORD

[0 Keep me logged in Forgot your password?

EE English v

for the first time please use (admin / admi
Your trial will expire in 20 days.

User

In this field, it is necessary to inform the user to login to Scriptcase. By default, the useris  admin.

Password

In this field, you must enter the password to login to Scriptcase. By default, the password is admin.

Keep me connected

This option keeps the user logged in until they log out through the Scriptcase interface.

Forgot your password?

By clicking this option, it is possible to recover the password of the informed user. An email will be sent to the user in question so they can access the recovery steps.

Important: You can only perform password recovery if you have configured your SMTP information. To access our documentation showing how to perform this configuration click  here.

Needing register your ScriptCase?
VYou can access our knowledge base to understand all the steps for registering Scriptcase license.



Scriptcase Manual Installation

Listed below are the steps needed to do a Scriptcase manual installation. To do the steps, it is needed that you have a web server configured in your machine .

1 - Download the Scriptcase (.zip) directly from the download page from our website.

2 - Extract the .zip file and rename the extracted folder to scriptcase .

3 - Move the scriptcase to your server root. Depending of your operating system and the installation the path can be different from the example. However, by default the paths are:

Windows Server

C:\Apache24\htdocs\  Apache

C:\inetpub\wwwroot\ 1S
Linux Server
Ivar/www/html/ Linux Local

/home/$(whoami)/public_html/ Linux Server

macOS Server

/Library/WebServer/Documents  Apache

4 - Access the Scriptcase using your browser:

127.0.0.1/scriptcase

e ydefault the selected language is English.

Installation - Inifiafing

STEPS
Welcome to ScriptCase!
Initiating
This wizard will guide you in the installation and configuration process of ScriptCase.
PHP Extensions ‘Youwill, step by step, be guided on all the stages necessary to adjustits environment to run the tool correctly.

SR Select the language that will be used during this installation
Database English M

ScriptCase Tables
user =

Finishing

5 - Check the extensions required for Scriptcase to function and database connection modules that are enabled.

Check if the necessary PHP extensions are loaded.

Required Extensions. Action.
@ oo This extension is used to create charts and manipulate images
MESTRING  This extension is used to convert special chars
The SimpleXML extension provides a very simple and easily usable toolset to

@ SimpleXML  convert XML to an object that can be processed with normal property selectors
and array iterators.

zIP This extenzion is used to create and extract files from a ZIP archive
ZLiB This extension is used to extract files from a ZIP archive
@ Json This extension implements the data interchange format JavaScript Object
Notation (JSON)
Database Extensions. Action.
& com_doinet  Generic ADO, MS Access ADO, MS SQL Server ADD
€ ibm_db2 DB2, DB2 ODBC NATIVE Enable
@  interoase Firebird, Interbase 6, Interbass 6.5
@ mssql MS SQL Server 7 Enable
@ mysql MaxS0L, MySQL (Non-Transactional), MySQL (Transactional) Enable
@ mysqi MySQLi
@ oo Oracle 2, Oracle & Poriable, Oracle 8.0.5
@ ome DB2 ODBC GENERIC, DB2 ODBC GENERIC 6, Generic ODBC, MS Access
ODEC, MS SQL Server ODBC, Oracle ODEC, Progress
& oracle Oracle 7 Enable
@  pdo_dblio Sybase PDO DELIB
@ pdo_firebird  Firebird PDC
&  pdo_ibm PDO IBM Enable
€  pdo_informix  Informix PDO Enable

Typical Installation

Check the steps below to complete the manual installation of Scriptcase in a typical way.

I NOTE: By selecting this installation, Scriptcase will set your environment by default. Defining the installation database and the login user in Scriptcase.

® Typical Installation:
Scriptcase will Install everyting automatically.

O customized Installation:
You could choose on which database you wish to install ScriptCase and the default usemame and password to access it



After clicking proceed, you will be redirected to the Scriptcase Login page.

PASSWORD

[0 Keep me logged in Forgot your password?

5= oy

To access for the first time please use [ad
“Your trial will expire in 20 days.

User

In this field, it is necessary to inform the user to login to Scriptcase. By default, the user is admin.

Password

In this field, you must enter the password to login to Scriptcase. By default, the password is admin.

Keep me connected
This option keeps the user logged in until they log out through the Scriptcase interface.

Forgot your password?

By clicking this option, it is possible to recover the password of the informed user. An email will be sent to the user in question so they can access the recovery steps.

Important: You can only perform password recovery if you have configured your SMTP information. To access our documentation showing how to perform this configuration click  here.

Custom Installation

Check the steps below to complete the manual installation of Scriptcase in a custom manner.

NOTE: By selecting this installation, you will be responsible for setting up your environment. Defining the installation database and the login user for Scriptcase.

O Typical Installation:
Scriptcase will install everything automatically.

® customized Installation:
You could choose on which database you wish to install ScripiCase and the default username and password to access it

1- Verify that the directories required by Scriptcase have the correct permissions. If any directory listed does not have the active check icon ¥, correct permission for this directory.

n - System Folders

ScripiCase performs many operafions with files. It is necessary that some
Initiating directories have the write permission set. Make sure the ScripiCase's

directories have the necessary authorization and correct the problem
PHP Extensions

W CiApache24/htdocsiscriptcase/app/

System Folders v C:/Apache24/htdocsiscriptcasescont/
v C/Apache24/htdocsiscripicasebackup/
Database ¥ C:JApache24/htdocsiscripicaseldeveliconfigrp/
¥’ Ci/Apach: i
ScripiCase Tables ¥ Ciapache24 i

v C:/Apache24/htdocs/scriptcasefiile/doc!
'y C:/Apache24/htdocsiscriptcaseffile/img/
¥ C:JApache24/hidocsiscriptcaseflog!
¥ C:JApache24/htdocsiscripicaseftmp/

User

Finishing

Click proceed to proceed with the installation process .

2- Choose the database where the Scriptcase database will be installed. By default, Scriptcase recommends that it be installed with the  SQLite database.



<y Installation - Datab

STEPS

SeriptCase stores its applications data in a databaze. You must chooze the
Initiating connection parameters for ScriptCase to be able to connact to this database.
PHP Extensions DBMS v

System Folders
4 We recommend to use SQLIte &5 your main ScriptCase database

Using SQLite, you ensure a greater reliability in ScriptCase features, including
Automatic Backup of your projects and applications

If you want to install ScriptCase in another database,

ScripiCase Tables be aware that the Automatic Backup ScriptCase will not consider your projects
and most of the data related to it

User
Change Database
Finishing

Database

e ou can change the default database by clicking the Change Database button. By clicking this option you will need to set the following options:

<y Installation - Database

STEPS
ScriptCase stores its applications data in a database. You must choose the
Initiating connection parameters for ScriptCase 1o be able ta connact to this database
PHP Extensions DBMS | mMysoL PDO v
System Folders Server | 192.163.254 1713308
User root
Database
Password|
ScriptCase Tables Database| scripicase
User

We recommend to use SQLite as your main ScripiCase dalabase.

Using SQLite, you ensure a greater reliability in ScriptCase features, including
Finishing Automatic Backup of your projecis and applications

I you want te install ScriptCase in another database,

be aware that the Automalic Backup ScriptCase will not consider your projecis
and most of the data related to it

DBMS

In this option, you will select the Driver to connect to your database.

Server

In this option, you will inform the server to connect to the desired database.

User

You need to inform a user who has access to the database you want Scriptcase to be installed on.

Password

You must enter the authentication password corresponding to the entered user.

Database

You must enter the name of the database where Scriptcase will be installed.
Example:
scriptcase

Clique em prosseguir para avangar no processo de instalagao.

3 - Verifique se a criacdo das tabelas da base de dados do Scriptcase ocorreu com sucesso. As tabelas serdo marcadas com o icone de sucesso ¥ na lateral.

n :: ScriptCase Tables

STEPS
ot ScriplCase uses fables on a database to store the applcations development data.
nitiating
W sc_tbprj Projects table
PHP Extensions ¥ sc_tbusu User Table.
W sc_tbgroup  Groups fable
Sistan B W sc_tbuser_groupRelationship table for users and groups
Database W sc_tbati User Status Table.
W sc_tbapl Appiication Table:
ScriptCase Tables W sc_tbemp Fiekds Tabl.
W sc_tblog Table of Iog schemes
ot W sc_tblog_apl  Applcations Backup Table.
Wsc_tblog_cmp  Backup Table of fieds
Finishing ¥ sc_tbrep Data Dictionary Table.

¥ sc_tbrep_tables Data Dictionary(Tables) Table’
¥ sc_tbrep_fields Data Dictionary(Fields) Table’

¥ sc_tbconex Connections Table.
¥ sc_thsess Session table
Wsc_tbversao  Project Version Table
¥ sc_tbevt Events Table

W se_iblog_evt  Events Backup Table.
¥ sc_tbtrans Transactions Table.

¥ sc_tbtodo Task list table

W'sc_tbmsg Table of messages between users.

All ScriptCase tables are aready created

Next »

Click proceed to proceed with the installation process.

-__Set the default user who will have access to Scriptcase.



The aceess to ScripiCase is made through a user/password system. To access it for the first time,

Iniiating a user will be created with admin privieges. This wil alow you to log on the system and ereate new users.
PHP Extensions
Login admin
System Folders
Password.
Database Confirmation
ScriptCase Tables
- [ |
Finishing
Login

In this option, you will enter the default Scriptcase User Login.

Password

In this option, you must enter the password that will correspond to the user informed.

Confirmation

You must repeat the previously entered password for successful user creation.
Click proceed to proceed with the installation process.

5 - Complete Scriptcase custom installation on your web server.

Finishing
STEPS
SeriptCase is now configured and ready to start
Initiating
PHP Extensions Ay Installation Complete.
Congratulations! SeriptCase was successfully installed on your web server. Click on the “Ne:xt
System Folders button to proceed to login page.
Database
User
Finishing

After clicking proceed, you will be redirected to the Scriptcase Login page.

PASSWORD

[0 Keep me logged in Forgot your password?

EE English v

for the first time please use ‘ idmin / admi
Your trial will expire in 20 days.

User

In this field, it is necessary to inform the user to login to Scriptcase. By default, the useris  admin.

Password

In this field, you must enter the password to login to Scriptcase. By default, the password is admin.

Keep me connected

This option keeps the user logged in until they log out through the Scriptcase interface.

Forgot your password?

By clicking this option, it is possible to recover the password of the informed user. An email will be sent to the user in question so they can access the recovery steps.



Important: You can only perform password recovery if you have configured your SMTP information. To access our documentation showing how to perform this configuration click  here.

Need to register your Scriptcase?
You can access our knowledge base to understand all the steps for registering a Scriptcase license.



General Overview

In this article, we present to you the main options from Scriptcase’s interface. There are two important screens: project dashboard and applications management interface.

Project Dashboard

The project dash is the first interface you will see once you log into Scriptcase. It's where you start a new project or select an existing project for editing.

S Propct Dslsbase Appicaon ook  Layod Locses Modules  Oplioms

= = |
Prosct
Main menu and toolbar
Project search B oty 1 Uit
e e camaszs amn camavoasen
|
Project list

Main Menu

The main menu contains both Scriptcase’s and project’s general settings, and it is available at the top of the page. Most of the options are related to the project settings and are not available before the project creation.

Tool Layout  Locales Module:

Toolbar

The toolbar is displayed right below the main menu, where you can find the most frequent used functions used. The toolbar is customizable, and you can create new functions as well as edit the current ones. Learn more about the toolb:

= e

; = i

= I -4
o= 2=

Project List

On this session is displayed a list with all the Scriptcase projects. You can display the project in a gallery or in list (to sort by date, name or creator). You have also a general search option.

+ Create project

Project - Description Administrator Createa Appiications
< cemony Nove Projeto Videos 20190516 3
< camoste Novo Projeto videos 20190517 E

demovt v Nov Projsto videos 20190815 2

fdemo vigeos 20170802 3

Application management interface

Once you create the project Scriptcase will display the applications management interface, where you can organize all project applications using folders. You are able also to search created applications, sort by date, creator, status, and te
deploy, rename and copy. You can edit one or various applications at a time.

# e Project folders (—oLis: of applications
4
TATDERS i . apeucaTIoN Yy ~ FRENCLYURE | DESCRIPTION s CREATOR & GENERANON STATUS &
s @ [ e PR, Jr— 1500 e o e
o s s
@ e e— e 021w e
™ R
- i oot
8 Calencar
[rese— sreme 0209150 e
W cat

sorer W9 150 wpaed

» B Coniol_sgencatons

e~ scrercass

o v 102u9 1500 upaama

B Dugrams srgiase 1024191500 upleied

» I8 Fom_Appicatons

B [ covode s e oot T ES R )
» B8 God_ppicatons id

@ o wse o OVSUR—
W irnenatonskzaton
W ve_Apchcations

W rovcran
8 POF_Repot_Apphcations.

2 & o am— owme o
W Programming
e 2 & owe fr— T —
(S, v @ s Pt 0 e —
8 Ton_roncasons ¥ @ sz Fonoel Chad. 20 vt scretease. 1020191500 cpdated

@[ Gt Gonerate  Ouploy  Osiste  Copy  Move  Ewport =t Mass application editing options

Project Explorer



In this session, you can find all the folders created to organize the applications. There's also the folder that contains all the applications of the project in one place.

FOLDERS 1

® il applications

I My applications

B Recens =R 2

~ I root

m Calendar
W chart
» B Control_Applications
8 Dashboard
8 Diagrams
» I Form_Appiications 4

» BB Grid_Applications

——

Search |
e - Folders functions;

e  -Filters;

e - Folders'structure;

e - Application search.

List of Applications

You can view a list of the applications that are in the selected folder in the Project Explorer presented on the left side.

[ APPLICATION * FRIENDLYURE DESCRIFTION + CREATOR & GENERATION STATUS & h ‘
. ‘Contro sppicabon ik ayoul vee - . —

@[] loginve e serpteass 102419 1500 updsted Run B3t Copy R

® [ men ae It appicaton scriplcase 02418 1500 updated Run E3t Copy Rename

= roouCalensar

@ [ canasror i nara Caisnga 2ppicaten * scrptease 102419 1500 updsted Run | E3t| Copy | Ranama

@ [ comndarnz boro & scriptease 102418 1500 updsted Run €5t Copy Ranam

@ calendard3 <k nere Catendarpor user scriplease 102419 1500 updated Run| B3t Cony | Ranam
caendaros . o scrptease 1024191500 updated Run | Et| Copy | Ranama
calendar_color_avent Cotscar Asgltafte mih ial ben d_ rcapicase 1024191500 updated B Eot Gy Ranama

event esior perday*
@[5 crjopn Log of calencr by user scrptease 102419 1500 updated | £t | Copy | Raname
2

B rootiChart

@ @ chanos iew Chart of Funrel scripcase 102418 1500 updated Run E3t Cony Raname

@ @ charos M Series Caat scriptcase 02418 1500 updated Run E3t Copy Rename

@ @ ocanses Funnel Chart - 30 serptease 1024191500 upaatea | £t opy | Raosmn

@  Edit  Generate  Deploy Delete  Copy  Move Export # 3

e -Columns;
® - Express options;

® - Footer Options.

Taskbar

This bar holds the tabs of all applications which are open for editing.

& Home dashboard_charts > dashboard_chart_gradebook * = dashboard_class_summary X

lashboard_chart_attendance




Main Menu

The main menu contains both Scriptcase’s and project’s general settings, and it is available at the top of the page. Most of the options are related to the project settings and are not available before the project creation. See below each ite

Project Database Applicalion Tools Layout Locales Modules Options  Help

Project

®  ew Project: To create a new project or import one of the system templates.

e  pen Project: Lists the projects that the user is permitted to access.

® lose Project: Closes the current project.

e roperties: Allows you to edit some of the project properties such as themes and languages.

e efault Values: Allows editing the current project default values.

e ersion History: Displays a list of project versions.

® ncrement Version: This option helps you to make the project version control.

e  xport Project: Allows to export one project at a time, taking all the project’s essential content for using in another Scriptcase of the same version.

e mport Project: Allows to import a project exported by Scriptcase of the same version.

e enerate Source Code: Generates the source code for all applications in the current project.

o eploy Applications: Opens the Publishing Wizard for publishing the applications of the current project.
o elete Project: This option is only available once you are into a project. This option deletes a project.

e eports:

o pplication List: Displays the project applications with details of its creation.
o evelopers Summary: Displays a summary of the applications and codes created by a developer.
e how Diagram: Displays a complete diagram of the project showing the relationship between the applications.

e roject Search: It allows to perform a search for texts in all the project’s applications.

Database
e ew Connection: Allows you to create a connection in the current project.
e dit Connection: Allows you to edit existing connections in the current project.
o mport ACCESS: Allows the conversion of an ACCESS data source into a structured database (MySQL, PostgreSQL, SQLite, and SQL Server).
o mport EXCEL: Allows the conversion of an EXCEL data source into a structured database (MySQL, PostgreSQL, SQLite, and SQL Server).

L]

mport CSV: Allows the conversion of a CSV data source into a structured database (MySQL, PostgreSQL, SQLite, and SQL Server).
® QL Builder: Tool for creating and executing SQL commands.
e  atabase Builder: Tool for rapidly creating and editing tables in the database.

e RDiagram: Tool that allows the visualization of the relationships between tables of the connected database.

Application

e  ew Application: Create a new application.

e atch Applications: Allows simultaneous creation of Grids and Forms.

e estore Applications: Allows the restoration of applications, where is displayed a list of the last edited applications.
e ave Application: Save changes made to the current application.

®  enerate Source: Generate the Source Code for all the applications in the current project.

e un Application: Saves and executes the current application.

e xport Applications: Allows the export of one or more project applications.

e mport Applications: Imports a backup file that contains an application from another or the same project.

e ource Code: Allows you to visualize the generated source code of the current application.

e atain Session: It displays all Scriptcase session variables, as well as those of the executed applications.

Tools

e  ata Dictionary: Allows the user to model and standardize the tables fields (names, translation, field types, and general settings).
e xpress Edit: Project applications mass editing.

e elpCase: Enables the creation of project documentation.

e xternal Libraries: It allows you to import third-party libraries from the web (javascript, CSS, PHP, for example) or to create your libraries to use within your current project or entire Scriptcase projects.
o nternal Libraries: Allows you to create PHP scripts, similar to external libraries, but exclusively for PHP.

o o0-Do List: Enables you to create a task list.

®  essages: Send messages among developers of the same Scriptcase installation.

e onverters:

o ersion 6: Converts your projects from ScriptCase version 6 to this current version.
o ersion 7: Converts your projects from ScriptCase version 7 to this current version.

o ersion 8: Converts your projects from ScriptCase version 8 to this current version.

Layout

eSS Applications (Themes): This option allows you to create or edit themes for the applications.

e SSButtons: This option allows you to create or edit button themes.

e  TML Templates: This option allows you to create or edit several HTML elements used within the applications.
®  SSMenus: This option allows you to edit the CSS of the menus.

e enulcons: Allows you to edit or create the icons of the menu application.

® mage Manager: This option manages the existing images in the project, also allowing you to add, delete and copy images.
e hart Themes: This option allows you to edit or create the themes used within the Chart applications.

e  TML Editor Templates : Allows you to configure the functionalities from the Form and Control HTML editor field.



Local

e pplication Language: Allows to define custom rr ges in different languages, according to the ones set during the project creation and the data dictionary.

e egional Settings: Allows you to define some parameters of monetary units, date and numbers according to the Country or Region.

Modules

® ecurity: This option allows you to implement access rules to your system, creating a complete system with access control in your project.
e og:

o reate/Edit Log Module: Allows you to create or edit a log module.

o  pplications Related to the log : Allows you to reference which applications will use the log.

o reate Query with Log Report : Allows you to create a Grid application that will display a log report.

Options
e ettings: Access all the ScriptCase settings.
e  yScriptCase: Allows you to customize the settings for the current user.
o hange Password: Allows the current user to change their password.

e  yToolbar: Allows you to change the position of the icons on the toolbar.

Help

e  ebHelp: Allows you to access the manual.

o echnical Support: Access to ScriptCase online support.

e iagnosis: Displays the settings of the Environment/Server where ScriptCase is installed.
o heck Version: Verifies if the version is updated.

e pdate Version: Allows you to update ScriptCase to the latest version available.

® icense Registration: Access the page to register your ScriptCase.

e bout: Information about ScriptCase.



Toolbar

The toolbar is displayed right below the main menu, where you can find the most frequent used functions used. The toolbar is customizable, and you can create new features as well as edit the current ones. Learn how to customize the

o

o

ome: Returns to the Application management interface.

ew Project: Starts a new project creation process.

pen Project: Returns to project dash interface where you can see all the projects that your current user has access.
lose Project: Closes the current project.

ew Connection: Displays a wizard to add new connections to the current project.

dit Connection: Edits the project database connections.

QL Builder: SQL editor to create or test queries inside the connected database. You can also run SQL commands using this feature.
ew Application: It opens the new application wizard for you to start a new application.

atch Applications: Creates various applications (Forms and Grids) simultaneously.

ave Application: Saves the current application changes.

enerate Source Code: Generate the Source Code for the existing Applications.

un Application: Saves the present application, generates the source code, and runs the applications.

un Project: Runs the complete project. To do this, you must enter the property in the project properties.

eploy Applications: Opens the wizard for the deployment procedure.

ata Dictionary: Allows the user to define standards for the tables (Names, Field Types, etc.).

pplication Language: Feature to assist within translation of the sistem tables and internal messagers.

elp: Scritcase’s documentation.

© ®© 06 00 06 060 0606 000 0 0 0 o



Project Dashboard

This is the initial Scriptcase screen, showed after login. It show the created projects that the user has access, these projects will be show as  Gallery(default) format.

| The definition of projects access should be made by the administrator user at the menu Options > Settings

Display Options
Through these bottom is possible to choose the project display between Gallery(Default) and List.

Gallery
The default display in the first time in Scriptcase, show the projects in cards with some basic information.
e Projectimage, it can be change in the project porperties.

® roject's name, choosed at create project.
e ow many application at this version.

Sample of Project gallery

List
Show the projects in list with some more details about the project.

® Projectimage, it can be change in the project porperties.

® roject - Project's name, choosed at create project.

e escription - An description defined na at project creation. These description can be change at project porperties

o dministrator - List of users with administrator permission at the project. It is done at users manager in Options > Settings
e reated - Date of project creation.

e  pplication - How many application at this version.

Sample of Project list

Search field

These field allow to search in the list of projects by the showed information, these way of display can be changed between Gallery or List also change how the field work because change the displayed information.

Sample of date search

Floating menu

These menu, can be access by the bottom , with some of project’s options helping the developer access.

Open project - Open the project at the home screen, showing the project’s aplications.
Deply - Open the project at deply screen.

Generate source - Open the project and generate the source code of all aplications.
Export Project - Open the project and start the export process.

Properties - Open the project at the project’s properties.

Delete - Delete the project without accessing it.

e o o 0o o o

Create project

The change of project’s display between Gallery and List also change the bottom display Create project.

| Click here and see how to create a blank project or import a sample project

Create project sample showing at gallery

Create project sample showing at list



Project explorer

In this area, you can find all the folders created to organize the applications.

ForpERs 1 =

8 A applications

I wmy applications
B Recens TP 2

[ ot g* 3
m Calendar
i chart

» I8 Control_Appiications
8 Dashboard
I Diagrams

» I8 Form_Applications 4

» I Grid_Applications

—

| Search

1 - Folders functions

Options for you to manage the folders (create, rename delete) to organize your application folders.

e reate: Creates a new folder.
e ename: Renames the selected folder.

e elete: Deletes the selected folder.

2 - Filters

Using the filter, you can quickly find an application per date or user. You can also display all the applications.

o Il Applications: Lists all applications from the folders and the existing subfolders.
e  yApplications: Lists all the applications from the folders and subfolders that the current user has created.

e ecent: List of all the new generated applications.

3 - Folders' structure

Scriptcase lists all application folders and sub-folders. It's recommendable for you to create folders to organize your project for future updates.

4 - Application search

Searches for the applications names or description.

e earch: It searches by name or descriptions of the project. The search occurs within the selected folder, and the search results are highlighted in yellow.



List of Applications

All project applications are available in this area. You can also take some specific actions using this interface, such as add a description, a friendly URL, rename, edit, copy, or run the application, one by one or various simultaneously.

I The columns can be edited in My Scriptcase menu.

l APPLICATION * FRIENDLYURE  DESCRIFTION + CREATOR & GENERATION STATUS & +.* 1

@ [E] tognve :;‘:m"“’“‘x"‘“"”“‘ scriptease 1024191500 upssted Run | Edt | Copy | Raname

@ E mew It sppicaton scriptcase 02419 1500 updated Run E3t Cagy Rename

B roouCalenar

@ [ camndarot Calenda Apphcation * seriptease 1024119 1500 updated Run Edt Copy Rensme

@ [ cekndar02 " scripteas 102191500 updated mun on Comy Rename

@ [ calendart3 Calendar per user scriplcase 1024191500 updated Run B3t Comy Raname

@ [ calncaros scrptease 1024191500 updated Run | Et| Copy | Ranama

@ [ cakndar_cokor_avent = et 024191500 updated Bun Eot Cory Ranama
=] even coir per day*

@[5 crlogn Log of calancar by usar scrptease 1024191500 uptated Run | £t Copy | Raname

2 ey

B rootiChart

@ @ manos Vew Chart of Funrel scrptcase 1024191500 uptated Bun B3t Cony Faname

@ @ chaos M Seres Caant scriptcase 02418 1500 updated Run €3t Cagy mename

@ @ cheriset Funeel Chort - 30 scriptease 1024191500 updated Run| €3t Copy Racame

|,4 Edit | Generate = Deploy  Delete  Copy = Move  Export % 3

1 - Columns

Here you have an editable grid with some suitable options from your applications, such as follows:

pplication: Application’s Name.

riendly URL: Friendly URL for the application.

escription: Application Description.

reator: Application Creator.

eneration: Last Source Code Generation date.

tatus: Status of the application: Updated means that all changes are within the application, and Outdated means that changes are not saved within the source code.

® e 0 0 o o

2 - Express options
You can use these options to express editing the applications.

un: Runs an application;

dit: Open the Application to edit;

opy: Creates a copy of the selected application;
ename: Renames the selected application.

® o o o

3 - Footer Options

The footer buttons are available when one or more application are selected.

e dit: Opens all the selected applications settings for editing.

e enerate: Generates the source code of all selected applications.

o  eploy: Opens the Publishing Wizard for all selected applications.

o elete: Delete all selected applications.

e opy: Copy the selected applications to another project.

®  ove: Moves the selected applications to another folder in the same project.
e  xport: Allows you to export the selected applications.



Taskbar

This bar contains the tabs of all the applications that were opened for editing.

# Home  [§@ dashboard_charts

dashboard_chart_attendance

ashboard_chart_gradebook dashboard_class_summary 3

This bar is only displayed when at least one application has been opened.

The applications open in tabs in the taskbar where you can navigate among applications in a fast and easy way.
The “x" presented at the side of the Application name is used to close the application.

When you right-click on one of the tabs on the taskbar, you will see some tab closing options.

orm_edit_users X [ sec_grid_sec
Home
‘ Close |
Close all E
Close other tabs



Keyboard Hotkeys

Keyboard hotkeys are keys or key combinations that provides an alternate way of doing something that you would normally do with a mouse.

The keyboard hotkeys are available in all browsers compatible with Scriptcase.

Browsers compatible with Scriptcase

@ Chrome All versions
@ Firefox Version 4 or above
@ Edge All versions

48 Internet Explorer  Version 11 or above
Q Opera Version 9 or above

@ safari Version 5.2 or above

Scriptcase Hotkeys

Efficiency is crucial to software development and the Keyboard Hotkeys are important to achieve that efficiently. You can see all the hotkeys that are now available in Scriptcase below:
Hotkeys Actions
F1 Opens the documentation of the tool
CTRL+H or &+H or F4  Displays the project homepage
CTRL+S or 8+Sor F7  Saves the changes made in the application
CTRL+Bor 3+Bor F8  Generates the source code of the current application
CTRL+E or $+E or F9 Runs the current application
F2 Opens the application creation screen

CTRL+l or 38+l or F6 Access to the SQL Builder

Alt+1~9 Accesses the selected tabs 1~9
Alt+Q Closes the current tab
Alt+PgDown Navigates back to the previous tab
Alt+PgUp Navigates to the next tab

Events Editor Hotkeys - PHP

Using Sublime shortcut patterns, Scriptcase provides a series of shortcuts to streamline its development.



Hotkeys Actions

Tab Indents the line or selection

Shift+Tab Removes line indentation or selection

Ctrl+Shift+K Deletes the current line

Ctrl+Left Moves the cursor to the next word

Ctrl+Right Moves the cursor to the previous word

Ctrl+L Selects the entire current line

Ctrl+Shift+L Adds the cursor to all selected lines

Ctrl+</span> Cancels multiple cursors and moves the cursor to the first instance
Ctrl+Enter Inserts a line after the current one

Ctrl+Shift+Enter Inserts a line before the current one

Ctrl+Shift+D Selects the next occurrence of selected text with the cursor
Ctrl+Shift+Space Selects the current scope (within parentheses, braces, brackets ...)
Ctrl+Shift+M Selects the broader context (keys, brackets, parentheses, page)
Ctrl+M Moves the cursor to the closing or opening of the current context. (braces, brackets, parentheses, tags)
Ctrl+/ Comments or Uncomments line

Ctrl+) Groups the line or selection

Ctrl+D Duplicates line or selection

Ctrl+F9 Sorts the lines alphabetically, ignoring upper cases

Backspace Intelligent Backspace (Removes indentation with line)

Ctrl+K Ctrl+K Deletes text to the right

Ctrl+K Ctrl+U Capital letters in the selection or cursor

Ctrl+K Ctrl+L Lowercase letters in the selection or cursor

Ctrl+K Ctrl+C Scrolls the line to the center of view

Ctrl+K Ctrl+Backspace  Deletes text to the left

Ctrl+Shift+Up Adds the cursor to the previous line
Ctrl+Shift+Down Adds the cursor to the next line

Ctrl+F3 Finds the next occurrence of the selection or cursor
Ctrl+Shift+F3 Finds the next occurrence of the selection or cursor
Ctrl+Shift+[ Shows indented tag

Ctrl+Shift+] Shows Inline tag

Ctrl+Shift+F Activates search and replaces

Ctrl+F Activates search

] Finds the next occurrence of the search

Shift+F3 Finds the previous occurrence of the search
Ctri+Alt+] Auto indentation of the selected code

Events Editor Hotkeys - HTML/CSS

Using Emmet’s shortcut patterns, Scriptcase provides a series of shortcuts to streamline its development. With this plug-in it is possible to write HTML and CSS codes through CSS selectors.
Click Here to view the list of selectors.

For example, just write ul> li.item $ {This is the item $} * 3 then press the “TAB" key and the following code will be generated.

<li class="item1">This is item 1</li>
<li class="item2">This is item 2</li>
<li class="item3">This is item 3</li>
</ul>

To use the EMMET hotkeys in Scriptcase events, you must close and open the event PHP. Example: ?> ul> li.item $ {This is the item $} * 3 <? PHP



Hotkeys Actions
Tab Enables EMMET abbreviations Ex. ul>li.item${item $}*3
Ctrl+Shift+A or §8+Shift+A Envelopes the selected text in an EMMET abbreviation. Select the text you want to envelop, then use the keys, and enter the tag.

Ctri+Alt+Right or 88+Alt+Right  Edit / selects the next node. Junction between tags, CSS blocks.

Ctri+Alt+Left or 8+Alt+Left Edit / selects the previous node. Junction between tags, CSS blocks.
Ctrl+Shift+Y or 8+Shift+Y Validates and solves math expressions. Example: 2*8+4 .

Ctrl+Up or &+Up Increments numeric value  +1

Ctrl+Down or #+Down Decrements numerical value -1

Ctrl+Shift+. or 38+Shift+. Edit / selects the next item. Attribute, tag name

Ctrl+Shift+, or 38 +Shift+, Edit / selects the previous item. Attribute, tag name

Enter Inserts indented line break.



Scriptcase Variables
Field Variables

In Scriptcase the fields are internally treated as local variables PHP, however, at Scriptcase interface it's necessary to inform these, using keys, so it's possible to retrieve or assign values to the application fields.
These fields can be used at Scriptcase events, but will not work from the onScriptinit event because only the events after that will have values in the fields.

In the examples below it's possible to visualize the operation of the fields.

Retrieving field value:

To assign the field value to a local variable to be used within an event, we can perform the steps as below:
$var_local = {application_field};
To assign the field value to a local variable to be used within an event, we can perform the steps as below:

[variavel_global] = {application_field};

Assigning Value to Field:

To assign a value to the field, we can do assignment in the same way as done with the variables, and if possible, according to the field type:

Field type Text: {field_text} = “This is a sample text”;
Field type Number: {field_number} = 100;

Global Variables (Session Variables)

These are variables that are stored in the application session, these variables can be used to pass parameters through the applications in the project. These variables can be used at any application event.
Unlike the local and field variables, Global variables can be used in the SQL of the applications that allows the manual to be changed, and in the  WHERE Clause of the Form application, thus enabling a dynamic use of the applications.

SQL Grid sample

Lequireddate,
shippeddate.

B
B
L3

name,

shippostalcede
FROM

orders
WHERE orderid = [order]

Sample in the WHERE Clause of the Form

Where clause arderid = [orders]

To define a global variable, you only have to enter it in between brackets, for example:

[global_variable].

Assigning value to global variable:

[text_variable] = “This global has a text stored in it";
[number_variable] = “This global has a number stored in it”;

Passing values between applications
To pass values between applications, it is necessary to define the same variable in the applications that will use them, however, in the source application the variable must be defined as  Output and in the destination application must k

To change the variable type, go to the menu Application> Global Variables .

4 APPLICATION

£} settings

) Navigation

T Messages

@ Global Variable

After clicking on this menu will show the variables in the application and its settings.

4 VARIABLE SETTINGS

ATTRIBUTE VALUE

global P

) sESSION
¥ posT
¥ GET

fings

) optional

Type
- Out
®n

In this configuration screen we have the following configuration options:



Attribute:

In Attributes we can see the variables in our application.

Value:

In Value we can see some options and configurations of our variable.

Type: This option defines whether the variable will be input or output.

Description:

Reports where the variable was declared by the developer.

Local Variables

Local variables are basically PHP's own variables. These variables must be set usinga $ dollar sign at the beginning and the variable names are case-sensitive.

These variables will only work in events or methods, using a variable in an event it will make it only available in that event.

Variable names follow the same rules as other labels in PHP. A valid variable name begins with a letter or underscore, followed by any number of letters, numbers, or underscores.
Below we can see some examples of local variables:

$text = “This variable stores a Text”;
$number = “This variable stores a number”;

For more information, visit the php variables.



EMMET Hotkeys

Below we have a list of EMMET CSS selectors in our event editor.

I Remember that as they are CSS Selectors, to work as expected it is necessary to use inside the tag  <style> @m </style>

CSS selectors To open

@i or @import @import url( );

@m or @media @media screen { }

@f @font-face {font-family: ; src:url(); }

@f+ @font-face {font-family: 'FontName'; src: url(‘FileName.eot'); src: url('FileName.eot?#iefix') format('embedded-opentype'), url('FileName.woff') format(‘woff'), url('FileName.ttf') format('truetype'), url(‘FileName.sv¢

normal; font-weight: normal; }

anim animation: ;

anim- animation: name duration timing-function delay iteration-count direction fill-mode;
animdel animation-delay: time;

animdir or animdir:n animation-direction: normal;
animdir:r animation-direction: reverse;
animdir:a animation-direction: alternate;
animdir:ar animation-direction: alternate-reverse;
animdur animation-duration: 0s;

animfm animation-fill-mode: both;

animfm:f animation-fill-mode: forwards;
animfm:b animation-fill-mode: backwards;
animfm:bt or animation-fill-mode: both;

animfm:bh

animic animation-iteration-count: 1;

animic:i animation-iteration-count: infinite;
animn animation-name: none;

animps animation-play-state: running;
animps:p animation-play-state: paused;
animps:r animation-play-state: running;
animtf animation-timing-function: linear;
animtf:e animation-timing-function:ease;
animtf:ei animation-timing-function:ease-in;
animtf:eo animation-timing-function:ease-out;
animtf:eio animation-timing-function:ease-in-out;
animtf:l animation-timing-function:linear;
animtf:cb animation-timing-function: cubic-bezier(0.1, 0.7, 0.1, 0.1);
ap appearance: none;

! limportant"

pos or pos:r position: relative;

pos:s position:static;

pos:a position:absolute;

pos:f position:fixed;

t top: ;

ta top:auto;

r right: ;

ra right:auto;

b bottom: ;

b:a bottom:auto;

| left: ;



58S selectors

za
flor fil
fi:n

fior
clorckb
ckn

ckl

ckr
colm
colmc
colmf
colmg
colmr
colmrc
colmrs
colmrw
colms
colmw
dord:b
d:n

d:f

d:if

d:i

d:ib
d:ib+

d:li

d:tb
d:ith
d:tbcp
d:tbcl
d:tbclg
d:tbhg
d:tbfg
d:tbr
d:tbrg

d:thc

d:rbb
d:rbbg
d:rbt
d:rbtg
vorvh
viv

vic

Tiereper;

z-index: ;
z-index:auto;

float: left;
float:none;
float:right;

clear: both;
clear:none;
clear:left;
clear:right;
columns: ;
column-count: ;
column-fill: ;
column-gap: ;
column-rule: ;
column-rule-color: ;
column-rule-style: ;
column-rule-width: ;
column-span: ;
column-width: ;
display: block;
display:none;
display:flex;
display:inline-flex;
display:inline;

display:inline-block;

display: inline-block;\n*display: inline;\n*zoom:

display:list-item;

display:run-in;

display:compact;

display:table;

display:inline-table;

display:table-caption;

display:table-column;

display:table-column-group;

display:table-header-group;

display:table-footer-group;

display:table-row;

display:table-row-group;

display:table-cell;

display:ruby;

display:ruby-base;

display:ruby-base-group;

display:ruby-text;

display:ruby-text-group;

visibility: hidden;

visibility:visible;

visibility:collapse;

-



ov or ov:h
CSS selectors
ov:v

ovis

ovia

ovx or ovx:h

ovX:s

ovx:ia

ovy

ovy:v

ovy:h

ovys

ovy:a

0VS Or ovsis

zm

P

cp:a

cpir

bxz:cb
bxz:bb
bxsh
bxsh:r
bxsh:ra

bxsh:n

ma

mr

mb

mb:a

ml

wa

h:a

overflow: hidden;

To open

overflow:visible;

overflow:scroll;

overflow:auto;

overflow-x: hidden;

overflow-x:visible;

overflow-x:scroll;

overflow-x:auto;

overflow-y: hidden;

overflow-y:visible;

overflow-y:hidden;

overflow-y:scroll;

overflow-y:auto;

overflow-style: scrollbar;

overflow-style:auto;

overflow-style:panner;

overflow-style:move;

overflow-style:marquee;

zoom:1;

zoom:1;

clip: ;

clip:auto;

clip: rect(top right bottom left);

box-sizing: border-box;

box-sizing:content-box;

box-sizing:border-box;

box-shadow: inset hoff voff blur color;

box-shadow: inset hoff voff blur spread rgb(0, 0, 0);

box-shadow: inset h v blur spread rgba(0, 0, 0, .5);

box-shadow:none;

margin: ;

margin:auto;

margin-top: ;

margin-top:auto;

margin-right: ;

margin-right:auto;

margin-bottom: ;

margin-bottom:auto;

margin-left: ;

margin-left:auto;

padding: ;

padding-top: ;

padding-right: ;

padding-bottom: ;

padding-left: ;

width: ;

width:auto;

height: ;

height:auto;



CSS selectors
maw

maw:n

mah:n
miw
mih
mar

mir

oln
olo
olw
olw:tn
olw:m
olw:tc
ols
ols:n
ols:dt
ols:ds
ols:s
ols:db
ols:g
ols:r
ols:i
ols:o
olc

olc:i

bd+

bd:n

bdbk or bdbk:c
bdcl

bdcl:c

bdcl:s

bdc

bdi:n
bdti
bdti:n

bdri

To open
max-width: ;

max-width:none;

max-height: ;

max-height:none;

min-width: ;

min-height: ;

max-resolution: res;

min-resolution: res;

orientation: ;

orientation:landscape;

orientation:portrait;

outline: ;

outline:none;

outline-offset: ;

outline-width: ;

outline-width:thin;

outline-width:medium;

outline-width:thick;

outline-style: ;

outline-style:none;

outline-style:dotted;

outline-style:dashed;

outline-style:solid;

outline-style:double;

outline-style:groove;

outline-style:ridge;

outline-style:inset;

outline-style:outset;

outline-color: #000;

outline-color:invert;

backface-visibility: ;

backface-visibility:hidden;

backface-visibility:visible;

border: ;

border: 1px solid #000;

border:none;

border-break: close;

border-collapse: ;

border-collapse:collapse;

border-collapse:separate;

border-color: #000;

border-color:transparent;

border-image: url();

border-image:none;

border-top-image:url();

border-top-image:none;

border-right-image:url();

border-right-image:none;



B9Bielectors TRPGHRIbottom-image:url();

bdbi:n border-bottom-image:none;
bdli border-left-image:url();

bdli:n border-left-image:none;

bdci border-corner-image:url();
bdci:n border-corner-image:none;
bdci:c border-corner-image:continue;
bdtli border-top-left-image:url();
bdtli:n border-top-left-image:none;
bdtli:c border-top-left-image:continue;
bdtri border-top-right-image:url();
bdtri:n border-top-right-image:none;
bdtri:c border-top-right-image:continue;
bdbri border-bottom-right-image:url();
bdbri:n border-bottom-right-image:none;
bdbri:c border-bottom-right-image:continue;
bdbli border-bottom-left-image:url();
bdbli:n border-bottom-left-image:none;
bdbli:c border-bottom-left-image:continue;
bdf or bdf:r border-fit: repeat;

bdf:c border-fit:clip;

bdf:sc border-fit:scale;

bdf:st border-fit:stretch;

bdf:ow border-fit:overwrite;

bdf:of border-fit:overflow;

bdf:sp border-fit:space;

bdlen border-length: ;

bdlen:a border-length:auto;

bdsp border-spacing:|;

bds border-style: ;

bds:n border-style:none;

bds:h border-style:hidden;

bds:dt border-style:dotted;

bds:ds border-style:dashed;

bds:s border-style:solid;

bds:db border-style:double;

bds:dtds border-style:dot-dash;
bds:dtdtds border-style:dot-dot-dash;
bds:w border-style:wave;

bds:g border-style:groove;

bds:r border-style:ridge;

bds:i border-style:inset;

bds:o border-style:outset;

bdw border-width: ;

bdtw border-top-width: ;

bdrw border-right-width: ;

bdbw border-bottom-width: ;

bdiw border-left-width: ;

hedt A bt Lo
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CSS selectors To open

bdt+ border-top: 1px solid #000;
bdt:n border-top:none;

bdts border-top-style: ;

bdts:n border-top-style:none;

bdtc border-top-color: #000;

bdtc:t border-top-color:transparent;
bdr or br border-right: ;

bdr+ border-right: 1px solid #000;
bdr:n border-right:none;

bdrst border-right-style: ;

bdrst:n border-right-style:none;

bdrc border-right-color: #000;
bdrc:t border-right-color:transparent;
bdb or bb border-bottom: ;

bdb+ border-bottom: 1px solid #000;
bdb:n border-bottom:none;

bdbs border-bottom-style: ;

bdbs:n border-bottom-style:none;
bdbc border-bottom-color: #000;
bdbc:t border-bottom-color:transparent;
bdl or bl border-left: ;

bdl+ border-left: 1px solid #000;
bdl:n border-left:none;

bdls border-left-style: ;

bdlis:n border-left-style:none;

bdlc border-left-color: #000;

bdlc:t border-left-color:transparent;
bdrs border-radius: ;

bdtrrs border-top-right-radius: ;
bdtirs border-top-left-radius: ;
bdbrrs border-bottom-right-radius: ;
bdblrs border-bottom-left-radius: ;
bg background: #000;

bg+ background: #fff url() 0 0 no-repeat;
bg:n background:none;

bg:ie filter:progid:DXImageTransform.Microsoft.AlphalmageLoader(src='x.png',sizingMethod="crop');
bgc background-color: #fff;

bgc:t background-color:transparent;
bgi background-image:url();

bgi:n background-image:none;

bgr background-repeat: ;

bgr:n background-repeat:no-repeat;
bgr:x background-repeat:repeat-x;
bgry background-repeat:repeat-y;
bgr:sp background-repeat:space;
bgr:rd background-repeat:round;
bga background-attachment: ;

bga:f background-attachment:fixed;



bga:gelectors Tig:eREMAUNd-attachment:scroll;

bgp background-position: 0 0;
bgpx background-position-x: ;

bgpy background-position-y: ;
bgbk background-break: ;

bgbk:bb background-break:bounding-box;
bgbk:eb background-break:each-box;
bgbk:c background-break:continuous;
bgcp or bgep:pb background-clip: padding-box;
bgcp:bb background-clip:border-box;
bgcp:ch background-clip:content-box;
bgcp:nc background-clip:no-clip;

bgo background-origin: ;

bgo:pb background-origin:padding-box;
bgo:bb background-origin:border-box;
bgo:cb background-origin:content-box;
bgsz background-size: ;

bgsz:a background-size:auto;
bgsz:ct background-size:contain;
bgsz:cv background-size:cover;

c color: #000;

cr color: rgb(0, 0, 0);

cra color: rgha(0, 0, 0, .5);

cm ¥

cnt content:' ;

cnt:n content:normal;

cnt:oq content:open-quote;

cnt:noq content:no-open-quote;
cnticq content:close-quote;

cnt:ncq content:no-close-quote;

cnta content:attr();

cnt:c content:counter();

cnt:cs content:counters();

tbl table-layout: ;

tbl:a table-layout:auto;

tbl:f table-layout:fixed;

cps caption-side: ;

cps:t caption-side:top;

cps:b caption-side:bottom;

ec empty-cells: ;

ecs empty-cells:show;

ech empty-cells:hide;

lis list-style: ;

lis:n list-style:none;

lisp list-style-position: ;

lisp:i list-style-position:inside;
lisp:o list-style-position:outside;

list list-style-type: ;



list:n list-style-type:none;

CSS selectors To open

list:d list-style-type:disc;

list:c list-style-type:circle;

list:s list-style-type:square;
list:dc list-style-type:decimal;
list:dclz list-style-type:decimal-leading-zero;
list:Ir list-style-type:lower-roman;
listur list-style-type:upper-roman;
lisi list-style-image: ;

lisi:n list-style-image:none;

q quotes: ;

q:n quotes:none;

q:ru quotes: '00AB' '00BB' '201E' '201C";
q:en quotes: '201C' '201D' '2018' '2019";
ct content: ;

ctn content:normal;

ct.oq content:open-quote;

ct:noq content:no-open-quote;
ct:cq content:close-quote;

ct:ncq content:no-close-quote;
cta content:attr( );

ctc content:counter( );

ct:cs content:counters( );

coi counter-increment: ;

cor counter-reset: ;

va or va:t vertical-align: top;

va:sup vertical-align:super;

va:tt vertical-align:text-top;
va:m vertical-align:middle;

vabl vertical-align:baseline;
va:b vertical-align:bottom;
vaitb vertical-align:text-bottom;
va:sub vertical-align:sub;

ta or tal text-align: left;

ta:c text-align:center;

tar text-align:right;

tayj text-align:justify;

ta-Ist text-align-last: ;

tal:a text-align-last:auto;

tall text-align-last:left;

tal:c text-align-last:center;

talr text-align-last:right;

td or td:n text-decoration: none;

td:u text-decoration:underline;
td:o text-decoration:overline;
td:l text-decoration:line-through;
te text-emphasis: ;

ten text-emphasis:none;

te:ac text-emphasis:accent;



CSS selectors
tedt

teic
te:ds
tetb
te:a
th
th:a
th:f
thit
th:m
ti

tic-

4
tj:a
tjiw
tsii
tjiic
tj:d
tjk
tit
tov or tove
tov:c
to
to+
to:n

tr

el

tw:no
twu
twis
tsh
tshir
tshira
tsh+
tsh:n
trf
trfiskx
trf:sky
trfisc
trfiscx

trf:scy

To open
text-emphasis:dot;

text-emphasis:circle;
text-emphasis:disc;
text-emphasis:before;
text-emphasis:after;
text-height: ;
text-height:auto;
text-height:font-size;
text-height:text-size;
text-height:max-size;
text-indent: ;
text-indent:-9999px;
text-justify: ;
text-justify:auto;
text-justify:inter-word;
text-justify:inter-ideograph;
text-justify:inter-cluster;
text-justify:distribute;
text-justify:kashida;
text-justify:tibetan;
text-overflow: ellipsis;
text-overflow:clip;
text-outline: ;
text-outline: 0 0 #000;
text-outline:none;
text-replace: ;
text-replace:none;
text-transform: uppercase;
text-transform:none;
text-transform:capitalize;
text-transform:uppercase;
text-transform:lowercase;
text-wrap: ;
text-wrap:normal;
text-wrap:none;
text-wrap:unrestricted;
text-wrap:suppress;
text-shadow: hoff voff blur #000;

text-shadow: h v blur rgb(0, 0, 0);

text-shadow: h v blur rgba(0, 0, 0, ..

text-shadow: 0 0 0 #000;

text-shadow:none;

transform: ;

transform: skewX(angle);

transform: skewY(angle);

transform: scale(x, y);

transform: scaleX(x);

transform: scaleY(y);
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trf:sc3
trfer
trfirx
trfry
trfirz
trfit
trfitx
trfty
trf:itz
trfit3
trfo
trfs
trs
trsde
trsdu
trsp

trstf

whs:n
whs:p
whs:nw
whs:pw

whs:pl

whsc:n
whsck
whsc:l
whsc:bs
whsc:ba
wob
wob:n
wob:k

wob:ba

wow:nm
wow:n
wow:u

Wow:s

wow:b

wm or wm:irt
wm:lrb
wmrlt
wm:rlb
wm:tbr

wm:tbl

ikt

mmm: scaleZ(z);

transform: scale3d(x, y, z);
transform: rotate(angle);
transform: rotateX(angle);
transform: rotateY(angle);
transform: rotateZ(angle);
transform: translate(x, y);
transform: translateX(x);
transform: translateY(y);
transform: translateZ(z);
transform: translate3d(tx, ty, tz);
transform-origin: ;
transform-style: preserve-3d;
transition: prop time;
transition-delay:time;
transition-duration:time;
transition-property:prop;
transition-timing-function:tfunc;
line-height: ;

white-space: ;

white-space: normal;
white-space: pre;
white-space: nowrap;
white-space: pre-wrap;
white-space: pre-line;
white-space-collapse: ;
white-space-collapse:normal;
white-space-collapse:keep-all;
white-space-collapse:loose;
white-space-collapse:break-strict;
white-space-collapse:break-all;
word-break: ;
word-break:normal;
word-break:keep-all;
word-break:break-all;
word-spacing: ;

word-wrap: ;
word-wrap:normal;
word-wrap:none;
word-wrap:unrestricted;
word-wrap:suppress;
word-wrap:break-word;
writing-mode:Ir-tb;
writing-mode:Ir-bt;
writing-mode:rl-tb;
writing-mode:rl-bt;
writing-mode:tb-rl;

writing-mode:tb-Ir;

10
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CSS selectors To open

wm:btr writing-mode:bt-rl;

Its letter-spacing: ;

Its-n letter-spacing:normal;

f font: ;

f+ font: 1em Arial,sans-serif;

fw font-weight: ;

fwin font-weight:normal;

fw:b font-weight:bold;

fw:br font-weight:bolder;

fwr font-weight:lighter;

fs or fsi font-style:italic;

fsin font-style:normal;

fs:o font-style:oblique;

fv font-variant: ;

fvin font-variant:normal;

fvisc font-variant:small-caps;

fz font-size: ;

fza font-size-adjust: ;

fzarn font-size-adjust:none;

ff font-family: ;

ffis font-family:serif;

ff:ss font-family:sans-serif;

ff:c font-family:cursive;

ff:f font-family:fantasy;

fi:m font-family:monospace;

ffa font-family: Arial, "Helvetica Neue", Helvetica, sans-serif;
ffit font-family: "Times New Roman", Times, Baskerville, Georgia, serif;
ffv font-family: Verdana, Geneva, sans-serif;
fef font-effect: ;

fefin font-effect:none;

fefeg font-effect:engrave;

fef:eb font-effect:emboss;

fef.o font-effect:outline;

fem font-emphasize: ;

femp font-emphasize-position: ;
femp:b font-emphasize-position:before;
femp:a font-emphasize-position:after;
fems font-emphasize-style: ;
fems:n font-emphasize-style:none;
fems:ac font-emphasize-style:accent;
fems:dt font-emphasize-style:dot;
fems:c font-emphasize-style:circle;
fems:ds font-emphasize-style:disc;
fsm font-smooth: ;

fsm:a font-smooth:auto;

fsm:n font-smooth:never;

fsm:aw font-smooth:always;

fst font-stretch: ;



fsenselectors TR@PaRetch:normal;

fstuc font-stretch:ultra-condensed;
fstec font-stretch:extra-condensed;
fst:c font-stretch:condensed;
fstisc font-stretch:semi-condensed;
fstse font-stretch:semi-expanded;
fste font-stretch:expanded;

fst:ee font-stretch:extra-expanded;
fst.ue font-stretch:ultra-expanded;
op opacity: ;

op+ opacity: ; filter: alpha(opacity=);
opiie filter:progid:DXImageTransform.Microsoft.Alpha(Opacity=100);
op:ms -ms-filter:'progid:DXImageTransform.Microsoft.Alpha(Opacity=100)';
rsz resize: ;

rszn resize:none;

rszb resize:both;

rszh resize:horizontal;

rsz.v resize:vertical;

cur cursor:pointer;

cur:a cursor:auto;

curd cursor:default;

cur:c cursor:crosshair;

cur:ha cursor:hand;

cur:he cursor:help;

cur:m cursor:move;

cur:p cursor:pointer;

curit cursor:text;

fxd flex-direction: ;

fxd:r flex-direction:row;

fxdirr flex-direction:row-reverse;
fxd:c flex-direction:column;

fxd:cr flex-direction:column-reverse;
fxw flex-wrap: ;

fxw:n flex-wrap:nowrap;

fxw:w flex-wrap:wrap;

fxw:wr flex-wrap:wrap-reverse;

xf flex-flow: ;

jc justify-content: ;

jofs justify-content:flex-start;
jcfe justify-content:flex-end;

jac justify-content:center;

jasb justify-content:space-between;
jasa justify-content:space-around;
ai align-items: ;

aicfs align-items:flex-start;

aicfe align-items:flex-end;

aicc align-items:center;

ai:b align-items:baseline;



ai:s
CSS selectors

ac
ac:fs

acfe

ac:sb

acsa

fxsh

fxb

as

as:fs

as:fe

pgbb
pgbb:au
pgbb:al
pgbb:l
pgbb:r
pgbi
pgbi:au

pgbizav

pgba:au

pgba:al

pgba:l

pgba:r

orp

us

wid

wfsm or wfsm:a
wfsm:s or wfsm:sa

wfsm:n

HTML Selectors
m

mae

m4s

ixt

Hixs

Hixxs

cciie6

align-items:stretch;

To open

align-content: ;
align-content:flex-start;
align-content:flex-end;
align-content:center;
align-content:space-between;
align-content:space-around;
align-content:stretch;
order: ;

flex-grow: ;

flex-shrink: ;

flex-basis: ;

flex: ;

align-self: ;

align-self:auto;
align-self:flex-start;
align-self:flex-end;
align-self:center;
align-self:baseline;
align-self:stretch;
page-break-before: ;
page-break-before:auto;
page-break-before:always;
page-break-before:left;
page-break-before:right;
page-break-inside: ;
page-break-inside:auto;
page-break-inside:avoid;
page-break-after: ;
page-break-after:auto;
page-break-after:always;
page-break-after:left;
page-break-after:right;
orphans: ;

user-select:none;

widows: ;
-webkit-font-smoothing:antialiased;
-webkit-font-smoothing:subpixel-antialiased;

-webkit-font-smoothing:none;

To open
<!DOCTYPE html>
<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN" "http://www.w3.0rg/TR/html4/loose.dtd">
<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01//EN" "http://www.w3.0rg/TR/html4/strict.dtd">
<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" "http://www.w3.0rg/TR/xhtmI|1/DTD/xhtml1-transitional.dtd">
<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Strict//EN" "http://www.w3.0rg/TR/xhtm|1/DTD/xhtml1-strict.dtd">
<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.1//EN" "http://www.w3.0rg/TR/xhtm|11/DTD/xhtmI11.dtd">

<I-

<!--[if Ite IE 6]> <![endif]-->
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ccie
HTML Selectors

cc:noie

alink

a:mail

abbr

acr or acronym
base

basefont

br

frame

hr

bdo

bdo:l

col

link

link:css

link:print

link:favicon

link:touch

link:rss

link:atom

link:im or link:import
meta

meta:utf

meta:win

meta:vp

meta:compat

style

script

scriptisrc

img

img:s or img:srcset
img:z or img:sizes
picture

src or source

SICSC OF SOUrce:src
SIC:s or source:srcset
src:m or source:media
Src:t or source:type
Src:z or source:sizes
srcmt or source:media:type
src:mz or source:mediasizes
src:zt or source:sizes:type
iframe

embed

object

<!--[if IE]> <![endif]-->
To open
<!--[if IE]><!--><!--<![endif]-->
Create an HTMLS5 structure
<a href=""></a>
<a href="http://"></a>
<a href="mailto:"></a>

<abbr title=""></abbr>

<acronym title=""></acronym>

<base href=

<basefont>

<br>

<frame>

<hr>

<bdo dir=""></bdo>

<bdo dir="rt|"></bdo>

<bdo dir="Itr"></bdo>

<col>

<link rel="stylesheet" href="">

<link rel="stylesheet" href="style.css">

<link rel="stylesheet" href="print.css" media="print">

<link rel="shortcut icon" type="image/x-icon" href="favicon.ico">

<link rel="apple-touch-icon" href="favicon.png">

<link rel="alternate" type="application/rss+xml" title="RSS" href="rss.xml">
<link rel="alternate" type="application/atom+xml" title="Atom" href="atom.xml|">
<link rel="import" href="component.html">

<meta>

<meta http-equiv="Content-Type" content="text/html;charset=UTF-8">

<meta http-equiv="Content-Type" content="text/html;charset=windows-1251">

<meta name="viewport" content="width=device-width, user-scalable=no, initial-scale=1.0, maximum-scale=1.0, minimum-scale=1.0">

<meta http-equiv="X-UA-Compatible" content="IE=7">

<style>

<script></script>

<script src=""></script>

<img src="" alt="">

<img srcset=""src="" alt="">

<img sizes="" srcset="" src="" alt="">

<picture>

<source>

<source src="" type=
<source srcset="">
<source media="(min-width: )" srcset="">

<source srcset="" type="image/">

<source sizes="" srcset="">

<source media="(min-width: )" srcset="" type="image/">

<source media="(min-width)" sizes="" srcset="">
<source sizes="" srcset="" type="image/">
<iframe src="" frameborder="0">

<embed src="" type="">

<object data="" type="">

14



HTML Selectors
param

map

area

area:d

area:c

arear

area:p

form

form:get

form:post

label

input

inp

input:h or input:hidden
input:t or input:text
input:search
input:email

input:url

input:p or input:password
input:datetime
input:date
input:datetime-local
input:month

input:week

input:time

input:tel

input:number
input:color

input:c or input:checkbox
inputir or input:radio
inputrange

input:f or input:file
input:s or input:submit
inputi or inputimage
input:b or input:button
isindex

inputreset

select

select:d or select:disabled
opt or option

textarea

marquee

menu:c or menu:context
menu:t or menu:toolbar
video

audio

html:xml

keygen or kg

To oOpem
<pdaram name="" value="">

<map name="">

alt:

<area shape="" coords="" href="

<area shape="default" href="" alt=

<area shape="circle" coords="" href="" alt="">

<area shape="rect" coords="" href="" alt

<area shape="poly" coords="" href="" alt="">

<form action="">

<form action="" method="get">

<form action="" method="post">

<label for="">

<input type="text">

<input type="text" name='

<input type="hidden" name="">

<input type="text" name=

<input type="search" name=""id="">

<input type="email" name=""id

<input type="url" name=""id="">

<input type="password" name=""id="">

<input type="datetime" name="" id="">

<input type="date" name=""id="">

<input type="datetime-local" name="" id=

<input type="month" name="" id="">

<input type="week" name=""id="">

<input type="time" name="" id="">

<input type="tel" name=""id="">

<input type="number" name=""id="">

<input type="color" name="" id="

<input type="checkbox" name="" id="">

<input type="radio" name="" id="">

<input type="range" name="" i

<input type="file" name=""id

<input type="submit" value="">

<input type="image" src="" alt="">

<input type="button" value:

<isindex>

<input type="reset" value="">

<select name="" id=""></select>

<select name=""id="" disabled></select>

<option value=""></option>

<textarea name=

<marquee behavior="" direction=

<menu type="context"></menu>

<menu type="toolbar"></menu>

<video src=""></video>

<audio src=""></audio>

<html xmIns="http://www.w3.0rg/1999/xhtml|"></html>

<keygen>

id="" cols="30" rows="10"></textarea>

"></marquee>
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EATaBd oFend TopaRand>

btn:s <button type="submit"></button>

btn:r <button type="reset"></button>

btn:d <button disabled></button>

fstd <fieldset disabled></fieldset>

bq <blockquote></blockquote>

fig <figure></figure>

figc <figcaption></figcaption>

pic <picture></picture>

ifr <iframe src="" frameborder="0"> </iframe>

emb <embed src="" type="">

obj <object data="" type=""></object>

cap <caption></caption>

colg <colgroup></colgroup>

fstor fset <fieldset></fieldset>

btn <button></button>

optg <optgroup></optgroup>

tarea <textarea name="" id="" cols="30" rows="10"></textarea>
leg <legend></legend>

sect <section></section>

art <article></article>

hdr <header></header>

ftr <footer></footer>

adr <address></address>

dig <dialog></dialog>

str <strong></strong>

prog <progress></progress>

mn <main></main>

tem <template></template>

datag <datagrid></datagrid>

datal <datalist></datalist>

out <output></output>

det <details></details>

doc Create an structure in HTML5 with the title "Documento”
doc4 Create an structure in HTML5 with the http-equiv="Content-Type" content="text/html;charset=UTF-8"
rizd or ri:dpr <img srcset=""src="" alt="">

rizv or rizviewport <img sizes="" srcset="" src="" alt:

ri:a or ri:art Create an structure with the following tags '<picture>', '<source media="(min-width: )" srcset="">"' e '<img src="" alt="">"
ri:t or rictype Create an structure with the following tags '<picture>', '<source srcset="" type="image/">' e '<img src="" alt="">"
html:4t Create an structure in HTML4 using 'loose.dtd"

html:4s Create an structure in HTML4 using 'strict.dtd"

html:xt Create an structure in HTML4 using 'xhtml1-transitional.dtd
html:xs Create an structure in HTML4 using 'xhtml1-strict.dtd"
html:xxs Create an structure in HTML4 using 'xhtml11.dtd"

html:5 Create an structure in HTML5

ol+ Create an structure with the following tags '<ol>' e '<li>'

ul+ Create an structure with the following tags '<ul>' e '<li>'

di+ Create an structure with the following tags '<dI>', '<dt>' e '<dd>"

mans+ Fraata an ctrictira with tha fallawina fane 'eman nama—"<! a '—araa chana—" ~anrde—11 hraf— i skt



H"I-’.hr/‘IL Selectors
table+

colgroup+ or colg+
tr+

select+

optgroup+ or optg+

pic+

PN e e e swiuo e e

To open
CCreate an structure with the following tags '<table>', '<tr>'e '<td>"

Create an structure with the following tags '<colgroup>' e '<col>'
Create an structure with the following tags '<tr>' e '<td>"
Create an structure with the following tags '<select name=""id="">" e '<option value=""></option>"

Create an structure with the following tags '<optgroup>' e '<option value=""></option>"

Create an structure with the following tags '<picture>', '<source srcset="">"' e '<img src="" alt:
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General Overview

Scriptcase uses the concept of projects to manage the development of the applications. You will use the projects to organize your system development in a simple and practical way.
To create a Project on Scriptcase, it is necessary to have an interaction with a Database. This way you can create applications based on database tables and views.

In a project, it's possible to define the applications development standards using the default values, work with project version control, deploy all the applications or part of them, create developers work flow reports, display application

have 3 privilege levels for users or user groups. These privileges can be set inside the menu options.

It's recommended to review your database tables and relationships to ensure that you have them correctly structured and organized. This will make your work on creating applications easier and faster when performing fields looku
database structure through the menu > Database > Diagram ER.

Click here to see the steps to create a project.

Related Videos >



New Project

In this article you learn how to create a new project within Scriptcase.

A system made with Scriptcase has always to start by creating a project. A project for Scriptcase is a set of applications with some standard settings. During the project creation, you define some essential options as name and description,
available, a layout template for the applications, and informs the database system connection data in which the applications fetch the information to form the system.

To start a new project you can access the menu “Project > New Project”.

Layout  Locales

|Frmm Dalabase  Application  Tools

© NewProject
L)

The project creation process has five steps, which are: Start, Database, Languages, Themes and End .

T
New Project & admin Fy

Start

Start

In this step, we should choose between a Blank project, where we have to create our database connection and every application from scratch, or one select of our Template projects, that can serve as a template to the creation of your

Create New Project
onnec

vith your database and crea

+ Create Blank Project

stem using all Scriptcase applications and tooks.

Or choose a web system template below:
I ith

ur examples, s and data, to help you better understand Seriptcase.

i s~
O ;i o1 515 % £ e— [« [T By

n Business Intellgence m Appointments @ Recruitments tracker &Y oocuments tivrary

See more

NOTE: Click on “See more” button to have access to our Sample Projects and click in the link here to know how to import them.

After we select Create Blank project, it is mandatory to define a name to our project.

Project details

Fill in with y and icon. Back

Project Name Project Description

project New Project

Additional Project Information

Create a blank project o select from 2 template system

& Add anicon

Project name

The only mandatory setting for this step is that the name must contain 1 to 32 alphanumeric characters and does not allow it to start with a number.

Project description

Anot required that allows us to define a description for the project.

After the creation of the project, we can see the description in the dialog box when we place the mouse over the project when we use the gallery view or in the Description column when the project's view isin  list format.

Additional Project Information

Not required fields that allow us to add additional information to the project. This information is within the project properties.

Image



Not required fields that allow us to define an image to represent our project.

You can change all non-mandatory fields in this step, and other project settings after project creation by accessing the option Project Properties.

Databases
During the connection creation, Scriptcase lists all database systems according to your license. If you're evaluating, Scriptcase displays all database systems available. You have to select your database and proceed to the next step to infor

You need to have a database system installed and the permissions to connect before you proceed.

Note: Ifyou don't have a database available to create the project, Scriptcase provides a sample database in SQLite with the tables ready for the user to proceed with the creation of the project. To create this database just click on the
(SQLite).

Select your database system and create a connection for your project.

Mys & oRACEE % @ DB2, Informix

Create a connection o

= WysQUMariaDB = Orade = MssaL Server = Postares = DB2 = Informix = 1S Access
WSQLM Ksvease @ . D
2 saLite 2 syBase 2 InterBase = Firebird = Microsoft Azure 2 Amazon RDS 2 Google Cloud
@ Generic
—]
@ < ' w=s ODBC
= Oracle Cloud = Progress = oDBC

The information required to connect is different for each database. In this example we will be using MySQL. To learn more about other connections please access  this link.

Using Scriptcase you are able to create as well as to manage database projects and tables. During this step you will need to create or connect to, at least, one database project. We are going to use a “Samples” one. After the project creati
Database manager and SQL Builder features to manage the database project and queries.

Create a connection MySQL/MariaDB

Enter the connection details for your se MySQL/MariaDB € Choose another connection

Connection Name 0BMS Driver
conn_mysal MySQL PDO v
Server/Host (Name or IP) Port

127001 3306

Username Password

root

Database Name

samples | List Database Create Database

# Test Connection

Database connection details.

o onnection Name: Define the name of the connection. You are not able to change this name in the future.

L]

BMS Driver : Defined as MySQL PDO. It can also be MySQLi.

erver/Host (Name or IP): Enter the IP of the server where the database is. If the database is on the same machine of Scriptcase, you can use the IP. 127.0.0.1 or localhost. If the Database is
ort: Define the port of the connection. By default, the port is 3306.

ser: Inform the username that you use to connect to your database.

assword: Inform the password that you use to connect to your database.

atabase Name: Click on the “List Database” and select the desired database.

e o o o o o

est Connection: Displays the connection status if it succeeded or not.

All available connections are listed according to on your license type. Go to our on-line store and view the available licenses.

| Ifyou have connection problems, access our free support to get assistance by chat or remote access.

Language
In this step, you should select the languages that are available for system development.

Scriptcase can easily create multilingual systems. You need to add more than one language in this step of the project. All the languages you choose are available to the project, and you must choose one as standard. You can also have the
different regional settings.

Scriptcase will automatically translate and apply the regional settings to your project applications (for buttons and internal messages for example). You can also use another tool from Scriptcase called  Data dictionary to import and trar
see, create or customize the messages inside the menu > Locales > Application language.



Project languages

Choose the languages that you will use for your applications. It is possible to choose regional settings and define a charset for each selected language.
Language Regional Settings Charset Default Delete
= Engish English (United States) v Westem (1S0-8859-1) N . =]
= spanisn Spanish (Spain) v Westem (1S0-8859-15) . &
B Portuguese Portugal Portuguese (Portugal) - Westem (1S0-8859-15) v B
® anguage - List of languages that are in the projects.
e  egional Settings - Contains the standard regional settings for the selected language. Regional Settings allows you to define some parameters of monetary units, dates, and numbers according to the country or region where your a
o harset - Sets the character encoding format for the application. This encoding must be the same used in your database. By default, the charset comes according to the language, and you can change after creation in project proper
o efault - Sets the project default language. Project applications are performed and displayed using this default language; it can also be changed individually within the application settings.
e elete - Removes the language of the project. In this way, the language removed will no longer be available. It may also be included or deleted after the project created within the Menu > Project > Properties.

After selecting the language, regional setting, and charset, click “Add” and then “Save” to move forward.

Themes

In the themes selection, you can choose one more than templates for your project. Within this template you will have a complete theme for all applications you create within the project. Ready to use screens with pre made CSS and HTMI

You

The

can also customize or create new themes from the templates. Once you are inside the projects, access the menu Layout > CSS Application (Themes).

mes

The theme defines

NP8 Scriotcxelds)  Public (653) Sebected themes (4]

e o o o

Sc9_SweetHollyhock S¢9_SweetGoldenSand Sc9_SweetCoral Sc9_SweetBlue
= = = =

1!

Sc9_SweetAmour Sc9_Midnight $¢9_Meadow
=A =1

II - Lists all the available themes for use in your project.

criptcase - Lists all Scriptcase standards themes.

ublic - Lists all themes defined in the Public level.

elected themes - Lists the themes selected for use in the project.

To add a theme to your project, you only need to select it, and then it is going to be listed inside the selected themes. You should select a theme to use as default, for this click on the “default” icon of the selected theme. The default them:
new application, and you can also select a different one according to the options available within the selected themes. You can also access this option in the future to add new themes.

When you add more than one theme, you can dynamically switch themes before creating the applications, by adding a toolbar button within the applications or using the macro  sc_set_theme.

End

The

project has been created successfully with the basic settings, and now you can create the applications. Visit the Applications menu to learn more about each application and to see the steps to create them.

Congratulations! Your project has been created successfully. You can
now create Forms, Reports, Charts, Pivot Tables, among others
applications to this project.

+ Create first application

USEFUL LINKS

EE samples © Videos & Forum @ Support [ Documentation G courses



Related Videos >



Open Project

This option redirects to the Project List page, without closing your current project. To return to the application list, just click on the home icon. If you access another project, your current project is closed

Access Project > Open Project or click on the Open Project icon on the toolbar.

at;

Project

© NewProject
F=>  Open Project

[3 Clese project

New Open Close
Project Project Project

Next, you will visualize the project list. The current project appears on the upper right corner, as shown in image below:

ﬁ) B z(: 4  PROJECT
Edit saL New Batch Dsta  Applcaon | Help elearning 1.0.0
connection  connection  Builder application  applications dieonary  lenguzge
APPLICATION + FRIENDLYURL % DESCRIPTION % CREATOR 4 | GENERATION % STATUS &
I Classes
B8 Comunication
m instructor
Bm security
B8 swdent
O [#] blank Home Click here to e scripicase 01/17/18 11:08 updated Run | Edit | Copy Rename
[ g container & scriptcase 01/17/18 11:09 updated Run | Edt | Copy | Rename
(=] container_admin Click he: e ere to e scripicase 01/17/18 11:08 updated Run | Edit | Copy Rename
(=] container_instructor Click here to edit scripicase 01/17/18 11:09 updated Run | Edit | Copy Rename
O [E] form_conf_email Email Configuraion  scriptcase 01/17/18 11:09 updated Run | Edt | Copy | Rename
O [Z] legin oe HTML Login scriptcase 01/17/18 11:09 updated Run | Edt | Copy | Rename
O [E menu Click here to e ere to & scriptcase 01/17/18 11:09 updated Run | Edt | Copy | Rename
O 3 tabs_last_comunic Click here to e ere to & scriptcase 01/17/18 11:09 updated Run | Edt | Copy Rename




Close Project

Closes the current project redirecting to the the Project List.

Access Project > Close Project

Project

©  New Project
= Open Project

(O cClose project

Or simple click on the Close Project Icon on the toolbar.

e 05

New Open Chose
Proct  Project project



Properties

| This option is only available when accessing a project. It allows the edliting of the project’s information.

Edit Project

We can edit some of the project information, like the description and the use of the index.

EDITPROJECT ~ LOCALES ~ THEMES

>

Project Name: samples

ijsztDescnmmn|

gx Choose tnelmt\a\apph:almn| ’T|
Use index page ® Yes O No
Charset conversion to UTF by database O Yes ® No
Keep old layout of file upload © Yes @ Ho
Browser tab icon (Favican) <. [z
FontFemly - FontSize = A -
Path: p

o roject Name - The name of the project informed on its creation. It is not possible to change the project name after its creation.

®  roject Description - Description informed on the project creation. Differently from the project name, it is possible to change it using this interface.

o hoose the initial application - Allows you to define the initial project application for the Run Project button. So every time you run the project, this application opens automatically, it can be a login screen, for example.
e selIndex Page - Allows the use of friendly URLs in the applications. Scriptcase enables this option by default.

e harset conversion to UTF8 by database - With this option enabled, the database will convert the characters sent by the server according to the charset of the database.

o eep old layout of file upload - Option defined for users who do not use the slash symbol (/) when creating a subdirectory, in the image and document type fields. In this scenario, files were stored directly in the “file” directory. If yo
enable this flag. In the latest versions, images and documents are being saved in the directories informed in the installation, that is, “file / img” for images and “file / doc” for documents.

e roject Information - Detailed description of the project.

Locales

Define the languages for the project applications. The languages are select as you create your project, you can edit this option to add or remove languages anytime.
EDIT PROJECT LOCALES THEMES

Project languages
Choose the languages that ye

ations. It is possible to choose regional settings and define a charset for each selected language.

Language Regional Settings Charset Default  Delete
L= English (United States) v | |Unicode (UTF-§) v @ o
& Portuguese Brazil Portuguese (Brazil) v | | Unicode (UTF-8) v . ™

Gancel m

® anguage - List of languages from the project.

e egional Settings - Standard regional settings for the selected language. Regional Settings allows you to define some parameters of monetary units, dates, and numbers according to the country or region where your application.
e  harset - Encoding used by the selected language.
o efault - Default a language for the project. All the applications created are executed on the default selected language.
o rash Can - Removes the language from the project. The removed language won't be available for changing dynamically in runtime.
Themes

It defines the available themes in the project and the default theme used by the applications. To set a default theme for your project, select the theme and click on  Set a default Theme, the “default” notation appears beside the theme
Sc9_Rhino.



Edit Project [
EOTPACHCT  10CAES | THEMES

Project themes ==

i Y (i ] [Proviovs ] (est | (Lost] [Imche | [Smve ]
529_Meadow | :_campo
Sco_SweeiGolgensan Block 1.1
Sc8_SweetBiue (Defaut)
S Mirignt Tle 1 Object text

Block 2.1
Title 1 Titie 2 Title 3

S23_valencia 8 i 2222072 133333
S0 Compta mnn 22222 1IN

R Footer
Sc8_Granada

e lIThemes - List of all the themes from ScriptCase.

e roject Themes - List of available themes within the project.



Default Values

With this configuration, it is possible to standardize the creation of the applications of the current project, increasing productivity in the development of the applications.

Common Settings

L090 | scriptcase__NM_img__NM__loga.png

Records per page ‘10

Display Line Number Cves @no

Display Titles @ves ONo

Show summary Cves ®o

Use ald Chart theme palettes Oves ®Np
Use Sweetalert ®ves Ono

SweetAlert position using Toast

gt v
Initial sort fields
g [becentort ]
number |m‘
currency |m‘

e 0go - The Favicon that is going to use with the project. Customize the project using the same Favicon in all the applications.

e ecords per page - Amount of records per page.

e isplay Line Number - Defines the display of the line number existing in each application.

e isplay Titles - Displays the title of the application in execution.

o how Summary - Displays the number of records on the page and the total of the records in the application. This option executes only if the line option in the Grid toolbar is disabled.
e se old Chart theme palettes - Defines the use of the old scheme of colors on the charts

e nitial sort fields - Defines the initial sorting of the fields.
Grid

Tablewidth [ g

Table width Unit ‘F‘
Format Row Counter ‘ Uang_um,_sm,y_mh)‘
TbaGrowpBy | qop
Separates the Group By ‘—‘

Records per page ‘ ‘

TEMPLATES

Header | Flat v 7 Footer | Default

GRID FIELDS ALIGNMENT

Default Numeric Date

Horizontal Alignment L v Rigt v| | center v
Vertical Alignment e v SiE™ g
Title Horizontal Alignment ‘ Left v H Left v H Left M |
Title Vertical Algnment | igqle v [ middie v || middie v

TOOLBAR BUTTONS

e able Width - Defines the length for the application table. this option is available to select Pixel or Percent in the table width unit.

e able Width Unit - The unit used to define the width of the application. Automatic (Width automatically defined according to the size of the fields); Pixel (Width defined by pixels, that should be informed in the Form: 800px); Percent (
informed in the Form: 80%)

o ormat Row Counter - Configuration of visualization of the display summary option of the Grid. The display summary option is displayed and executed only if the line option in the toolbar isn't enabled

e abaGroup By - Defines the left margin of the Group By.

e  eparates the Group - Defines the margin between two Group By.

e ecords per page - Available values in the Record button, on the toolbar

e emplates - Defines the templates used by default on the Header and Footer. It's possible to inform the values to the variables of the selected templates, clicking on the editing icon right beside the field of the template selection.
o rid fields alignment - It's possible to define the default alignment specifically for the fields that contain numbers and dates and the other types of fields.

e oolbar Buttons - Define the buttons that'll be set up by default in the toolbar for the new applications. We can set up the toolbar for the Grid, Detail, and Summary.

Form



Table width 100
Table Width Unit | popcant M
Format Row Counter
Automatictab O ves ® o

Highlight Text on Focus ® ves ) No
Highlight Field with Error ) veg ® no

ERROR SETTINGS

Error Position on the field |, v
Show the Error Title in the Application @ ves O No
Show the Error Title in the Field @ vag ) Np

Error Title

REQUIRED FIELDS
Display message ) ves ® Ng

TEMPLATES

Header | Flat v | Footer | Default v

TOOLBAR BUTTONS

e able Width - Defines the length for the application table. this option is available to select Pixel or Percent in the table width unit.

e able Width Unit - The unit used to define the width of the application. Automatic (Width automatically defined according to the size of the fields); Pixel (Width defined by pixels, that should be informed in the Form: 800 pixels); Perce
be informed in the Form: 80%)

e ormat Row Counter - Configuration of visualization of the display summary option of the Form on a horizontal orientation. The Display summary option is displayed and executed only if the line option in the toolbar isn't enabled
e  utomatic tab - Enables the automatic tab when finishing to inform a field.

e ighlight Text on Focus - Allows the content of the fields to be Highlighted when the field is focused.

e ighlight Field with Error - When occurring an error on a field, it is also required, for example, the focus will be applied to this field.

e rror Position on the field - Position of the field error.

o how the Error Title in the Application - Defines the display of the title of the application error.

e how the Error Title in the Field - Defines the display of the error Title for the field.

e rrorTitle - Defines the error Title.

e isplay message - Defines the display for the message if the field is required.

o emplates - Defines the templates used by default on the Header and Footer. It's possible to inform the values to the variables of the selected templates, clicking on the editing icon right beside the field of the template selection.

e oolbar Buttons - Define the buttons that'll be set up by default in the toolbar for the new applications.

Control

Highlight Field with Error O ves ® no

ERROR SETTINGS
Error Position on the field |, v
Show the Error Title in the Application @ yeg No
Shaw the Error Title in the Field ) yes ® po

Error Title

REQUIRED FIELDS

Display message O ves ® No

TEMPLATES

Header | Flat ¥ |7 Footer | Default M

o ighlight Text on Focus - Allows the content of the fields to be highlighted when the field is focused.

e ighlight Field with Error - When occurring, an error on a field is also required. For example, the focus will be applied to this field.
e rror Position on the field - Position of the field error.

e how the Error Title in the Application - Defines the display of the title of the application error.

o how the Error Title in the Field - Defines the display of the error Title for the field.

e rrorTitle - Defines the error Title.

e isplay message - Defines the display for the message if the field is required.

e emplates - Defines the templates used by default on the Header and Footer. It's possible to inform the values to the variables of the selected templates, clicking on the editing icon right beside the field of the template selection.

Search



Empty Search

® ves O No
Search Criteria |ﬁ‘
Horizontal Algnment ["coneer v
Display Condition () yes ® o
Keep Values @ ves (0 No
Keep columns and sorting & yas O o
Tblewidth 10 |
Table Width NIt | porent v
Use Iframe () ves ® Mo

Show Results ® ves ' No

Iframe Height | 1500

ERROR SETTINGS

Error Position on the field | up v ‘

Show the Error Title in the Application @ vyag ) o

Show the Error Title in the Field ) yes ® o
Error Title |
TEMPLATES

Header | Flat 7 Footer | Default

TOOLBAR BUTTONS

o mpty Search - Defines how the search treats the conditions. “AND" (Should satisfy all the conditions so that the search can return some results) “OR” (Should satisfy any condition informed so that the search can return some results

e orizontal Alignment - Horizontal Alignment of the search.

e isplay Condition - Displays the condition of the search so that the user can make their choice. (“AND" or “OR")
e eep Values - Keep the values of the previous searches done when reaccessing the search.

e eep Columns and Order Selection - Preserve the position of the fields and the sorting of the previous search.

e able Width - Defines the length for the application table. this option is available to select Pixel or Percent in the table width unit.

e able Width Unit - The unit used to define the width of the application. Automatic (Width automatically defined according to the size of the fields); Pixel (Width defined by pixels, that should be informed in the Form: 800 pixes); Perce

be informed in the Form: 80%)
e selframe - Allows the use and the display of the application searched in the same page within an iframe.
e nitial State - Defines how the application is displayed at first when using the search with an iframe, if the application is displayed at first or only the search is displayed.
e frame Height - Defines the height of the iframe in pixels.
e rror Position on the field - Position of the field error.
o how the Error Title in the Application - Defines the display of the title of the application error.
e how the Error Title in the Field - Defines the display of the error Title for the field.
e rrorTitle - Defines the error Title.
e isplay message - Defines the display for the message if the field is required.
o emplates - Defines the templates used be default on the Header and Footer. It's possible to inform the values to the variables of the selected templates, clicking on the editing icon right beside the field of the template selection.

e oolbar Buttons - Define the buttons that'll be setup by default in the toolbar for the new applications.

TOOLBAR BUTTONS
Top

Navigation Left

First Center

Previous Right

Next @

Last ®

Exit @ O]

Navigation by page ® IG)
Update © Group

Insert @

Update m Edit EE

Delete

Cancel
Others

Languages
Navigation Left

First Insert

Previous Update

Next Delete @

Last Cancel ©

@ Center
®

Navigation by page ® | right ©

Update © Exit Group
®

Others

Languages

e oolbar Buttons - Define the default buttons in the toolbar for the new applications.

New Chart



TOOLBAR BUTTONS

Top:
Navigation - Left -~
Sorting
Export Custom @
Bar ©
Others ® Line ®
[©] Area ®
@© pie
Languages @ Stacked Group
Themes Combination Edit .
Combinaton [ e ] [ oocce |
summary
Dynamic Search
- Center -~
Navigation - Left -
Exit Center
Export Right
POF ®
Print ©
Others ® ®
Search @ G]
Dynamic Search © s
Languages @ roup
Summary
Sorting
Charts types - -

e oolbar Buttons - Define the buttons that will be set up by default in the toolbar for the new applications.

Old Chart

TOOLBAR BUTTONS

Top
Export - Left -
Group By
Center

Others {lang_btns_expt} @
Search PDF (@]
Dynamic Search ® Print o)

@ | Groupky @

Languages @ Exit &
Themes @ Right roup
Summary

N aaa Jf e |

Separator

Export = Left =
PDF Center
Print Right

Others 9]
Search ©
Dynamic Search ® &
Group By [©] o)
Languages 6] Grou
Themes @ P
Summary

N =] (EE] (==]
Exit

Separator

e oolbar Buttons - Define the default buttons in the toolbar for the new applications.

Tab

Tab Alignment ||,

TEMPLATES

Header | Flat 7 Footer | pefault f

e ab Alignment - Display alignment of the tabs in the application.

e emplates - Defines the templates used by default on the Header and Footer. It's possible to inform the values to the variables of the selected templates, clicking on the editing icon right beside the field of the template selection.

Menu

Hoizontal Algnment of theMenu |
Horizontal Algnment of the ftems [\ ]|
TEMPLATES
Header | Flat Footer | Default

e orizontal Alignment of the Menu - Menu alignment.
e orizontal Alignment of the Items - Menu item alignment

e emplates - Defines the templates used by default on the Header and Footer. It's possible to inform the values to the variables of the selected templates, clicking on the editing icon right beside the field of the template selection.

Dashboard



TEMPLATES

Header | Flat v | W@ Footer | Default v

e emplates - Defines the templates used by default on the Header and Footer. It's possible to inform the values to the variables of the selected templates, clicking on the editing icon right beside the field of the template selection.

HTML Editor

The HTML Editor has to options of configurations, depending on the option selected on Use template in the HTML Editor .

o setemplate in the HTML Editor - Selecting Yes (Image Below), you use the new templated of the HTML Editor field, these themes should be setupin  Layout > HTML Editor Templates .
e  TML Editor template - Defines the template for editing of the field HTML Editor.
o ield Preview - Default Text of the HTML Editor Fields.

ATTRIBUTE VALUE
Use template in the HTML Editor @ vyeg No
HTML Editor template | g v

File~ Edit~ Insert~ View~ Format~ Table~ Tools~

# @ Fomas~ B J =

1]
iii
“
i
“

e setemplate in the HTML Editor - Selecting No (Image Below), you won't be using the new templated of the HTML Editor field. In this case, the options should be set up in the field.
e roperties - Defines the display properties.

e ocation - Defines the position of the items in the field. Top or Bottom

e uttons Alignment - Defines the alignment of the items in the field. Left, Center, Right.

e tatus bar - Position of the Status Bar.

e oolbar Count - Amount of the bars to organize the items.

e uttons’ Organization - Set the available items in the bars.

ATTRIBUTE VALUE

Use template in the HTML Editor Yes ® No

¥ Pproperties
Localization | 5 v
Buttons Alignment | _o\o v
Status bar | ok chow v
Toclbar Count | v
[ Buttons' Organization
- Toolbars 1 -
Bold
@ | rralic
[©] Underline @
@ | strikethrough @
@ Justify Left
Justify Center
- Justify Right -

Font Family = Font Size - ﬁ'

P [OF

Internal Libraries

Define the libraries available in the project.
Level  scriptease v

([ sc_ssn.php

e evel - Access level of the library.

e istof Libraries - List of all the libraries available for use in the project.



Version History

Lists all the versions of the current project. The Version History page manages the versions of the project, created in the option of version incrementation, here we can return to earlier versions, open a previous version or delete created

Version's description

Version Description Creation Delete  Status  Edit
1.00 Prisamples-v.1 0321117 09:57 o o &

e ersion - Project Version.

e escription - Project version description.

e  reation - Date of the version creation.

o elete - Delete the selected version of the project and all its applications. Applications from the other versions are not affected.

e tatus - Defines if the version of the project is opened or closed.

e dit - Allows to edit the selected version of the project. This option is available for the version that have the status Open.



Version Incrementing

Allows the control over the project in development, separating it in versions. The project version control allows you to protect the functionalities existing in the system, before doing any important modifications, by creating a new versior

I The version increment allows that only the latest version of the project to be increased.

Increment Project Version samples

Current Version 1.0
New Version 1 *F 1
Description

m Cancel

e urrent Version - Informs the current version of the project.
e ew Version - Defines the number of the new version of the project.
e escription - New project description.



Generating Source Code

Allows you to generate the source code for all the applications in the project, select the chosen application, or generate the source code for the outdated ones.

Selects applications to generate

Select Applications.
& Al
) Qutdated Applications (51}

- Select Applications

m Cancel

o |I- Generates the source code for all the applications in the current project when selecting this option, you are redirected to the page where the code is generated, where you can also see the log.
e utdated Applications - Generates the source code only for the outdated applications (recently modified applications that weren't generated yet), when selecting this option, you will be redirected to the page where the code will b
e elect Applications - This option allows you to select the applications that you want to generate the source code, when selecting this option, you will be redirected to the application selection page.

Selecting Applications

All the applications from the project are listed here, and you should select the applications that you want the source code to be generated. The application can be listed in two ways, using the filter to list by Application types or by folders

Select Applications

Applications ?
Visualization ) Per Type '® Per Folder
root
[ menu () menu_ve1
V)
root/Calendar
[ calendar01 [ calendar02 [ calendar03
I calendar_color_event O cir_login
)
root/Chart
[ ehart_area [ chart_area81 [ chart_bars_2D
[ chart_bars_3D () chart_columns_2D [ chart_columns_3D
[ chart_cantainer () chart_donut [ chart_gauge
I chart_gauges1 [ chart_line [ chart_line_step
[ chart_pie_2d [ chart_pie_3d [ chart_pizza
hart_pyramid ([ chart_pyramida1 [ enart_spline
I chart_stacked_bar_3D 1) combination_chart
)
rootControl_Applications/Bussiness_Rules
g " ctroa [ ctroa_1
O etroa_a (O er_auth

I ctri_xm|_generator_dom
)

After selecting the application that will be generated, you will be redirected to the page where the code will be generated, where you can also see the log.

Generating source-code

Code generation succassiul.

Elapsed time: 0:00:58
Average time per application: 0:00:00.855
Total applications generated: 67 /67

S@ s s

E tabs_last_comunic =
Application Type: Tab Status: Ok

E tabs_student_courses =

Application Type: Tab Status: Ok @

'ﬁ‘ blank =

Application Type: Blank Status: Ok -

o vimeo B
Application Type: Blank Status: Ok

E app_grid_sec_groups =

Application Type: Grid Status: Ok -

|—v-!-‘ app_grid_sec_users =y

= Annlicatinn Tina- Grid Statis Ok -}

We can see in the highlighted folder of the image some filter options.

pen Folder Icon - Allows possible errors to be displayed when generating the code.
losed Folder Icon - Allows to hide the possible errors when generating the code.
ocument ok - Displays only the applications that haven't had any problems generating the code.

L]
.
L]
o ocument error - Displays only the applications that has had any problems generating the code.



Export Project

This option allows you to create a .zip file with all the applications from the current project and all its required files.

Access File > Export Project .

G Database  Appl
© New Project
[ Open Project
O Close Project
& Properties
= Default values
Bl Version History

O Increment Version

Export Project

& Import Project

Next, select the project that you want to export.

Export Project

Selectthe project

gradebook v

When finishing the process, the file will be available for download.

Backup



Import Project

Allows you to import a project exported by ScriptCase, with all the required files.

Access File > Import Project .

Project JIEELELTINN

© NewProject
Open Project

Close project

g OO0

Properties

Default values

a

B, Version History

{il Increment Version

4+ Export Project

& Import Project

Next, we need to select the project file that we want to import.

Select the backup file to upload ?

Choose File | sc9_bkp_ele..12282

After finishing the process, we should inform the name of the project that is being imported.

| In case there is a project with the same name in your ScriptCase, the project that is being imported will overwrite the existing project.

Import project

Project [Ejearning

= =]

After finishing the import, we can open the project.

Import project

Open project



Deleting a Project

The project can be deleted by Floating menu available in the projects interface. Click here for more menu details.

Floating menu at project list

Or can be deleted by menu Project > Delete project, in this case will be necessary to open the project.

Project Menu

Delete confirmation

Now will open a pop-up to confirmation the action.

Delete a project can't be undone, so we recommend doing a backup to avoid a definition lost of the project.

On this screen we will have some important information to delete a project.

Confirmation of project name and version

In case the project has more then one version, configured at increment Project, it will show them with the possibility to delete or not.
After deleting a project, we have to delete the open version, unless it has the close status. Click here for more details about it.

List of project versions

Related Videos



Reports

We offer two types of reports for projects: Application List and Developers Summary.

To generate the reports, access Project > Reports

Project atabase  Applicafion ools  Layout ocales  Modules

£

@ NewProject

. ow Edit saL Nev
Open Project connection connection  Builder applica

=

[0 Close project

& Properties

=+ Default values

Bl Version History

O  Increment Version
Export Project
Import Project

+

+

£  Generate source code
&  Deploy applications
&

Delete project

Reports 4

Application list
& Show diagram & Developers summary

Q  Application search

Application List
Displays a list with all the existing applications in the current project and the SQL INSERT Queries of the tables. To generate the report, first you need to define which information you want to be available.

Report: Applications List

- Name -
@ Description

@ Create user @
Select Columns Date/Hour of Creation
@ Date/Hour of Update @
&) | DatelHour of Generation
- Generation Status -
- +MName - Order By
Description )] Ascendant
Create user
Sorting | Date/Hour of Creation ® @ Descendant
Date/Hour of Update @© @
Date/Hour of Generation (]
Generation Status - -
Group By v

o

elect Columns - Defines the columns that will be part of the report.

orting - Defines the fields and the sorting that will be available.

rder By - Defines the initial sorting for the report. It will use Ascendant by default if not informed.
roup By - Defines the grouping of the report, by type (application) or by folder (Project’s File Directory).

® o 0 o

After finishing the configurations, click on Report.

Report: Applications List

Name Description  Create user ‘of Creation of Update of lion Status
calendar_calendar admin 02/05/18 10:52 02/05/18 10:55 02/05/18 10:55 Generated
form_products admin 02/07/18 16:22 02/07/18 16:24 Outdated
grid_products admin 02/02/18 14:06 02/02/18 14:06 02/02/18 17:48 Generated
search_products admin 02/05/18 10:27 02/05/18 10:27 Outdated

=] =

Developers Summary

Generates a Summary with every action each developer had done, showing the total applications and their types and the total of code lines that the user wrote in the applications.

Developers summary

|| Report ‘ Charts

REPORT: SUMMARY BY DEVELOPER 7
Developer Grid Chart Form Control Tabs Procedure Menu MenuTree Search Dashboard Blank Total Code Lines
__ldap_ralves 0 0 0 0 0 [ [ 0 [ 0 0 [ 0
admin 3 0 3 0 0 [ [ 0 [ 0 0 6 0
scriptcase 33 0o 20 3 2 [ 1 1 1 3 2 68 0
support 0 0 0 o [ [ [ 0 [ 0 0 [ 0



This same report is available in Charts, with three types of visualization.

pplications - Total of applications in the project grouped by their type.

.
e evelopers - Total of application created by developer in the project.
e pplications x Developers - A junction of the other two charts.
Applications Developers | Applications Type X Developers.
Total Application X Type
W0
-
=
]
H
]
3
o

Application types
il Form ik Search ils Menu ik Menu Tree ik Tabs il Procedure

Blank i Chart il Dashboard i, Control ik Grid



Showing Diagram

Generates a diagram of relationships between applications in the project. On this diagram, you can see in a clear way which applications are related and which is the method used to create the relationship.

I On this example we're showing the relationship of all the applications in the sc_album project.

[ slank [] control [ Dashboard [] Form [] Grid [ Menu [] Search [] Tabs [[] Tree Menu

E tabs_student_courses

e = Mo Mars Mars Mars Mens

- blank E form_inbox E.pinfsmﬂmu E

Applicasian Svefier Evenn Event Fimd Apgiicaiin i

o_search_sec_groups.

e 3

Options Print

There are some options that can help visualizing the diagram.

We can display a mini map of all the diagrams, to help with the display. In order to visualize it, click on the icon on the lower left side of the diagram.

There are other options of views, instead of the mini map, as shown below.

Diagram layout Read mode Spacing c

™ Horizontal Vertical
- . E WVertical v 50 200 Options Print

e iagram Format - Build the Diagram according to the ties positioning.
e eading Mode - Defines the perspective of reading for the diagram when it's created.
o  pace - Defines the space between the columns(Horizontally) and the layers(Vertically).



Application Search

It performs a search in the project with all the content informed by the search itself.

The location on which the search will look for defined by a checkbox.

| At least one of the options need to be selected.

APPLICATION SEARCH

Search word: m ® Anything ' words

@ Al () Theme
[ saL () Template Name

(] Field Mame and Label [ Libraries

[ Links () Header and Footer

) Lookup |~ Block Name and Label

Il - Performs a search in all the options listed below.

QL - Searches only in the SQL areas of the applications.

ield Name and label - Performs a search for the name and label of the field.

inks - Performs a search only for the name of the applications.

ookup - Searches inky in the lookup area of the fields.

hemes - Searches only for theme names.

emplate Name - Searches only for HTML templates names.

ibraries - Searches for internal libraries that contain this specific name.

eader and Footer - Searches only for the Application Titles.

lock Name and Label - Searches only for the name or label of the block informed.

® ®o 00 00 0 0 0 o

The results will be displayed as shown below.

Application Item Value
chart01 (Grid)

SOL Select Statement SELECT
orderid,
customerid,
employeeid,
orderdate,
requireddate,
shippeddate,
shipvia,
freight,
priceorder,
shipcountry,
shipregion,
shipstate,
shipcity,
shipname,
shipaddress,
shippostalcode
FROM

orders
Grid Title {lang_header_grid_70_tfitle}
Detail Title {lang_header_grid_70_iitle}

Blocks )

Name => grid_orders
Text == grid_orders

chart02 (Grid)

SQL Select Statement SELECT
orderid,
customerid
employeeid,
orderdate,
requireddate
shippeddate
shipvia,
freight,
priceorder,
shipcountry,
shipregion,
shipstate

e pplication - Name of the applications found that satisfies the search.
e tem - Location where the search criteria was found.
e alues - Values found that satisfies the search.



Importing a template Project

In this tutorial, you learn how to import a project template from Scriptcase. The project templates contain various samples applications for you to copy or learn how to apply Scriptcase features. You can run all the template projects to tes

The process of importing a template is divided into two steps, which are detailed below.

The projects created with access permission for the user, appear in Project List.
Start
During the first step of the project creation, you can create a Blank project or Import a template according to the options below.

Or choose a web system template below:
Import one of our examples, with applicati

s and data, to help you better understand Scriptcase.

Point of Saes % [ svmvies ovicarons CRM Project Helpdesk
n Business Intelligence m Appointments [g Recruitments tracker [ oocuments ubrary
'9 Delivery Tracking . Health Care E FluxeCaixa - Personal Finances

u elearning ‘Q Online Shop ﬂ Training - GradeBaok

o Project Management n Security

News =]~

When you import a project template, Scriptcase will delivery some ready to use applications and also the database tables. Here you see the steps to import one template project, the “Samples.”

First, you need to choose the project and customize all the details. Description and image are optional.

Project details

Fill in with your project details, such as: name, description and icon. Back
Project Name Project Description
Elearning eLearning

Additional Project Information

Template system for creation of virtual learning environments (EAD). Designed to assist in content management
and administration of courses online. With catalog of courses,
and administration of classes, teachers and students

L. Addanicon

£

® rojectIcon - You can select a project icon for display purposes in the project list. This field is not required, and you may change after creation inside project properties.

e roject Name - The project name must contain 1-32 alphanumeric characters, without space neither special characters.

e roject Description - Here, you give a brief description of the project, not required, also able to inform after the creation of the project.

e dditional Project information - Here, you can add some additional information you want for the project. This field is not required, and you may change after the creation of project properties.
Database

Our template projects are available for MySQL, Oracle, SQL Server, PostgreSQL, Access, SQLite, Firebird.
You can choose to use the default connection or to configure a new connection to your database.

Use default connection (SQLite)

By clicking on the option “Use default connection (SQLite),” Scriptcase undertakes to create a database, with the SQLite database, and insert all the information of tables and records. The database file with the project tables and some dur

Creating the new project
Elearning

Step 1/4 - Creating the new project. ¥

Step 2/4 - Preparing the database and the applications to import. ¢

Step 3/4 - Importing the applications (this step may take a few minutes). +
Step 4/4 - Creating the database. ¥

67 Imported applications in 00:00:09

rate source-code Open project
The project will be created and configured with all the essential information. Generate the source code to compile and applications and then “open project” and view all the applications created or “Run” the project to open the initial appli

Create a new connection to my database



Select your database system and create a connection for your project.

MgSlﬁRL oracts % @ DB2, Informix @

Createa connection o

£ MySQuMariaDB £ Oradle = 1SsOL Server = Postgres S DpB2 = Informix = NS Access
Woi. Esms @ VAN ¢ 3 S
= salite = syBase = Firebird = Microsoft Azure = Amazon RDS = Google Cloud = Oracle Cloud

After selecting the database you want to connect, enter the required data to perform the connection.

The information needed to create a connection varies according to the selected database. In the example below, we show with MySQL connection. For more details on how to connect your database  click here.

®

CONNECTION ~ SECURITY  FILTER  ADVANCED

Gonnection Name DBMS Driver
conn_mysal MySQLPDO j
ServeriHost (Name or IP) Port

127.001 3306 =

Usemame Password

root sesssnse
Database Name

samples :J List Database Create Database

7 ot

onnection Name: Define the name of the connection. You can change this name in the future.

BMS Driver : Defined as MySQL PDO. It can also be MySQLi.

erver/Host (Name or IP): Enter the IP of the server where the database is. If the database is on the same machine of Scriptcase, you can use the IP 127.0.0.1 or localhost.
Port _: Define the port of the connection. By default, the port is 3306.

ser: Inform the user name that you use to connect to your database.

assword: Inform the password that you use to connect to your database.

atabase Name: Click on the “List Database” and select the desired database.

est Connection: Displays the connection status if it succeeded or not.

® ® 0 0 0 0 0 0

If you don't have a database created, click on the button “Create Database” and the window below appears.

The option of Create Database is available for: MySQL/MariaDB, MSSQL Server and PostegreSQL

Create Database

Cancel m

Enter a name for your database and click “OK.” After that, the database created will be displayed on the database list. To create a database directly from Scriptcase, you need to have the correct permissions within the database system its
refused, especially when you have the database in another server. In this example, we have the database located on the same server, localhost.

Project Generation

After you finish, Scriptcase undertakes to create all the tables and insert all the information used in applications.

Creating the new project
Elearning

Step 1/4 - Creating the new project. ¥

Step 2/4 - P ing the and the icati to import. v
Step 3/4 - Importing the applications (this step may take a few minutes). v
Step 4/4 - Creating the database. v

67 Imported applications in 00:00:09

All set! Now the project will be created and configured with all the essential information. Generate the source code to compile the applications and then open project and view all the applications created.

Related Links »






ScriptCase Available Connections
DN

Mysol

ORACLE

)
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Access

In ScriptCase we provide two drivers for the MS ACCESS connection, MS Access ODBC and MS Access ADO.
You can find out if drivers are available by going to diagnosis. See below how to find your diagnostics and check if the driver is enabled.

e  ccessing the top menu help > Diagnosis, you can faind it in the interface.

@ WebHelp ..

® Technical Support

e oucan find it too in your browser:
127.0.0.1:8092/scriptcase/diagnosis.php or domain.net/scriptcase/diagnosis.php
Click on the driver that you need know how to enable.

o Access ODBC
o Access ADO



Connecting with MS Access ODBC

The Scriptcase provides two drivers for connecting to the Access database: ODBC and ADO. For more information on how to enable the MS Access ADO driver see our
documentation.

In Scriptcase, it is also possible to convert tables from Access database files (mdb or .accdb) to the databases: MySQL, PostgreSQL, SQLite and SQL Server. For more
information, see our documentation for Database Convert.

Requirements

Before proceeding with this documentation, check your PHP architecture. For the drivers to be enabled correctly files must be downloaded according to the architecture
used.

e In your Scriptcase, there is the fileinfo.php, access it by the URL: http://127.0.0.1:8092/scriptcase/info.php, where you will find information regarding architecture in thephpinfo().

e x86 Architecture = 32 Bits
e x64 Architecture = 64 Bits

WARNING: The PHP architecture of Scriptcase and MS Access must be equivalent.
In the automatic installation of Scriptcase, theCOM extension is already enabled in PHP, requiring only the following items below to make the connection with Access:

e The MS Access database (.mdb or .accdb) must be stored on the same server/machine as Scriptcase with one or more tables created.
e Access Database Engine installed.
e System DSN ODBC created in the Windows ODBC Manager.

Necessary files:
x64
e Access Database Engine 2010: Click here
x86
e Access Database Engine 2010: Click here
Installing the Microsoft Access Database Engine 2010 Driver
e First we must download Driver Access Database Engine 2010 according toyour PHP architecture:

Access Database Engine 2010

x86 Download
:;zess Database Engine 2010 Download

After download, run the file to install the engine:

1 - Click “Next” to continue the installation.

2 - Accept the license terms and agree to continue.

3 - Set the path of the Access Engine installation. You can also use the default path entered by the installer.

4 - Installation complete, click “OK?” to finish.

Create an ODBC System DSN

See below for all the tutorials for creating an ODBC data source to connect to Scriptcase.
NOTE: The ODBC must be created on the same server where ScriptCase is installed.

1 - Access the ODBC Data Manager and select according to architecture. We will select the x64 version:

2 -When you log into ODBC Data Source Manager, select the DSN tab and click Add to create your connection to your Access database.

3 - After this, you need to select the controller to connect to Access. Select driver: Microsoft Access Driver (*mdb, *accdb).

4 - Now you need to define the name of the DSN and select the Access database file.

Data Source Name

Here you will define the name of the DSN to be entered in the Scriptcase connection.



Description
In this item, you can create a description for this DSN by distinguishing it from another one created.
Database

In this section, you must select the database file by clicking theSelect... button, but you can also create new databases, repair or compress existing files.

5 - After clicking Select, you must choose the path to the Access file.

6 - Now just click “OK” to confirm the creation of DSN, so it will appear in the list of DSN available.

Create a connection in Scriptcase

In this documentation we will show the connection through the ODBC driver bySystem DSN and in File path to the Access database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

e Select connection “MS Access”.

e Select DBMS driver: MS Access ODBC(Recommended)

In this access connection controller, we can connect in two ways: using the ODBC DSN and entering the database path in“Server/Host (Name or IP)”.
Connect to Scriptcase using the system DSN:

In this type of connection, we must inform the DSN of the system created in stepCreating an ODBC data source to make the connection.

Connection name

Define the name of your new connection in Scriptcase.

DBMS driver

Select the access connection controller.

Server/Host (Name or IP)

Enter the system DSN created in Windows ODBC.

Username

Inform the user to connect to the Access database.This option should only be populated if a user is configured as required when connecting to the Access database.
Password

Enter the password to connect to the Access database.This option should be completed only if a password is set as needed when connecting to the Access database.
Connect to Scriptcase using the file path:

In this type of connection, we must enter the full path to the Access database file to make the connection.

Connection name

Define the name of your new connection in Scriptcase.

DBMS driver

Select the access connection controller.

Server/Host (Name or IP)

Enter the full path to the Access database file.

Username

Inform the user to connect to the Access database.This option should only be populated if a user is configured as required when connecting to the Access database.
Password

Enter the password to connect to the Access database.This option should be completed only if a password is set as needed when connecting to the Access database.
Filter

We can configure the initial filtering of the information that the database will bring and display.



Show

In this option, we will define if the connection will show theTables, Views, System Tables or Procedures databases.

Searches

In this option we can configure the display of specific tables by user. If the elements are empty, the user informed in authentication will see all the data available.
e Tables: We will list the tables that may or may not be displayed.
e Owner: We will inform you of the name of the user who has access to the necessary tables or to the complete database.
e Show: We will define if the reported elements will be displayed or not in this connection.

Advanced

You can configure more advanced settings for the connection.

Decimal separator

This option allows you to define the decimal separator of numerical values. You can choose between dot () and comma (,).
Persistent Connection

Enabling this option will close connections when script execution completes.

Use the schema before the table name

This option causes Scriptcase to use the database schema before the table names in its actions. For example:
dbo.Account
e dbo: It is the name of the scheme used.

e Account: This is the name of the table that is used soon after.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connection with MS Access ADO

Scriptcase provides two drivers for connecting to the Access database: ADO and ODBC. For more information on how to enable the MS Access ODBC driver, see ourdocumentation.

In Scriptcase, you can also convert tables from Access database files.(mdb or .accdb) for databases: MySQL, PostgreSQL, SQLite and SQL Server. For more information, see
our documentation for database import.

Prerequisites

To create a Scriptcase connection to the Access Database using the ADO connection, you must use the full path to the database file.

In Scriptcase automatic installation, the COM extension is already enabled in PHP, and only requires the following elements:

e The PHP architecture of Scriptcase and Access must be equivalent.
e Microsoft Access Database Engine 2010client installed.
e The access database (.mdb or .accdb) must be stored on the same Scriptcase server/machine with one or more tables created.

Checking the PHP Architecture

Before continuing with this documentation, it is important to check your PHP architecture inside phpinfo(). If you are using Scriptcase’s automatic installer, the PHP architecture will
be the same as that of the downloaded installer.

You can access the phpinfo of your Scriptcase through your own path, like:

http://127.0.0.1:8092/scriptcase/info.php

e x86 Architecture = 32 Bits
e x64 Architecture = 64 Bits

Installing the Microsoft Access Database Engine 2010 Driver
e First we must download Driver Access Database Engine 2010 according toyour PHP architecture:

Access Database Engine 2010

x86 Download
:;zess Database Engine 2010 Download

After download, run the file to install the engine:

1 - Click “Next” to continue the installation.

2 - Accept the license terms and agree to continue.

3 - Set the path of the Access Engine installation. You can also use the default path entered by the installer.

4 - Installation complete, click “OK?” to finish.

Create a connection in Scriptcase

In this documentation we will show the connection to the Access database file.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

e Select connection “MS Access”.

e Select DBMS Driver: MS Access ADO
Connecting to Scriptcase

In this type of connection, we must enter the full path to the Access database file to make the connection.

Connection name

Define the name of your new connection in Scriptcase.



DBMS Driver

Select the access connection controller.

Server/Host(Name or IP)

Enter the full path to the Access database file.

User

Inform the user to connect to the Access database.This option should only be completed if a user is configured as required when connecting to the Access database.
Password

Enter the password to connect to the Access database.This option should only be completed if a password is set as required when connecting to the Access database.
Filter

We can configure the initial filtering of the information that the database will bring and display.

Show
In this option we will define if the connection will bringTables, Views, System Tables, Procedures.
Searches

In this option we can configure the display of specific tables by user. If the elements are empty, the user informed in authentication will see all the data available.
e Tables: We will list the tables that can be displayed or not.
e Owner: We will inform the name of the user who has access to the required tables or to the complete database.

e Show: We will define if the reported elements will be shown or not in this connection.
Advanced

You can configure more advanced settings for the connection.

Decimal separator

This option allows you to define the decimal separator of numerical values. You can choose between dot () and comma (,).
Persistent Connection

Enabling this option will close connections when script execution completes.

Use the schema before the table name

This option causes Scriptcase to use the database schema before the table names in its actions. For example:
dbo.Account
e dbo: It is the name of the scheme used.

e Account: This is the name of the table that is used soon after.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



IBM DB2

Scriptcase provides some driver options for connecting to DB2.

You can see if drivers are enabled by going to diagnosis.

Acessando pelo menu do Scriptcase.

After login, in the tool's top menu, access Help > Diagnosis .

© WebHelp

€ Technical Support

Accessing directly through the browser

In your browser, without having to login to Scriptcase, you can access the diagnosis.

In case of local installations:
127.0.0.1:8092/scriptcase/diagnosis.php ou localhost:8092/scriptcase/diagnosis.php

In case of installation on a server.

domain.com/scriptcase/diagnosis.php

Click on the driver you want to use, according to your operating system.

Windows

DB2 PDO ODBC
PDO IBM

DB2

DB2 ODBC Nativo
DB2 ODBC Genérico

L]
L]
.
L]
L]
& DB2 ODBC Genérico 6 ou Abaixo

Linux

e DB2 PDO ODBC

e PDOIBM

e DB2

e DB2 ODBC Nativo

e DB2 ODBC Genérico

& DB2 ODBC Genérico 6 ou Abaixo



Connecting with DB2 PDO ODBC

In Scriptcase, we have the following drivers available for connection to DB2: DB2 PDO ODBC, PDO IBM, DB2, DB2 Native ODBC, DB2 ODBC Generic and DB2 ODBC Generic
6 or Below. If you are using your own, pre-configured environment, DB2 extensionsmust be manually enabledin PHP.

Prerequisites

Before proceeding with this documentation, check your PHP architecture. In order for drivers to be enabled correctly files must be downloaded according to the used
architecture.

e In your Scriptcase, there is the fileinfo.php, access it by the URL: http://127.0.0.1:8092/scriptcase/info.php, where you will find the information regarding the architecture inphpinfo().

NOTE: If you are using Scriptcase’s automatic installer, the PHP architecture will be the same as the one you downloadedDownload the IBM Data Server Runtime
Client according to your PHP architecture.

e Architecture x86 = 32 bits
e Architecture x64 = 64 bits

Listed below are the files required for DB2 drivers to be enabled.
Required files:
x64
e IBM Data Server Runtime Client 11.5(x64): Click here
x86
e IBM Data Server Runtime Client 11.5(x86): Click here
Other Files
e PHP extensions (PHP_PDO_IBM and PHP_IBM_DB2): Click here

Configuring DB2 PDO ODBC on Windows

Before installing the IBM Data Server Runtime Client, you need to enable the extensions in PHP for Scriptcase to recognize the DB2 connection drivers. Follow them steps below to
correctly enable all drivers in Scriptcase.

IMPORTANT: If you are using Scriptcase’s automatic installer, the extensions are already enabled in PHP, requiring only the installation of the clientProceed to item 3.
1 - Extract the .zip file and copy the downloaded php_pdo_ibm and php_ibm_db2 .dIl extension files previously to your PHP ext folder.
2 - In the php.ini file, located in C:\php, add the lines referring to the DB2 extensions php_pdo_ibm and php_ibm_db2. See the example below:

extension=ibm_db2
extension=pdo_ibm

3 - After downloading, follow the installation wizard by clicking on next, keeping the default values of the installer.

4 - Accept the terms and proceed with the installation.

5 - Click Next, to keep the default values of the installer.

6 - Click Install, to start the installation process.

7 - Click Finish to complete the installation.

8 - Restart the Apache service using theTask Manager.
e Open the Task Manager and click on theServices tab.

e Search for the ApacheScriptcase9php81 service and right click on this service, thenRestart.

Creating the DSN for connection

To connect to the DB2 PDO ODBC Driver, you need to manually create a DataSource Name in the DB2 files. Follow the steps described below to perform this configuration.
ATTENTION: The ODBC must be created on the same server where Scriptcase is installed.
1 - Access your ODBC Data Source Manager and select according to your architecture. We will select the x64 version:

2 - When entering the ODBC Data Sources Administrator, select the DSN System tab and click Add to create your connection to your Access Database.

3 - After that, it is necessary to select the Driver to connect to DB2. Select the Driver:1BM DB2 ODBC DRIVER.



4 - Now, you need to define the DSN name and the Database alias.

o Data Source Name: Enter the name that the DSN will have so that you can use it in Scriptcase.
o Database alias: Include and enter the name of the database you will connect to.
e Description: Add a description for the DSN.

4.1 - After entering the name and description, click the button. After informing the name and description, click thelnclude button.

e User ID: Inform the user to authenticate with the DB2 database.
e Password: Enter the corresponding password to authenticate with the informed user.
e Save Password: By checking this option, the password is stored for future authentications and connection tests.

4.2 - Now, to configure the database, click on theTCP/IP tab.

« Database Name: Inform the database that you will connect to.

o Database alias: Enter the database alias, if the database has one. If not, use the same name as the database.
o Hostname: Enter the IP or domain of the server where the DB2 database is installed.

e Port Number: Enter the port for connection. By default, DB2 banks use port50000.

To finish, click on OK.

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using the enabled Driver and the DB2 database.
1 - Access a project from your Scriptcase.

2 - Click the New Connection icon to create a connection

or access the Database > New connectionmenu.

After that, a screen will appear with all database connections.

3 - Select the DB2 connection.

Connection

Enter the parameters for connecting to your database as follows:

e Connection name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
e DBMS Driver: Select the Driver for connection. In this example, we use theDB2 PDO ODBC Driver.

e Server/Host (Name or IP): Enter the System DSN created in the ODBC Data Source.

o EX: db2

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database .

e Username: Inform the user to authenticate the connection to your database.
e Password: Enter the password to complete the authentication process.

e Test connection: Click this button to get a response to the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending on the owner or not.

Show

It allows the connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are already
selected by Scriptcase.

e Tables: Selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option .

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option .

e System Tables: Selecting this option, the system tables of your database will be displayed.



e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.

e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX%% or name of the tables to display.
o By default, Scriptcase leaves this option empty .
o EX:

e Owner: Inform the user who sees the tables informed for display.
o User must be capitalized as in the example above .
e View: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The settings made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use client_encodingUTF-8.
o By default, this option is left blank by Scriptcase .
o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the. dot is selected as a separator .
e Persistent Connection: Define whether connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option .
e Use the schema before the table name: Define whether the database schema will be displayed before the table names.
o By default, Scriptcase enables this option .

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with PDO IBM

In Scriptcase, we have the following drivers available for connection to DB2: DB2 PDO ODBC, PDO IBM, DB2, DB2 Native ODBC, DB2 ODBC Generic and DB2 ODBC Generic
6 or Below. If you are using your own, pre-configured environment, DB2 extensionsmust be manually enabledin PHP.

Prerequisites

Before proceeding with this documentation, check your PHP architecture. In order for drivers to be enabled correctly files must be downloaded according to the used
architecture.

e In your Scriptcase, there is the fileinfo.php, access it by the URL: http://127.0.0.1:8092/scriptcase/info.php, where you will find the information regarding the architecture inphpinfo().

NOTE: If you are using Scriptcase’s automatic installer, the PHP architecture will be the same as the one you downloadedDownload the IBM Data Server Runtime
Client according to your PHP architecture.

e Architecture x86 = 32 bits
e Architecture x64 = 64 bits

Listed below are the files required for DB2 drivers to be enabled.
Required files:
x64

e IBM Data Server Runtime Client 11.5(x64): Click here
x86

e IBM Data Server Runtime Client 11.5(x86): Click here
Other Files

e PHP extensions (PHP_PDO_IBM and PHP_IBM_DB2): Click here
Configuring PDO IBM on Windows

Before installing the IBM Data Server Runtime Client, you need to enable the extensions in PHP for Scriptcase to recognize the DB2 connection drivers. Follow them steps below to
correctly enable all drivers in Scriptcase.

IMPORTANT: If you are using Scriptcase’s automatic installer, the extensions are already enabled in PHP, requiring only the installation of the clientProceed to item 3.
1 - Extract the .zip file and copy the downloaded php_pdo_ibm and php_ibm_db2 .dIl extension files previously to your PHP ext folder.
2 - In the php.ini file, located in C:\php, add the lines referring to the DB2 extensions php_pdo_ibm and php_ibm_db2. See the example below:

extension=ibm_db2
extension=pdo_ibm

3 - After downloading, follow the installation wizard by clicking on next, keeping the default values of the installer.

4 - Accept the terms and proceed with the installation.

5 - Click Next, to keep the default values of the installer.

6 - Click Install, to start the installation process.

7 - Click Finish to complete the installation.

8 - Restart the Apache service using theTask Manager.
e Open the Task Manager and click on theServices tab.

e Search for the ApacheScriptcase9php73 service and right click on this service, thenRestart.

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using the enabled Driver and the DB2 database.
1 - Access a project from your Scriptcase.

2 - Click the New Connection icon to create a connection

or access the Database > New connectionmenu.

After that, a screen will appear with all database connections.



3 - Select the DB2 connection.

Connection

Enter the parameters for connecting to your database as follows:

e Connection name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
e DBMS Driver: Select the Driver for connection. In this example, we use DriverPDO IBM.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed.

e EX: dominiodoserver.com Or 192.168.254.170

e Port: Enter the port to connect to DB2. By default, the defined port is50000.

o Database Name: Enter the name of the database you will connect to.

e EX: SAMPLE

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database .

e Username: Inform the user to authenticate the connection to your database.
e Password: Enter the password to complete the authentication process.

e Test connection: Click this button to get a response to the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending on the owner or not.

Show

It allows the connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are already
selected by Scriptcase.

e Tables: Selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option .

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option .

e System Tables: Selecting this option, the system tables of your database will be displayed.
e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.

e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX%% or name of the tables to display.
o By default, Scriptcase leaves this option empty .
o EX:

e Owner: Inform the user who sees the tables informed for display.
o User must be capitalized as in the example above .
e View: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The settings made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use client_encodingUTF-8.
o By default, this option is left blank by Scriptcase .
o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the. dot is selected as a separator .
e Persistent Connection: Define whether connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option .
e Use the schema before the table name: Define whether the database schema will be displayed before the table names.
o By default, Scriptcase enables this option .

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with DB2

In Scriptcase, we have the following drivers available for connection to DB2: DB2 PDO ODBC, PDO IBM, DB2, DB2 Native ODBC, DB2 ODBC Generic and DB2 ODBC Generic
6 or Below. If you are using your own, pre-configured environment, DB2 extensionsmust be manually enabledin PHP.

Prerequisites

Before proceeding with this documentation, check your PHP architecture. In order for drivers to be enabled correctly files must be downloaded according to the used
architecture.

e In your Scriptcase, there is the fileinfo.php, access it by the URL: http://127.0.0.1:8092/scriptcase/info.php, where you will find the information regarding the architecture inphpinfo().

NOTE: If you are using Scriptcase’s automatic installer, the PHP architecture will be the same as the one you downloadedDownload the IBM Data Server Runtime
Client according to your PHP architecture.

e Architecture x86 = 32 bits
e Architecture x64 = 64 bits

Listed below are the files required for DB2 drivers to be enabled.
Required files:
x64

e IBM Data Server Runtime Client 11.5(x64): Click here
x86

e IBM Data Server Runtime Client 11.5(x86): Click here
Other Files

e PHP extensions (PHP_PDO_IBM and PHP_IBM_DB2): Click here
Configuring DB2 on Windows

Before installing the IBM Data Server Runtime Client, you need to enable the extensions in PHP for Scriptcase to recognize the DB2 connection drivers. Follow them steps below to
correctly enable all drivers in Scriptcase.

IMPORTANT: If you are using Scriptcase’s automatic installer, the extensions are already enabled in PHP, requiring only the installation of the clientProceed to item 3.
1 - Extract the .zip file and copy the downloaded php_pdo_ibm and php_ibm_db2 .dIl extension files previously to your PHP ext folder.
2 - In the php.ini file, located in C:\php, add the lines referring to the DB2 extensions php_pdo_ibm and php_ibm_db2. See the example below:

extension=ibm_db2
extension=pdo_ibm

3 - After downloading, follow the installation wizard by clicking on next, keeping the default values of the installer.

4 - Accept the terms and proceed with the installation.

5 - Click Next, to keep the default values of the installer.

6 - Click Install, to start the installation process.

7 - Click Finish to complete the installation.

8 - Restart the Apache service using theTask Manager.
e Open the Task Manager and click on theServices tab.

e Search for the ApacheScriptcase9php81 service and right click on this service, thenRestart.

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using the enabled Driver and the DB2 database.
1 - Access a project from your Scriptcase.

2 - Click the New Connection icon to create a connection

or access the Database > New connectionmenu.

After that, a screen will appear with all database connections.



3 - Select the DB2 connection.

Connection

Enter the parameters for connecting to your database as follows:

e Connection name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
e DBMS Driver: Select the Driver for connection. In this example, we use DriverDB2.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed.

e EX: dominiodoserver.com Or 192.168.254.170

e Port: Enter the port to connect to DB2. By default, the defined port is50000.

o Database Name: Enter the name of the database you will connect to.

e EX: SAMPLE

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database .

e Username: Inform the user to authenticate the connection to your database.
e Password: Enter the password to complete the authentication process.

e Test connection: Click this button to get a response to the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending on the owner or not.

Show

It allows the connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are already
selected by Scriptcase.

e Tables: Selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option .

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option .

e System Tables: Selecting this option, the system tables of your database will be displayed.
e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.

e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX%% or name of the tables to display.
o By default, Scriptcase leaves this option empty .
o EX:

e Owner: Inform the user who sees the tables informed for display.
o User must be capitalized as in the example above .
e View: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The settings made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use client_encodingUTF-8.
o By default, this option is left blank by Scriptcase .
o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the. dot is selected as a separator .
e Persistent Connection: Define whether connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option .
e Use the schema before the table name: Define whether the database schema will be displayed before the table names.
o By default, Scriptcase enables this option .

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with DB2 Native ODBC

In Scriptcase, we have the following drivers available for connection to DB2: DB2 PDO ODBC, PDO IBM, DB2, DB2 Native ODBC, DB2 ODBC Generic and DB2 ODBC Generic
6 or Below. If you are using your own, pre-configured environment, DB2 extensionsmust be manually enabledin PHP.

Prerequisites

Before proceeding with this documentation, check your PHP architecture. In order for drivers to be enabled correctly files must be downloaded according to the used
architecture.

e In your Scriptcase, there is the fileinfo.php, access it by the URL: http://127.0.0.1:8092/scriptcase/info.php, where you will find the information regarding the architecture inphpinfo().

NOTE: If you are using Scriptcase’s automatic installer, the PHP architecture will be the same as the one you downloadedDownload the IBM Data Server Runtime
Client according to your PHP architecture.

e Architecture x86 = 32 bits
e Architecture x64 = 64 bits

Listed below are the files required for DB2 drivers to be enabled.
Required files:
x64

e IBM Data Server Runtime Client 11.5(x64): Click here
x86

e IBM Data Server Runtime Client 11.5(x86): Click here
Other Files

e PHP extensions (PHP_PDO_IBM and PHP_IBM_DB2): Click here
Configuring DB2 Native ODBC on Windows

Before installing the IBM Data Server Runtime Client, you need to enable the extensions in PHP for Scriptcase to recognize the DB2 connection drivers. Follow them steps below to
correctly enable all drivers in Scriptcase.

IMPORTANT: If you are using Scriptcase’s automatic installer, the extensions are already enabled in PHP, requiring only the installation of the clientProceed to item 3.
1 - Extract the .zip file and copy the downloaded php_pdo_ibm and php_ibm_db2 .dIl extension files previously to your PHP ext folder.
2 - In the php.ini file, located in C:\php, add the lines referring to the DB2 extensions php_pdo_ibm and php_ibm_db2. See the example below:

extension=ibm_db2
extension=pdo_ibm

3 - After downloading, follow the installation wizard by clicking on next, keeping the default values of the installer.

4 - Accept the terms and proceed with the installation.

5 - Click Next, to keep the default values of the installer.

6 - Click Install, to start the installation process.

7 - Click Finish to complete the installation.

8 - Restart the Apache service using theTask Manager.
e Open the Task Manager and click on theServices tab.

e Search for the ApacheScriptcase9php81 service and right click on this service, thenRestart.

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using the enabled Driver and the DB2 database.
1 - Access a project from your Scriptcase.

2 - Click the New Connection icon to create a connection

or access the Database > New connectionmenu.

After that, a screen will appear with all database connections.



3 - Select the DB2 connection.

Connection

Enter the parameters for connecting to your database as follows:

e Connection name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
e DBMS Driver: Select the Driver for connection. In this example, we use DriverDB2 Native ODBC.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed.

e EX: dominiodoserver.com Or 192.168.254.170

e Port: Enter the port to connect to DB2. By default, the defined port is50000.

o Database Name: Enter the name of the database you will connect to.

e EX: SAMPLE

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database .

e Username: Inform the user to authenticate the connection to your database.
e Password: Enter the password to complete the authentication process.

e Test connection: Click this button to get a response to the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending on the owner or not.

Show

It allows the connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are already
selected by Scriptcase.

e Tables: Selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option .

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option .

e System Tables: Selecting this option, the system tables of your database will be displayed.
e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.

e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX%% or name of the tables to display.
o By default, Scriptcase leaves this option empty .
o EX:

e Owner: Inform the user who sees the tables informed for display.
o User must be capitalized as in the example above .
e View: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The settings made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use client_encodingUTF-8.
o By default, this option is left blank by Scriptcase .
o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the. dot is selected as a separator .
e Persistent Connection: Define whether connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option .
e Use the schema before the table name: Define whether the database schema will be displayed before the table names.
o By default, Scriptcase enables this option .

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with DB2 Generic ODBC

In Scriptcase, we have the following drivers available for connection to DB2: DB2 PDO ODBC, PDO IBM, DB2, DB2 Native ODBC, DB2 ODBC Generic and DB2 ODBC Generic
6 or Below. If you are using your own, pre-configured environment, DB2 extensionsmust be manually enabledin PHP.

Prerequisites

Before proceeding with this documentation, check your PHP architecture. In order for drivers to be enabled correctly files must be downloaded according to the used
architecture.

e In your Scriptcase, there is the fileinfo.php, access it by the URL: http://127.0.0.1:8092/scriptcase/info.php, where you will find the information regarding the architecture inphpinfo().

NOTE: If you are using Scriptcase’s automatic installer, the PHP architecture will be the same as the one you downloadedDownload the IBM Data Server Runtime
Client according to your PHP architecture.

e Architecture x86 = 32 bits
e Architecture x64 = 64 bits

Listed below are the files required for DB2 drivers to be enabled.
Required files:
x64
e IBM Data Server Runtime Client 11.5(x64): Click here
x86
e IBM Data Server Runtime Client 11.5(x86): Click here
Other Files
e PHP extensions (PHP_PDO_IBM and PHP_IBM_DB2): Click here
Configuring DB2 Generic ODBC on Windows

Before installing the IBM Data Server Runtime Client, you need to enable the extensions in PHP for Scriptcase to recognize the DB2 connection drivers. Follow them steps below to
correctly enable all drivers in Scriptcase.

IMPORTANT: If you are using Scriptcase’s automatic installer, the extensions are already enabled in PHP, requiring only the installation of the clientProceed to item 3.
1 - Extract the .zip file and copy the downloaded php_pdo_ibm and php_ibm_db2 .dIl extension files previously to your PHP ext folder.
2 - In the php.ini file, located in C:\php, add the lines referring to the DB2 extensions php_pdo_ibm and php_ibm_db2. See the example below:

extension=ibm_db2
extension=pdo_ibm

3 - After downloading, follow the installation wizard by clicking on next, keeping the default values of the installer.

4 - Accept the terms and proceed with the installation.

5 - Click Next, to keep the default values of the installer.

6 - Click Install, to start the installation process.

7 - Click Finish to complete the installation.

8 - Restart the Apache service using theTask Manager.
e Open the Task Manager and click on theServices tab.

e Search for the ApacheScriptcase9php81 service and right click on this service, thenRestart.

Creating the DSN for connection

To connect to the DB2 Generic ODBC Driver, you need to manually create a DataSource Name in the DB2 files. Follow the steps described below to perform this configuration.
ATTENTION: The ODBC must be created on the same server where Scriptcase is installed.
1 - Access your ODBC Data Source Manager and select according to your architecture. We will select the x64 version:

2 - When entering the ODBC Data Sources Administrator, select the DSN System tab and click Add to create your connection to your Access Database.

3 - After that, it is necessary to select the Driver to connect to DB2. Select the Driver:1BM DB2 ODBC DRIVER.



4 - Now, you need to define the DSN name and the Database alias.

o Data Source Name: Enter the name that the DSN will have so that you can use it in Scriptcase.
o Database alias: Include and enter the name of the database you will connect to.
e Description: Add a description for the DSN.

4.1 - After entering the name and description, click the button. After informing the name and description, click thelnclude button.

e User ID: Inform the user to authenticate with the DB2 database.
e Password: Enter the corresponding password to authenticate with the informed user.
e Save Password: By checking this option, the password is stored for future authentications and connection tests.

4.2 - Now, to configure the database, click on theTCP/IP tab.

« Database Name: Inform the database that you will connect to.

o Database alias: Enter the database alias, if the database has one. If not, use the same name as the database.
o Hostname: Enter the IP or domain of the server where the DB2 database is installed.

e Port Number: Enter the port for connection. By default, DB2 banks use port50000.

To finish, click on OK.

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using the enabled Driver and the DB2 database.
1 - Access a project from your Scriptcase.

2 - Click the New Connection icon to create a connection

or access the Database > New connectionmenu.

After that, a screen will appear with all database connections.

3 - Select the DB2 connection.

Connection

Enter the parameters for connecting to your database as follows:

e Connection name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
e DBMS Driver: Select the Driver for connection. In this example, we use theDB2 ODBC Genérico driver.

e Server/Host (Name or IP): Enter the System DSN created in the ODBC Data Source.

o EX: db2

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database .

e Username: Inform the user to authenticate the connection to your database.
e Password: Enter the password to complete the authentication process.

e Test connection: Click this button to get a response to the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending on the owner or not.

Show

It allows the connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are already
selected by Scriptcase.

e Tables: Selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option .

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option .

e System Tables: Selecting this option, the system tables of your database will be displayed.



e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.

e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX%% or name of the tables to display.
o By default, Scriptcase leaves this option empty .
o EX:

e Owner: Inform the user who sees the tables informed for display.
o User must be capitalized as in the example above .
e View: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The settings made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use client_encodingUTF-8.
o By default, this option is left blank by Scriptcase .
o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the. dot is selected as a separator .
e Persistent Connection: Define whether connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option .
e Use the schema before the table name: Define whether the database schema will be displayed before the table names.
o By default, Scriptcase enables this option .

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with DB2 Generic ODBC 6 or Lower

In Scriptcase, we have the following drivers available for connection to DB2: DB2 PDO ODBC, PDO IBM, DB2, DB2 Native ODBC, DB2 ODBC Generic and DB2 ODBC Generic
6 or Below. If you are using your own, pre-configured environment, DB2 extensionsmust be manually enabledin PHP.

Prerequisites

Before proceeding with this documentation, check your PHP architecture. In order for drivers to be enabled correctly files must be downloaded according to the used
architecture.

e In your Scriptcase, there is the fileinfo.php, access it by the URL: http://127.0.0.1:8092/scriptcase/info.php, where you will find the information regarding the architecture inphpinfo().

NOTE: If you are using Scriptcase’s automatic installer, the PHP architecture will be the same as the one you downloadedDownload the IBM Data Server Runtime
Client according to your PHP architecture.

e Architecture x86 = 32 bits
e Architecture x64 = 64 bits

Listed below are the files required for DB2 drivers to be enabled.
Required files:
x64

e IBM Data Server Runtime Client 11.5(x64): Click here
x86

e IBM Data Server Runtime Client 11.5(x86): Click here
Other Files

e PHP extensions (PHP_PDO_IBM and PHP_IBM_DB2): Click here

Configuring DB2 Generic ODBC 6 or Lower on Windows

Before installing the IBM Data Server Runtime Client, you need to enable the extensions in PHP for Scriptcase to recognize the DB2 connection drivers. Follow them steps below to
correctly enable all drivers in Scriptcase.

IMPORTANT: If you are using Scriptcase’s automatic installer, the extensions are already enabled in PHP, requiring only the installation of the clientProceed to item 3.
1 - Extract the .zip file and copy the downloaded php_pdo_ibm and php_ibm_db2 .dIl extension files previously to your PHP ext folder.
2 - In the php.ini file, located in C:\php, add the lines referring to the DB2 extensions php_pdo_ibm and php_ibm_db2. See the example below:

extension=ibm_db2
extension=pdo_ibm

3 - After downloading, follow the installation wizard by clicking on next, keeping the default values of the installer.

4 - Accept the terms and proceed with the installation.

5 - Click Next, to keep the default values of the installer.

6 - Click Install, to start the installation process.

7 - Click Finish to complete the installation.

8 - Restart the Apache service using theTask Manager.
e Open the Task Manager and click on theServices tab.

e Search for the ApacheScriptcase9php81 service and right click on this service, thenRestart.

Creating the DSN for connection

To connect to the DB2 Generic ODBC 6 or LowerDriver, you need to manually create a DataSource Name in the DB2 files. Follow the steps described below to perform this
configuration.

ATTENTION: The ODBC must be created on the same server where Scriptcase is installed.

1 - Access your ODBC Data Source Manager and select according to your architecture. We will select the x64 version:

2 - When entering the ODBC Data Sources Administrator, select theDSN System tab and click Add to create your connection to your Access Database.



3 - After that, it is necessary to select the Driver to connect to DB2. Select the Driver:1BM DB2 ODBC DRIVER.

4 - Now, you need to define the DSN name and the Database alias.

o Data Source Name: Enter the name that the DSN will have so that you can use it in Scriptcase.
o Database alias: Include and enter the name of the database you will connect to.
e Description: Add a description for the DSN.

4.1 - After entering the name and description, click the button. After informing the name and description, click thelnclude button.

e User ID: Inform the user to authenticate with the DB2 database.
e Password: Enter the corresponding password to authenticate with the informed user.
e Save Password: By checking this option, the password is stored for future authentications and connection tests.

4.2 - Now, to configure the database, click on theTCP/IP tab.

o Database Name: Inform the database that you will connect to.

o Database alias: Enter the database alias, if the database has one. If not, use the same name as the database.
o Hostname: Enter the IP or domain of the server where the DB2 database is installed.

e Port Number: Enter the port for connection. By default, DB2 banks use port50000.

To finish, click on OK.

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using the enabled Driver and the DB2 database.
1 - Access a project from your Scriptcase.

2 - Click the New Connection icon to create a connection

or access the Database > New connectionmenu.

After that, a screen will appear with all database connections.

3 - Select the DB2 connection.

Connection

Enter the parameters for connecting to your database as follows:

e Connection name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the Driver for connection. In this example, we use theDB2 Generic ODBC 6 or Lower.

e Server/Host (Name or IP): Enter the System DSN created in the ODBC Data Source.

e EX: db2

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database .

e Username: Inform the user to authenticate the connection to your database.
e Password: Enter the password to complete the authentication process.

e Test connection: Click this button to get a response to the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending on the owner or not.

Show

It allows the connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are already
selected by Scriptcase.

e Tables: Selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option .

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option .



e System Tables: Selecting this option, the system tables of your database will be displayed.
e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.

e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX%% or name of the tables to display.
o By default, Scriptcase leaves this option empty .
o EX:

e Owner: Inform the user who sees the tables informed for display.
o User must be capitalized as in the example above .
e View: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The settings made in this session impact the data display and application performance.

o client_encoding: Select the encoding used in your database. In the example above, we use client_encodingUTF-8.
o By default, this option is left blank by Scriptcase .
¢ Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the. dot is selected as a separator .
e Persistent Connection: Define whether connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option .
e Use the schema before the table name: Define whether the database schema will be displayed before the table names.
o By default, Scriptcase enables this option .

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connection to DB2 PDO ODBC

At Scriptcase, we have the following drivers available for connection to DB2: DB2 PDO ODBC, PDO IBM, DB2, DB2 ODBC Native, DB2 ODBC Generic and DB2 ODBC Generic

6 or Below . If you are using your own,

Pré-requisitos

Before proceeding with this documentation, check your PHP architecture. In order for the drivers to be enabled correctly files must be downloaded according to the

architecture used .

e In your Scriptcase, there is the fileinfo.php, access it by the URL: http://127.0.0.1:8092/scriptcase/info.php, where you will find the information regarding the architecture inphpinfo().

CAUTION: Download the Oracle in

e Architecture i386/i686 = 32 bits
e Architecture x86_64 = 64 bits

Required files:

x64

pre-configured environment , DB2 extensions must be enabled manually in PHP.

stant client according to your PHP architecture.

e |BM DsDriver Linux(x64): click here

x86

e |BM DsDriver Linux(x86): click here

Configuring DB2 PDO ODBC on Linux

The automatic installation of Scriptcase
drivers in Scriptcase.

1 - Install the dependencies below:

UBUNTU\DEBIAN
- sudo apt-get update -
- sudo apt-get install libaiol -
- sudo apt-get install libncurses5 -
- sudo apt-get install alien -
- sudo apt-get install gcc-multilib g++-multilib -
- sudo apt-get install libpamOg -
- sudo apt-get install ksh -

- sudo apt-get install unixodbc-dev unixodbc -

N

- Install the IBM DB2 DsDriver:

ARCHITECTURE x86
sudo mkdir -p /opt/IBM/Db2

comes with IBM DB2 pre-configured, you must install only DsDriver to make the connection. Follow them steps below to correctly enable all

CENTOS\RHEL
sudo yum update
sudo yum install libaio-devel
sudo yum install libaio
sudo yum install glibc
sudo yum install compat-libstdc++-33
sudo yum install glibc-devel
sudo yum install libstdc++
sudo yum install libstdc++
sudo yum install pam
sudo yum install ncurses-devel
sudo yum install unixODBC
sudo wget ftp://195.220.108.108/linux/centos/6.7/0s/i386/Packages/ksh-20120801-28.el6.i686.rpm
sudo yum install ksh-20120801-28.el6.i1686.rpm

sudo yum install nano

ARCHITECTURE x64
- sudo mkdir -p /opt/IBM/Db2

- sudo cp sudo cp x86_v10.5fp8_linuxia32_dsdriver.tar.gz /opt/IBM/Db2 - sudo cp x64_v10.5fp8_linuxx64_dsdriver.tar.gz /opt/IBM/Db2
- sudo tar -zxf /opt/IBM/Db2/x86_v10.5fp8_linuxia32_dsdriver.tar.gz - sudo tar -zxf /opt/IBM/Db2/x64_v10.5fp8_linuxx64_dsdriver.tar.gz

sudo ksh /opt/IBM/Db2/dsdriver/installDSDriver
3 - Restart the Apache service:

UBUNTU\DEBIAN

- sudo ksh /opt/IBM/Db2/dsdriver/installDSDriver

CENTOS\RHEL

sudo service apachesc9php73 restart OU sudo service apache2 restart sudo systemctl restart httpd

Creating a Connection

in Scriptcase

See below how to create a connection in your Scriptcase project, using the enabled Driver and the DB2 database.

1 - Access a project from your Scriptcase.

2 - Click the New Connection icon to create a connection

or access the Database > New connectionmenu.

After that, a screen will appear with all database connections.

3 - Select the DB2 connection.

Connection

Enter the parameters for connecting to your database as follows:



e Connection name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the Driver for connection. In this example, we use theDB2 PDO ODBC Driver.

e Server/Host (Name or IP): Enter the System DSN created in the ODBC Data Source.

e EX: db2

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database .

e Username: Inform the user to authenticate the connection to your database.
e Password: Enter the password to complete the authentication process.

e Test connection: Click this button to get a response to the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending on the owner or not.

Show

It allows the connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are already

selected by Scriptcase.

e Tables: Selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option .

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option .

e System Tables: Selecting this option, the system tables of your database will be displayed.
e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.

e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX%% or name of the tables to display.
o By default, Scriptcase leaves this option empty .
o EX:

e Owner: Inform the user who sees the tables informed for display.
o User must be capitalized as in the example above .
e View: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The settings made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use client_encodingUTF-8.
o By default, this option is left blank by Scriptcase .
« Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the. dot is selected as a separator .
e Persistent Connection: Define whether connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option .
e Use the schema before the table name: Define whether the database schema will be displayed before the table names.
o By default, Scriptcase enables this option .

Questions or Connection Problems?

Contact our support in case of connection problems or questions regarding this database.



Connection to PDO IBM

At Scriptcase, we have the following drivers available for connection to DB2: DB2 PDO ODBC, PDO IBM, DB2, DB2 ODBC Native, DB2 ODBC Generic and DB2 ODBC Generic
6 or Below . If you are using your own, pre-configured environment , DB2 extensions must be enabled manually in PHP.

Pré-requisitos

Before proceeding with this documentation, check your PHP architecture. In order for the drivers to be enabled correctly files must be downloaded according to the
architecture used .

e In your Scriptcase, there is the fileinfo.php, access it by the URL: http://127.0.0.1:8092/scriptcase/info.php, where you will find the information regarding the architecture inphpinfo().

CAUTION: Download the Oracle instant client according to your PHP architecture.

e Architecture i386/i686 = 32 bits
e Architecture x86_64 = 64 bits

Required files:
x64
e IBM DsDriver Linux(x64): click here
x86
e |BM DsDriver Linux(x86): click here
Configuring PDO IBM on Linux

The automatic installation of Scriptcase comes with IBM DB2 pre-configured, you must install only DsDriver to make the connection. Follow them steps below to correctly enable all
drivers in Scriptcase.

1 - Install the dependencies below:

UBUNTU\DEBIAN CENTOS\RHEL
- sudo apt-get update - sudo yum update
- sudo apt-get install libaiol - sudo yum install libaio-devel
- sudo apt-get install libncurses5 - sudo yum install libaio
- sudo apt-get install alien - sudo yum install glibc

- sudo apt-get install gcc-multilib g++-multilib - sudo yum install compat-libstdc++-33
- sudo apt-get install libpamOg - sudo yum install glibc-devel
- sudo apt-get install ksh - sudo yum install libstdc++
- sudo apt-get install unixodbc-dev unixodbc - sudo yum install libstdc++
- sudo yum install pam
- sudo yum install ncurses-devel
- sudo yum install unixODBC
- sudo wget ftp://195.220.108.108/linux/centos/6.7/0s/i386/Packages/ksh-20120801-28.el6.i1686.rpm
- sudo yum install ksh-20120801-28.€el6.i1686.rpm

- sudo yum install nano

2 - Install the IBM DB2 DsDriver:
ARCHITECTURE x86 ARCHITECTURE x64
- sudo mkdir -p /opt/IBM/Db2 - sudo mkdir -p /opt/IBM/Db2
- sudo cp sudo cp x86_v10.5fp8_linuxia32_dsdriver.tar.gz /opt/IBM/Db2 - sudo cp x64_v10.5fp8_linuxx64_dsdriver.tar.gz /opt/IBM/Db2
- sudo tar -zxf /opt/IBM/Db2/x86_v10.5fp8_linuxia32_dsdriver.tar.gz - sudo tar -zxf /opt/IBM/Db2/x64_v10.5fp8_linuxx64_dsdriver.tar.gz
- sudo ksh /opt/IBM/Db2/dsdriver/installDSDriver - sudo ksh /opt/IBM/Db2/dsdriver/installDSDriver

3 - Restart the Apache service:

UBUNTU\DEBIAN CENTOS\RHEL

sudo service apachesc9php73 restart OU sudo service apache2 restart sudo systemctl restart httpd

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using the enabled Driver and the DB2 database.
1 - Access a project from your Scriptcase.

2 - Click the New Connection icon to create a connection

or access the Database > New connectionmenu.

After that, a screen will appear with all database connections.

3 - Select the DB2 connection.

Connection

Enter the parameters for connecting to your database as follows:



e Connection name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the Driver for connection. In this example, we use DriverPDO IBM.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed.

e EX: dominiodoserver.com Or 192.168.254.170

e Port: Enter the port to connect to DB2. By default, the defined port is50000.

« Database Name: Enter the name of the database you will connect to.

o EX: SAMPLE

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database .

e Username: Inform the user to authenticate the connection to your database.
e Password: Enter the password to complete the authentication process.

e Test connection: Click this button to get a response to the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending on the owner or not.

Show

It allows the connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are already
selected by Scriptcase.

e Tables: Selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option .

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option .

e System Tables: Selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.

e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX%% or name of the tables to display.
o By default, Scriptcase leaves this option empty .
o EX:

e Owner: Inform the user who sees the tables informed for display.
o User must be capitalized as in the example above .
e View: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The settings made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use client_encodingUTF-8.
o By default, this option is left blank by Scriptcase .
o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the. dot is selected as a separator .
e Persistent Connection: Define whether connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option .
e Use the schema before the table name: Define whether the database schema will be displayed before the table names.
o By default, Scriptcase enables this option .

Questions or Connection Problems?

Contact our support in case of connection problems or questions regarding this database.



Connection to DB2

At Scriptcase, we have the following drivers available for connection to DB2: DB2 PDO ODBC, PDO IBM, DB2, DB2 ODBC Native, DB2 ODBC Generic and DB2 ODBC Generic
6 or Below . If you are using your own, pre-configured environment , DB2 extensions must be enabled manually in PHP.

Pré-requisitos

Before proceeding with this documentation, check your PHP architecture. In order for the drivers to be enabled correctly files must be downloaded according to the
architecture used .
e In your Scriptcase, there is the fileinfo.php, access it by the URL: http://127.0.0.1:8092/scriptcase/info.php, where you will find the information regarding the architecture inphpinfo().

CAUTION: Download the Oracle instant client according to your PHP architecture.

e Architecture i386/i686 = 32 bits
e Architecture x86_64 = 64 bits

Required files:
x64

e IBM DsDriver Linux(x64): click here
x86

IBM DsDriver Linux(x86): click here

Configuring DB2 on Linux

The automatic installation of Scriptcase comes with IBM DB2 pre-configured, you must install only DsDriver to make the connection. Follow them steps below to correctly enable all
drivers in Scriptcase.

1 - Install the dependencies below:

UBUNTU\DEBIAN CENTOS\RHEL

sudo apt-get update

sudo apt-get install libaiol

sudo apt-get install libncurses5 -
sudo apt-get install alien -
sudo apt-get install gcc-multilib g++-multilib -
sudo apt-get install libpamOg -
sudo apt-get install ksh -
sudo apt-get install unixodbc-dev unixodbc -

N

- Install the IBM DB2 DsDriver:

ARCHITECTURE x86
sudo mkdir -p /opt/IBM/Db2

sudo ksh /opt/IBM/Db2/dsdriver/installDSDriver
3 - Restart the Apache service:

UBUNTU\DEBIAN

sudo service apachesc9php73 restart OU sudo service apache2 restart

Creating a Connection

See below how to create a connection in your Scriptcase project, using the enabled Driver and the DB2 database.

sudo cp sudo cp x86_v10.5fp8_linuxia32_dsdriver.tar.gz /opt/IBM/Db2
sudo tar -zxf /opt/IBM/Db2/x86_v10.5fp8_linuxia32_dsdriver.tar.gz

sudo yum update

sudo yum install libaio-devel

sudo yum install libaio

sudo yum install glibc

sudo yum install compat-libstdc++-33
sudo yum install glibc-devel

sudo yum install libstdc++

sudo yum install libstdc++

sudo yum install pam

sudo yum install ncurses-devel

sudo yum install unixODBC

sudo wget ftp://195.220.108.108/linux/centos/6.7/0s/i386/Packages/ksh-20120801-28.el6.i686.rpm

sudo yum install ksh-20120801-28.el6.i1686.rpm

sudo yum install nano

ARCHITECTURE x64

- sudo mkdir -p /opt/IBM/Db2

CENTOS\RHEL

sudo systemctl restart httpd

in Scriptcase

1 - Access a project from your Scriptcase.

2 - Click the New Connection icon to create a connection

or access the Database > New connectionmenu.

After that, a screen will appear with all database connections.

3 - Select the DB2 connection.

Connection

Enter the parameters for connecting to your database as follows:

sudo cp x64_v10.5fp8_linuxx64_dsdriver.tar.gz /opt/IBM/Db2
sudo tar -zxf /opt/IBM/Db2/x64_v10.5fp8_linuxx64_dsdriver.tar.gz
sudo ksh /opt/IBM/Db2/dsdriver/installDSDriver



e Connection name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the Driver for connection. In this example, we use DriverDB2.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed.

e EX: dominiodoserver.com Or 192.168.254.170

e Port: Enter the port to connect to DB2. By default, the defined port is50000.

« Database Name: Enter the name of the database you will connect to.

o EX: SAMPLE

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database .

e Username: Inform the user to authenticate the connection to your database.
e Password: Enter the password to complete the authentication process.

e Test connection: Click this button to get a response to the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending on the owner or not.

Show

It allows the connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are already
selected by Scriptcase.

e Tables: Selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option .

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option .

e System Tables: Selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.

e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX%% or name of the tables to display.
o By default, Scriptcase leaves this option empty .
o EX:

e Owner: Inform the user who sees the tables informed for display.
o User must be capitalized as in the example above .
e View: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The settings made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use client_encodingUTF-8.
o By default, this option is left blank by Scriptcase .
o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the. dot is selected as a separator .
e Persistent Connection: Define whether connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option .
e Use the schema before the table name: Define whether the database schema will be displayed before the table names.
o By default, Scriptcase enables this option .

Questions or Connection Problems?

Contact our support in case of connection problems or questions regarding this database.



Connection to DB2 Native ODBC

At Scriptcase, we have the following drivers available for connection to DB2: DB2 PDO ODBC, PDO IBM, DB2, DB2 ODBC Native, DB2 ODBC Generic and DB2 ODBC Generic

6 or Below . If you are using your own,

Pré-requisitos

Before proceeding with this documentation, check your PHP architecture. In order for the drivers to be enabled correctly files must be downloaded according to the

architecture used .

e In your Scriptcase, there is the fileinfo.php, access it by the URL: http://127.0.0.1:8092/scriptcase/info.php, where you will find the information regarding the architecture inphpinfo().

CAUTION: Download the Oracle in

e Architecture i386/i686 = 32 bits
e Architecture x86_64 = 64 bits

Required files:

x64

pre-configured environment , DB2 extensions must be enabled manually in PHP.

stant client according to your PHP architecture.

e |BM DsDriver Linux(x64): click here

x86

e |BM DsDriver Linux(x86): click here

Configuring DB2 Native ODBC on Linux

The automatic installation of Scriptcase
drivers in Scriptcase.

1 - Install the dependencies below:

UBUNTU\DEBIAN
- sudo apt-get update -
- sudo apt-get install libaiol -
- sudo apt-get install libncurses5 -
- sudo apt-get install alien -
- sudo apt-get install gcc-multilib g++-multilib -
- sudo apt-get install libpamOg -
- sudo apt-get install ksh -

- sudo apt-get install unixodbc-dev unixodbc -

N

- Install the IBM DB2 DsDriver:

ARCHITECTURE x86
sudo mkdir -p /opt/IBM/Db2

comes with IBM DB2 pre-configured, you must install only DsDriver to make the connection. Follow them steps below to correctly enable all

CENTOS\RHEL
sudo yum update
sudo yum install libaio-devel
sudo yum install libaio
sudo yum install glibc
sudo yum install compat-libstdc++-33
sudo yum install glibc-devel
sudo yum install libstdc++
sudo yum install libstdc++
sudo yum install pam
sudo yum install ncurses-devel
sudo yum install unixODBC
sudo wget ftp://195.220.108.108/linux/centos/6.7/0s/i386/Packages/ksh-20120801-28.el6.i686.rpm
sudo yum install ksh-20120801-28.el6.i1686.rpm

sudo yum install nano

ARCHITECTURE x64
- sudo mkdir -p /opt/IBM/Db2

- sudo cp sudo cp x86_v10.5fp8_linuxia32_dsdriver.tar.gz /opt/IBM/Db2 - sudo cp x64_v10.5fp8_linuxx64_dsdriver.tar.gz /opt/IBM/Db2
- sudo tar -zxf /opt/IBM/Db2/x86_v10.5fp8_linuxia32_dsdriver.tar.gz - sudo tar -zxf /opt/IBM/Db2/x64_v10.5fp8_linuxx64_dsdriver.tar.gz

sudo ksh /opt/IBM/Db2/dsdriver/installDSDriver
3 - Restart the Apache service:

UBUNTU\DEBIAN

- sudo ksh /opt/IBM/Db2/dsdriver/installDSDriver

CENTOS\RHEL

sudo service apachesc9php73 restart OU sudo service apache2 restart sudo systemctl restart httpd

Creating a Connection

in Scriptcase

See below how to create a connection in your Scriptcase project, using the enabled Driver and the DB2 database.

1 - Access a project from your Scriptcase.

2 - Click the New Connection icon to create a connection

or access the Database > New connectionmenu.

After that, a screen will appear with all database connections.

3 - Select the DB2 connection.

Connection

Enter the parameters for connecting to your database as follows:



e Connection name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the Driver for connection. In this example, we use DriverDB2 Native ODBC.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed.

e EX: dominiodoserver.com Or 192.168.254.170

e Port: Enter the port to connect to DB2. By default, the defined port is50000.

« Database Name: Enter the name of the database you will connect to.

o EX: SAMPLE

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database .

e Username: Inform the user to authenticate the connection to your database.
e Password: Enter the password to complete the authentication process.

e Test connection: Click this button to get a response to the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending on the owner or not.

Show

It allows the connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are already
selected by Scriptcase.

e Tables: Selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option .

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option .

e System Tables: Selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.

e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX%% or name of the tables to display.
o By default, Scriptcase leaves this option empty .
o EX:

e Owner: Inform the user who sees the tables informed for display.
o User must be capitalized as in the example above .
e View: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The settings made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use client_encodingUTF-8.
o By default, this option is left blank by Scriptcase .
o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the. dot is selected as a separator .
e Persistent Connection: Define whether connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option .
e Use the schema before the table name: Define whether the database schema will be displayed before the table names.
o By default, Scriptcase enables this option .

Questions or Connection Problems?

Contact our support in case of connection problems or questions regarding this database.



Connection to DB2 Generic ODBC

At Scriptcase, we have the following drivers available for connection to DB2: DB2 PDO ODBC, PDO IBM, DB2, DB2 ODBC Native, DB2 ODBC Generic and DB2 ODBC Generic

6 or Below . If you are using your own,

Pré-requisitos

Before proceeding with this documentation, check your PHP architecture. In order for the drivers to be enabled correctly files must be downloaded according to the

architecture used .

e In your Scriptcase, there is the fileinfo.php, access it by the URL: http://127.0.0.1:8092/scriptcase/info.php, where you will find the information regarding the architecture inphpinfo().

CAUTION: Download the Oracle in

e Architecture i386/i686 = 32 bits
e Architecture x86_64 = 64 bits

Required files:

x64

pre-configured environment , DB2 extensions must be enabled manually in PHP.

stant client according to your PHP architecture.

e |BM DsDriver Linux(x64): click here

x86

e |BM DsDriver Linux(x86): click here

Configuring DB2 Native ODBC on Linux

The automatic installation of Scriptcase
drivers in Scriptcase.

1 - Install the dependencies below:

UBUNTU\DEBIAN
- sudo apt-get update -
- sudo apt-get install libaiol -
- sudo apt-get install libncurses5 -
- sudo apt-get install alien -
- sudo apt-get install gcc-multilib g++-multilib -
- sudo apt-get install libpamOg -
- sudo apt-get install ksh -

- sudo apt-get install unixodbc-dev unixodbc -

N

- Install the IBM DB2 DsDriver:

ARCHITECTURE x86
sudo mkdir -p /opt/IBM/Db2

comes with IBM DB2 pre-configured, you must install only DsDriver to make the connection. Follow them steps below to correctly enable all

CENTOS\RHEL
sudo yum update
sudo yum install libaio-devel
sudo yum install libaio
sudo yum install glibc
sudo yum install compat-libstdc++-33
sudo yum install glibc-devel
sudo yum install libstdc++
sudo yum install libstdc++
sudo yum install pam
sudo yum install ncurses-devel
sudo yum install unixODBC
sudo wget ftp://195.220.108.108/linux/centos/6.7/0s/i386/Packages/ksh-20120801-28.el6.i686.rpm
sudo yum install ksh-20120801-28.el6.i1686.rpm

sudo yum install nano

ARCHITECTURE x64
- sudo mkdir -p /opt/IBM/Db2

- sudo cp sudo cp x86_v10.5fp8_linuxia32_dsdriver.tar.gz /opt/IBM/Db2 - sudo cp x64_v10.5fp8_linuxx64_dsdriver.tar.gz /opt/IBM/Db2
- sudo tar -zxf /opt/IBM/Db2/x86_v10.5fp8_linuxia32_dsdriver.tar.gz - sudo tar -zxf /opt/IBM/Db2/x64_v10.5fp8_linuxx64_dsdriver.tar.gz

sudo ksh /opt/IBM/Db2/dsdriver/installDSDriver
3 - Restart the Apache service:

UBUNTU\DEBIAN

- sudo ksh /opt/IBM/Db2/dsdriver/installDSDriver

CENTOS\RHEL

sudo service apachesc9php73 restart OU sudo service apache2 restart sudo systemctl restart httpd

Creating a Connection

in Scriptcase

See below how to create a connection in your Scriptcase project, using the enabled Driver and the DB2 database.

1 - Access a project from your Scriptcase.

2 - Click the New Connection icon to create a connection

or access the Database > New connectionmenu.

After that, a screen will appear with all database connections.

3 - Select the DB2 connection.

Connection

Enter the parameters for connecting to your database as follows:



e Connection name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
e DBMS Driver: Select the Driver for connection. In this example, we use theDB2 ODBC Genérico driver.

e Server/Host (Name or IP): Enter the System DSN created in the ODBC Data Source.

e EX: db2

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database .

e Username: Inform the user to authenticate the connection to your database.
e Password: Enter the password to complete the authentication process.

e Test connection: Click this button to get a response to the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending on the owner or not.

Show

It allows the connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are already

selected by Scriptcase.

e Tables: Selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option .

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option .

e System Tables: Selecting this option, the system tables of your database will be displayed.
e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.

e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX%% or name of the tables to display.
o By default, Scriptcase leaves this option empty .
o EX:

e Owner: Inform the user who sees the tables informed for display.
o User must be capitalized as in the example above .
e View: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The settings made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use client_encodingUTF-8.
o By default, this option is left blank by Scriptcase .
« Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the. dot is selected as a separator .
e Persistent Connection: Define whether connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option .
e Use the schema before the table name: Define whether the database schema will be displayed before the table names.
o By default, Scriptcase enables this option .

Questions or Connection Problems?

Contact our support in case of connection problems or questions regarding this database.



Connection to DB2 Generic ODBC 6 or Lower

At Scriptcase, we have the following drivers available for connection to DB2: DB2 PDO ODBC, PDO IBM, DB2, DB2 ODBC Native, DB2 ODBC Generic and DB2 ODBC Generic
6 or Below . If you are using your own, pre-configured environment , DB2 extensions must be enabled manually in PHP.

Pré-requisitos

Before proceeding with this documentation, check your PHP architecture. In order for the drivers to be enabled correctly files must be downloaded according to the
architecture used .

e In your Scriptcase, there is the fileinfo.php, access it by the URL: http://127.0.0.1:8092/scriptcase/info.php, where you will find the information regarding the architecture inphpinfo().

CAUTION: Download the Oracle instant client according to your PHP architecture.

e Architecture i386/i686 = 32 bits
e Architecture x86_64 = 64 bits

Required files:
x64
e |BM DsDriver Linux(x64): click here
x86
e |BM DsDriver Linux(x86): click here
Configuring DB2 Generic ODBC 6 or Lower on Linux

The automatic installation of Scriptcase comes with IBM DB2 pre-configured, you must install only DsDriver to make the connection. Follow them steps below to correctly enable all
drivers in Scriptcase.

1 - Install the dependencies below:

UBUNTU\DEBIAN CENTOS\RHEL
- sudo apt-get update - sudo yum update
- sudo apt-get install libaiol - sudo yum install libaio-devel
- sudo apt-get install libncurses5 - sudo yum install libaio
- sudo apt-get install alien - sudo yum install glibc

- sudo apt-get install gcc-multilib g++-multilib - sudo yum install compat-libstdc++-33
- sudo apt-get install libpamOg - sudo yum install glibc-devel
- sudo apt-get install ksh - sudo yum install libstdc++
- sudo apt-get install unixodbc-dev unixodbc - sudo yum install libstdc++
- sudo yum install pam
- sudo yum install ncurses-devel
- sudo yum install unixODBC
- sudo wget ftp://195.220.108.108/linux/centos/6.7/0s/i386/Packages/ksh-20120801-28.el6.i1686.rpm
- sudo yum install ksh-20120801-28.€el6.i1686.rpm

- sudo yum install nano

2 - Install the IBM DB2 DsDriver:
ARCHITECTURE x86 ARCHITECTURE x64
- sudo mkdir -p /opt/IBM/Db2 - sudo mkdir -p /opt/IBM/Db2
- sudo cp sudo cp x86_v10.5fp8_linuxia32_dsdriver.tar.gz /opt/IBM/Db2 - sudo cp x64_v10.5fp8_linuxx64_dsdriver.tar.gz /opt/IBM/Db2
- sudo tar -zxf /opt/IBM/Db2/x86_v10.5fp8_linuxia32_dsdriver.tar.gz - sudo tar -zxf /opt/IBM/Db2/x64_v10.5fp8_linuxx64_dsdriver.tar.gz
- sudo ksh /opt/IBM/Db2/dsdriver/installDSDriver - sudo ksh /opt/IBM/Db2/dsdriver/installDSDriver

3 - Restart the Apache service:

UBUNTU\DEBIAN CENTOS\RHEL

sudo service apachesc9php73 restart OU sudo service apache2 restart sudo systemctl restart httpd

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using the enabled Driver and the DB2 database.
1 - Access a project from your Scriptcase.

2 - Click the New Connection icon to create a connection

or access the Database > New connectionmenu.

After that, a screen will appear with all database connections.

3 - Select the DB2 connection.

Connection

Enter the parameters for connecting to your database as follows:



e Connection name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the Driver for connection. In this example, we use theDB2 Generic ODBC 6 or Lower.

e Server/Host (Name or IP): Enter the System DSN created in the ODBC Data Source.

e EX: db2

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database .

e Username: Inform the user to authenticate the connection to your database.
e Password: Enter the password to complete the authentication process.

e Test connection: Click this button to get a response to the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending on the owner or not.

Show

It allows the connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are already

selected by Scriptcase.

e Tables: Selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option .

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option .

e System Tables: Selecting this option, the system tables of your database will be displayed.
e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.

e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX%% or name of the tables to display.
o By default, Scriptcase leaves this option empty .
o EX:

e Owner: Inform the user who sees the tables informed for display.
o User must be capitalized as in the example above .
e View: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The settings made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use client_encodingUTF-8.
o By default, this option is left blank by Scriptcase .
« Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the. dot is selected as a separator .
e Persistent Connection: Define whether connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option .
e Use the schema before the table name: Define whether the database schema will be displayed before the table names.
o By default, Scriptcase enables this option .

Questions or Connection Problems?

Contact our support in case of connection problems or questions regarding this database.



Firebird with Scriptcase

Scriptcase, installed in environments with PHP 8.1, provides only the Firebird PDO driver to make the connection with Firebird.

| For environments with PHP 7.3 the Firebird driver is also available. See the articles according to your operating system: Firebird in Scriptcase with PHP 7.3 - Windows Firebird in Scriptcase with PHP 7.3 - Linux Firebird in Scriptcase w.

In Scriptcase, we have two drivers to connect with Firebird. You must choose the most suitable for your environment. It is recommended to use  Firebird PDO which is more faster, however it is up to you to choose the driver. If you are
Firebird extensions must be manually enabled in PHP.

You can check your enabled drivers by accessing your Scriptcase diagnosis. See below on how to locate your diagnosis and check if the driver is enabled.

®  ccessing the top menu Help > Diagnosis, you can easily find it through the interface.

© WebHelp ..

€ Technical Support

® 1, by accessing your browser url:
127.0.0.1:8092/scriptcase/diagnosis.php or domain.com/scriptcase/diagnosis.php
If the desired driver is already enabled and you just want to know how to connect with Scriptcase, click on the link below according to the driver that will be used.

e  indows - Firebird PDO
e inux - Firebird PDO
®  acOS - Firebird PDO



Connecting with Firebird PDO

In Scriptcase, we have the following drivers available for Firebird connections: Firebird PDO. If you are using your own pre-configured environment, the Firebird extensions must be
enabled manually in PHP.

Prerequisites

If you are using a manual installation on Windows, you will need to enable the Firebird extensions in thghp.ini file. See below for how to do this.

1 - In the php.ini file located under c:\php, uncomment the line for the Firebird extensionpdo_firebird by removing the; from the start of the line. See the example below:

2 - Restart the Apache service using theTask Manager.
e Open Task Manager and click on the Services tab.

e Look for the Apache2.4 or ApacheScriptcase9php81 service and right click on this service, then Restart.

Creating a connection in Scriptcase

Here’s how to create a connection in your Scriptcase project using the Firebird database.
1 - Access any project from your Scriptcase.

2 - Click on the New connection icon to create a connection.

or go to the Database > New Connectionmenu.

After that a new page will appear with all the database connections.

3 - Select the Firebird connection.

Connection

Enter the parameters for connecting to your Firebird database as follows:

e Connection Name: Set the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
e DBMS Driver: Select the Firebird Driver used to connect. In this example we use theFirebird PDO Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed.
o EX: serverdomain.com Or 192.168.254.170.

e Port: Enter the numeric port for your database server.
o Ex: 3050

o Database Name: Enter the database created for use by the entered user.

e Username: Enter the user to authenticate the connection to your Firebird database.

e Password: Enter the password to complete the authentication process.

e Test Connection: Click this button to get a response from Scriptcase request to know if the entered parameters are correct.

Filter

By accessing this tab, you can configure which items from the Database will be displayed in the connection, depending on the owner or not.

Show

Allows the Firebird connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: Selecting this option will display your database views.
o By default, Scriptcase enables this option.

e System tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: When you select this option, the procedures from your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.

e Tables: You can define in this option which tables are displayed. The setting can contain aPREFIX% or name of the tables to be displayed.



o By default, Scriptcase leaves this option empty.
o Ex:

e Owner: Inform the user who sees the inserted tables for display.
o User must be in capital letters, as in the example above.

e Show: Choose whether tables are displayed for the owner entered.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimprove the performance of your database connection.
Advanced

In this tab, you have access to connection-specific settings. Changes made in this section impact the data display and performance of the application.

e client_encoding: Select the encoding used in your database. In the example above, we used client_encodingUTF-8.

o Decimal Separator: Select the separator type for decimal records, between comma and period.
o By default, period. is selected as the separator.

e Persistent connection: Set whether connections will be closed after your scripts run in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use schema before table name: Set whether the database schema is displayed before table names.

o By default, Scriptcase enables this option.

o Ex:

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with Firebird PDO

In Scriptcase, we have the following driver available for Firebird connection:Firebird PDO. If you are using your own pre-configured environment, the Firebird extensions must be
enabled manually in PHP.

Prerequisites

If you are using a manual installation on Linux, you will need to install the Firebird php extension. See below for how to do this.

1 - Log into your Linux terminal and type this line below according to your operating system to install the Firebird PDO driver.

Ubuntu CentOS

sudo apt-get install php8.1-interbase sudo yum install php-interbase
2 - Check that the Firebird driver is enabled in your Scriptcase diagnostics. Here is how to locate your diagnostics and verify that the driver is enabled.

e By accessing the top menu Help > Diagnostics, you can find it easily through the interface.

e Or, by accessing your Scriptcase installation path:

127.0.0.1/scriptcase/diagnosis.php Or domain.com/scriptcase/diagnosis.php

Creating a connection in Scriptcase

Here’s how to create a connection in your Scriptcase project using the Firebird database.
1 - Access any project from your Scriptcase.

2 - Click on the New connection icon to create a connection.

or go to the Database > New Connectionmenu.

After that a new page will appear with all the database connections.

3 - Select the Firebird connection.

Connection

Enter the parameters for connecting to your Firebird database as follows:

e Connection Name: Set the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the Firebird Driver used to connect. In this example we use theFirebird PDO Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed.
o EXx: serverdomain.com Or 192.168.254.170.

e Port: Enter the numeric port for your database server.
o Ex: 3050

o Database Name: Enter the database created for use by the entered user.
e Username: Enter the user to authenticate the connection to your Firebird database.
e Password: Enter the password to complete the authentication process.

e Test Connection: Click this button to get a response from Scriptcase request to know if the entered parameters are correct.

Filter

By accessing this tab, you can configure which items from the Database will be displayed in the connection, depending on the owner or not.

Show

Allows the Firebird connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: Selecting this option will display your database views.
o By default, Scriptcase enables this option.

o System tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: When you select this option, the procedures from your database will be displayed.

Searches



Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables are displayed. The setting can contain aPREFIX% or name of the tables to be displayed.

o By default, Scriptcase leaves this option empty.
o Ex:

e Owner: Inform the user who sees the inserted tables for display.
o User must be in capital letters, as in the example above.

e Show: Choose whether tables are displayed for the owner entered.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimprove the performance of your database connection.
Advanced

In this tab, you have access to connection-specific settings. Changes made in this section impact the data display and performance of the application.

e client_encoding: Select the encoding used in your database. In the example above, we used client_encodingUTF-8.

o Decimal Separator: Select the separator type for decimal records, between comma and period.
o By default, period. is selected as the separator.

e Persistent connection: Set whether connections will be closed after your scripts run in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use schema before table name: Set whether the database schema is displayed before table names.
o By default, Scriptcase enables this option.

o Ex:

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with Firebird PDO

In Scriptcase, we have the following drivers available for Firebird connections: Firebird PDO, Firebird. If you are using your own pre-configured environment, the Firebird
extensions must be enabled manually in PHP.

Prerequisites

If you are using a manual installation on MacOS, you will need to install PHP and the Firebird driver will be enabled. Clickere to see how to do this.
1 - Check that the Firebird driver is enabled in your Scriptcase diagnostics. Here is how to locate your diagnostics below and verify that the driver is enabled.

e By going to the top menu Help > Diagnostics, you can easily find it through the interface.

e Or, by accessing your Scriptcase installation path:

127.0.0.1/scriptcase/diagnosis.php Or domain.com/scriptcase/diagnosis.php

Creating a connection in Scriptcase

Here’s how to create a connection in your Scriptcase project using the Firebird database.
1 - Access any project from your Scriptcase.

2 - Click on the New connection icon to create a connection.

or go to the Database > New Connectionmenu.

After that a new page will appear with all the database connections.

3 - Select the Firebird connection.

Connection

Enter the parameters for connecting to your Firebird database as follows:

e Connection Name: Set the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
e DBMS Driver: Select the Firebird Driver used to connect. In this example we use theFirebird PDO Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed.
o EX: serverdomain.com Or 192.168.254.170.

e Port: Enter the numeric port for your database server.
o Ex: 3050

o Database Name: Enter the database created for use by the entered user.

e Username: Enter the user to authenticate the connection to your Firebird database.

e Password: Enter the password to complete the authentication process.

e Test Connection: Click this button to get a response from Scriptcase request to know if the entered parameters are correct.

Filter

By accessing this tab, you can configure which items from the Database will be displayed in the connection, depending on the owner or not.

Show

Allows the Firebird connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: Selecting this option will display your database views.
o By default, Scriptcase enables this option.
e System tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: When you select this option, the procedures from your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.

e Tables: You can define in this option which tables are displayed. The setting can contain aPREFIX% or name of the tables to be displayed.
o By default, Scriptcase leaves this option empty.
o Ex:



e Owner: Inform the user who sees the inserted tables for display.
o User must be in capital letters, as in the example above.

e Show: Choose whether tables are displayed for the owner entered.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimprove the performance of your database connection.
Advanced

In this tab, you have access to connection-specific settings. Changes made in this section impact the data display and performance of the application.

e client_encoding: Select the encoding used in your database. In the example above, we used client_encodingUTF-8.

o Decimal Separator: Select the separator type for decimal records, between comma and period.
o By default, period. is selected as the separator.

e Persistent connection: Set whether connections will be closed after your scripts run in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use schema before table name: Set whether the database schema is displayed before table names.

o By default, Scriptcase enables this option.

o Ex:

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Informix in Scriptcase

In Scriptcase, we have the following driver available for connecting to Informix: Informix PDO. If you are using your own pre-configured environment, the Informix extension must be enabled manually in PHP .
You can verify that the driver is enabled by accessing your Scriptcase diagnostic. Here is how to locate your diagnostics.

e yaccessing the top menu Help > Diagnostics, you can easily find it through the interface.

@ WebHelp ..

® Technical Support

e 1, by accessing the url in your browser:
127.0.0.1:8092/scriptcase/diagnosis.php or domain.com/scriptcase/diagnosis.php

If the driver is already enabled and you just want to know how to connect to Scriptcase, click on the link below according to the operating system that will be used.

Environment  Informix PDO

Windows Conecte
Linux Conecte
macOS Conecte

Doubts or Connection Problems?
Contact our Support Team in case of connection problems or questions regarding this database.



Connection with Informix - Windows

In Scriptcase, we have the following driver available for connecting to Informix: Informix PDO. If you are using your own pre-configured environment, the Informix extension must be enabled manually in PHP.

| NOTE: On automatic Scriptcase installation, the Informix PDO driver is already enabled. Just follow the steps to connect by clicking here.

Prerequisites

If you are using a manual installation on Windows, you will need to enable the Informix extension in the php.|

i file and install the Client SDK. See below for how to do this.

e ownload the instant client SDK compatible with your operating system'’s x64 or x86 architecture. Click here to access the Informix SDK Client Download page.
o 86=32bits
o 64=64bits

Informix SDK Client Installation
1 - Unzip the file into any folder.

e xample: client informix

B Extraction path and options ? X

General  Advanced

Destination path {wil be created if does not exist) Display
[ C\users\gustavo verasiponnloads\dent informix ~] New folder
Update mod
paate mode - Downloads -
@ Extract and replace files 2006 - Pensei que Fosse o Cét
() Extract and update files Atendimentos
(O Fresh existing files orly dl
instantdient_11_dlis
Overnrite mode Login
(® sk before overwrite marcos
0ci8-2.0.8
O Overwrite without prompt rteosetia
(O skip existing files b vusic
(O Rename automatically =] Pictures
1B videos
Miscelneaus s Local Disk (C2)
Extract archives to subfolders L DVD RW Drive (E)
[ Keep broken fies  Lbraries
g Network

[ isplay fles in Explarer

-*&, Homegroup

Save settings < >

Cancsl Help

2 - Access your windows CMD by searching for command prompt in Windows search or by pressing ctrl+r and typing cmd in execute.

Best match

Command Prompt
Desktap app

Apps

Git CMD
2% Perl (command line)
Folders

cmdline

My stuff 2 Web

cmd ‘

3 - When starting CMD, access the folder where the file was saved after downloading using the c¢d command and entering the path to the folder the SDK client is in. Example:

[En] CAWINDOWS\system32\cmd.exe

4 - Then run the .exe file with the -i and GUI parameters.

e xample: installclientsdk.exe -i GUI

AWINDOWShsystem32\cmd,

5 - Follow the client installation wizard by clicking next to keep the default values for the installation. Pay attention to the Security Features step.



¥ Introduction
[> Installation location

> Installation features

[> Webserver Configuration
[> Security Features

[> Installation summary

[> Installing

> Installation Complete

Install&nywhere will guide you through the installation of IBM Informix
Client SDK 4.10.TC5

Copyright IBM Corporation 1985, . All rights reserved

Itis strongly recommended that you guit all programs before
continuing with this installation.

Click Next'to proceed to the next sereen. Click Previous' fo navigate
to a previous step.

Click ‘Cancel'to cancel the installation at any time.

6 - Here you can choose whether or not to use a password to access the OAT (Informix Administration Application)

+/ Intraduction
+/ Installation location

+/ Installation features

+/ Webserver Configuration
» Security Features

[> Installation summary

[> Installing.

[> Installation Complete

With OAT only OAT il can
add and edit connection groups and change OAT
configurations. Other users can manage 1BM Informix
database servers, but they cannot modify connection
groups and OAT configurations.

Check the following if you wish to enable OAT password
protection.
OAT password protection

7 - Set your login and password, if you have checked the OAT password protection option

+/ Intraduction
+ Installation location

+/ Installation features

+/ Webserver Configuration
» Security Features

[> Installation summary

[> Installing.

> Installation Complete

Enter the user name and password for accessing the OAT Admin
pages.

User name: adnin ]

Password|

Retype the password|

8 - Select NO and proceed with the installation as usual.

+ Introduction
+/ Installation location

+/ Installation features

+/ Webserver Configuration
' Security Features

» Installation summary

[> Installing.

> Installation Complete

Do you want to install the IBM Data Server Driver Package?

@ Yes
@ Mo

9 - Proceed with the installation by clicking on Done and wait for the process to finish.




[ Informix Client-SDK =l s

+/ Introduction Congratulations! 1BM Informix Client SDK 4 10.TC5 has been
+/ Installation location successiully installed to

+ Installation features

+/ Webserver Configuration

' Security Features To run the OpenAdmin Tool, go to the following web page
hittp:iforac-PC:8080/openadmin

C:\Program Files\BW Informix Client SDK

» Installation summary

Insialing Glick Done' to exit the installation process.
Installation Complete

Setting php.ini .

1-Inthe php.ini file, located under C:\php , uncomment the line for the Informix extension php_pdo_informix by removing the ; from the start of the line. See the example below:

;extension=bz2

; Must be after mbstring as it depends on it

; Use with Oracle Database 12c Instant Client

extension=pdo_oci
on=pdo_odbc

extension=pdo_sqlite
on=pgsql

;extension=shmop

extension=php_pdo_informix

2 - Restart the Apache service using the Task Manager.
e  pen Task Manager and click on the Services tab.

e ook forthe Apache2.4 or ApacheScriptcase9php73 service and right-click on this service, then Restart.

Gerenciador de Tarefas

Arquive Opgdes Exibir

- Servigos

Nome PID Descrigdo

" Apachescriptcasedphpd] 4204 ApacheScriptcasedphpgl

Abrir Servigos
Pesquisar online

Ir para detalhes

Creating a Connection in Scriptcase

Here is how to create a connection in your Scriptcase project using the Informix database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connection icon to create a connection.

> Project Database  Application Tools Lay Locales Mo
Home New Opef New Edit
Project Project project project connection fconnection




or go to the Database > New Connection menu.

Database [Ve=1l]

Home

€, Edit connection

Newcomr @ Import ACCESS

[A Import EXCEL

After that, a new page will appear with all the database connections.

3 - Select the connection Informix.

Create a connection

Select your database system and create  cannection for your project.

R, B

ORACLE"
MySsoL Mt
= $BLserver
MysQL Oracle MSSQL Server
Wior..  Ssmse
MS Access SQLite SyBase
Connection

DB2 | Informix
L) SOFTWARE
PostgreSQL
Postgres DB2 Informix
G (@ Firebird’ .
InterBase
InterBase Firebird ODBC

Enter the parameters for connecting to your Informix database as follows:

Create a connection Informix

Enter the connection details for your da

base Informix

CONNECTION  FILTER  ADVANCED

Connection Name

conn_informix

Server/Host (Name or IP}

92.204.163.43:9053

DBMS Driver

Informix PDO

€ Choose another connection

Database Name

SAMPLE

Username

Password

informis ssssssscas

e onnection Name: Set the name of your new connection. By default, Scriptcase adds the prefix conn along with the database name.
®  BMS Driver: Select the Informix Driver used to connect. In this example we use the Informix PDO Driver.

e erver/Host (Name or IP): Enter the IP or domain of the server where the database is installed along with the access port.
o x: serverdomain.com:9088 or 192.168.254.170:9088
e  atabase Name: Enter the name of your database to connect to it.

e sername: Enter the user to authenticate the connection to your Informix database.
e assword: Enter the password to complete the authentication process.

e est Connection: Click this button to get a response from Scriptcase request to know if the parameters entered are correct.

Connection Success

==

Filter

By accessing this tab, you can configure which items from the Database will be displayed in the connection, depending on the owner or not.



CONNECTION | FILTER | ADVANCED o

Show Searches
| Tables

Tables Owner Show
| Views

System tables
Procedures

Show

Allows the Informix connection to see tables, views, system tables, and procedures depending on the items selected by the user. By default, the items  Tables and Views are already selected by Scriptcase.

e  ables: By selecting this option, the tables in your database will be displayed.
o ydefault, Scriptcase enables this option.

e iews: Selecting this option will display your database views.
o ydefault, Scriptcase enables this option.

e  ystem tables: By selecting this option, the system tables of your database will be displayed.

e rocedures: When you select this option, the procedures from your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.

e ables: You can define in this option which tables will be displayed. The setting can containa  PREFIX% or name of the tables to be displayed.
o ydefault, Scriptcase leaves this option empty.

o X:
Using the table prefix
Tables Owner
SUP% SYSTEM
Using the table name
Tables Owner
SUP_ACCOUNT, SUP_ORDEF SYSTEM

®  wner: Enter the user who sees the inserted tables for display.
o ser must be in capital letters, as in the example above.

o how: Choose whether tables are displayed for the owner entered.

NOTE: By using table filtering, you eliminate unnecessary tables for your project and improve the performance of your database connection.

Advanced

In this tab, you have access to connection-specific settings. Changes made in this section impact the data display and performance of the application.

CONNECTION  FILTER | ADVANCED

client_encoding

UTF8 - Unicode, 8-bit -

Decimal Separator

Persistent Connection

No -

Use the schema before table name

Yes -

e lient_encoding: Select the encoding used in your database. In the example above, we used client_encoding UTF-8.

e  ecimal separator: Select the type of separator for decimal records, between comma and period.
o ydefault, period . is selected as the separator.

e ersistent connection: Set whether connections will be closed after your scripts run in Scriptcase applications.
o ydefault, Scriptcase disables this option.



se schema before table name: Set whether the database schema is displayed before table names.
o ydefault, Scriptcase enables this option.

o X2

Using the schema before table name | Not using the schema before table name
Connection ™ Connection”

conn_oracle v conn_oracle ™
Table Table

"SYSTEM".GOL - < coL - <

Doubts or Connection Problems?
Contact our Support Team in case of connection problems or questions regarding this database.



Connection with Informix - Linux

In Scriptcase, we have the following driver available for connecting to Informix: Informix PDO. If you are using your own pre-configured environment, the Informix extension must be enabled manually in PHP.

| NOTE: On automatic Scriptcase installation, the Informix PDO driver is already enabled. Just follow the steps to connect by clicking here.

Prerequisites
Install the dependencies below:
UBUNTU\DEBIAN CENTOS\RHEL
- sudo apt-get update - sudo yum update
- sudo apt-get install libaio1 - sudo yum install libaio-devel
- sudo apt-get install libncurses5 - sudo yum install libaio
- sudo apt-get install alien - sudo yum install glibc

- sudo apt-get install gcc-multilib g++-multilib - sudo yum install compat-libstdc++-33

- sudo apt-get install libpamOg - sudo yum install glibc-devel
- sudo apt-get install ksh - sudo yum install libstdc++
- sudo apt-get install unixodbc-dev unixodbc - sudo yum install libstdc++

- sudo yum install pam

- sudo yum install ncurses-devel

- sudo yum install unixODBC

- sudo wget ftp://195.220.108.108/linux/centos/6.7/0s/i386/Packages/ksh-20120801-28.el6.i686.rpm
- sudo yum install ksh-20120801-28.e16.i686.rpm

- sudo yum install nano

Informix SDK Client Configuration and Installation

1 - Download the instant client SDK compatible with your operating system’s x64 or x86 architecture. Click here to access the Informix SDK Client Download page.

® 86=32bits
®  64=64bits

NOTE: The Informix client installation directory must be according to your architecture:

® 2 Bits: /opt/IBM/ifx
® 4 Bits: /opt/IBM/x64/informix

2 - Realize a instalagdo do Client SDK:

x86 Architecture x64 Architecture

1 - sudo tar -xf x86_clientsdk.3.70.UC8DE.LINUX.tar 1 - sudo tar -xf x64_clientsdk.4.10.FC6DE.LINUX.tar
2 - sudo Jinstallclientsdk 2 - sudo Jinstallclientsdk

3 - Select 1 to accept the terms. 3 - Select 1 to accept the terms.

4 - Select the options: 1,2,3,4,5,6,7,8,9,10,11,12,13,14,15,16,17 4 - Select the options: 1,2,3,4,5,6,7,8,9,10,11,12,13,14,15,16,17
Proceed with completing the installation.

3 - Restart the Apache service using the following command in the terminal:

Ubuntu 20\Debian 9 or Higher CentOS 7/8 or Higher

sudo service apache2 restart sudo systemctl restart httpd

Creating a Connection in Scriptcase

Here is how to create a connection in your Scriptcase project using the Informix database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connection icon to create a connection.

> Project se  Application cales Moy
PNy m
lal |
Home New Oy Edit
Project Project project project connection  jconnection

or go to the Database > New Connection menu.



Database [Nsdllleiile)]

€, Edit connection

Newconn @ Import ACCESS

[@ Import EXCEL

After that, a new page will appear with all the database connections.

3 - Select the connection Informix.

Create a connection
Select your database system and create  connection for your project.

AN ORACLE ) D BZ Informix

MySau r U soFTwARE
= SQL Server PostareSOL

MysQL Oracle MSSQL Server Postgres DB2 Informix

: ESynase '
P InterBase

MS Access SQlite SyBase InterBase Firebird ODBC

Connection

Enter the parameters for connecting to your Informix database as follows:

Create a connection Informix
Enter the connection details for your da

CONNECTION  FILTER  ADVANCED o

R & Choose another connection
base Informix

Connection Name DBMS Driver

conn_informix Informix PDO -
Server/Host (Name or IP} Database Name:

92.204.163.43:9088 SAMPLE
Username

informix

e onnection Name: Set the name of your new connection. By default, Scriptcase adds the prefix conn along with the database name.
®  BMS Driver: Select the Informix Driver used to connect. In this example we use the Informix PDO Driver.

e erver/Host (Name or IP): Enter the IP or domain of the server where the database is installed along with the access port.
o x: serverdomain.com:9088 or 192.168.254.170:9088
e atabase Name: Enter the name of your database to connect to it.

e sername: Enter the user to authenticate the connection to your Informix database.
e assword: Enter the password to complete the authentication process.

e est Connection: Click this button to get a response from Scriptcase request to know if the parameters entered are correct.

Connection Success

> coven | o]

Filter

By accessing this tab, you can configure which items from the Database will be displayed in the connection, depending on the owner or not.



CONNECTION | FILTER | ADVANCED o

Show Searches
| Tables

Tables Owner Show
| Views

System tables
Procedures

Show

Allows the Informix connection to see tables, views, system tables, and procedures depending on the items selected by the user. By default, the items  Tables and Views are already selected by Scriptcase.

e  ables: By selecting this option, the tables in your database will be displayed.
o ydefault, Scriptcase enables this option.

e iews: Selecting this option will display your database views.
o ydefault, Scriptcase enables this option.

e  ystem tables: By selecting this option, the system tables of your database will be displayed.

e rocedures: When you select this option, the procedures from your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.

e ables: You can define in this option which tables will be displayed. The setting can containa  PREFIX% or name of the tables to be displayed.
o ydefault, Scriptcase leaves this option empty.

o X2
Using the table prefix
Tables Owner
SUP% SYSTEM
Using the table name
Tables Owner
SUP_ACCOUNT, SUP_ORDEF SYSTEM

®  wner: Enter the user who sees the inserted tables for display.
o ser must be in capital letters, as in the example above.

o how: Choose whether tables are displayed for the owner entered.

NOTE: By using table filtering, you eliminate unnecessary tables for your project and improve the performance of your database connection.

Advanced

In this tab, you have access to connection-specific settings. Changes made in this section impact the data display and performance of the application.

CONNECTION  FILTER | ADVANCED

client_encoding

UTF8 - Unicode, 8-bit -

Decimal Separator

Persistent Connection

No -

Use the schema before table name

Yes -

e lient_encoding: Select the encoding used in your database. In the example above, we used client_encoding UTF-8.

e  ecimal separator: Select the type of separator for decimal records, between comma and period.
o ydefault, period . is selected as the separator.

e ersistent connection: Set whether connections will be closed after your scripts run in Scriptcase applications.
o ydefault, Scriptcase disables this option.



se schema before table name: Set whether the database schema is displayed before table names.
o ydefault, Scriptcase enables this option.

o X2

Using the schema before table name | Not using the schema before table name
Connection ™ Connection”

conn_oracle v conn_oracle ™
Table Table

"SYSTEM".GOL - < coL - <

Doubts or Connection Problems?
Contact our Support Team in case of connection problems or questions regarding this database.



Connection with Informix - MacOs

In Scriptcase, we have the following driver available for connecting to Informix: Informix PDO. If you are using your own pre-configured environment, the Informix extension must be enabled manually in PHP.

| NOTE: On automatic Scriptcase installation, the Informix PDO driver is already enabled. Just follow the steps to connect by clicking here.

Prerequisites
e ownload the instant client SDK compatible with your operating system’s x64 or x86 architecture. Click here to access the Informix SDK Client Download page.
o 86=32bits
o 64=64bits

Informix SDK Client Configuration and Installation
1 - Extract the instant Client SDK file.
2 - Perform the installation via terminal, accessing the extracted folder and running the command below:

sudo ./installclientsdk

NOTE: Install in the default directory (/Applications/IBM/informix).

3 - Choose options 1 through 17 and finish the installation.
4 - After doing so, save the file and restart the apache service.

MacOs “Catalina” 10.15 or Higher

sudo apachectl restart
Creating a Connection in Scriptcase
Here is how to create a connection in your Scriptcase project using the Informix database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connection icon to create a connection.

Project  Dx ase  Application Tools Layout

P m
& = 5
Home New Op:
Project Project project project connection fconnection

or go to the Database > New Connection menu.

> Project [EMEIELEN:MN Application Tools L4
—

S, Edit connection

Newconn @ Import ACCESS

[@ Import EXCEL

After that, a new page will appear with all the database connections.

3 - Select the connection Informix.

Create a connection
Select your database system and create a connection for your project.

AN ORACLE' \ﬁ D BZ Informix

MySaL: g g soFTIARE
< SQL Server PostaraSOL

MysQL Oracle MSSQL Server Postgres DB2 Informix

E v o 8 o B

InterBase

MS Access SQlite SyBase InterBase Firebird ODBC

Connection

Enter the parameters for connecting to your Informix database as follows:



Create a connection Informix
Enter the connection details for your da

ase Informisx

CONNECTION ~ FILTER  ADVANCED

Connection Name

conn_informix

Server/Host (Name or IP)

DBMS Driver

Informix PDO

€ Choose another connection

Database Name

92.204.163.43:9088 SAMPLE

Username Password

infarmix esesscnses

e onnection Name: Set the name of your new connection. By default, Scriptcase adds the prefix conn along with the database name.
®  BMS Driver: Select the Informix Driver used to connect. In this example we use the Informix PDO Driver.

e erver/Host (Name or IP): Enter the IP or domain of the server where the database is installed along with the access port.
o X: serverdomain.com:9088 or 192.168.254.170:9088
e  atabase Name: Enter the name of your database to connect to it.

o sername: Enter the user to authenticate the connection to your Informix database.
e assword: Enter the password to complete the authentication process.

e est Connection: Click this button to get a response from Scriptcase request to know if the parameters entered are correct.

Connection Success

> v | o ]

Filter

By accessing this tab, you can configure which items from the Database will be displayed in the connection, depending on the owner or not.

CONNECTION | FILTER | ADVANCED
Show Searches
| Tables
Tables Owmner Show
w| Views
System tables
No -
Procedures
Show

Allows the Informix connection to see tables, views, system tables, and procedures depending on the items selected by the user. By default, the items ~ Tables and Views are already selected by Scriptcase.

e ables: By selecting this option, the tables in your database will be displayed.
o ydefault, Scriptcase enables this option.

o iews: Selecting this option will display your database views.
o ydefault, Scriptcase enables this option.

e ystem tables: By selecting this option, the system tables of your database will be displayed.

e rocedures: When you select this option, the procedures from your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.

o ables: You can define in this option which tables will be displayed. The setting can contain a
o ydefault, Scriptcase leaves this option empty.
o x

PREFIX% or name of the tables to be displayed.



Using the table prefix

Tables Owner
SUP% SYSTEM
Using the table name
Tables Owner
SUP_ACCOUNT, SUP_ORDEF SYSTEM

e wner: Enter the user who sees the inserted tables for display.

o ser must be in capital letters, as in the example above.

o how: Choose whether tables are displayed for the owner entered.

NOTE: By using table filtering, you eliminate unnecessary tables for your project and improve the performance of your database connection.

Advanced

In this tab, you have access to connection-specific settings. Changes made in this section impact the data display and performance of the application.

CONNECTION  FILTER = ADVANCED

client_encoding

UTF8 - Unicode, 8-bit -

Decimal Separator

Persistent Connection

No -

Use the schema before table name

Yes -

e lient_encoding: Select the encoding used in your database. In the example above, we used client_encoding UTF-8.
e  ecimal separator: Select the type of separator for decimal records, between comma and period.
o ydefault, period . is selected as the separator.
e ersistent connection: Set whether connections will be closed after your scripts run in Scriptcase applications.
o ydefault, Scriptcase disables this option.
.

se schema before table name: Set whether the database schema is displayed before table names.
o ydefault, Scriptcase enables this option.

o X:

Using the schema before table name | Not using the schema before table name

Connection Connection”

conn_oracle ~

conn_oracle v
Table Table
"SYSTEM".COL - [+ cOoL - =

Contact our Support Team in case of connection problems or questions regarding this database.

Doubts or Connection Problems?



Interbase with Scriptcase

In Scriptcase, we have only one driver to connect with Interbase: pdo_firebird. If you are using your own pre-configured environment, PDO Firebird extension must be manually enabled in PHP.

You can check your enabled drivers by accessing your Scriptcase diagnosis. See below on how to locate your diagnosis and check if the driver is enabled.

e ccessing the top menu Help > Diagnosis, you can easily find it through the interface.

©@ WebHelp

® Technical Support

e r, by accessing your browser url:

127.0.0.1:8092/scriptcase/diagnosis.php or domain.com/scriptcase/diagnosis.php

Connections available

Firebird connection is available for Windows, Linux and MacOS with Firebird PDO driver.
Select the system where Scriptcase will be used and see our documentation about the connection.
e Interbase on Windows

e Interbase on Linux
e Interbase on macOS

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Interbase connection with PDO Firebird

In Scriptcase, we have the following driver available for Interbase connections: PDO Firebird. If you are using your own pre-configured environment, Interbase extensions must be
enabled manually in PHP.

Prerequisites

If you are using a manual installation on Windows, you will need to enable the PDO Firebird extension in thghp.ini file. See below for how to do this.

1 - In the php.ini file, located under c:\php, uncomment the line for Firebird extension: pdo_firebird by removing the; from the beginning of the line. See the example below:

2 - Restart the Apache service using theTask Manager.
e Open Task Manager and click on the Services tab.

e Look for the Apache2.4 or ApacheScriptcase9php81 service and right-click on this service, then Restart.

Creating a connection in Scriptcase

Here’s how to create a connection in your Scriptcase project using the Interbase database.
1 - Access any project from your Scriptcase.

2 - Click on the New connection icon to create a connection.

or go to the Database > New Connectionmenu.

After that a new page will appear with all the database connections.

3 - Select the Interbase connection.

Connection

Enter the parameters for connecting to your Interbase database as follows:

e Connection Name: Set the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
e DBMS Driver: Select the Interbase Driver used to connect. In this example we use thelnterbase 6.5 or Above Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed.
o EX: serverdomain.com Or 192.168.254.170.

e Port: Enter the numeric port for your database server.
o Ex: 3050

e Username: Enter the user to authenticate the connection to your Interbase database.
e Password: Enter the password to complete the authentication process.

e Test Connection: Click this button to get a response from Scriptcase request to know if the entered parameters are correct.

Filter

By accessing this tab, you can configure which items from the Database will be displayed in the connection, depending on the owner or not.

Show

Allows the Interbase connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are
already selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: Selecting this option will display your database views.
o By default, Scriptcase enables this option.
e System tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: When you select this option, the procedures from your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.

e Tables: You can define in this option which tables are displayed. The setting can contain aPREFIX% or name of the tables to be displayed.
o By default, Scriptcase leaves this option empty.



e Owner: Inform the user who sees the inserted tables for display.
o User must be in capital letters, as in the example above.

e Show: Choose whether tables are displayed for the owner entered.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimprove the performance of your database connection.
Advanced

In this tab, you have access to connection-specific settings. Changes made in this section impact the data display and performance of the application.

e client_encoding: Select the encoding used in your database. In the example above, we used client_encodingUTF-8.

« Decimal Separator: Select the separator type for decimal records, between comma and period.
o By default, period. is selected as the separator.

e Persistent connection: Set whether connections will be closed after your scripts run in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use schema before table name: Set whether the database schema is displayed before table names.
o By default, Scriptcase enables this option.

o Ex:

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Interbase connection with PDO Firebird

In Scriptcase, we have the following driver available for Interbase connections: PDO Firebird. If you are using your own pre-configured environment, Interbase extensions must be
enabled manually in PHP.

Prerequisites
If you are using a manual installation on Linux, you will need to install the php extension for Firebird. See below for how to do this.
1 - Log into your Linux terminal and type this line below according to your operating system to install the Firebird PDO Firebird driver.

Ubuntu/Debian CentOS

sudo apt-get install php8.1-interbase sudo yum install php-interbase
2 - Check if the PDO Firebird driver is enabled in your Scriptcase diagnostic. Here is how to locate your diagnostics and verify that the driver is enabled.

e When you access the top menu Help > Diagnostics, you can easily find it through the interface.

e Or, by accessing your Scriptcase installation path:

127.0.0.1/scriptcase/diagnosis.php Or domain.com/scriptcase/diagnosis.php

Creating a connection in Scriptcase

Here’s how to create a connection in your Scriptcase project using the Interbase database.
1 - Access any project from your Scriptcase.

2 - Click on the New connection icon to create a connection.

or go to the Database > New Connectionmenu.

After that a new page will appear with all the database connections.

3 - Select the Interbase connection.

Connection

Enter the parameters for connecting to your Interbase database as follows:

e Connection Name: Set the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the Interbase Driver used to connect. In this example we use thelnterbase 6.5 or Above Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed.
o EXx: serverdomain.com Or 192.168.254.170.

e Port: Enter the numeric port for your database server.
o Ex: 3050

e Username: Enter the user to authenticate the connection to your Interbase database.
e Password: Enter the password to complete the authentication process.

e Test Connection: Click this button to get a response from Scriptcase request to know if the entered parameters are correct.

Filter

By accessing this tab, you can configure which items from the Database will be displayed in the connection, depending on the owner or not.

Show

Allows the Interbase connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are
already selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: Selecting this option will display your database views.
o By default, Scriptcase enables this option.

e System tables: By selecting this option, the system tables of your database will be displayed.
e Procedures: When you select this option, the procedures from your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.



Tables: You can define in this option which tables are displayed. The setting can contain aPREFIX% or name of the tables to be displayed.
o By default, Scriptcase leaves this option empty.
o Ex:

Owner: Inform the user who sees the inserted tables for display.
o User must be in capital letters, as in the example above.

Show: Choose whether tables are displayed for the owner entered.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimprove the performance of your database connection.

Advanced

In this tab, you have access to connection-specific settings. Changes made in this section impact the data display and performance of the application.

client_encoding: Select the encoding used in your database. In the example above, we used client_encodingUTF-8.

Decimal Separator: Select the separator type for decimal records, between comma and period.
o By default, period. is selected as the separator.

Persistent connection: Set whether connections will be closed after your scripts run in Scriptcase applications.
o By default, Scriptcase disables this option.

Use schema before table name: Set whether the database schema is displayed before table names.
o By default, Scriptcase enables this option.

o Ex:

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connection to Interbase 6.5 or Above

In Scriptcase, we have the following drivers available for Interbase connections: Interbase 6.5 or Above, Interbase. If you are using your own pre-configured environment,
Interbase extensions must be enabled manually in PHP.

NOTE: The Scriptcase installer automatically enables the InterBase module by default, just make theconnection to the database from Scriptcase.

Prerequisites

If you are using a manual installation on MacOS, you will need to install PHP and the Interbase driver will be enabled. Clickere to see how to do this.
1 - Check that the Interbase driver is enabled in your Scriptcase diagnostic. See below for how to locate your diagnostics and verify that the driver is enabled.

e When you go to the top menuHelp > Diagnostics, you can easily find it through the interface.

e Or, by accessing your Scriptcase installation path:

127.0.0.1/scriptcase/diagnosis.php Or domain.com/scriptcase/diagnosis.php

Creating a connection in Scriptcase

Here’s how to create a connection in your Scriptcase project using the Interbase database.
1 - Access any project from your Scriptcase.

2 - Click on the New connection icon to create a connection.

or go to the Database > New Connectionmenu.

After that a new page will appear with all the database connections.

3 - Select the Interbase connection.

Connection

Enter the parameters for connecting to your Interbase database as follows:

e Connection Name: Set the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the Interbase Driver used to connect. In this example we use thelnterbase 6.5 or Above Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed.
o EXx: serverdomain.com Or 192.168.254.170.

e Port: Enter the numeric port for your database server.
o Ex: 3050

e Username: Enter the user to authenticate the connection to your Interbase database.
e Password: Enter the password to complete the authentication process.

e Test Connection: Click this button to get a response from Scriptcase request to know if the entered parameters are correct.

Filter

By accessing this tab, you can configure which items from the Database will be displayed in the connection, depending on the owner or not.

Show

Allows the Interbase connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are
already selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: Selecting this option will display your database views.
o By default, Scriptcase enables this option.
e System tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: When you select this option, the procedures from your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.

e Tables: You can define in this option which tables are displayed. The setting can contain aPREFIX% or name of the tables to be displayed.
o By default, Scriptcase leaves this option empty.
o Ex:



e Owner: Inform the user who sees the inserted tables for display.
o User must be in capital letters, as in the example above.

e Show: Choose whether tables are displayed for the owner entered.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimprove the performance of your database connection.
Advanced

In this tab, you have access to connection-specific settings. Changes made in this section impact the data display and performance of the application.

e client_encoding: Select the encoding used in your database. In the example above, we used client_encodingUTF-8.

o Decimal Separator: Select the separator type for decimal records, between comma and period.
o By default, period. is selected as the separator.

e Persistent connection: Set whether connections will be closed after your scripts run in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use schema before table name: Set whether the database schema is displayed before table names.

o By default, Scriptcase enables this option.

o Ex:

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connection to Interbase

In Scriptcase, we have the following drivers available for Interbase connections: Interbase 6.5 or Above, Interbase. If you are using your own pre-configured environment,
Interbase extensions must be enabled manually in PHP.

NOTE: The Scriptcase installer automatically enables the InterBase module by default, just make theconnection to the database from Scriptcase.

Prerequisites

If you are using a manual installation on MacOS, you will need to install PHP and the Interbase driver will be enabled. Clickere to see how to do this.
1 - Check that the Interbase driver is enabled in your Scriptcase diagnostic. See below for how to locate your diagnostics and verify that the driver is enabled.

e When you go to the top menuHelp > Diagnostics, you can easily find it through the interface.

e Or, by accessing your Scriptcase installation path:

127.0.0.1/scriptcase/diagnosis.php Or domain.com/scriptcase/diagnosis.php

Creating a connection in Scriptcase

Here’s how to create a connection in your Scriptcase project using the Interbase database.
1 - Access any project from your Scriptcase.

2 - Click on the New connection icon to create a connection.

or go to the Database > New Connectionmenu.

After that a new page will appear with all the database connections.

3 - Select the Interbase connection.

Connection

Enter the parameters for connecting to your Interbase database as follows:

e Connection Name: Set the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the Interbase Driver used to connect. In this example we use thelnterbase Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed.
o EXx: serverdomain.com Or 192.168.254.170.

e Port: Enter the numeric port for your database server.
o Ex: 3050

e Username: Enter the user to authenticate the connection to your Interbase database.
e Password: Enter the password to complete the authentication process.

e Test Connection: Click this button to get a response from Scriptcase request to know if the entered parameters are correct.

Filter

By accessing this tab, you can configure which items from the Database will be displayed in the connection, depending on the owner or not.

Show

Allows the Interbase connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are
already selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: Selecting this option will display your database views.
o By default, Scriptcase enables this option.
e System tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: When you select this option, the procedures from your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.

e Tables: You can define in this option which tables are displayed. The setting can contain aPREFIX% or name of the tables to be displayed.
o By default, Scriptcase leaves this option empty.
o Ex:



e Owner: Inform the user who sees the inserted tables for display.
o User must be in capital letters, as in the example above.

e Show: Choose whether tables are displayed for the owner entered.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimprove the performance of your database connection.
Advanced

In this tab, you have access to connection-specific settings. Changes made in this section impact the data display and performance of the application.

e client_encoding: Select the encoding used in your database. In the example above, we used client_encodingUTF-8.

o Decimal Separator: Select the separator type for decimal records, between comma and period.
o By default, period. is selected as the separator.

e Persistent connection: Set whether connections will be closed after your scripts run in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use schema before table name: Set whether the database schema is displayed before table names.

o By default, Scriptcase enables this option.

o Ex:

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



MySQL with Scriptcase

In Scriptcase, we have two drivers to connecting with MySQL. You must choose the most suitable for your environment. It is recommended to use  MySQL PDO which is more faster, however it is up to you to choose the driver. If you:

environment, MySQL extensions must be manually enabled in PHP.

You can check your enabled drivers by accessing your Scriptcase diagnosis. See below on how to locate your diagnosis and check if the driver is enabled.

e  ccessing the top menu Help > Diagnosis, you can easily find it through the interface.
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e r, by accessing your browser url:
127.0.0.1:8092/scriptcase/diagnosis.php or domain.com/scriptcase/diagnosis.php

If the desired driver is already enabled and you just want to know how to connect with Scriptcase, click on the link below according to the driver that will be used.

Environment  MySQL PDO MySQLi

Windows See how to connect  See how to connect
Linux See how to connect ~ See how to connect
macOS See how to connect  See how to connect

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with MySQL PDO

In Scriptcase, we have the following drivers available for connections with MySQL: MySQL PDO and MySQLi. If you are using your own pre-configured environment, MySQL
extensions must be manually enabled in PHP.

Prerequisites

If you are using a manual installation on Windows, you’ll need to enable the MySQL extensions orphp.ini file. Check below how to do it.

1 - In the php.ini file, located in C:\php, uncomment the lines referring to the MySQL extensionsphp_pdo_mysql and php_mysqli removing the; from the beginning of the line. See
the example below:

2 - Restart the Apache service using theTask Manager.
e Open the Task Manager and click on theServices tab.

e Search for the Apache2.4 or ApacheScriptcase9php81 service and right click on this service, then Restart.

Creating a Connection in Scriptcase

Server sent charset unknown to the clientlIf you are using MySQL 8, and your Scriptcase is using PHP 7.0 or 7.3, due to the PHP 7 bug, an error occurs when trying to
connect to the Scriptcase. Click here and see how to work around this error.

See below how to create a connection in your Scriptcase project using the MySQL database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the MySQL connection.

Connection

Enter the parameters for connecting to your MySQL database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the MySQL Driver used to connect. In this example, we use theMySQL PDO Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed.
o E.g. serverdomain.com Or 192.168.254.170

e Port: Inform the number port for your database server.
e Username: Inform the user to authenticate the connection to your MySQL database.
e Password: Enter the password to complete the authentication process.

« Database Name: Type your database name to connect with him. Or, if you want to choose one different database, click on the buttorList Database to show all databases
availabes for your user.
o Create Database: Clicking on this button, you will create a new MySQL database for use.
e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Security

On this tab you can set your SSL encryption for your database connection. Check below how to do this.

Use SSL : Activates or deactivates the use of secure connections with MySQL.

Client Key : Path to the client’s private identification key in the format PEM.

Client Certificate : Path to the client’s public certificate key.

CA Path : Path to the directory that contains the Certificate of Authority (CA) in the format PEM, if used, it should specify the same certificate used by the server.

CA Certificate : Path to the Certificate of Authority (AC) in the format PEM. This option, if used, should specify the same certificate as the server.

Specific Chipper : A list of permitted numbers to use with the cryptography of the connection. If one of the numbers is not supported, the SSL connection won't work.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the MySQL connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are already



selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.

o By default, Scriptcase enables this option.
e System Tables: By selecting this option, the system tables of your database will be displayed.
e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

e Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with MySQLi

In Scriptcase, we have the following drivers available for connections with MySQL: MySQL PDO and MySQLi. If you are using your own pre-configured environment, MySQL
extensions must be manually enabled in PHP.

Prerequisites

If you are using a manual installation on Windows, you’ll need to enable the MySQL extensions orphp.ini file. Check below how to do it.

1 - In the php.ini file, located in C:\php, uncomment the lines referring to the MySQL extensionsphp_pdo_mysql and php_mysqli removing the; from the beginning of the line. See
the example below:

2 - Restart the Apache service using theTask Manager.
e Open the Task Manager and click on theServices tab.

e Search for the Apache2.4 or ApacheScriptcase9php81 service and right click on this service, then Restart.

Creating a Connection in Scriptcase

Server sent charset unknown to the clientlIf you are using MySQL 8, and your Scriptcase is using PHP 7.0 or 7.3, due to the PHP 7 bug, an error occurs when trying to
connect to the Scriptcase. Click here and see how to work around this error.

See below how to create a connection in your Scriptcase project using the MySQL database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the MySQL connection.

Connection

Enter the parameters for connecting to your MySQL database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the MySQL Driver used to connect. In this example, we use theMySQLi Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed.
o E.g. serverdomain.com Or 192.168.254.170

e Port: Inform the number port for your database server.
e Username: Inform the user to authenticate the connection to your MySQL database.
e Password: Enter the password to complete the authentication process.

« Database Name: Type your database name to connect with him. Or, if you want to choose one different database, click on the buttorList Database to show all databases
availabes for your user.
o Create Database: Clicking on this button, you will create a new MySQL database for use.
e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Security

On this tab you can set your SSL encryption for your database connection. Check below how to do this.

Use SSL : Activates or deactivates the use of secure connections with MySQL.

Client Key : Path to the client’s private identification key in the format PEM.

Client Certificate : Path to the client’s public certificate key.

CA Path : Path to the directory that contains the Certificate of Authority (CA) in the format PEM, if used, it should specify the same certificate used by the server.

CA Certificate : Path to the Certificate of Authority (AC) in the format PEM. This option, if used, should specify the same certificate as the server.

Specific Chipper : A list of permitted numbers to use with the cryptography of the connection. If one of the numbers is not supported, the SSL connection won't work.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the MySQL connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are already



selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.

o By default, Scriptcase enables this option.
e System Tables: By selecting this option, the system tables of your database will be displayed.
e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

e Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with MySQL PDO

In Scriptcase, we have the following drivers available for connections with MySQL: MySQL PDO and MySQLi. If you are using your own pre-configured environment, MySQL
extensions must be manually enabled in PHP.

Prerequisites

If you are using a manual installation on Linux, you'll need to install the MySQL php extension. Check below how to do it.
1 - Access your Linux terminal and type this line below according to your OS to install MySQL PDO driver.

Ubuntu CentOS
sudo apt-get install php8.1-mysql sudo yum install php-mysql

2 - Check if the MySQL driver is enabled in your Scriptcase diagnosis. See below on how to locate your diagnosis and check if the driver is enabled.

e Accessing the top menu Help > Diagnosis, you can easily find it through the interface.

e Or, by accessing your Scriptcase installation path:

127.0.0.1/scriptcase/diagnosis.php Or domain.com/scriptcase/diagnosis.php

Creating a Connection with ScriptCase

Server sent charset unknown to the clientlf you are using MySQL 8, and your Scriptcase is using PHP 7.0 or 7.3, due to the PHP 7 bug, an error occurs when trying to
connect to the Scriptcase. Click here and see how to work around this error.

See below how to create a connection in your Scriptcase project using the MySQL database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the MySQL connection.

Connection

Enter the parameters for connecting to your MySQL database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the MySQL Driver used to connect. In this example, we use theMySQL PDO Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed.
o E.g. serverdomain.com Or 192.168.254.170

e Port: Inform the number port for your database server.
e Username: Inform the user to authenticate the connection to your MySQL database.
e Password: Enter the password to complete the authentication process.

« Database Name: Type your database name to connect with him. Or, if you want to choose one different database, click on the buttorList Database to show all databases
availabes for your user.
o Create Database: Clicking on this button, you will create a new MySQL database for use.
e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Security

On this tab you can set your SSL encryption for your database connection. Check below how to do this.

Use SSL : Activates or deactivates the use of secure connections with MySQL.

Client Key : Path to the client’s private identification key in the format PEM.

Client Certificate : Path to the client’s public certificate key.

CA Path : Path to the directory that contains the Certificate of Authority (CA) in the format PEM, if used, it should specify the same certificate used by the server.

CA Certificate : Path to the Certificate of Authority (AC) in the format PEM. This option, if used, should specify the same certificate as the server.

Specific Chipper : A list of permitted numbers to use with the cryptography of the connection. If one of the numbers is not supported, the SSL connection won't work.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show



It allows the MySQL connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.

e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

e Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with MySQLi

In Scriptcase, we have the following drivers available for connections with MySQL: MySQL PDO and MySQLi. If you are using your own pre-configured environment, MySQL
extensions must be manually enabled in PHP.

Prerequisites

If you are using a manual installation on Linux, you'll need to install the MySQL php extension. Check below how to do it.
1 - Access your Linux terminal and type this line below according to your OS to install MySQLi driver.

Ubuntu CentOS
sudo apt-get install php8.1-mysql sudo yum install php-mysql

2 - Check if the MySQL driver is enabled in your Scriptcase diagnosis. See below on how to locate your diagnosis and check if the driver is enabled.

e Accessing the top menu Help > Diagnosis, you can easily find it through the interface.

e Or, by accessing your Scriptcase installation path:

127.0.0.1/scriptcase/diagnosis.php Or domain.com/scriptcase/diagnosis.php

Creating a Connection with ScriptCase

Server sent charset unknown to the clientlf you are using MySQL 8, and your Scriptcase is using PHP 7.0 or 7.3, due to the PHP 7 bug, an error occurs when trying to
connect to the Scriptcase. Click here and see how to work around this error.

See below how to create a connection in your Scriptcase project using the MySQL database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the MySQL connection.

Connection

Enter the parameters for connecting to your MySQL database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the MySQL Driver used to connect. In this example, we use theMySQLi Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed.
o E.g. serverdomain.com Or 192.168.254.170

e Port: Inform the number port for your database server.
e Username: Inform the user to authenticate the connection to your MySQL database.
e Password: Enter the password to complete the authentication process.

« Database Name: Type your database name to connect with him. Or, if you want to choose one different database, click on the buttorList Database to show all databases
availabes for your user.
o Create Database: Clicking on this button, you will create a new MySQL database for use.
e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Security

On this tab you can set your SSL encryption for your database connection. Check below how to do this.

Use SSL : Activates or deactivates the use of secure connections with MySQL.

Client Key : Path to the client’s private identification key in the format PEM.

Client Certificate : Path to the client’s public certificate key.

CA Path : Path to the directory that contains the Certificate of Authority (CA) in the format PEM, if used, it should specify the same certificate used by the server.

CA Certificate : Path to the Certificate of Authority (AC) in the format PEM. This option, if used, should specify the same certificate as the server.

Specific Chipper : A list of permitted numbers to use with the cryptography of the connection. If one of the numbers is not supported, the SSL connection won't work.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show



It allows the MySQL connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.

e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

e Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with MySQL PDO

In Scriptcase, we have the following drivers available for connections with MySQL: MySQL PDO and MySQLi. If you are using your own pre-configured environment, MySQL
extensions must be manually installed with PHP.

Prerequisites

If you are using a manual installation on MacOS, you’ll need to install the PHP and the MySQL driver will be enabled. Clickere to see how to do it.
1 - Check if the MySQL driver is enabled in your Scriptcase diagnosis. See below on how to locate your diagnosis and check if the driver is enabled.

e Accessing the top menu Help > Diagnosis, you can easily find it through the interface.

e Or, by accessing your Scriptcase installation path:

127.0.0.1/scriptcase/diagnosis.php Or domain.com/scriptcase/diagnosis.php

Creating a Connection with ScriptCase

Server sent charset unknown to the clientlf you are using MySQL 8, and your Scriptcase is using PHP 7.0 or 7.3, due to the PHP 7 bug, an error occurs when trying to
connect to the Scriptcase. Click here and see how to work around this error.

See below how to create a connection in your Scriptcase project using the MySQL database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the MySQL connection.

Connection

Enter the parameters for connecting to your MySQL database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
e DBMS Driver: Select the MySQL Driver used to connect. In this example, we use theMySQL PDO Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed.
o E.g. serverdomain.com Or 192.168.254.170

e Port: Inform the number port for your database server.
e Username: Inform the user to authenticate the connection to your MySQL database.
e Password: Enter the password to complete the authentication process.

o Database Name: Type your database name to connect with him. Or, if you want to choose one different database, click on the buttorList Database to show all databases
availabes for your user.
o Create Database: Clicking on this button, you will create a new MySQL database for use.
e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Security

On this tab you can set your SSL encryption for your database connection. Check below how to do this.

Use SSL : Activates or deactivates the use of secure connections with MySQL.

Client Key : Path to the client’s private identification key in the format PEM.

Client Certificate : Path to the client’s public certificate key.

CA Path : Path to the directory that contains the Certificate of Authority (CA) in the format PEM, if used, it should specify the same certificate used by the server.

CA Certificate : Path to the Certificate of Authority (AC) in the format PEM. This option, if used, should specify the same certificate as the server.

Specific Chipper : A list of permitted numbers to use with the cryptography of the connection. If one of the numbers is not supported, the SSL connection won’t work.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the MySQL connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.



o By default, Scriptcase enables this option.
e Views: By selecting this option, the views of your database will be displayed.

o By default, Scriptcase enables this option.
e System Tables: By selecting this option, the system tables of your database will be displayed.
e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

e Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with MySQLi

In Scriptcase, we have the following drivers available for connections with MySQL: MySQL PDO and MySQLi. If you are using your own pre-configured environment, MySQL
extensions must be manually installed with PHP.

Prerequisites

If you are using a manual installation on MacOS, you’ll need to install the PHP and the MySQL driver will be enabled. Clickere to see how to do it.
1 - Check if the MySQL driver is enabled in your Scriptcase diagnosis. See below on how to locate your diagnosis and check if the driver is enabled.

e Accessing the top menu Help > Diagnosis, you can easily find it through the interface.

e Or, by accessing your Scriptcase installation path:

127.0.0.1/scriptcase/diagnosis.php Or domain.com/scriptcase/diagnosis.php

Creating a Connection with ScriptCase

Server sent charset unknown to the clientlf you are using MySQL 8, and your Scriptcase is using PHP 7.0 or 7.3, due to the PHP 7 bug, an error occurs when trying to
connect to the Scriptcase. Click here and see how to work around this error.

See below how to create a connection in your Scriptcase project using the MySQL database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the MySQL connection.

Connection

Enter the parameters for connecting to your MySQL database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
e DBMS Driver: Select the MySQL Driver used to connect. In this example, we use theMySQLi Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed.
o E.g. serverdomain.com Or 192.168.254.170

e Port: Inform the number port for your database server.
e Username: Inform the user to authenticate the connection to your MySQL database.
e Password: Enter the password to complete the authentication process.

o Database Name: Type your database name to connect with him. Or, if you want to choose one different database, click on the buttorList Database to show all databases
availabes for your user.
o Create Database: Clicking on this button, you will create a new MySQL database for use.
e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Security

On this tab you can set your SSL encryption for your database connection. Check below how to do this.

Use SSL : Activates or deactivates the use of secure connections with MySQL.

Client Key : Path to the client’s private identification key in the format PEM.

Client Certificate : Path to the client’s public certificate key.

CA Path : Path to the directory that contains the Certificate of Authority (CA) in the format PEM, if used, it should specify the same certificate used by the server.

CA Certificate : Path to the Certificate of Authority (AC) in the format PEM. This option, if used, should specify the same certificate as the server.

Specific Chipper : A list of permitted numbers to use with the cryptography of the connection. If one of the numbers is not supported, the SSL connection won’t work.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the MySQL connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.



o By default, Scriptcase enables this option.
e Views: By selecting this option, the views of your database will be displayed.

o By default, Scriptcase enables this option.
e System Tables: By selecting this option, the system tables of your database will be displayed.
e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

e Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Oracle with Scriptcase

In Scriptcase, we have several drivers for connecting to Oracle. You must choose the most suitable for your environment. It is recommended to use  Oracle PDO which is more faster, however it is up to you to choose the driver. Ifyou &
environment, Oracle extensions must be manually enabled in PHP.

You can check your enabled drivers by accessing your diagnosis. See below on how to locate your diagnosis and check if the driver is enabled.

®  ccessing the top menu Help > Diagnosis, you can easily find it through the interface.

© WebHelp

@® Technical Support

e 1, by accessing your browser url:

127.0.0.1:8092/scriptcase/diagnosis.php or domain.com/scriptcase/diagnosis.php

Automatic Installation

If the desired driver is already enabled and you just want to know how to connect with Scriptcase, click on the link below according to the driver that will be used.

Environment  Oracle PDO Oracle 8.0.5 ouAcima  Oracle ODBC Oracle 8

Windows See how to connect  See how to connect See how to connect  See how to connect
Linux See how to connect  See how to connect See how to connect ~ See how to connect
macOS See how to connect  See how to connect See how to connect  See how to connect

Manual Installation

If the driver you want to use is disabled, see how to enable each one. Click on the link below according to the driver to be used.

Environment  Oracle PDO Oracle 8.0.5 ouAcima  Oracle ODBC Oracle 8
Windows See how to connect  See how to connect See how to connect  See how to connect
Linux See how to connect  See how to connect See how to connect  See how to connect

macOS See how to connect  See how to connect See how to connect  See how to connect



Connecting with Oracle PDO

In Scriptcase, we have the following drivers available for connections with Oracle:Oracle PDO, Oracle 8.0.5 or Higher, Oracle ODBC and Oracle 8.f you are using your own
pre-configured environment, Oracle extensions must be manually enabled in PHP.

Prerequisites

Before proceeding with this documentation, check your PHP architecture. In order for the drivers to be enabled correctly the files must be downloaded according to the
architecture used.

e In Scriptcase, there is the info.php file, access it through the URL: http://127.0.0.1:8092/scriptcase/info.php, where you will find information regarding the architecture in phpinfo().

NOTE: If you are using Scriptcase’s automatic installer, the PHP architecture will be the same as the installer downloadedDownload the Oracle Instant Client
according to your PHP architecture.

e x86 Architecture = 32 bits
e x64 Architecture = 64 bits

Below are listed the files required for Oracle drivers to be enabled. If you installed the tool using Scripcase installer, it is not necessary to download thMicrosoft Visual C++
2017. For manual installations, you must download and install both versions of Microsoft Visual C ++ 2017.

Required Files:
x64

e Oracle Instant Client 19.6.0.0(x64): Click Here
e Microsoft Visual C++ 2017(x64): Click Here

x86

e Oracle Instant Client 19.6.0.0(x86): Click Here
e Microsoft Visual C++ 2017(x86): Click Here

WARNING: PHP 8.1 is compatible with Oracle Instant Client 11 or Higher.
To download Oracle Instant Client lower than version 19.6.0.0, you must have an Oracle Account.

Other Files

e Oracle Instant Client 18.5.0.0 or Lower: Click Here
Oracle PDO Driver Compatibility Table

Drive Oracle Database Version
11g R2(11.2)
Oracle PDO 9i 109 11g R1 12c 18c 19c

Version de base de datos

Instant Client
Oracle

) 11g R2(11.2)
19.6.0.0 9 10g 11g R1 12¢ 18c 19c

Configuring Oracle PDO on Windows

Scriptcase’s automatic installation comes with pre-configured Oracle drivers, just missinglnstant_Client to be configured to make the connection. Follow the steps described below
to enable the connection drivers.

1 - Extract the previously downloaded Instant Client Basic package to your computer’s root folder.
E.g.,
C:\instantclient_19_6
2 - Paste the DLLs listed below into the Scriptcase PHP folder C:\Program Files\NetMake\v9-php81\components\php:
e oci.dll
e oraocieil9.dll
e oraons.dll

3 - Add in the Path parameter of the Environment Variables the full path to thelnstant Client. Follow the steps below to perform this procedure:

e Go to Control Panel > System >Advanced System Settings.

e Click on the Advanced > Environment Variables tab.

e Under System Variables, Select the Path item and click Edit.

e Click the New button and add the path to the instant client as shown below:

4 - Restart the Apache service using theTask Manager.
e Open the Task Manager and click on theServices tab.

e Search for the ApacheScriptcase9php81 service and right click on this service, then Restart.



Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using thepreviously enabled Driver and the Oracle database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connection icon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Oracle connection.

Connection

Enter the parameters for connecting to your Oracle database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
e DBMS Driver: Select the Oracle Driver used to connect. In this example, we use theOracle PDO Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed along withService Name.
o E.g. serverdomain.com/XE Or 192.168.254.170/XE
o For more information about Oracle’s Service Name, click here.

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your Oracle database.
o For Oracle connections, the user must be capitalized, as in the example

e Password: Enter the password to complete the authentication process.

e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the Oracle connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the items Tables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.

e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your Oracle database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.



client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.
o By default, this option is left blank by Scriptcase.

Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with Oracle 8.0.5 or Higher

In Scriptcase, we have the following drivers available for connections with Oracle:Oracle PDO, Oracle 8.0.5 or Higher, Oracle ODBC and Oracle 8.f you are using your own
pre-configured environment, Oracle extensions must be manually enabled in PHP.

Prerequisites

Before proceeding with this documentation, check your PHP architecture. In order for the drivers to be enabled correctly the files must be downloaded according to the
architecture used.

e In Scriptcase, there is the info.php file, access it through the URL: http://127.0.0.1:8092/scriptcase/info.php, where you will find information regarding the architecture in phpinfo().

NOTE: If you are using Scriptcase’s automatic installer, the PHP architecture will be the same as the installer downloadedDownload the Oracle Instant Client
according to your PHP architecture.

e x86 Architecture = 32 bits
e x64 Architecture = 64 bits

Below are listed the files required for Oracle drivers to be enabled. If you installed the tool using Scripcase installer, it is not necessary to download thMicrosoft Visual C++
2017. For manual installations, you must download and install both versions of Microsoft Visual C ++ 2017.

Required Files:

x64

e Oracle Instant Client 19.6.0.0(x64): Click Here
e Microsoft Visual C++ 2017(x64): Click Here

x86

e Oracle Instant Client 19.6.0.0(x86): Click Here
e Microsoft Visual C++ 2017(x86): Click Here

WARNING: PHP 8.1 is compatible with Oracle Instant Client 11 or Higher.
To download Oracle Instant Client lower than version 19.6.0.0, you must have an Oracle Account.

Other Files

e Oracle Instant Client 18.5.0.0 or Lower: Click Here

Oracle 8.0.5 or Higher Driver Compatibility Table

Drive Oracle Database Version
Oracle 8.0.5 or ) 11g R2(11.2)
Higher 9i 10g 11gR1 12c 18c 19c

Version de base de datos

Instant Client
Oracle

. 11g R2(11.2)
19.6.0.0 9i 10g 11g R1 12¢ 18c 19c

Configuring Oracle 8.0.5 or Higher on Windows

Scriptcase’s automatic installation comes with pre-configured Oracle drivers, just missinglnstant_Client to be configured to make the connection. Follow the steps described below
to enable the connection drivers.

1 - Extract the previously downloaded Instant Client Basic package to your computer’s root folder.
E.g.,
C:\instantclient_19_6
2 - Paste the DLLs listed below into the Scriptcase PHP folder C:\Program Files\NetMake\v9-php81\components\php:
e oci.dll
e oraocieil9.dll
e oraons.dll

3 - Add in the Path parameter of the Environment Variables the full path to thelnstant Client. Follow the steps below to perform this procedure:

e Go to Control Panel > System >Advanced System Settings.

e Click on the Advanced > Environment Variables tab.

e Under System Variables, Select the Path item and click Edit.

e Click the New button and add the path to the instant client as shown below:

4 - Restart the Apache service using theTask Manager.
e Open the Task Manager and click on theServices tab.

e Search for the ApacheScriptcase9php81 service and right click on this service, then Restart.



Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using thepreviously enabled Driver and the Oracle database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connection icon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Oracle connection.

Connection

Enter the parameters for connecting to your Oracle database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
e DBMS Driver: Select the Oracle Driver used to connect. In this example, we use theOracle 8.0.5 or HigherDriver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed along withService Name.
o E.g. serverdomain.com/XE Or 192.168.254.170/XE
o For more information about Oracle’s Service Name, click here.

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your Oracle database.
o For Oracle connections, the user must be capitalized, as in the example

e Password: Enter the password to complete the authentication process.

e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the Oracle connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the items Tables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.

e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your Oracle database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.



client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.
o By default, this option is left blank by Scriptcase.

Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting withte Oracle ODBC

In Scriptcase, we have the following drivers available for connections with Oracle:Oracle PDO, Oracle 8.0.5 or Higher, Oracle ODBC and Oracle 8.f you are using your own
pre-configured environment, Oracle extensions must be manually enabled in PHP.

Prerequisites

Before proceeding with this documentation, check your PHP architecture. In order for the drivers to be enabled correctly the files must be downloaded according to the
architecture used.

e In Scriptcase, there is the info.php file, access it through the URL: http://127.0.0.1:8092/scriptcase/info.php, where you will find information regarding the architecture in phpinfo().

NOTE: If you are using Scriptcase’s automatic installer, the PHP architecture will be the same as the installer downloadedDownload the Oracle Instant Client
according to your PHP architecture.

e x86 Architecture = 32 bits
e x64 Architecture = 64 bits

Below are listed the files required for Oracle drivers to be enabled. If you installed the tool using Scripcase installer, it is not necessary to download thMicrosoft Visual C++
2017. For manual installations, you must download and install both versions of Microsoft Visual C ++ 2017.

Required Files:

x64
e Oracle Instant Client 19.6.0.0(x64): Click Here

e Oracle ODBC Package 19.6.0.0(x64): Click Here
e Microsoft Visual C++ 2017(x64): Click Here

x86
e Oracle Instant Client 19.6.0.0(x86): Click Here
e Oracle ODBC Package 19.6.0.0(x86): Click Here
e Microsoft Visual C++ 2017(x86): Click Here

WARNING: PHP 8.1 is compatible with Oracle Instant Client 11 or Higher.
To download Oracle Instant Client lower than version 19.6.0.0, you must have an Oracle Account.

Other Files
e Oracle Instant Client 18.5.0.0 or Below: Click Here

Oracle ODBC Driver Compatibility Table

Drive Oracle Database Version
Oracle 8.0.5 or ) 11g R2(11.2)
Higher 9i 10g 11gR1 12c 18c 19c

Version de base de datos

Instant Client
Oracle

. 11g R2(11.2)
19.6.0.0 9i 10g 11g R1 12¢ 18c 19c

Configuring Oracle ODBC on Windows

Scriptcase’s automatic installation comes with pre-configured Oracle drivers, just missinginstant_client and the ODBC package to be configured to make the connection. Follow
the steps described below to enable the connection drivers.

1 - Extract the previously downloaded Instant Client Basic package to your computer’s root folder.
E.g., C:instantclient_19_6
2 - Extract the previously downloaded ODBC package to the Instant Client folder on the root path of your computer.
3 - Run the odbc_install.exe file with administrator privileges for the driver to be installed on your system.
4 - Paste the DLLs listed below into the Scriptcase PHP folder C:\Program Files\NetMake\v9-php81\components\php:
e oci.dll
e oraocieil9.dll
e oraons.dll

5 - Add in the Path parameter of the Environment Variables the full path to thelnstant Client. Follow the steps below to perform this procedure:

e Go to Control Panel > System >Advanced System Settings.

e Click on the Advanced > Environment Variables tab.

e Under System Variables, Select the Path item and click Edit.

e Click the New button and add the path to the instant client as shown below:

6 - Restart the Apache service using theTask Manager.



e Open the Task Manager and click on theServices tab.

e Search for the ApacheScriptcase9php81 service and right click on this service, thenRestart.

Creating a System ODBC Data Source

Check below the entire step by step to create an ODBC data source to connect to Scriptcase.
NOTE: ODBC must be created on the same server where ScriptCase is installed.

1 - Access your ODBC Data Source Manager and select according to your architecture. We will be selecting thex64 version:

2 - When accessing the ODBC Data Sources Administrator, select the DSN System tab and click on Add to create your connection to your Oracle Database.

3 - After that, it is necessary to select the Driver to connect to Oracle. Select the Driver: Oracle in instantclient_19_5

4 - Now, enter the connection parameters as shown below:

Data Source Name: Define here the name of the ODBC object that will be used when connecting to Scriptcase.
Description: Write a definition for the Data Source, e.g., what is the purpose?.

TNS Service Name: Enter the server’s IP or domain here followed by the Oracle SERVICE NAME.

User ID: Inform the user that will be used in the connection for authentication.

5 - Test the connection to check if all parameters have been filled in correctly.

You will be asked to enter the password to connect.

6 - Click OK to complete this process.

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using thepreviously enabled Driver and the Oracle database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Oracle connection.

Connection

Enter the parameters for connecting to your Oracle database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the Oracle Driver used to connect. In this example, we use theOracle ODBC Driver.

e Server/Host (Name or IP): Enter the Data Source Name created in your ODBC manager.
o E.G. oracle

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your Oracle database.
o For Oracle connections, the user must be capitalized, as in the example

e Password: Enter the password to complete the authentication process.

e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the Oracle connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the items Tables and Views are already
selected by Scriptcase.



e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.

o By default, Scriptcase enables this option.

e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your Oracle database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.
o By default, this option is left blank by Scriptcase.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

e Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with Oracle 8

In Scriptcase, we have the following drivers available for connections with Oracle:Oracle PDO, Oracle 8.0.5 or Higher, Oracle ODBC and Oracle 8.f you are using your own
pre-configured environment, Oracle extensions must be manually enabled in PHP.

Prerequisites

Before proceeding with this documentation, check your PHP architecture. In order for the drivers to be enabled correctly the files must be downloaded according to the
architecture used.

e In Scriptcase, there is the info.php file, access it through the URL: http://127.0.0.1:8092/scriptcase/info.php, where you will find information regarding the architecture in phpinfo().

NOTE: If you are using Scriptcase’s automatic installer, the PHP architecture will be the same as the installer downloadedDownload the Oracle Instant Client
according to your PHP architecture.

e x86 Architecture = 32 bits
e x64 Architecture = 64 bits

Below are listed the files required for Oracle drivers to be enabled. If you installed the tool using Scripcase installer, it is not necessary to download thMicrosoft Visual C++
2017. For manual installations, you must download and install both versions of Microsoft Visual C ++ 2017.

Required Files:

x64

e Oracle Instant Client 19.6.0.0(x64): Click Here
e Microsoft Visual C++ 2017(x64): Click Here

x86

e Oracle Instant Client 19.6.0.0(x86): Click Here
e Microsoft Visual C++ 2017(x86): Click Here

WARNING: PHP 8.1 is compatible with Oracle Instant Client 11 or Higher.
To download Oracle Instant Client lower than version 19.6.0.0, you must have an Oracle Account.

Other Files

e Oracle Instant Client 18.5.0.0 or Lower: Click Here

Oracle 8 Driver Compatibility Table

Drive Oracle Database Version
Oracle 8.0.5 or ) 11g R2(11.2)
Higher 9i 10g 11gR1 12c 18c 19c

Version de base de datos

Instant Client
Oracle

. 11g R2(11.2)
19.6.0.0 9i 10g 11g R1 12¢ 18c 19c

Configuring Oracle 8 on Windows

Scriptcase’s automatic installation comes with pre-configured Oracle drivers, just missinglnstant_Client to be configured to make the connection. Follow the steps described below
to enable the connection drivers.

1 - Extract the previously downloaded Instant Client Basic package to your computer’s root folder.
E.g.,
C:\instantclient_19_6
2 - Paste the DLLs listed below into the Scriptcase PHP folder C:\Program Files\NetMake\v9-php81\components\php:
e oci.dll
e oraocieil9.dll
e oraons.dll

3 - Add in the Path parameter of the Environment Variables the full path to thelnstant Client. Follow the steps below to perform this procedure:

e Go to Control Panel > System >Advanced System Settings.

e Click on the Advanced > Environment Variables tab.

e Under System Variables, Select the Path item and click Edit.

e Click the New button and add the path to the instant client as shown below:

4 - Restart the Apache service using theTask Manager.
e Open the Task Manager and click on theServices tab.

e Search for the ApacheScriptcase9php81 service and right click on this service, then Restart.



Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using thepreviously enabled Driver and the Oracle database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connection icon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Oracle connection.

Connection

Enter the parameters for connecting to your Oracle database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
e DBMS Driver: Select the Oracle Driver used to connect. In this example, we use theOracle 8 Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed along withService Name.
o E.g. serverdomain.com/XE Or 192.168.254.170/XE
o For more information about Oracle’s Service Name, click here.

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your Oracle database.
o For Oracle connections, the user must be capitalized, as in the example

e Password: Enter the password to complete the authentication process.

e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the Oracle connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the items Tables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.

e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your Oracle database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.



client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.
o By default, this option is left blank by Scriptcase.

Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with Oracle PDO

In Scriptcase, we have the following drivers available for connections with Oracle:Oracle PDO, Oracle 8.0.5 or Higher, Oracle ODBC and Oracle 8.

Prerequisites

Before proceeding with this documentation, check your PHP architecture. In order for the drivers to be enabled correctly the files must be downloaded according to the
architecture used.

e In Scriptcase, there is the info.php file, access it through the URL: http://127.0.0.1/scriptcase/info.php, where you will find information regarding the architecture inphpinfo().

WARNING: Download the Oracle instant client according to your PHP architecture.

e x86 Architecture = 32 bits
e x64 Architecture = 64 bits

Below are listed the files required for Oracle drivers to be enabled.For manual installations, you must download and install both versions of Microsoft Visual C ++ 2017.
Required Files:
x64

e Oracle Instant Client 19.6.0.0(x64): Click Here
e Microsoft Visual C++ 2017(x64): Click Here

x86

e Oracle Instant Client 19.6.0.0(x86): Click Here
e Microsoft Visual C++ 2017(x86): Click Here

WARNING: PHP 7.3 is compatible with Oracle Instant Client 11 or Higher.
To download Oracle Instant Client lower than version 19.6.0.0, you must have anQOracle Account.

Other Files

e Oracle Instant Client 18.5.0.0 or Lower: Click Here
Oracle PDO Driver Compatibility Table

Drive Oracle Database Version
. 11g R2(11.2)
Oracle PDO 9i 109 11g R1 12c 18c 19c

Version de base de datos

Instant Client
nstant Clien Oracle

11g R2(11.2)
19.6.0.0 9i 109 11gR1 12c 18c 19c

Configuring Oracle PDO on Windows

It is necessary to enable the extension in PHP and configure instant_client to make the connection. Follow the steps described below to enable the connection drivers.

1 - In the php.ini file, located in C:\php, uncomment the lines referring to the oracle extensionsoci8_12c and pdo_oci removing the; from the beginning of the line. See the example
below:

2 - Extract the previously downloaded Instant Client Basic package to your computer’s root folder.
E.g.,
C:\instantclient_19_6
3 - Paste the DLLs listed below into the Scriptcase PHP folder C:\php:
e oci.dll
e oraocieil9.dll
e oraons.dll

4 - Add in the Path parameter of the Environment Variables the full path to thelnstant Client. Follow the steps below to perform this procedure:

e Go to Control Panel > System >Advanced System Settings.

e Click on the Advanced > Environment Variables tab.

e Under System Variables, Select the Path item and click Edit.

e Click the New button and add the path to the instant client as shown below:

5 - Restart the Apache service using theTask Manager.
e Open the Task Manager and click on theServices tab.

e Search for the Apache2.4 service and right click on this service, thenRestart.



Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using thepreviously enabled Driver and the Oracle database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connection icon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Oracle connection.

Connection

Enter the parameters for connecting to your Oracle database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
e DBMS Driver: Select the Oracle Driver used to connect. In this example, we use theOracle PDO Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed along withService Name.
o E.g. serverdomain.com/XE Or 192.168.254.170/XE
o For more information about Oracle’s Service Name, click here.

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your Oracle database.
o For Oracle connections, the user must be capitalized, as in the example

e Password: Enter the password to complete the authentication process.

e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the Oracle connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the items Tables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.

e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your Oracle database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.



client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.
o By default, this option is left blank by Scriptcase.

Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with Oracle 8.0.5 or Higher

In Scriptcase, we have the following drivers available for connections with Oracle:Oracle PDO, Oracle 8.0.5 or Higher, Oracle ODBC and Oracle 8.

Prerequisites

Before proceeding with this documentation, check your PHP architecture. In order for the drivers to be enabled correctly the files must be downloaded according to the
architecture used.

e In Scriptcase, there is the info.php file, access it through the URL: http://127.0.0.1/scriptcase/info.php, where you will find information regarding the architecture inphpinfo().

WARNING: Download the Oracle instant client according to your PHP architecture.

e x86 Architecture = 32 bits
e x64 Architecture = 64 bits

Below are listed the files required for Oracle drivers to be enabled.For manual installations, you must download and install both versions of Microsoft Visual C ++ 2017.
Required Files:
x64

e Oracle Instant Client 19.6.0.0(x64): Click Here
e Microsoft Visual C++ 2017(x64): Click Here

x86

e Oracle Instant Client 19.6.0.0(x86): Click Here
e Microsoft Visual C++ 2017(x86): Click Here

WARNING: PHP 7.3 is compatible with Oracle Instant Client 11 or Higher.
To download Oracle Instant Client lower than version 19.6.0.0, you must have anQOracle Account.

Other Files

e Oracle Instant Client 18.5.0.0 or Lower: Click Here

Oracle 8.0.5 or Higher Driver Compatibility Table

Drive Oracle Database Version
Oracle 8.0.5 or ) 11g R2(11.2)
Higher 9i 109 11gR1 12c 18¢c 19¢

Version de base de datos

Instant Client
nstant Clien oracle

11g R2(11.2)
19.6.0.0 9i 109 11gR1 12c 18c 19c

Configuring Oracle 8.0.5 or Higher on Windows
It is necessary to enable the extension in PHP and configure instant_client to make the connection. Follow the steps described below to enable the connection drivers.

1 - In the php.ini file, located in C:\php, uncomment the lines referring to the oracle extensionsoci8_12c and pdo_oci removing the; from the beginning of the line. See the example
below:

2 - Extract the previously downloaded Instant Client Basic package to your computer’s root folder.
E.g.,
C:\instantclient_19_6
3 - Paste the DLLs listed below into the Scriptcase PHP folder C:\php:
e oci.dll
e oraocieil9.dll
e oraons.dll

4 - Add in the Path parameter of the Environment Variables the full path to thelnstant Client. Follow the steps below to perform this procedure:

e Go to Control Panel > System >Advanced System Settings.

e Click on the Advanced > Environment Variables tab.

e Under System Variables, Select the Path item and click Edit.

e Click the New button and add the path to the instant client as shown below:

5 - Restart the Apache service using theTask Manager.
e Open the Task Manager and click on theServices tab.

e Search for the Apache2.4 service and right click on this service, thenRestart.



Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using thepreviously enabled Driver and the Oracle database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connection icon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Oracle connection.

Connection

Enter the parameters for connecting to your Oracle database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
e DBMS Driver: Select the Oracle Driver used to connect. In this example, we use theOracle 8.0.5 or HigherDriver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed along withService Name.
o E.g. serverdomain.com/XE Or 192.168.254.170/XE
o For more information about Oracle’s Service Name, click here.

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your Oracle database.
o For Oracle connections, the user must be capitalized, as in the example

e Password: Enter the password to complete the authentication process.

e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the Oracle connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the items Tables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.

e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your Oracle database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.



client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.
o By default, this option is left blank by Scriptcase.

Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with Oracle ODBC

In Scriptcase, we have the following drivers available for connections with Oracle:Oracle PDO, Oracle 8.0.5 or Higher, Oracle ODBC and Oracle 8.

Prerequisites

Before proceeding with this documentation, check your PHP architecture. In order for the drivers to be enabled correctly the files must be downloaded according to the

architecture used.

e In Scriptcase, there is the info.php file, access it through the URL: http://127.0.0.1/scriptcase/info.php, where you will find information regarding the architecture inphpinfo().

WARNING: Download the Oracle instant client according to your PHP architecture.

e x86 Architecture = 32 bits
e x64 Architecture = 64 bits

For manual installations, you must download and install both versions of Microsoft Visual C ++ 2017.
Required Files:
x64
e Oracle Instant Client 19.6.0.0(x64): Click Here
e Oracle ODBC Package 19.6.0.0(x64): Click Here
e Microsoft Visual C++ 2017(x64): Click Here
x86
e Oracle Instant Client 19.6.0.0(x86): Click Here

e Oracle ODBC Package 19.6.0.0(x86): Click Here
e Microsoft Visual C++ 2017(x86): Click Here

WARNING: PHP 7.3 is compatible with Oracle Instant Client 11 or Higher.
To download Oracle Instant Client lower than version 19.6.0.0, you must have anQOracle Account.

Other Files
e Oracle Instant Client 18.5.0.0 or Lower: Click Here

Oracle ODBC Driver Compatibility Table

Drive Oracle Database Version
Oracle 8.0.5 or ) 11g R2(11.2)
Higher 9i 109 11gR1 12c

Version de base de datos

Instant Client
nstant Clien oracle

11g R2(11.2)
19.6.0.0 9i 109 11gR1 12c

Configuring Oracle ODBC on Windows

18c 19c

18c 19c

It is necessary to enable the extension in PHP and configure instant_client to make the connection. Follow the steps described below to enable the connection drivers.

1 - In the php.ini file, located in C:\php, uncomment the lines referring to the oracle extensionsoci8_12c and pdo_oci removing the; from the beginning of the line. See the example

below:

2 - Extract the previously downloaded Instant Client Basic package to your computer’s root folder.
E.g., C:instantclient_19_6
3 - Paste the DLLs listed below into the Scriptcase PHP folder C:\php:

e oci.dll
e oraocieil9.dll
e oraons.dll

4 - Add in the Path parameter of the Environment Variables the full path to thelnstant Client. Follow the steps below to perform this procedure:

e Go to Control Panel > System >Advanced System Settings.

e Click on the Advanced > Environment Variables tab.

e Under System Variables, Select the Path item and click Edit.

e Click the New button and add the path to the instant client as shown below:

5 - Restart the Apache service using theTask Manager.
e Open the Task Manager and click on theServices tab.

e Search for the Apache2.4 service and right click on this service, thenRestart.



Creating a System ODBC Data Source

Check below the entire step by step to create an ODBC data source to connect to Scriptcase.
NOTE: ODBC must be created on the same server where ScriptCase is installed.

1 - Access your ODBC Data Source Manager and select according to your architecture. We will be selecting thex64 version:

2 - When accessing the ODBC Data Sources Administrator, select the DSN System tab and click on Add to create your connection to your Oracle Database.

3 - After that, it is necessary to select the Driver to connect to Oracle. Select the Driver: Oracle in instantclient_19_5

4 - Now, enter the connection parameters as shown below:

Data Source Name: Define here the name of the ODBC object that will be used when connecting to Scriptcase.
Description: Write a definition for the Data Source, e.g., what is the purpose?.

TNS Service Name: Enter the server’s IP or domain here followed by the Oracle SERVICE NAME.

User ID: Inform the user that will be used in the connection for authentication.

5 - Test the connection to check if all parameters have been filled in correctly.

You will be asked to enter the password to connect.

6 - Click OK to complete this process.

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using thepreviously enabled Driver and the Oracle database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Oracle connection.

Connection

Enter the parameters for connecting to your Oracle database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
e DBMS Driver: Select the Oracle Driver used to connect. In this example, we use theOracle ODBC Driver.

e Server/Host (Name or IP): Enter the Data Source Name created in your ODBC manager.
o E.G. oracle

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your Oracle database.
o For Oracle connections, the user must be capitalized, as in the example

e Password: Enter the password to complete the authentication process.

e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the Oracle connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the items Tables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.



e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.
e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your Oracle database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.
o By default, this option is left blank by Scriptcase.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

e Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with Oracle 8

In Scriptcase, we have the following drivers available for connections with Oracle:Oracle PDO, Oracle 8.0.5 or Higher, Oracle ODBC and Oracle 8.

Prerequisites

Before proceeding with this documentation, check your PHP architecture. In order for the drivers to be enabled correctly the files must be downloaded according to the
architecture used.

e In Scriptcase, there is the info.php file, access it through the URL: http://127.0.0.1/scriptcase/info.php, where you will find information regarding the architecture inphpinfo().

WARNING: Download the Oracle instant client according to your PHP architecture.

e x86 Architecture = 32 bits
e x64 Architecture = 64 bits

Below are listed the files required for Oracle drivers to be enabled.For manual installations, you must download and install both versions of Microsoft Visual C ++ 2017.
Required Files:
x64

e Oracle Instant Client 19.6.0.0(x64): Click Here
e Microsoft Visual C++ 2017(x64): Click Here

x86

e Oracle Instant Client 19.6.0.0(x86): Click Here
e Microsoft Visual C++ 2017(x86): Click Here

WARNING: PHP 7.3 is compatible with Oracle Instant Client 11 or Higher.
To download Oracle Instant Client lower than version 19.6.0.0, you must have anQOracle Account.

Other Files

e Oracle Instant Client 18.5.0.0 or Lower: Click Here

Oracle 8 Driver Compatibility Table

Drive Oracle Database Version
Oracle 8.0.5 or ) 11g R2(11.2)
Higher 9i 109 11gR1 12c 18¢c 19¢

Version de base de datos

Instant Client
nstant Clien oracle

11g R2(11.2)
19.6.0.0 9i 109 11gR1 12c 18c 19c

Configuring Oracle 8 on Windows

It is necessary to enable the extension in PHP and configure instant_client to make the connection. Follow the steps described below to enable the connection drivers.

1 - In the php.ini file, located in C:\php, uncomment the lines referring to the oracle extensionsoci8_12c and pdo_oci removing the; from the beginning of the line. See the example
below:

2 - Extract the previously downloaded Instant Client Basic package to your computer’s root folder.
E.g.,
C:\instantclient_19_6
3 - Paste the DLLs listed below into the Scriptcase PHP folder C:\php:
e oci.dll
e oraocieil9.dll
e oraons.dll

4 - Add in the Path parameter of the Environment Variables the full path to thelnstant Client. Follow the steps below to perform this procedure:

e Go to Control Panel > System >Advanced System Settings.

e Click on the Advanced > Environment Variables tab.

e Under System Variables, Select the Path item and click Edit.

e Click the New button and add the path to the instant client as shown below:

5 - Restart the Apache service using theTask Manager.
e Open the Task Manager and click on theServices tab.

e Search for the Apache2.4 service and right click on this service, thenRestart.



Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using thepreviously enabled Driver and the Oracle database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connection icon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Oracle connection.

Connection

Enter the parameters for connecting to your Oracle database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
e DBMS Driver: Select the Oracle Driver used to connect. In this example, we use theOracle 8 Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed along withService Name.
o E.g. serverdomain.com/XE Or 192.168.254.170/XE
o For more information about Oracle’s Service Name, click here.

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your Oracle database.
o For Oracle connections, the user must be capitalized, as in the example

e Password: Enter the password to complete the authentication process.

e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the Oracle connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the items Tables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.

e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your Oracle database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.



client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.
o By default, this option is left blank by Scriptcase.

Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with Oracle PDO

In Scriptcase, we have the following drivers available for connections with Oracle:Oracle PDO, Oracle 8.0.5 or Higher, Oracle ODBC and Oracle 8.f you are using your own
pre-configured environment, Oracle extensions must be manually enabled in PHP.

Prerequisites

Before proceeding with this documentation, check your PHP architecture. In order for the drivers to be enabled correctly the files must be downloaded according to the
architecture used.

e In Scriptcase, there is the info.php file, access it through the URL: http://127.0.0.1:8092/scriptcase/info.php, where you will find information regarding the architecture in phpinfo().

NOTE: If you are using Scriptcase’s automatic installer, the PHP architecture will be the same as the installer downloadedDownload the Oracle Instant Client
according to your PHP architecture.

e i386/i686 Architecture = 32 bits
e x86_64 Architecture = 64 bits

Below are listed the files required for Oracle drivers to be enabled.
Required Files:
x86_64

e Oracle Instant Client - Basic Package 12.1.0.2(x86_64): Click Here
e Oracle Instant Client - Devel Package 12.1.0.2(x86_64): Click Here

i386/i686

e Oracle Instant Client - Basic Package 12.1.0.2(i386/i686): Click Here
e Oracle Instant Client - Devel Package 12.1.0.2(i386/i686): Click Here

WARNING: PHP 7.3 is compatible with Oracle Instant Client 11.2 or Higher.
To download Oracle Instant Client lower than version 19, you must have anOracle Account

Other Files
e Oracle Instant Client 12.2.0 or Higher: Click Here
Oracle PDO Driver Compatibility Table

Drive Oracle Database Version

. 11g R2(11.2)
Oracle PDO 9i 109 11g R1 12c 18c 19c

Version de base de datos

Instant Client
nstant Clien Oracle

11g R2(11.2)
19.6.0.0 9i 109 11gR1 12c 18c 19c

Configuring Oracle PDO on Linux

Scriptcase’s automatic installation comes with pre-configured Oracle drivers, just missinglnstant_Client to be configured to make the connection. Follow the steps described below
to enable the connection drivers.

1 - Install the packages below:

UBUNTU\DEBIAN CENTOS\RHEL
sudo apt-get update sudo yum update
sudo apt-get install libaiol sudo yum install libaio-devel
sudo apt-get install libncurses5 sudo yum install libaio
sudo apt-get install alien sudo yum install glibc

sudo apt-get install gcc-multilib g++-multilib sudo yum install compat-libstdc++-33
sudo apt-get install libpamOg sudo yum install glibc-devel
sudo apt-get install unixodbc-dev unixodbc  sudo yum install libstdc++

sudo yum install libstdc++

sudo yum install pam

sudo yum install ncurses-devel

sudo yum install unixODBC
2 - Convert and install the previously downloaded Instant Client Basic packages on your Linux system:

UBUNTU\DEBIAN CENTOS\RHEL
sudo alien oracle-instantclient12.1-devel-12.1.0.2.0-1.x86_64.rpm  sudo yum install oracle-instantclient12.1-basic-12.1.0.2.0-1.x86_64.rpm
sudo alien oracle-instantclient12.1-basic-12.1.0.2.0-1.x86_64.rpm  sudo yum install oracle-instantclient12.1-devel-12.1.0.2.0-1.x86_64.rpm
sudo dpkg -i oracle-instantclient12.1-basic_12.1.0.2.0-2_amd64.deb
sudo dpkg -i oracle-instantclient12.1-devel_12.1.0.2.0-2_amd64.deb

3 - Edit the environment variable file and declare the variable responsible for identifying the Oracle library:

Enter the variable LD_LIBRARY_PATH and the path to the library in the file responsible for your system’s environment variables. Check the path below according to your operating
system:

WARNING: The path to the library may depend on your installation, by default the path is this:/usr/lib/oracle/12.1/client64/lib/.

UBUNTU\DEBIAN CENTOS\RHEL

sudo nano /etc/apache2/envvars sudo nano /etc/sysconfig/httpd



UBUNTU\DEBIAN CENTOS\RHEL
e Add this variable at the end of the file with the following syntax:

export LD_LIBRARY_PATH=/usr/lib/oracle/12.1/client64/lib/

NOTE: If you are using CentOS/RHEL, it is not necessary to use ‘export’ before the variable.
4 - Restart the Scriptcase apache service for the changes to take effect. Use the commands below according to your operating system.
UBUNTU\DEBIAN CENTOS\RHEL

sudo service apachesc9php73 restart sudo systemctl restart apachesc9php73

Creating a Connection in Scriptcase
See below how to create a connection in your Scriptcase project, using the previously enabled Driver and the Oracle database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connection icon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Oracle connection.

Connection

Enter the parameters for connecting to your Oracle database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the Oracle Driver used to connect. In this example, we use theOracle PDO Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed along withService Name.
o E.g. serverdomain.com/XE Or 192.168.254.170/XE
o For more information about Oracle’s Service Name, click here.

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your Oracle database.
o For Oracle connections, the user must be capitalized, as in the example
e Password: Enter the password to complete the authentication process.

e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the Oracle connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the items Tables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.
e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.

e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.
o By default, Scriptcase leaves this option empty.
o E.g.



e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your Oracle database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.
o By default, this option is left blank by Scriptcase.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

e Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with Oracle 8.0.5 or Higher

In Scriptcase, we have the following drivers available for connections with Oracle:Oracle PDO, Oracle 8.0.5 or Higher, Oracle ODBC and Oracle 8.f you are using your own
pre-configured environment, Oracle extensions must be manually enabled in PHP.

Prerequisites

Before proceeding with this documentation, check your PHP architecture. In order for the drivers to be enabled correctly the files must be downloaded according to the
architecture used.

e In Scriptcase, there is the info.php file, access it through the URL: http://127.0.0.1:8092/scriptcase/info.php, where you will find information regarding the architecture in phpinfo().

NOTE: If you are using Scriptcase’s automatic installer, the PHP architecture will be the same as the installer downloadedDownload the Oracle Instant Client
according to your PHP architecture.

e i386/i686 Architecture = 32 bits
e x86_64 Architecture = 64 bits

Below are listed the files required for Oracle drivers to be enabled.
Required Files:
x86_64

e Oracle Instant Client - Basic Package 12.1.0.2(x86_64): Click Here
e Oracle Instant Client - Devel Package 12.1.0.2(x86_64): Click Here

i386/i686

e Oracle Instant Client - Basic Package 12.1.0.2(i386/i686): Click Here
e Oracle Instant Client - Devel Package 12.1.0.2(i386/i686): Click Here

WARNING: PHP 7.3 is compatible with Oracle Instant Client 11.2 or Higher.
To download Oracle Instant Client lower than version 19, you must have anOracle Account

Other Files
e Oracle Instant Client 12.2.0 or Higher: Click Here

Oracle 8.0.5 or Higher Driver Compatibility Table

Drive Oracle Database Version
Oracle 8.0.5 or ) 11g R2(11.2)
Higher 9i 109 11gR1 12c 18¢c 19¢

Version de base de datos

Instant Client
nstant Clien oracle

11g R2(11.2)
19.6.0.0 9i 109 11gR1 12c 18c 19c

Configuring Oracle 8.0.5 or Higher on Linux

Scriptcase’s automatic installation comes with pre-configured Oracle drivers, just missinglnstant_Client to be configured to make the connection. Follow the steps described below
to enable the connection drivers.

1 - Install the packages below:

UBUNTU\DEBIAN CENTOS\RHEL
sudo apt-get update sudo yum update
sudo apt-get install libaiol sudo yum install libaio-devel
sudo apt-get install libncurses5 sudo yum install libaio
sudo apt-get install alien sudo yum install glibc

sudo apt-get install gcc-multilib g++-multilib sudo yum install compat-libstdc++-33
sudo apt-get install libpamOg sudo yum install glibc-devel
sudo apt-get install unixodbc-dev unixodbc  sudo yum install libstdc++

sudo yum install libstdc++

sudo yum install pam

sudo yum install ncurses-devel

sudo yum install unixODBC
2 - Convert and install the previously downloaded Instant Client Basic packages on your Linux system:

UBUNTU\DEBIAN CENTOS\RHEL
sudo alien oracle-instantclient12.1-devel-12.1.0.2.0-1.x86_64.rpm  sudo yum install oracle-instantclient12.1-basic-12.1.0.2.0-1.x86_64.rpm
sudo alien oracle-instantclient12.1-basic-12.1.0.2.0-1.x86_64.rpm  sudo yum install oracle-instantclient12.1-devel-12.1.0.2.0-1.x86_64.rpm
sudo dpkg -i oracle-instantclient12.1-basic_12.1.0.2.0-2_amd64.deb
sudo dpkg -i oracle-instantclient12.1-devel_12.1.0.2.0-2_amd64.deb

3 - Edit the environment variable file and declare the variable responsible for identifying the Oracle library:

Enter the variable LD_LIBRARY_PATH and the path to the library in the file responsible for your system’s environment variables. Check the path below according to your operating
system:

WARNING: The path to the library may depend on your installation, by default the path is this:/usr/lib/oracle/12.1/client64/lib/.

UBUNTU\DEBIAN CENTOS\RHEL

sudo nano /etc/apache2/envvars sudo nano /etc/sysconfig/httpd



UBUNTU\DEBIAN CENTOS\RHEL
e Add this variable at the end of the file with the following syntax:

export LD_LIBRARY_PATH=/usr/lib/oracle/12.1/client64/lib/

NOTE: If you are using CentOS/RHEL, it is not necessary to use ‘export’ before the variable.
4 - Restart the Scriptcase apache service for the changes to take effect. Use the commands below according to your operating system.
UBUNTU\DEBIAN CENTOS\RHEL

sudo service apachesc9php73 restart sudo systemctl restart apachesc9php73

Creating a Connection in Scriptcase
See below how to create a connection in your Scriptcase project, using the previously enabled Driver and the Oracle database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connection icon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Oracle connection.

Connection

Enter the parameters for connecting to your Oracle database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the Oracle Driver used to connect. In this example, we use theOracle 8.0.5 or Higher Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed along withService Name.
o E.g. serverdomain.com/XE Or 192.168.254.170/XE
o For more information about Oracle’s Service Name, click here.

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your Oracle database.
o For Oracle connections, the user must be capitalized, as in the example
e Password: Enter the password to complete the authentication process.

e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the Oracle connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the items Tables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.
e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.

e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.
o By default, Scriptcase leaves this option empty.
o E.g.



e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your Oracle database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.
o By default, this option is left blank by Scriptcase.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

e Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with Oracle ODBC

In Scriptcase, we have the following drivers available for connections with Oracle:Oracle PDO, Oracle 8.0.5 or Higher, Oracle ODBC and Oracle 8.f you are using your own
pre-configured environment, Oracle extensions must be manually enabled in PHP.

Prerequisites

Before proceeding with this documentation, check your PHP architecture. In order for the drivers to be enabled correctly the files must be downloaded according to the
architecture used.

e In Scriptcase, there is the info.php file, access it through the URL: http://127.0.0.1:8092/scriptcase/info.php, where you will find information regarding the architecture in phpinfo().

NOTE: If you are using Scriptcase’s automatic installer, the PHP architecture will be the same as the installer downloadedDownload the Oracle Instant Client
according to your PHP architecture.

e i386/i686 Architecture = 32 bits
e x86_64 Architecture = 64 bits

Below are listed the files required for Oracle drivers to be enabled.
Required Files:

x86_64
e Oracle Instant Client - Basic Package 12.1.0.2(x86_64): Click Here

e Oracle Instant Client - Devel Package 12.1.0.2(x86_64): Click Here
e Oracle Instant Client - ODBC Package 12.1.0.2(x86_64): Clique Aqui

i386/i686
e Oracle Instant Client - Basic Package 12.1.0.2(i386/i686): Click Here
e Oracle Instant Client - Devel Package 12.1.0.2(i386/i686): Click Here
e Oracle Instant Client - ODBC Package 12.1.0.2(i386/i686): Clique Aqui

WARNING: PHP 7.3 is compatible with Oracle Instant Client 11.2 or Higher.
To download Oracle Instant Client lower than version 19, you must have anQOracle Account.

Other Files

e Oracle Instant Client 12.2.0 or Higher: Click Here

Oracle ODBC Driver Compatibility Table

Drive Oracle Database Version
Oracle 8.0.5 or ) 11g R2(11.2)
Higher 9i 109 11gR1 12c 18¢c 19¢

Versién de base de datos

Instant Client
nstant Clien oracle

11g R2(11.2)
19.6.0.0 9i 109 11gR1 12c 18c 19c

Configuring Oracle ODBC on Linux

Scriptcase’s automatic installation comes with pre-configured Oracle drivers, just missinglnstant_Client to be configured to make the connection. Follow the steps described below
to enable the connection drivers.

1 - Install the packages below:

UBUNTU\DEBIAN CENTOS\RHEL
sudo apt-get update sudo yum update
sudo apt-get install libaiol sudo yum install libaio-devel
sudo apt-get install libncurses5 sudo yum install libaio
sudo apt-get install alien sudo yum install glibc

sudo apt-get install gcc-multilib g++-multilib sudo yum install compat-libstdc++-33
sudo apt-get install libpamOg sudo yum install glibc-devel
sudo apt-get install unixodbc-dev unixodbc  sudo yum install libstdc++

sudo yum install libstdc++

sudo yum install pam

sudo yum install ncurses-devel

sudo yum install unixODBC
2 - Convert and install the previously downloaded Instant Client Basic packages on your Linux system:

UBUNTU\DEBIAN CENTOS\RHEL
sudo alien oracle-instantclient12.1-devel-12.1.0.2.0-1.x86_64.rpm  sudo yum install oracle-instantclient12.1-basic-12.1.0.2.0-1.x86_64.rpm
sudo alien oracle-instantclient12.1-basic-12.1.0.2.0-1.x86_64.rpm  sudo yum install oracle-instantclient12.1-devel-12.1.0.2.0-1.x86_64.rpm
sudo dpkg -i oracle-instantclient12.1-basic_12.1.0.2.0-2_amd64.deb
sudo dpkg -i oracle-instantclient12.1-devel_12.1.0.2.0-2_amd64.deb

3 - Edit the environment variable file and declare the variable responsible for identifying the Oracle library:

Enter the variable LD_LIBRARY_PATH and the path to the library in the file responsible for your system’s environment variables. Check the path below according to your operating
system:

WARNING: The path to the library may depend on your installation, by default the path is this:/usr/lib/oracle/12.1/client64/lib/.



UBUNTU\DEBIAN CENTOS\RHEL

sudo nano /etc/apache2/envvars sudo nano /etc/sysconfig/httpd
e Add this variable at the end of the file with the following syntax:
export LD_LIBRARY_PATH=/usr/lib/oracle/12.1/client64/lib/

NOTE: If you are using CentOS/RHEL, it is not necessary to use ‘export’ before the variable.
4 - Restart the Scriptcase apache service for the changes to take effect. Use the commands below according to your operating system.
UBUNTU\DEBIAN CENTOS\RHEL

sudo service apachesc9php73 restart sudo systemctl restart apachesc9php73

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using the previously enabled Driver and the Oracle database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Oracle connection.

Connection

Enter the parameters for connecting to your Oracle database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the Oracle Driver used to connect. In this example, we use theOracle ODBC Driver.

e Server/Host (Name or IP): Enter the Data Source Name created in your ODBC manager.
o E.G. oracle

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your Oracle database.
o For Oracle connections, the user must be capitalized, as in the example
e Password: Enter the password to complete the authentication process.

e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the Oracle connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the items Tables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.
e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.

e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.
o By default, Scriptcase leaves this option empty.
o E.g.



e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your Oracle database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.
o By default, this option is left blank by Scriptcase.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

e Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with Oracle 8

In Scriptcase, we have the following drivers available for connections with Oracle:Oracle PDO, Oracle 8.0.5 or Higher, Oracle ODBC and Oracle 8.f you are using your own
pre-configured environment, Oracle extensions must be manually enabled in PHP.

Prerequisites

Before proceeding with this documentation, check your PHP architecture. In order for the drivers to be enabled correctly the files must be downloaded according to the
architecture used.

e In Scriptcase, there is the info.php file, access it through the URL: http://127.0.0.1:8092/scriptcase/info.php, where you will find information regarding the architecture in phpinfo().

NOTE: If you are using Scriptcase’s automatic installer, the PHP architecture will be the same as the installer downloadedDownload the Oracle Instant Client
according to your PHP architecture.

e i386/i686 Architecture = 32 bits
e x86_64 Architecture = 64 bits

Below are listed the files required for Oracle drivers to be enabled.
Required Files:
x86_64

e Oracle Instant Client - Basic Package 12.1.0.2(x86_64): Click Here
e Oracle Instant Client - Devel Package 12.1.0.2(x86_64): Click Here

i386/i686

e Oracle Instant Client - Basic Package 12.1.0.2(i386/i686): Click Here
e Oracle Instant Client - Devel Package 12.1.0.2(i386/i686): Click Here

WARNING: PHP 7.3 is compatible with Oracle Instant Client 11.2 or Higher.
To download Oracle Instant Client lower than version 19, you must have anOracle Account

Other Files
e Oracle Instant Client 12.2.0 or Higher: Click Here

Oracle 8 Driver Compatibility Table

Drive Oracle Database Version
Oracle 8.0.5 or ) 11g R2(11.2)
Higher 9i 109 11gR1 12c 18¢c 19¢

Version de base de datos

Instant Client
nstant Clien oracle

11g R2(11.2)
19.6.0.0 9i 109 11gR1 12c 18c 19c

Configuring Oracle 8 on Linux

Scriptcase’s automatic installation comes with pre-configured Oracle drivers, just missinglnstant_Client to be configured to make the connection. Follow the steps described below
to enable the connection drivers.

1 - Install the packages below:

UBUNTU\DEBIAN CENTOS\RHEL
sudo apt-get update sudo yum update
sudo apt-get install libaiol sudo yum install libaio-devel
sudo apt-get install libncurses5 sudo yum install libaio
sudo apt-get install alien sudo yum install glibc

sudo apt-get install gcc-multilib g++-multilib sudo yum install compat-libstdc++-33
sudo apt-get install libpamOg sudo yum install glibc-devel
sudo apt-get install unixodbc-dev unixodbc  sudo yum install libstdc++

sudo yum install libstdc++

sudo yum install pam

sudo yum install ncurses-devel

sudo yum install unixODBC
2 - Convert and install the previously downloaded Instant Client Basic packages on your Linux system:

UBUNTU\DEBIAN CENTOS\RHEL
sudo alien oracle-instantclient12.1-devel-12.1.0.2.0-1.x86_64.rpm  sudo yum install oracle-instantclient12.1-basic-12.1.0.2.0-1.x86_64.rpm
sudo alien oracle-instantclient12.1-basic-12.1.0.2.0-1.x86_64.rpm  sudo yum install oracle-instantclient12.1-devel-12.1.0.2.0-1.x86_64.rpm
sudo dpkg -i oracle-instantclient12.1-basic_12.1.0.2.0-2_amd64.deb
sudo dpkg -i oracle-instantclient12.1-devel_12.1.0.2.0-2_amd64.deb

3 - Edit the environment variable file and declare the variable responsible for identifying the Oracle library:

Enter the variable LD_LIBRARY_PATH and the path to the library in the file responsible for your system’s environment variables. Check the path below according to your operating
system:

WARNING: The path to the library may depend on your installation, by default the path is this:/usr/lib/oracle/12.1/client64/lib/.

UBUNTU\DEBIAN CENTOS\RHEL

sudo nano /etc/apache2/envvars sudo nano /etc/sysconfig/httpd



UBUNTU\DEBIAN CENTOS\RHEL
e Add this variable at the end of the file with the following syntax:

export LD_LIBRARY_PATH=/usr/lib/oracle/12.1/client64/lib/

NOTE: If you are using CentOS/RHEL, it is not necessary to use ‘export’ before the variable.
4 - Restart the Scriptcase apache service for the changes to take effect. Use the commands below according to your operating system.
UBUNTU\DEBIAN CENTOS\RHEL

sudo service apachesc9php73 restart sudo systemctl restart apachesc9php73

Creating a Connection in Scriptcase
See below how to create a connection in your Scriptcase project, using the previously enabled Driver and the Oracle database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connection icon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Oracle connection.

Connection

Enter the parameters for connecting to your Oracle database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the Oracle Driver used to connect. In this example, we use theOracle 8 Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed along withService Name.
o E.g. serverdomain.com/XE Or 192.168.254.170/XE
o For more information about Oracle’s Service Name, click here.

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your Oracle database.
o For Oracle connections, the user must be capitalized, as in the example
e Password: Enter the password to complete the authentication process.

e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the Oracle connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the items Tables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.
e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.

e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.
o By default, Scriptcase leaves this option empty.
o E.g.



e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your Oracle database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.
o By default, this option is left blank by Scriptcase.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

e Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with Oracle PDO

In Scriptcase, we have the following drivers available for connections with Oracle:Oracle PDO, Oracle 8.0.5 or Higher, Oracle ODBC and Oracle 8.

Prerequisites

Before proceeding with this documentation, check your PHP architecture. In order for the drivers to be enabled correctly the files must be downloaded according to the
architecture used.

e In Scriptcase, there is the info.php file, access it through the URL: http://127.0.0.1/scriptcase/info.php, where you will find information regarding the architecture inphpinfo().

WARNING: Download the Oracle instant client according to your PHP architecture.

e i386/i686 Architecture = 32 bits
e x86_64 Architecture = 64 bits

Below are listed the files required for Oracle drivers to be enabled.
Required Files:

e oci8.so extension: Click Here
x86_64

e Oracle Instant Client - Basic Package 12.1.0.2(x86_64): Click Here
e Oracle Instant Client - Devel Package 12.1.0.2(x86_64): Click Here

i386/i686

e Oracle Instant Client - Basic Package 12.1.0.2(i386/i686): Click Here
e Oracle Instant Client - Devel Package 12.1.0.2(i386/i686): Click Here

WARNING: PHP 8.1 is compatible with Oracle Instant Client 11.2 or Higher.
To download Oracle Instant Client lower than version 19, you must have an Oracle Account.

Other Files

e Oracle Instant Client 12.2.0 or Higher: Click Here
Oracle PDO Driver Compatibility Table

Oracle Database

Drive .
Version

) 11g R2(11.2)
Oracle PDO 9i 10g 11gR1 12c 18c 19c

Instant Client Oracle database version

. 11g R2(11.2)
19.6.0.0 9i 10g 11g R1 12¢ 18c 19c

Configuring Oracle PDO on Linux
It is necessary to enable the Oracle extension in PHP and configure Instant_Client to make the connection. Follow the steps described below to enable the connection drivers.

1 - Install the packages below:

UBUNTU\DEBIAN CENTOS\RHEL
sudo apt-get update sudo yum update
sudo apt-get install libaiol sudo yum install libaio-devel
sudo apt-get install libncurses5 sudo yum install libaio
sudo apt-get install alien sudo yum install glibc

sudo apt-get install gcc-multilib g++-multilib sudo yum install compat-libstdc++-33
sudo apt-get install libpamOg sudo yum install glibc-devel
sudo apt-get install unixodbc-dev unixodbc  sudo yum install libstdc++

sudo yum install libstdc++

sudo yum install pam

sudo yum install ncurses-devel

sudo yum install unixODBC
2 - Convert and install the previously downloaded Instant Client Basic packages on your Linux system:

UBUNTU\DEBIAN CENTOS\RHEL
sudo alien oracle-instantclient12.1-devel-12.1.0.2.0-1.x86_64.rpm  sudo yum install oracle-instantclient12.1-basic-12.1.0.2.0-1.x86_64.rpm
sudo alien oracle-instantclient12.1-basic-12.1.0.2.0-1.x86_64.rpm  sudo yum install oracle-instantclient12.1-devel-12.1.0.2.0-1.x86_64.rpm
sudo dpkg -i oracle-instantclient12.1-basic_12.1.0.2.0-2_amd64.deb
sudo dpkg -i oracle-instantclient12.1-devel_12.1.0.2.0-2_amd64.deb

3 - Copy the previously downloaded oci8.so extension to the PHP extensions directory:
E.g. sudo cp oci8.so /usr/lib/php/20180731

Access the info.php file and search for the extension_dir line. It will tell you the exact path to the directory responsible for PHP extensions.

4 - Edit the php.ini file and declare the Oracle extension at the end of the file.



UBUNTU\DEBIAN CENTOS\RHEL
/etc/php/8.1/apache2/php.ini letc/php.ini

E.g. extension=oci8.so

5 - Edit the environment variable file and declare the variable responsible for identifying the Oracle library:

Enter the variable LD_LIBRARY_PATH and the path to the library in the file responsible for your system’s environment variables. Check the path below according to your operating
system:

WARNING: The path to the library may depend on your installation, by default the path is this:/usr/lib/oracle/12.1/client64/lib/.

UBUNTU\DEBIAN CENTOS\RHEL

sudo nano /etc/apache2/envvars sudo nano /etc/sysconfig/httpd
e Add this variable at the end of the file with the following syntax:
export LD_LIBRARY_PATH=/usr/lib/oracle/12.1/client64/lib/

NOTE: If you are using CentOS/RHEL, it is not necessary to use ‘export’ before the variable.
6 - Restart the Scriptcase apache service for the changes to take effect. Use the commands below according to your operating system.
UBUNTU\DEBIAN CENTOS\RHEL

sudo service apache2 restart sudo systemctl restart httpd

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using the previously enabled Driver and the Oracle database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Oracle connection.

Connection

Enter the parameters for connecting to your Oracle database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the Oracle Driver used to connect. In this example, we use theOracle PDO Driver.
e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed along withService Name.

o E.g. serverdomain.com/XE Or 192.168.254.170/XE
o For more information about Oracle’s Service Name, click here.

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your Oracle database.
o For Oracle connections, the user must be capitalized, as in the example

e Password: Enter the password to complete the authentication process.

e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the Oracle connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the items Tables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.



e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your Oracle database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.
o By default, this option is left blank by Scriptcase.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

e Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with Oracle 8.0.5 or Higher

In Scriptcase, we have the following drivers available for connections with Oracle:Oracle PDO, Oracle 8.0.5 or Higher, Oracle ODBC and Oracle 8.

Prerequisites

Before proceeding with this documentation, check your PHP architecture. In order for the drivers to be enabled correctly the files must be downloaded according to the
architecture used.

e In Scriptcase, there is the info.php file, access it through the URL: http://127.0.0.1/scriptcase/info.php, where you will find information regarding the architecture inphpinfo().

WARNING: Download the Oracle instant client according to your PHP architecture.

e i386/i686 Architecture = 32 bits
e x86_64 Architecture = 64 bits

Below are listed the files required for Oracle drivers to be enabled.
Required Files:

e oci8.so extension: Click Here
x86_64

e Oracle Instant Client - Basic Package 12.1.0.2(x86_64): Click Here
e Oracle Instant Client - Devel Package 12.1.0.2(x86_64): Click Here

i386/i686

e Oracle Instant Client - Basic Package 12.1.0.2(i386/i686): Click Here
e Oracle Instant Client - Devel Package 12.1.0.2(i386/i686): Click Here

WARNING: PHP 8.1 is compatible with Oracle Instant Client 11.2 or Higher.
To download Oracle Instant Client lower than version 19, you must have an Oracle Account.

Other Files
e Oracle Instant Client 12.2.0 or Higher: Click Here
Oracle 8.0.5 or Higher Driver Compatibility Table

Oracle Database
Version

Oracle 8 or ) 11g R2(11.2)
Highter 9i 10g 11gR1 12c 18c 19c

Instant Client Oracle database version

Drive

. 11g R2(11.2)
19.6.0.0 9i 10g 11g R1 12¢ 18c 19c

Configuring Oracle 8.0.5 or Higher on Linux
It is necessary to enable the Oracle extension in PHP and configure Instant_Client to make the connection. Follow the steps described below to enable the connection drivers.

1 - Install the packages below:

UBUNTU\DEBIAN CENTOS\RHEL
sudo apt-get update sudo yum update
sudo apt-get install libaiol sudo yum install libaio-devel
sudo apt-get install libncurses5 sudo yum install libaio
sudo apt-get install alien sudo yum install glibc

sudo apt-get install gcc-multilib g++-multilib sudo yum install compat-libstdc++-33
sudo apt-get install libpamOg sudo yum install glibc-devel
sudo apt-get install unixodbc-dev unixodbc  sudo yum install libstdc++

sudo yum install libstdc++

sudo yum install pam

sudo yum install ncurses-devel

sudo yum install unixODBC
2 - Convert and install the previously downloaded Instant Client Basic packages on your Linux system:

UBUNTU\DEBIAN CENTOS\RHEL
sudo alien oracle-instantclient12.1-devel-12.1.0.2.0-1.x86_64.rpm  sudo yum install oracle-instantclient12.1-basic-12.1.0.2.0-1.x86_64.rpm
sudo alien oracle-instantclient12.1-basic-12.1.0.2.0-1.x86_64.rpm  sudo yum install oracle-instantclient12.1-devel-12.1.0.2.0-1.x86_64.rpm
sudo dpkg -i oracle-instantclient12.1-basic_12.1.0.2.0-2_amd64.deb
sudo dpkg -i oracle-instantclient12.1-devel_12.1.0.2.0-2_amd64.deb

3 - Copy the previously downloaded oci8.so extension to the PHP extensions directory:
E.g. sudo cp oci8.so /usr/lib/php/20180731

Access the info.php file and search for the extension_dir line. It will tell you the exact path to the directory responsible for PHP extensions.

4 - Edit the php.ini file and declare the Oracle extension at the end of the file.



UBUNTU\DEBIAN CENTOS\RHEL
/etc/php/8.1/apache2/php.ini letc/php.ini

E.g. extension=oci8.so

5 - Edit the environment variable file and declare the variable responsible for identifying the Oracle library:

Enter the variable LD_LIBRARY_PATH and the path to the library in the file responsible for your system’s environment variables. Check the path below according to your operating
system:

WARNING: The path to the library may depend on your installation, by default the path is this:/usr/lib/oracle/12.1/client64/lib/.

UBUNTU\DEBIAN CENTOS\RHEL

sudo nano /etc/apache2/envvars sudo nano /etc/sysconfig/httpd
e Add this variable at the end of the file with the following syntax:
export LD_LIBRARY_PATH=/usr/lib/oracle/12.1/client64/lib/

NOTE: If you are using CentOS/RHEL, it is not necessary to use ‘export’ before the variable.
6 - Restart the Scriptcase apache service for the changes to take effect. Use the commands below according to your operating system.
UBUNTU\DEBIAN CENTOS\RHEL

sudo service apache2 restart sudo systemctl restart httpd

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using the previously enabled Driver and the Oracle database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Oracle connection.

Connection

Enter the parameters for connecting to your Oracle database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the Oracle Driver used to connect. In this example, we use theOracle 8.0.5 or Higher Driver.
e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed along withService Name.

o E.g. serverdomain.com/XE Or 192.168.254.170/XE
o For more information about Oracle’s Service Name, click here.

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your Oracle database.
o For Oracle connections, the user must be capitalized, as in the example

e Password: Enter the password to complete the authentication process.

e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the Oracle connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the items Tables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.



e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your Oracle database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.
o By default, this option is left blank by Scriptcase.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

e Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with Oracle ODBC

In Scriptcase, we have the following drivers available for connections with Oracle:Oracle PDO, Oracle 8.0.5 or Higher, Oracle ODBC and Oracle 8.

Prerequisites

Before proceeding with this documentation, check your PHP architecture. In order for the drivers to be enabled correctly the files must be downloaded according to the
architecture used.

e In Scriptcase, there is the info.php file, access it through the URL: http://127.0.0.1/scriptcase/info.php, where you will find information regarding the architecture inphpinfo().

WARNING: Download the Oracle instant client according to your PHP architecture.

e i386/i686 Architecture = 32 bits
e x86_64 Architecture = 64 bits

Below are listed the files required for Oracle drivers to be enabled.
Required Files:

e oci8.so extension: Click Here
x86_64

e Oracle Instant Client - Basic Package 12.1.0.2(x86_64): Click Here
e Oracle Instant Client - Devel Package 12.1.0.2(x86_64): Click Here

i386/i686

e Oracle Instant Client - Basic Package 12.1.0.2(i386/i686): Click Here
e Oracle Instant Client - Devel Package 12.1.0.2(i386/i686): Click Here

WARNING: PHP 8.1 is compatible with Oracle Instant Client 11.2 or Higher.
To download Oracle Instant Client lower than version 19, you must have an Oracle Account.

Other Files

e Oracle Instant Client 12.2.0 or Higher: Click Here
Oracle ODBC Driver Compatibility Table

Oracle Database

Drive .
Version

) 11g R2(11.2)
Oracle ODBC 9i 10g 11gR1 12c 18c 19c

Instant Client Oracle database version
. 11g R2(11.2)
19.6.0.0 9i 109 11g R1 12c 18c 19c
Configuring Oracle ODBC on Linux
It is necessary to enable the Oracle extension in PHP and configure Instant_Client to make the connection. Follow the steps described below to enable the connection drivers.

1 - Install the packages below:

UBUNTU\DEBIAN CENTOS\RHEL
sudo apt-get update sudo yum update
sudo apt-get install libaiol sudo yum install libaio-devel
sudo apt-get install libncurses5 sudo yum install libaio
sudo apt-get install alien sudo yum install glibc

sudo apt-get install gcc-multilib g++-multilib sudo yum install compat-libstdc++-33
sudo apt-get install libpamOg sudo yum install glibc-devel
sudo apt-get install unixodbc-dev unixodbc  sudo yum install libstdc++

sudo yum install libstdc++

sudo yum install pam

sudo yum install ncurses-devel

sudo yum install unixODBC
2 - Convert and install the previously downloaded Instant Client Basic packages on your Linux system:

UBUNTU\DEBIAN CENTOS\RHEL
sudo alien oracle-instantclient12.1-devel-12.1.0.2.0-1.x86_64.rpm  sudo yum install oracle-instantclient12.1-basic-12.1.0.2.0-1.x86_64.rpm
sudo alien oracle-instantclient12.1-basic-12.1.0.2.0-1.x86_64.rpm  sudo yum install oracle-instantclient12.1-devel-12.1.0.2.0-1.x86_64.rpm
sudo dpkg -i oracle-instantclient12.1-basic_12.1.0.2.0-2_amd64.deb
sudo dpkg -i oracle-instantclient12.1-devel_12.1.0.2.0-2_amd64.deb

3 - Copy the previously downloaded oci8.so extension to the PHP extensions directory:
E.g. sudo cp oci8.so /usr/lib/php/20180731

Access the info.php file and search for the extension_dir line. It will tell you the exact path to the directory responsible for PHP extensions.

4 - Edit the php.ini file and declare the Oracle extension at the end of the file.



UBUNTU\DEBIAN CENTOS\RHEL
/etc/php/8.1/apache2/php.ini letc/php.ini

E.g. extension=oci8.so

5 - Edit the environment variable file and declare the variable responsible for identifying the Oracle library:

Enter the variable LD_LIBRARY_PATH and the path to the library in the file responsible for your system’s environment variables. Check the path below according to your operating
system:

WARNING: The path to the library may depend on your installation, by default the path is this:/usr/lib/oracle/12.1/client64/lib/.

UBUNTU\DEBIAN CENTOS\RHEL

sudo nano /etc/apache2/envvars sudo nano /etc/sysconfig/httpd
e Add this variable at the end of the file with the following syntax:
export LD_LIBRARY_PATH=/usr/lib/oracle/12.1/client64/lib/

NOTE: If you are using CentOS/RHEL, it is not necessary to use ‘export’ before the variable.
6 - Restart the Scriptcase apache service for the changes to take effect. Use the commands below according to your operating system.
UBUNTU\DEBIAN CENTOS\RHEL
sudo service apache2 restart sudo systemctl restart httpd

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using the previously enabled Driver and the Oracle database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Oracle connection.

Connection

Enter the parameters for connecting to your Oracle database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the Oracle Driver used to connect. In this example, we use theOracle ODBC Driver.

e Server/Host (Name or IP): Enter the Data Source Name created in your ODBC manager.
o E.G. oracle

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your Oracle database.
o For Oracle connections, the user must be capitalized, as in the example

e Password: Enter the password to complete the authentication process.

e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the Oracle connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the items Tables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.



e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your Oracle database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.
o By default, this option is left blank by Scriptcase.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

e Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with Oracle 8

In Scriptcase, we have the following drivers available for connections with Oracle:Oracle PDO, Oracle 8.0.5 or Higher, Oracle ODBC and Oracle 8.

Prerequisites

Before proceeding with this documentation, check your PHP architecture. In order for the drivers to be enabled correctly the files must be downloaded according to the
architecture used.

e In Scriptcase, there is the info.php file, access it through the URL: http://127.0.0.1/scriptcase/info.php, where you will find information regarding the architecture inphpinfo().

WARNING: Download the Oracle instant client according to your PHP architecture.

e i386/i686 Architecture = 32 bits
e x86_64 Architecture = 64 bits

Below are listed the files required for Oracle drivers to be enabled.
Required Files:

e oci8.so extension: Click Here
x86_64

e Oracle Instant Client - Basic Package 12.1.0.2(x86_64): Click Here
e Oracle Instant Client - Devel Package 12.1.0.2(x86_64): Click Here

i386/i686

e Oracle Instant Client - Basic Package 12.1.0.2(i386/i686): Click Here
e Oracle Instant Client - Devel Package 12.1.0.2(i386/i686): Click Here

WARNING: PHP 8.1 is compatible with Oracle Instant Client 11.2 or Higher.
To download Oracle Instant Client lower than version 19, you must have an Oracle Account.

Other Files

e Oracle Instant Client 12.2.0 or Higher: Click Here
Oracle 8 Driver Compatibility Table

Oracle Database

Drive .
Version

) 11g R2(11.2)
Oracle 8 9i 10g 11gR1 12c 18c 19c

Instant Client Oracle database version
. 11g R2(11.2)
19.6.0.0 9i 109 11g R1 12c 18c 19c
Configuring Oracle 8 on Linux
It is necessary to enable the Oracle extension in PHP and configure Instant_Client to make the connection. Follow the steps described below to enable the connection drivers.

1 - Install the packages below:

UBUNTU\DEBIAN CENTOS\RHEL
sudo apt-get update sudo yum update
sudo apt-get install libaiol sudo yum install libaio-devel
sudo apt-get install libncurses5 sudo yum install libaio
sudo apt-get install alien sudo yum install glibc

sudo apt-get install gcc-multilib g++-multilib sudo yum install compat-libstdc++-33
sudo apt-get install libpamOg sudo yum install glibc-devel
sudo apt-get install unixodbc-dev unixodbc  sudo yum install libstdc++

sudo yum install libstdc++

sudo yum install pam

sudo yum install ncurses-devel

sudo yum install unixODBC
2 - Convert and install the previously downloaded Instant Client Basic packages on your Linux system:

UBUNTU\DEBIAN CENTOS\RHEL
sudo alien oracle-instantclient12.1-devel-12.1.0.2.0-1.x86_64.rpm  sudo yum install oracle-instantclient12.1-basic-12.1.0.2.0-1.x86_64.rpm
sudo alien oracle-instantclient12.1-basic-12.1.0.2.0-1.x86_64.rpm  sudo yum install oracle-instantclient12.1-devel-12.1.0.2.0-1.x86_64.rpm
sudo dpkg -i oracle-instantclient12.1-basic_12.1.0.2.0-2_amd64.deb
sudo dpkg -i oracle-instantclient12.1-devel_12.1.0.2.0-2_amd64.deb

3 - Copy the previously downloaded oci8.so extension to the PHP extensions directory:
E.g. sudo cp oci8.so /usr/lib/php/20180731

Access the info.php file and search for the extension_dir line. It will tell you the exact path to the directory responsible for PHP extensions.

4 - Edit the php.ini file and declare the Oracle extension at the end of the file.



UBUNTU\DEBIAN CENTOS\RHEL
/etc/php/8.1/apache2/php.ini letc/php.ini

E.g. extension=oci8.so

5 - Edit the environment variable file and declare the variable responsible for identifying the Oracle library:

Enter the variable LD_LIBRARY_PATH and the path to the library in the file responsible for your system’s environment variables. Check the path below according to your operating
system:

WARNING: The path to the library may depend on your installation, by default the path is this:/usr/lib/oracle/12.1/client64/lib/.

UBUNTU\DEBIAN CENTOS\RHEL

sudo nano /etc/apache2/envvars sudo nano /etc/sysconfig/httpd
e Add this variable at the end of the file with the following syntax:
export LD_LIBRARY_PATH=/usr/lib/oracle/12.1/client64/lib/

NOTE: If you are using CentOS/RHEL, it is not necessary to use ‘export’ before the variable.
6 - Restart the Scriptcase apache service for the changes to take effect. Use the commands below according to your operating system.
UBUNTU\DEBIAN CENTOS\RHEL

sudo service apache2 restart sudo systemctl restart httpd

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using the previously enabled Driver and the Oracle database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Oracle connection.

Connection

Enter the parameters for connecting to your Oracle database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the Oracle Driver used to connect. In this example, we use theOracle 8 Driver.
e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed along withService Name.

o E.g. serverdomain.com/XE Or 192.168.254.170/XE
o For more information about Oracle’s Service Name, click here.

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your Oracle database.
o For Oracle connections, the user must be capitalized, as in the example

e Password: Enter the password to complete the authentication process.

e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the Oracle connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the items Tables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.



e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your Oracle database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.
o By default, this option is left blank by Scriptcase.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

e Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with Oracle PDO

At Scriptcase, we have the following drivers available for connection to Oracle: Oracle PDO, Oracle 8.0.5 or Higher, Oracle ODBC and Oracle 8.f you are using your own pre-
configured environment, Oracle extensions must be manually enabled in PHP.

Prerequisites
Before proceeding at this documentation, check your PHP architecture. For drivers to be enabled correctly,the files must be downloaded according to the architecture used.
e In your Scriptcase, there is the fileinfo.php, access it by URL: http://127.0.0.1:8092/scriptcase/info.php, where you will find information regarding architecture in thephpinfo().

NOTE: If you are using Scriptcase’s automatic installer, the PHP architecture will be the same as the one you downloadedDownload the Oracle instant client
according to your PHP architecture.

e Architecture i386/i686 = 32 bits
e Architecture x86_64 = 64 bits

Below are listed the files required for Oracle drivers to be enabled.
Required files:
x86_64

e Oracle Instant Client 12.1.0.2(x86_64): Click Here

IMPORTANT: The PHP 8.1 is compatible with Oracle Instant Client 11.2 or Higher.
To download the Oracle Instant Client below the version 19.5.0.0, it is necessary to have a Oracle account.

Other Files
e Oracle Instant Client 12.2.0 or Higher: Click Here
Oracle PDO Driver Compatibility Table

Drive Oracle Database Version
11g R2(11.2)
Oracle PDO 9i 109 11g R1 12c 18c 19c

Version de base de datos

Instant Client
Oracle

) 11g R2(11.2)
19.6.0.0 9 10g 11g R1 12¢ 18c 19c

Configuring Oracle PDO on MacOs

The automatic installation of Scriptcase comes with pre-configured Oracle drivers, with onlyinstant_client missing to be configured to make the connection. Follow the steps
outlined below to enable the connection drivers.

1 - On your Mac terminal, log in asroot and create a folder with instant client numbering in/usr/local/instantclient/12.1.0.2/.
EX:
e mkdir -p /usr/local/instantclient/12.1.0.2/
2 - Extract all content from the Instant Client downloaded previously on your Mac system and copy to the folder created in the previous step:
EX:

e unzip oci_client_macosx_12.zip
® cp-avr __MACOSX/ oci_client_macosx_12/ /usr/local/instantclient/12.1.0.2/

3 - Restart the Scriptcase apache service for the changes to be saved. Use the command below for this:
EX:
sudo /Applications/Scriptcase/v9-php73/components/apache/bin/apachectl restart

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using thepreviously enabled Driver and the Oracle database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Oracle connection.

Connection

Enter the parameters for connecting to your Oracle database as follows:



e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the Oracle Driver used to connect. In this example, we use theOracle PDO Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed along withService Name.
o E.g. serverdomain.com/XE Or 192.168.254.170/XE
o For more information about Oracle’s Service Name, click here.

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your Oracle database.
o For Oracle connections, the user must be capitalized, as in the example

e Password: Enter the password to complete the authentication process.

e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the Oracle connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the items Tables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.

o By default, Scriptcase enables this option.

e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your Oracle database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.
o By default, this option is left blank by Scriptcase.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

e Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Questions or Connection Problems?

Contact our Support in case of connection problems or questions regarding this database.



Connecting with Oracle 8.0.5 or Higher

At Scriptcase, we have the following drivers available for connection to Oracle: Oracle PDO, Oracle 8.0.5 or Higher, Oracle ODBC and Oracle 8.f you are using your own pre-
configured environment, Oracle extensions must be manually enabled in PHP.

Prerequisites

Before proceeding at this documentation, check your PHP architecture. For drivers to be enabled correctly,the files must be downloaded according to the architecture used.
e In your Scriptcase, there is the fileinfo.php, access it by URL: http://127.0.0.1:8092/scriptcase/info.php, where you will find information regarding architecture in thephpinfo().

NOTE: If you are using Scriptcase’s automatic installer, the PHP architecture will be the same as the one you downloadedDownload the Oracle instant client
according to your PHP architecture.

e Architecture i386/i686 = 32 bits
e Architecture x86_64 = 64 bits

Below are listed the files required for Oracle drivers to be enabled.
Required files:
x86_64

e Oracle Instant Client 12.1.0.2(x86_64): Click Here

IMPORTANT: The PHP 7.3 is compatible with Oracle Instant Client 11.2 or Higher.
To download the Oracle Instant Client below the version 19.5.0.0, it is necessary to have a Oracle account.

Other Files
e Oracle Instant Client 12.2.0 or Higher: Click Here

Oracle 8.0.5 or Higher Driver Compatibility Table

Drive Oracle Database Version
Oracle 8.0.5 or ) 11g R2(11.2)
Higher 9i 10g 11gR1 12c 18c 19c

Version de base de datos

Instant Client
Oracle

. 11g R2(11.2)
19.6.0.0 9i 10g 11g R1 12¢ 18c 19c

Configuring Oracle 8.0.5 or Higher on MacOs

The automatic installation of Scriptcase comes with pre-configured Oracle drivers, with onlyinstant_client missing to be configured to make the connection. Follow the steps
outlined below to enable the connection drivers.

1 - On your Mac terminal, log in asroot and create a folder with instant client numbering in/usr/local/instantclient/12.1.0.2/.
EX:
e mkdir -p /usr/local/instantclient/12.1.0.2/
2 - Extract all content from the Instant Client downloaded previously on your Mac system and copy to the folder created in the previous step:
EX:

e unzip oci_client_macosx_12.zip
® cp-avr __MACOSX/ oci_client_macosx_12/ /usr/local/instantclient/12.1.0.2/

3 - Restart the Scriptcase apache service for the changes to be saved. Use the command below for this:
EX:
sudo /Applications/Scriptcase/v9-php73/components/apache/bin/apachectl restart

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using thepreviously enabled Driver and the Oracle database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Oracle connection.

Connection

Enter the parameters for connecting to your Oracle database as follows:



e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the Oracle Driver used to connect. In this example, we use theOracle 8.0.5 or Higher Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed along withService Name.
o E.g. serverdomain.com/XE Or 192.168.254.170/XE
o For more information about Oracle’s Service Name, click here.

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your Oracle database.
o For Oracle connections, the user must be capitalized, as in the example

e Password: Enter the password to complete the authentication process.

e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the Oracle connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the items Tables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.

o By default, Scriptcase enables this option.

e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your Oracle database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.
o By default, this option is left blank by Scriptcase.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

e Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Questions or Connection Problems?

Contact our Support in case of connection problems or questions regarding this database.



Connecting with Oracle ODBC

At Scriptcase, we have the following drivers available for connection to Oracle: Oracle PDO, Oracle 8.0.5 or Higher, Oracle ODBC and Oracle 8.f you are using your own pre-
configured environment, Oracle extensions must be manually enabled in PHP.

Prerequisites

Before proceeding at this documentation, check your PHP architecture. For drivers to be enabled correctly,the files must be downloaded according to the architecture used.
e In your Scriptcase, there is the fileinfo.php, access it by URL: http://127.0.0.1:8092/scriptcase/info.php, where you will find information regarding architecture in thephpinfo().

NOTE: If you are using Scriptcase’s automatic installer, the PHP architecture will be the same as the one you downloadedDownload the Oracle instant client
according to your PHP architecture.

e Architecture i386/i686 = 32 bits
e Architecture x86_64 = 64 bits

Below are listed the files required for Oracle drivers to be enabled.
Required files:
x86_64

e Oracle Instant Client 12.1.0.2(x86_64): Click Here

IMPORTANT: The PHP 7.3 is compatible with Oracle Instant Client 11.2 or Higher.
To download the Oracle Instant Client below the version 19.5.0.0, it is necessary to have a Oracle account.

Other Files
e Oracle Instant Client 12.2.0 or Higher: Click Here

Oracle ODBC Driver Compatibility Table

Drive Oracle Database Version
Oracle 8.0.5 or ) 11g R2(11.2)
Higher 9i 10g 11gR1 12c 18c 19c

Version de base de datos

Instant Client
Oracle

. 11g R2(11.2)
19.6.0.0 9i 10g 11g R1 12¢ 18c 19c

Configuring Oracle ODBC on MacOs

The automatic installation of Scriptcase comes with pre-configured Oracle drivers, with onlyinstant_client missing to be configured to make the connection. Follow the steps
outlined below to enable the connection drivers.

1 - On your Mac terminal, log in asroot and create a folder with instant client numbering in/usr/local/instantclient/12.1.0.2/.
EX:
e mkdir -p /usr/local/instantclient/12.1.0.2/
2 - Extract all content from the Instant Client downloaded previously on your Mac system and copy to the folder created in the previous step:
EX:

e unzip oci_client_macosx_12.zip
® cp-avr __MACOSX/ oci_client_macosx_12/ /usr/local/instantclient/12.1.0.2/

3 - Restart the Scriptcase apache service for the changes to be saved. Use the command below for this:
EX:
sudo /Applications/Scriptcase/v9-php73/components/apache/bin/apachectl restart

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using thepreviously enabled Driver and the Oracle database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Oracle connection.

Connection

Enter the parameters for connecting to your Oracle database as follows:



e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the Oracle Driver used to connect. In this example, we use theOracle ODBC Driver.

e Server/Host (Name or IP): Enter the Data Source Name created in your ODBC manager.
o E.G. oracle

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your Oracle database.

o For Oracle connections, the user must be capitalized, as in the example

e Password: Enter the password to complete the authentication process.

e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the Oracle connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the items Tables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.

o By default, Scriptcase enables this option.

e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your Oracle database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.
o By default, this option is left blank by Scriptcase.

« Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

e Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Questions or Connection Problems?

Contact our Support in case of connection problems or questions regarding this database.



Connecting with Oracle 8

At Scriptcase, we have the following drivers available for connection to Oracle: Oracle PDO, Oracle 8.0.5 or Higher, Oracle ODBC and Oracle 8.f you are using your own pre-
configured environment, Oracle extensions must be manually enabled in PHP.

Prerequisites

Before proceeding at this documentation, check your PHP architecture. For drivers to be enabled correctly,the files must be downloaded according to the architecture used.
e In your Scriptcase, there is the fileinfo.php, access it by URL: http://127.0.0.1:8092/scriptcase/info.php, where you will find information regarding architecture in thephpinfo().

NOTE: If you are using Scriptcase’s automatic installer, the PHP architecture will be the same as the one you downloadedDownload the Oracle instant client
according to your PHP architecture.

e Architecture i386/i686 = 32 bits
e Architecture x86_64 = 64 bits

Below are listed the files required for Oracle drivers to be enabled.
Required files:
x86_64

e Oracle Instant Client 12.1.0.2(x86_64): Click Here

IMPORTANT: The PHP 7.3 is compatible with Oracle Instant Client 11.2 or Higher.
To download the Oracle Instant Client below the version 19.5.0.0, it is necessary to have a Oracle account.

Other Files
e Oracle Instant Client 12.2.0 or Higher: Click Here

Oracle 8 Driver Compatibility Table

Drive Oracle Database Version
Oracle 8.0.5 or ) 11g R2(11.2)
Higher 9i 10g 11gR1 12c 18c 19c

Version de base de datos

Instant Client
Oracle

. 11g R2(11.2)
19.6.0.0 9i 10g 11g R1 12¢ 18c 19c

Configuring Oracle 8 on MacOs

The automatic installation of Scriptcase comes with pre-configured Oracle drivers, with onlyinstant_client missing to be configured to make the connection. Follow the steps
outlined below to enable the connection drivers.

1 - On your Mac terminal, log in asroot and create a folder with instant client numbering in/usr/local/instantclient/12.1.0.2/.
EX:
e mkdir -p /usr/local/instantclient/12.1.0.2/
2 - Extract all content from the Instant Client downloaded previously on your Mac system and copy to the folder created in the previous step:
EX:

e unzip oci_client_macosx_12.zip
® cp-avr __MACOSX/ oci_client_macosx_12/ /usr/local/instantclient/12.1.0.2/

3 - Restart the Scriptcase apache service for the changes to be saved. Use the command below for this:
EX:
sudo /Applications/Scriptcase/v9-php73/components/apache/bin/apachectl restart

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using thepreviously enabled Driver and the Oracle database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Oracle connection.

Connection

Enter the parameters for connecting to your Oracle database as follows:



e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the Oracle Driver used to connect. In this example, we use theOracle 8 Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed along withService Name.
o E.g. serverdomain.com/XE Or 192.168.254.170/XE
o For more information about Oracle’s Service Name, click here.

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your Oracle database.
o For Oracle connections, the user must be capitalized, as in the example

e Password: Enter the password to complete the authentication process.

e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the Oracle connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the items Tables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.

o By default, Scriptcase enables this option.

e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your Oracle database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.
o By default, this option is left blank by Scriptcase.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

e Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Questions or Connection Problems?

Contact our Support in case of connection problems or questions regarding this database.



Connecting with Oracle PDO

At Scriptcase, we have the following drivers available for connection to Oracle: Oracle PDO, Oracle 8.0.5 or Higher, Oracle ODBC and Oracle 8.

Prerequisites

Before proceeding at this documentation, check your PHP architecture. For drivers to be enabled correctly,the files must be downloaded according to the architecture used.
e In your Scriptcase, there is the fileinfo.php, access it by URL: http://127.0.0.1:8092/scriptcase/info.php, Where you will find information regarding architecture in thephpinfo().

NOTE: Download the Oracle instant client according to your PHP architecture.

e Architecture i386/i686 = 32 bits
e Architecture x86_64 = 64 bits

Below are listed the files required for Oracle drivers to be enabled.
Required files:

e Extension oci8.so: Clique Aqui
x86_64

e Oracle Instant Client 12.1.0.2(x86_64): Clique Aqui

IMPORTANT: The PHP 7.3 is compatible with Oracle Instant Client 11.2 or Higher.
To download the Oracle Instant Client below the version 19.5.0.0, it is necessary to have a Oracle account.

Other Files
e Oracle Instant Client 12.2.0 or Higher: Click Here
Oracle PDO Driver Compatibility Table

Drive Oracle Database Version

. 11g R2(11.2)
Oracle PDO 9i 109 11g R1 12c 18c 19c

Version de base de datos

Instant Client
nstant Clien Oracle

11g R2(11.2)
19.6.0.0 9i 109 11gR1 12c 18c 19c

Configuring Oracle PDO on MacOs

It is necessary to enable the Oracle extension in PHP and configure Instant_Client to make the connection. Follow the steps described below to enable the connection drivers.
1 - On your Mac terminal, log in asroot and create a folder with instant client numbering in/usr/local/instantclient/12.1.0.2/.
EX:
e mkdir -p /usr/local/instantclient/12.1.0.2/
2 - Extract all content from the Instant Client downloaded previously on your Mac system and copy to the folder created in the previous step:
EX:

e unzip oci_client_macosx_12.zip
® cp-avr __MACOSX/ oci_client_macosx_12/ /usr/local/instantclient/12.1.0.2/

3 - Copy the previously downloaded oci8.so extension to the PHP extensions directory:

ATENCAO: If you followed our documentation to install Scriptcase manually on macOs, the extension is already in the extensions directory. You can proceed to item5.
EX:
sudo cp oci8.so /usr/local/lib/php/pecl/20180731

Access the info.php file and search for the extension_dir line. It will tell you the exact path to the directory responsible for PHP extensions.

4 - Edit the php.ini file(/usr/local/etc/php/7.3/php.ini) and declare the Oracle extension at the end of the file.

EX:

extension=o0ci8.so

5 - Restart the apache service for the changes to be saved. Use the command below for this:
EX:

sudo apachectl restart

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using thepreviously enabled Driver and the Oracle database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.



or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Oracle connection.

Connection

Enter the parameters for connecting to your Oracle database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
e DBMS Driver: Select the Oracle Driver used to connect. In this example, we use theOracle PDO Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed along withService Name.
o E.g. serverdomain.com/XE Or 192.168.254.170/XE
o For more information about Oracle’s Service Name, click here.

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your Oracle database.
o For Oracle connections, the user must be capitalized, as in the example

e Password: Enter the password to complete the authentication process.

e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the Oracle connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the items Tables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.

e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your Oracle database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.
o By default, this option is left blank by Scriptcase.

« Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

e Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.



e Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Questions or Connection Problems?

Contact our Support in case of connection problems or questions regarding this database.



Connecting with Oracle 8.0.5 or Higher

At Scriptcase, we have the following drivers available for connection to Oracle: Oracle PDO, Oracle 8.0.5 or Higher, Oracle ODBC and Oracle 8.

Prerequisites

Before proceeding at this documentation, check your PHP architecture. For drivers to be enabled correctly,the files must be downloaded according to the architecture used.
e In your Scriptcase, there is the fileinfo.php, access it by URL: http://127.0.0.1:8092/scriptcase/info.php, Where you will find information regarding architecture in thephpinfo().

NOTE: Download the Oracle instant client according to your PHP architecture.

e Architecture i386/i686 = 32 bits
e Architecture x86_64 = 64 bits

Below are listed the files required for Oracle drivers to be enabled.
Required files:

e Extension oci8.so: Clique Aqui
x86_64

e Oracle Instant Client 12.1.0.2(x86_64): Clique Aqui

IMPORTANT: The PHP 7.3 is compatible with Oracle Instant Client 11.2 or Higher.
To download the Oracle Instant Client below the version 19.5.0.0, it is necessary to have a Oracle account.

Other Files
e Oracle Instant Client 12.2.0 or Higher: Click Here

Oracle 8.0.5 or Higher Driver Compatibility Table

Drive Oracle Database Version
Oracle 8.0.5 or ) 11g R2(11.2)
Higher 9i 109 11gR1 12c 18¢c 19¢

Version de base de datos

Instant Client
nstant Clien oracle

11g R2(11.2)
19.6.0.0 9i 109 11gR1 12c 18c 19c

Configuring Oracle 8.0.5 or Higher on MacOs

It is necessary to enable the Oracle extension in PHP and configure Instant_Client to make the connection. Follow the steps described below to enable the connection drivers.
1 - On your Mac terminal, log in asroot and create a folder with instant client numbering in/usr/local/instantclient/12.1.0.2/.
EX:
e mkdir -p /usr/local/instantclient/12.1.0.2/
2 - Extract all content from the Instant Client downloaded previously on your Mac system and copy to the folder created in the previous step:
EX:

e unzip oci_client_macosx_12.zip
® cp-avr __MACOSX/ oci_client_macosx_12/ /usr/local/instantclient/12.1.0.2/

3 - Copy the previously downloaded oci8.so extension to the PHP extensions directory:

ATENCAO: If you followed our documentation to install Scriptcase manually on macOs, the extension is already in the extensions directory. You can proceed to item5.
EX:
sudo cp oci8.so /usr/local/lib/php/pecl/20180731

Access the info.php file and search for the extension_dir line. It will tell you the exact path to the directory responsible for PHP extensions.

4 - Edit the php.ini file(/usr/local/etc/php/8.1/php.ini) and declare the Oracle extension at the end of the file.

EX:

extension=o0ci8.so

5 - Restart the apache service for the changes to be saved. Use the command below for this:
EX:

sudo apachectl restart

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using thepreviously enabled Driver and the Oracle database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.



or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Oracle connection.

Connection

Enter the parameters for connecting to your Oracle database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
e DBMS Driver: Select the Oracle Driver used to connect. In this example, we use theOracle 8.0.5 or HigherDriver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed along withService Name.
o E.g. serverdomain.com/XE Or 192.168.254.170/XE
o For more information about Oracle’s Service Name, click here.

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your Oracle database.
o For Oracle connections, the user must be capitalized, as in the example

e Password: Enter the password to complete the authentication process.

e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the Oracle connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the items Tables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.

e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your Oracle database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.
o By default, this option is left blank by Scriptcase.

« Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

e Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.



e Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Questions or Connection Problems?

Contact our Support in case of connection problems or questions regarding this database.



Connecting with Oracle ODBC

At Scriptcase, we have the following drivers available for connection to Oracle: Oracle PDO, Oracle 8.0.5 or Higher, Oracle ODBC and Oracle 8.

Prerequisites
Before proceeding at this documentation, check your PHP architecture. For drivers to be enabled correctly,the files must be downloaded according to the architecture used.
e In your Scriptcase, there is the fileinfo.php, access it by URL: http://127.0.0.1:8092/scriptcase/info.php, Where you will find information regarding architecture in thephpinfo().

NOTE: Download the Oracle instant client according to your PHP architecture.

e Architecture i386/i686 = 32 bits
e Architecture x86_64 = 64 bits

Below are listed the files required for Oracle drivers to be enabled.
Required files:

e Extension oci8.so: Clique Aqui
x86_64

e Oracle Instant Client 12.1.0.2(x86_64): Clique Aqui

IMPORTANT: The PHP 7.3 is compatible with Oracle Instant Client 11.2 or Higher.
To download the Oracle Instant Client below the version 19.5.0.0, it is necessary to have a Oracle account.

Other Files
e Oracle Instant Client 12.2.0 or Higher: Click Here

Oracle ODBC Driver Compatibility Table

Drive Oracle Database Version
Oracle 8.0.5 or ) 11g R2(11.2)
Higher 9i 109 11gR1 12c 18¢c 19¢

Version de base de datos

Instant Client
nstant Clien oracle

11g R2(11.2)
19.6.0.0 9i 109 11gR1 12c 18c 19c

Configuring Oracle ODBC on MacOs

It is necessary to enable the Oracle extension in PHP and configure Instant_Client to make the connection. Follow the steps described below to enable the connection drivers.
1 - On your Mac terminal, log in asroot and create a folder with instant client numbering in/usr/local/instantclient/12.1.0.2/.
EX:
e mkdir -p /usr/local/instantclient/12.1.0.2/
2 - Extract all content from the Instant Client downloaded previously on your Mac system and copy to the folder created in the previous step:
EX:

e unzip oci_client_macosx_12.zip
® cp-avr __MACOSX/ oci_client_macosx_12/ /usr/local/instantclient/12.1.0.2/

3 - Copy the previously downloaded oci8.so extension to the PHP extensions directory:

ATENCAO: If you followed our documentation to install Scriptcase manually on macOs, the extension is already in the extensions directory. You can proceed to item5.
EX:
sudo cp oci8.so /usr/local/lib/php/pecl/20180731

Access the info.php file and search for the extension_dir line. It will tell you the exact path to the directory responsible for PHP extensions.

4 - Edit the php.ini file(/usr/local/etc/php/8.1/php.ini) and declare the Oracle extension at the end of the file.

EX:

extension=o0ci8.so

5 - Restart the apache service for the changes to be saved. Use the command below for this:
EX:

sudo apachectl restart

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using thepreviously enabled Driver and the Oracle database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.



or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Oracle connection.

Connection

Enter the parameters for connecting to your Oracle database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
e DBMS Driver: Select the Oracle Driver used to connect. In this example, we use theOracle ODBC Driver.

e Server/Host (Name or IP): Enter the Data Source Name created in your ODBC manager.
o E.G. oracle

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your Oracle database.
o For Oracle connections, the user must be capitalized, as in the example

e Password: Enter the password to complete the authentication process.

e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the Oracle connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the items Tables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.

o By default, Scriptcase enables this option.

e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your Oracle database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.
o By default, this option is left blank by Scriptcase.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

e Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.



e Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Questions or Connection Problems?

Contact our Support in case of connection problems or questions regarding this database.



Connecting with Oracle 8

At Scriptcase, we have the following drivers available for connection to Oracle: Oracle PDO, Oracle 8.0.5 or Higher, Oracle ODBC and Oracle 8.

Prerequisites

Before proceeding at this documentation, check your PHP architecture. For drivers to be enabled correctly,the files must be downloaded according to the architecture used.
e In your Scriptcase, there is the fileinfo.php, access it by URL: http://127.0.0.1:8092/scriptcase/info.php, Where you will find information regarding architecture in thephpinfo().

NOTE: Download the Oracle instant client according to your PHP architecture.

e Architecture i386/i686 = 32 bits
e Architecture x86_64 = 64 bits

Below are listed the files required for Oracle drivers to be enabled.
Required files:

e Extension oci8.so: Clique Aqui
x86_64

e Oracle Instant Client 12.1.0.2(x86_64): Clique Aqui

IMPORTANT: The PHP 7.3 is compatible with Oracle Instant Client 11.2 or Higher.
To download the Oracle Instant Client below the version 19.5.0.0, it is necessary to have a Oracle account.

Other Files
e Oracle Instant Client 12.2.0 or Higher: Click Here

Oracle 8 Driver Compatibility Table

Drive Oracle Database Version
Oracle 8.0.5 or ) 11g R2(11.2)
Higher 9i 109 11gR1 12c 18¢c 19¢

Version de base de datos

Instant Client
nstant Clien oracle

11g R2(11.2)
19.6.0.0 9i 109 11gR1 12c 18c 19c

Configuring Oracle 8 on MacOs

It is necessary to enable the Oracle extension in PHP and configure Instant_Client to make the connection. Follow the steps described below to enable the connection drivers.
1 - On your Mac terminal, log in asroot and create a folder with instant client numbering in/usr/local/instantclient/12.1.0.2/.
EX:
e mkdir -p /usr/local/instantclient/12.1.0.2/
2 - Extract all content from the Instant Client downloaded previously on your Mac system and copy to the folder created in the previous step:
EX:

e unzip oci_client_macosx_12.zip
® cp-avr __MACOSX/ oci_client_macosx_12/ /usr/local/instantclient/12.1.0.2/

3 - Copy the previously downloaded oci8.so extension to the PHP extensions directory:

ATENCAO: If you followed our documentation to install Scriptcase manually on macOs, the extension is already in the extensions directory. You can proceed to item5.
EX:
sudo cp oci8.so /usr/local/lib/php/pecl/20180731

Access the info.php file and search for the extension_dir line. It will tell you the exact path to the directory responsible for PHP extensions.

4 - Edit the php.ini file(/usr/local/etc/php/8.1/php.ini) and declare the Oracle extension at the end of the file.

EX:

extension=o0ci8.so

5 - Restart the apache service for the changes to be saved. Use the command below for this:
EX:

sudo apachectl restart

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using thepreviously enabled Driver and the Oracle database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.



or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Oracle connection.

Connection

Enter the parameters for connecting to your Oracle database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
e DBMS Driver: Select the Oracle Driver used to connect. In this example, we use theOracle 8 Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed along withService Name.
o E.g. serverdomain.com/XE Or 192.168.254.170/XE
o For more information about Oracle’s Service Name, click here.

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your Oracle database.
o For Oracle connections, the user must be capitalized, as in the example

e Password: Enter the password to complete the authentication process.

e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the Oracle connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the items Tables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.

e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your Oracle database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.
o By default, this option is left blank by Scriptcase.

« Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

e Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.



e Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Questions or Connection Problems?

Contact our Support in case of connection problems or questions regarding this database.



PostgreSQL with Scriptcase

In Scriptcase, we have four drivers to connect with PostgreSQL. You must choose the most suitable for your environment.
It is recommended to use PostgreSQL PDO which is faster, however, it is up to you to choose the driver. If you are using your own pre-configured environment, PostgreSQL extensions must be manually enabled in PHP.

Check below the PostgreSQL versions that you can use in the Scriptcase 9
PostgreSQL versions list supported in Scriptcase 9

PostgreSQL Version  PostgreSQL PDO (recommended)  PostgreSQL 7 or Higher ~ PostgreSQL 6.4 or Higher ~ PostegreSQL 6.3 or Lower

15 (] (-] (/] (-]

9.6
9.5
94
9.3
9.2

9.1

9.0

Check if PostgreSQL drivers in enable

You can check your enabled drivers by accessing your Scriptcase diagnosis. See below on how to locate your diagnosis and check if the driver is enabled.

®  ccessing the top menu Help > Diagnosis, you can easily find it through the interface.

© WebHelp .

@& Technical Support

® r, by accessing your browser url:
127.0.0.1:8092/scriptcase/diagnosis.php or domain.com/scriptcase/diagnosis.php

Make sure the driver is enabled, as in the image below:

The extension PDO PostGreSQL enable all drivers. The extension PostGreSQL enable this drivers: PostgreSQL 7 or Higher, PostgreSQL 6.4 or Higher and PostgreSQL 6.3 or Lower.

Click on the link below according to the driver that will be used

Environment  PostgreSQL PDO (recommended)  PostgreSQL 7 or Higher ~ PostgreSQL 6.4 or Higher ~ PostgreSQL 6.3 or Lower

Windows Click Here Click Here Click Here Click Here
Linux Click Here Click Here Click Here Click Here
macOS Click Here Click Here Click Here Click Here

Doubts or Connection Problems?
Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with PostgreSQL PDO

In Scriptcase, we have the following drivers available for connections with PostgreSQL: PostgreSQL PDO, PostgreSQL 7 or Higher, PostgreSQL 6.4 or Higher and PostgreSQL
6.3 or Lower. If you are using your own pre-configured environment, PostgreSQL extensions must be manually enabled in PHP.

Prerequisites

If you are using a manual installation on Windows, you’ll need to enable the PostgreSQL extensions orphp.ini file. Check below how to do it.

1 - In the php.ini file, located in C:\php, uncomment the lines referring to the PostgreSQL extensions pdo_pgsql and php_pgsql removing the; from the beginning of the line. See the
example below:

2 - Restart the Apache service using theTask Manager.
e Open the Task Manager and click on theServices tab.

e Search for the Apache2.4 or ApacheScriptcase9php81 service and right click on this service, then Restart.

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project using the PostgreSQL database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Postgres connection.

Connection

Enter the parameters for connecting to your PostgreSQL database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the PostgreSQL Driver used to connect. In this example, we use thePostgreSQL PDO Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed.
o E.g. serverdomain.com Or 192.168.254.170

e Port: Inform the number port for your database server.

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your PostgreSQL database.
e Password: Enter the password to complete the authentication process.

« Database Name: Type your database name to connect with him. Or, if you want to choose one different database, click on the buttorList Database to show all databases
availabes for your user.
o Create Database: Clicking on this button, you will create a new PostgreSQL database for use.
e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the PostgreSQL connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are
already selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.

e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches



Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

e Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with PostgreSQL 7 or Higher

In Scriptcase, we have the following drivers available for connections with PostgreSQL: PostgreSQL PDO, PostgreSQL 7 or Higher, PostgreSQL 6.4 or Higher and PostgreSQL
6.3 or Lower. If you are using your own pre-configured environment, PostgreSQL extensions must be manually enabled in PHP.

Prerequisites

If you are using a manual installation on Windows, you’ll need to enable the PostgreSQL extensions orphp.ini file. Check below how to do it.

1 - In the php.ini file, located in C:\php, uncomment the lines referring to the PostgreSQL extensions pdo_pgsql and php_pgsql removing the; from the beginning of the line. See the
example below:

2 - Restart the Apache service using theTask Manager.
e Open the Task Manager and click on theServices tab.

e Search for the Apache2.4 or ApacheScriptcase9php81 service and right click on this service, then Restart.

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project using the PostgreSQL database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Postgres connection.

Connection

Enter the parameters for connecting to your PostgreSQL database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the PostgreSQL Driver used to connect. In this example, we use thePostgreSQL 7 or Higher Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed.
o E.g. serverdomain.com Or 192.168.254.170

e Port: Inform the number port for your database server.

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your PostgreSQL database.
e Password: Enter the password to complete the authentication process.

« Database Name: Type your database name to connect with him. Or, if you want to choose one different database, click on the buttorList Database to show all databases
availabes for your user.
o Create Database: Clicking on this button, you will create a new PostgreSQL database for use.
e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the PostgreSQL connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are
already selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.

e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches



Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

e Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with PostgreSQL 6.4 or Higher

In Scriptcase, we have the following drivers available for connections with PostgreSQL: PostgreSQL PDO, PostgreSQL 7 or Higher, PostgreSQL 6.4 or Higher and PostgreSQL
6.3 or Lower. If you are using your own pre-configured environment, PostgreSQL extensions must be manually enabled in PHP.

Prerequisites

If you are using a manual installation on Windows, you’ll need to enable the PostgreSQL extensions orphp.ini file. Check below how to do it.

1 - In the php.ini file, located in C:\php, uncomment the lines referring to the PostgreSQL extensions pdo_pgsql and php_pgsql removing the; from the beginning of the line. See the
example below:

2 - Restart the Apache service using theTask Manager.
e Open the Task Manager and click on theServices tab.

e Search for the Apache2.4 or ApacheScriptcase9php81 service and right click on this service, then Restart.

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project using the PostgreSQL database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Postgres connection.

Connection

Enter the parameters for connecting to your PostgreSQL database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the PostgreSQL Driver used to connect. In this example, we use thePostgreSQL 6.4 or Higher Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed.
o E.g. serverdomain.com Or 192.168.254.170

e Port: Inform the number port for your database server.

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your PostgreSQL database.
e Password: Enter the password to complete the authentication process.

« Database Name: Type your database name to connect with him. Or, if you want to choose one different database, click on the buttorList Database to show all databases
availabes for your user.
o Create Database: Clicking on this button, you will create a new PostgreSQL database for use.
e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the PostgreSQL connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are
already selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.

e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches



Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

e Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with PostgreSQL 6.3 or Lower

In Scriptcase, we have the following drivers available for connections with PostgreSQL: PostgreSQL PDO, PostgreSQL 7 or Higher, PostgreSQL 6.4 or Higher and PostgreSQL
6.3 or Lower. If you are using your own pre-configured environment, PostgreSQL extensions must be manually enabled in PHP.

Prerequisites

If you are using a manual installation on Windows, you’ll need to enable the PostgreSQL extensions orphp.ini file. Check below how to do it.

1 - In the php.ini file, located in C:\php, uncomment the lines referring to the PostgreSQL extensions pdo_pgsql and php_pgsql removing the; from the beginning of the line. See the
example below:

2 - Restart the Apache service using theTask Manager.
e Open the Task Manager and click on theServices tab.

e Search for the Apache2.4 or ApacheScriptcase9php81 service and right click on this service, then Restart.

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project using the PostgreSQL database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Postgres connection.

Connection

Enter the parameters for connecting to your PostgreSQL database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the PostgreSQL Driver used to connect. In this example, we use thePostgreSQL 6.3 or lower Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed.
o E.g. serverdomain.com Or 192.168.254.170

e Port: Inform the number port for your database server.

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your PostgreSQL database.
e Password: Enter the password to complete the authentication process.

« Database Name: Type your database name to connect with him. Or, if you want to choose one different database, click on the buttorList Database to show all databases
availabes for your user.
o Create Database: Clicking on this button, you will create a new PostgreSQL database for use.
e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the PostgreSQL connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are
already selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.

e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches



Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

e Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with PostgreSQL PDO

In Scriptcase, we have the following drivers available for connections with PostgreSQL: PostgreSQL PDO, PostgreSQL 7 or Higher, PostgreSQL 6.4 or Higher and PostgreSQL
6.3 or Lower. If you are using your own pre-configured environment, PostgreSQL extensions must be manually enabled in PHP.

Prerequisites

If you are using a manual installation on Linux, you'll need to install the PostgreSQL php extension. Check below how to do it.
1 - Access your Linux terminal and type this line below according to your OS to install PostgreSQL PDO driver.

Ubuntu CentOS
sudo apt-get install php8.1-pgsql sudo yum install php-pgsql

2 - Check if the PostgreSQL driver is enabled in your Scriptcase diagnosis. See below on how to locate your diagnosis and check if the driver is enabled.

e Accessing the top menu Help > Diagnosis, you can easily find it through the interface.

e Or, by accessing your Scriptcase installation path:

127.0.0.1/scriptcase/diagnosis.php Or domain.com/scriptcase/diagnosis.php

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project using the PostgreSQL database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Postgres connection.

Connection

Enter the parameters for connecting to your PostgreSQL database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the PostgreSQL Driver used to connect. In this example, we use thePostgreSQL PDO Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed.
o E.g. serverdomain.com Or 192.168.254.170

e Port: Inform the number port for your database server.

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your PostgreSQL database.
e Password: Enter the password to complete the authentication process.

« Database Name: Type your database name to connect with him. Or, if you want to choose one different database, click on the buttorList Database to show all databases
availabes for your user.
o Create Database: Clicking on this button, you will create a new PostgreSQL database for use.
e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the PostgreSQL connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are
already selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.

e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.



Searches

Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

e Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with PostgreSQL 7 or Higher

In Scriptcase, we have the following drivers available for connections with PostgreSQL: PostgreSQL PDO, PostgreSQL 7 or Higher, PostgreSQL 6.4 or Higher and PostgreSQL
6.3 or Lower. If you are using your own pre-configured environment, PostgreSQL extensions must be manually enabled in PHP.

Prerequisites

If you are using a manual installation on Linux, you'll need to install the PostgreSQL php extension. Check below how to do it.
1 - Access your Linux terminal and type this line below according to your OS to install PostgreSQL PDO driver.

Ubuntu CentOS
sudo apt-get install php8.1-pgsql sudo yum install php-pgsql

2 - Check if the PostgreSQL driver is enabled in your Scriptcase diagnosis. See below on how to locate your diagnosis and check if the driver is enabled.

e Accessing the top menu Help > Diagnosis, you can easily find it through the interface.

e Or, by accessing your Scriptcase installation path:

127.0.0.1/scriptcase/diagnosis.php Or domain.com/scriptcase/diagnosis.php

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project using the PostgreSQL database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Postgres connection.

Connection

Enter the parameters for connecting to your PostgreSQL database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the PostgreSQL Driver used to connect. In this example, we use thePostgreSQL 7 or Higher Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed.
o E.g. serverdomain.com Or 192.168.254.170

e Port: Inform the number port for your database server.

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your PostgreSQL database.
e Password: Enter the password to complete the authentication process.

« Database Name: Type your database name to connect with him. Or, if you want to choose one different database, click on the buttorList Database to show all databases
availabes for your user.
o Create Database: Clicking on this button, you will create a new PostgreSQL database for use.
e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the PostgreSQL connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are
already selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.

e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.



Searches

Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

e Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with PostgreSQL 6.4 or Higher

In Scriptcase, we have the following drivers available for connections with PostgreSQL: PostgreSQL PDO, PostgreSQL 7 or Higher, PostgreSQL 6.4 or Higher and PostgreSQL
6.3 or Lower. If you are using your own pre-configured environment, PostgreSQL extensions must be manually enabled in PHP.

Prerequisites

If you are using a manual installation on Linux, you'll need to install the PostgreSQL php extension. Check below how to do it.
1 - Access your Linux terminal and type this line below according to your OS to install PostgreSQL PDO driver.

Ubuntu CentOS
sudo apt-get install php8.1-pgsql sudo yum install php-pgsql

2 - Check if the PostgreSQL driver is enabled in your Scriptcase diagnosis. See below on how to locate your diagnosis and check if the driver is enabled.

e Accessing the top menu Help > Diagnosis, you can easily find it through the interface.

e Or, by accessing your Scriptcase installation path:

127.0.0.1/scriptcase/diagnosis.php Or domain.com/scriptcase/diagnosis.php

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project using the PostgreSQL database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Postgres connection.

Connection

Enter the parameters for connecting to your PostgreSQL database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the PostgreSQL Driver used to connect. In this example, we use thePostgreSQL 6.4 or Higher Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed.
o E.g. serverdomain.com Or 192.168.254.170

e Port: Inform the number port for your database server.

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your PostgreSQL database.
e Password: Enter the password to complete the authentication process.

« Database Name: Type your database name to connect with him. Or, if you want to choose one different database, click on the buttorList Database to show all databases
availabes for your user.
o Create Database: Clicking on this button, you will create a new PostgreSQL database for use.
e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the PostgreSQL connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are
already selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.

e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.



Searches

Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

e Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with PostgreSQL 6.3 or Lower

In Scriptcase, we have the following drivers available for connections with PostgreSQL: PostgreSQL PDO, PostgreSQL 7 or Higher, PostgreSQL 6.4 or Higher and PostgreSQL
6.3 or Lower. If you are using your own pre-configured environment, PostgreSQL extensions must be manually enabled in PHP.

Prerequisites

If you are using a manual installation on Linux, you'll need to install the PostgreSQL php extension. Check below how to do it.
1 - Access your Linux terminal and type this line below according to your OS to install PostgreSQL PDO driver.

Ubuntu CentOS
sudo apt-get install php8.1-pgsql sudo yum install php-pgsql

2 - Check if the PostgreSQL driver is enabled in your Scriptcase diagnosis. See below on how to locate your diagnosis and check if the driver is enabled.

e Accessing the top menu Help > Diagnosis, you can easily find it through the interface.

e Or, by accessing your Scriptcase installation path:

127.0.0.1/scriptcase/diagnosis.php Or domain.com/scriptcase/diagnosis.php

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project using the PostgreSQL database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Postgres connection.

Connection

Enter the parameters for connecting to your PostgreSQL database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the PostgreSQL Driver used to connect. In this example, we use thePostgreSQL 6.3 or lower Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed.
o E.g. serverdomain.com Or 192.168.254.170

e Port: Inform the number port for your database server.

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your PostgreSQL database.
e Password: Enter the password to complete the authentication process.

« Database Name: Type your database name to connect with him. Or, if you want to choose one different database, click on the buttorList Database to show all databases
availabes for your user.
o Create Database: Clicking on this button, you will create a new PostgreSQL database for use.
e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the PostgreSQL connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are
already selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.

e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.



Searches

Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o E.g.

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

e Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with PostgreSQL PDO

In Scriptcase, we have the following drivers available for connections with PostgreSQL: PostgreSQL PDO, PostgreSQL 7 or Higher, PostgreSQL 6.4 or Higher and PostgreSQL
6.3 or Lower. If you are using your own pre-configured environment, PostgreSQL extensions must be manually enabled in PHP.

Prerequisites

If you are using a manual installation on MacOS, you’ll need to install the PHP and the PostgreSQL driver will be enabled. Clickere to see how to do it.
1 - Check if the PostgreSQL driver is enabled in your Scriptcase diagnosis. See below on how to locate your diagnosis and check if the driver is enabled.
e Accessing the top menu Help > Diagnosis, you can easily find it through the interface.
![Accessing diagnosis - Help Menu][diagnosis_sc]
e Or, by accessing your Scriptcase installation path:

127.0.0.1/scriptcase/diagnosis.php Or domain.com/scriptcase/diagnosis.php

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project using the PostgreSQL database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Postgres connection.

Connection

Enter the parameters for connecting to your PostgreSQL database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the PostgreSQL Driver used to connect. In this example, we use thePostgreSQL PDO Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed.
o E.g. serverdomain.com Or 192.168.254.170

e Port: Inform the number port for your database server.

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your PostgreSQL database.
e Password: Enter the password to complete the authentication process.

« Database Name: Type your database name to connect with him. Or, if you want to choose one different database, click on the buttorList Database to show all databases
availabes for your user.
o Create Database: Clicking on this button, you will create a new PostgreSQL database for use.
e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the PostgreSQL connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are
already selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.

e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.



Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.
o By default, Scriptcase leaves this option empty.
o E.g.

Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

Show: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.

Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.

Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with PostgreSQL 7 or Higher

In Scriptcase, we have the following drivers available for connections with PostgreSQL: PostgreSQL PDO, PostgreSQL 7 or Higher, PostgreSQL 6.4 or Higher and PostgreSQL
6.3 or Lower. If you are using your own pre-configured environment, PostgreSQL extensions must be manually enabled in PHP.

Prerequisites

If you are using a manual installation on MacOS, you’ll need to install the PHP and the PostgreSQL driver will be enabled. Clickere to see how to do it.
1 - Check if the PostgreSQL driver is enabled in your Scriptcase diagnosis. See below on how to locate your diagnosis and check if the driver is enabled.
e Accessing the top menu Help > Diagnosis, you can easily find it through the interface.
![Accessing diagnosis - Help Menu][diagnosis_sc]
e Or, by accessing your Scriptcase installation path:

127.0.0.1/scriptcase/diagnosis.php Or domain.com/scriptcase/diagnosis.php

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project using the PostgreSQL database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Postgres connection.

Connection

Enter the parameters for connecting to your PostgreSQL database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the PostgreSQL Driver used to connect. In this example, we use thePostgreSQL 7 or Higher Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed.
o E.g. serverdomain.com Or 192.168.254.170

e Port: Inform the number port for your database server.

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your PostgreSQL database.
e Password: Enter the password to complete the authentication process.

« Database Name: Type your database name to connect with him. Or, if you want to choose one different database, click on the buttorList Database to show all databases
availabes for your user.
o Create Database: Clicking on this button, you will create a new PostgreSQL database for use.
e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the PostgreSQL connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are
already selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.

e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.



Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.
o By default, Scriptcase leaves this option empty.
o E.g.

Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

Show: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.

Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.

Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with PostgreSQL 6.4 or Higher

In Scriptcase, we have the following drivers available for connections with PostgreSQL: PostgreSQL PDO, PostgreSQL 7 or Higher, PostgreSQL 6.4 or Higher and PostgreSQL
6.3 or Lower. If you are using your own pre-configured environment, PostgreSQL extensions must be manually enabled in PHP.

Prerequisites

If you are using a manual installation on MacOS, you’ll need to install the PHP and the PostgreSQL driver will be enabled. Clickere to see how to do it.
1 - Check if the PostgreSQL driver is enabled in your Scriptcase diagnosis. See below on how to locate your diagnosis and check if the driver is enabled.
e Accessing the top menu Help > Diagnosis, you can easily find it through the interface.
![Accessing diagnosis - Help Menu][diagnosis_sc]
e Or, by accessing your Scriptcase installation path:

127.0.0.1/scriptcase/diagnosis.php Or domain.com/scriptcase/diagnosis.php

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project using the PostgreSQL database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Postgres connection.

Connection

Enter the parameters for connecting to your PostgreSQL database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the PostgreSQL Driver used to connect. In this example, we use thePostgreSQL 6.4 or Higher Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed.
o E.g. serverdomain.com Or 192.168.254.170

e Port: Inform the number port for your database server.

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your PostgreSQL database.
e Password: Enter the password to complete the authentication process.

« Database Name: Type your database name to connect with him. Or, if you want to choose one different database, click on the buttorList Database to show all databases
availabes for your user.
o Create Database: Clicking on this button, you will create a new PostgreSQL database for use.
e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the PostgreSQL connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are
already selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.

e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.



Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.
o By default, Scriptcase leaves this option empty.
o E.g.

Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

Show: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.

Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.

Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



Connecting with PostgreSQL 6.3 or Lower

In Scriptcase, we have the following drivers available for connections with PostgreSQL: PostgreSQL PDO, PostgreSQL 7 or Higher, PostgreSQL 6.4 or Higher and PostgreSQL
6.3 or Lower. If you are using your own pre-configured environment, PostgreSQL extensions must be manually enabled in PHP.

Prerequisites

If you are using a manual installation on MacOS, you’ll need to install the PHP and the PostgreSQL driver will be enabled. Clickere to see how to do it.
1 - Check if the PostgreSQL driver is enabled in your Scriptcase diagnosis. See below on how to locate your diagnosis and check if the driver is enabled.
e Accessing the top menu Help > Diagnosis, you can easily find it through the interface.
![Accessing diagnosis - Help Menu][diagnosis_sc]
e Or, by accessing your Scriptcase installation path:

127.0.0.1/scriptcase/diagnosis.php Or domain.com/scriptcase/diagnosis.php

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project using the PostgreSQL database.
1 - Access any project from your Scriptcase.

2 - Click on the New Connectionicon to create a connection.

or access the Database > New Connectionmenu tab.

After that, a new page will appear with all database connections.

3 - Select the Postgres connection.

Connection

Enter the parameters for connecting to your PostgreSQL database as follows:

e Connection Name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the PostgreSQL Driver used to connect. In this example, we use thePostgreSQL 6.3 or lower Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed.
o E.g. serverdomain.com Or 192.168.254.170

e Port: Inform the number port for your database server.

e Schema: Inform the Scheme of specific tables created for the use of the informed user.
o This item is optional if you do not have a schema configured in your database.

e Username: Inform the user to authenticate the connection to your PostgreSQL database.
e Password: Enter the password to complete the authentication process.

« Database Name: Type your database name to connect with him. Or, if you want to choose one different database, click on the buttorList Database to show all databases
availabes for your user.
o Create Database: Clicking on this button, you will create a new PostgreSQL database for use.
e Test Connection: Click on this button to get a response from the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending or not on the owner.

Show

It allows the PostgreSQL connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are
already selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.

e System Tables: By selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.



Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX% or name of the tables to display.
o By default, Scriptcase leaves this option empty.
o E.g.

Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

Show: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.

Advanced

In this tab, you have access to specific settings for the connection. The changes made in this session impact the data display and application performance.

client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingUTF-8.

Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the period. is selected as a separator.

Persistent Connection: Define whether the connections will be closed after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

Use the schema before table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

o E.g.

Doubts or Connection Problems?

Contact our Support Team in case of connection problems or questions regarding this database.



MSSQL Server

Scriptcase provides some driver options for connecting to MSSQL Server, compatible with the latest versions of Windows, Linux and MacOS.

You can see if drivers are enabled by going to diagnosis.

Accessing from the Scriptcase menu.

After login, in the top menu of the tool access Help > Diagnosis.

© WebHelp ..

€ Technical Support
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Accessing directly through the browser

In your browser, without having to login to Scriptcase, you can access the diagnosis.

When installation is local:
127.0.0.1:8092/scriptcase/diagnosis.php ou localhost:8092/scriptcase/diagnosis.php

In case of installation on a server.

domain.com/scriptcase/diagnosis.php

Click on the driver you want to use, according to your operating system.

Windows

e MSSQL Server NATIVE SRV
e MSSQL Server NATIVE SRV PDO
® MSSQL Server ODBC

Linux
e PDO DBLIB

Mac OS

e PDODBLIB

Compatibility Table

Check below the list of drivers available for each operating system.

OS x Drivers Native SRVPDO  Native SRV ODBC PDO DBlib
Windows Server 2016 [} (] (] (<]
Windows Server 2019

Windows Server 2012 /R2 (] (] (] DJ
Windows 10 [} [ (] 4
Windows 8 /8.1 ] (] (] ]
Windows Server 2008 SP2 / R2 SP1 (] (] (] DJ
Windows 7 SP1 o (] (] ]
Windows Vista SP2 3} a3 @ 4]
Linux a3 (<] o (]
Mac 0S ] ] X] (]



Connection to MSSQL Server NATIVE SRV

At Scriptcase, we have the following drivers available for connecting to SQL Server on Windows: MSSQL Server NATIVE SRV, MSSQL Server NATIVE SRV PDO and MSSQL
Server ODBC .. If you are using your own PHP, as a pre-configured MSSQL environment, it can be manually configured in PHP.

Requirements

Before proceeding with this documentation, check your PHP architecture. For drivers to be enabled correctly,files must be downloaded according to the architecture used.
e In your Scriptcase, there is the fileinfo.php, access it by the URL: http://127.0.0.1:8092/scriptcase/info.php, where you will find the information regarding the architecture inphpinfo().

NOTE: If you are using Scriptcase’s automatic installer, the PHP architecture will be the same as the one you downloadedDownload Microsoft ODBC Driver 13 For
SQL Server according to your PHP architecture .

e x86 Architecture = 32 bits
e x64 Architecture = 64 bits

File list

Listed below are the necessary files for the drivers to be enabled.

e Download Microsoft ODBC Driver 13 For SQL Server x64
e Download Microsoft ODBC Driver 13 For SQL Server x86
e SQL Server extensions for PHP

Compatibility Table

Server 2016 Serv/e;22012 Windows 10 Windows 8 / 8.1 Server 2(;(;815P2 / R2 Win;l:;ws 7 Windosv;s2 Vista
Native SRV
PDO
Native SRV
ODBC

IMPORTANT: if you need to use Database Identifiers in your tables, we recommend using the double quotation marks(“ ) instead of the brackets([ 1) because of the
conflict with the of Global Variables syntax Scriptcase. Using the brackets as database identifiers may lead to problems in the Scriptcase applications

Configuring and enabling MSSQL Server SRV PDO on Windows

If you are using Scriptcase’s automatic installer,the extensions are already enabled in PHP, requiring only the installation of the client. Proceed to item 3
1 - Extract the .zip file and copy the files from thephp_pdo_sqlsrv_81_nts_x64 and php_sqlsrv_81_nts_x64 .dll extensions previously downloaded to your PHP’s ext folder.
2 - In the php.ini file, located in C:\php, add the lines referring to the MSSQL Server extensions php_pdo_sqlsrv_81_nts_x64 and php_sqlsrv_81_nts_x64. See the example below:

extension=pdo_sqlsrv_81_nts_x64
extension=sqlsrv_81_nts_x64

3 - After downloading the Microsoft ODBC Driver 13 For SQL Server file, run the installer and follow the steps below:

4 - Accept the terms of the license agreement and click Next.

5 - Check the option “ODBC Driver for SQL Server SDK”, because the components that we will need are also in this option.

e In this option, leave the option “Client Components” checked.

6 - Click Install to start the client installation.

7 - The program features you selected are being installed.

8 - Click finish to exit.

9 - Restart Apache service through Task Manager.
e Open the Task Manager and click on theServices tab.

e Look for the ApacheScriptcase9php81 Or Apache2.4 service and right click on that service, then clickReiniciar.

Creating a Connection in Scriptcase
See below how to create a connection in your Scriptcase project, using the enabled Driver and the Microsoft SQL Server database.
1 - Access a project from your Scriptcase.

2 - Click the New Connection icon to create a connection



or access the Database > New connectionmenu.

After that, a screen will appear with all database connections.

3 - Select the MSSQL Server connection.

Connection

Enter the parameters for connecting to your MSSQL Server database as follows:

Connection name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
DBMS Driver: Select the DB2 Driver to connect. In this example, we use theMSSQL Server NATIVE SRV PDODDriver.

Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed and its instance separated by a backslash.
EX: dominiodoserver.com\SQLEXPRESS Or 192.168.254.170\SQLEXPRESS

Port: Enter the port to connect to the MSSQL Server. By default, the port defined is1433.

Database Name: List and select the database you will connect to.

EX: samples

Username: Inform the user to authenticate the connection to your database.

Password: Enter the password to complete the authentication process.

Test connection: Click this button to get a response to the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending on the owner or not.

Show

It allows the connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are already
selected by Scriptcase.

Tables: Selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option .

Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option .

System Tables: Selecting this option, the system tables of your database will be displayed.

Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.

Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX%% or name of the tables to display.
o By default, Scriptcase leaves this option empty .
o EX:

Owner: Inform the user who sees the tables informed for display.
o User must be capitalized as in the example above .
View: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.

Advanced

In this tab, you have access to specific settings for the connection. The settings made in this session impact the data display and application performance.

Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the. dot is selected as a separator .

Persistent Connection: Define whether connections will be terminated after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option .

Use the schema before the table name: Define whether the database schema will be displayed before the table names.
o By default, Scriptcase enables this option .



Connection to MSSQL Server NATIVE SRV PDO

At Scriptcase, we have the following drivers available for connecting to SQL Server on Windows: MSSQL Server NATIVE SRV, MSSQL Server NATIVE SRV PDO and MSSQL
Server ODBC .. If you are using your own PHP, as a pre-configured MSSQL environment, it can be manually configured in PHP.

Requirements

Before proceeding with this documentation, check your PHP architecture. For drivers to be enabled correctly,files must be downloaded according to the architecture used.
e In your Scriptcase, there is the fileinfo.php, access it by the URL: http://127.0.0.1:8092/scriptcase/info.php, where you will find the information regarding the architecture inphpinfo().

NOTE: If you are using Scriptcase’s automatic installer, the PHP architecture will be the same as the one you downloadedDownload Microsoft ODBC Driver 13 For
SQL Server according to your PHP architecture .

e x86 Architecture = 32 bits
e x64 Architecture = 64 bits

File list

Listed below are the necessary files for the drivers to be enabled.

e Download Microsoft ODBC Driver 13 For SQL Server x64
e Download Microsoft ODBC Driver 13 For SQL Server x86
e SQL Server extensions for PHP

Compatibility Table

Server 2016 Serv/e;22012 Windows 10 Windows 8 / 8.1 Server 2(;(;815P2 / R2 Win;l:;ws 7 Windosv;s2 Vista
Native SRV
PDO
Native SRV
ODBC

IMPORTANT: if you need to use Database Identifiers in your tables, we recommend using the double quotation marks(“ ) instead of the brackets([ 1) because of the
conflict with the of Global Variables syntax Scriptcase. Using the brackets as database identifiers may lead to problems in the Scriptcase applications

Configuring and enabling MSSQL Server SRV PDO on Windows

If you are using Scriptcase’s automatic installer,the extensions are already enabled in PHP, requiring only the installation of the client. Proceed to item 3
1 - Extract the .zip file and copy the files from thephp_pdo_sqlsrv_81_nts_x64 and php_sqlsrv_81_nts_x64 .dll extensions previously downloaded to your PHP’s ext folder.
2 - In the php.ini file, located in C:\php, add the lines referring to the MSSQL Server extensions php_pdo_sqlsrv_81_nts_x64 and php_sqlsrv_81_nts_x64. See the example below:

extension=pdo_sqlsrv_81_nts_x64
extension=sqlsrv_81_nts_x64

3 - After downloading the Microsoft ODBC Driver 13 For SQL Server file, run the installer and follow the steps below:

4 - Accept the terms of the license agreement and click Next.

5 - Check the option “ODBC Driver for SQL Server SDK”, because the components that we will need are also in this option.

e In this option, leave the option “Client Components” checked.

6 - Click Install to start the client installation.

7 - The program features you selected are being installed.

8 - Click finish to exit.

9 - Restart Apache service through Task Manager.
e Open the Task Manager and click on theServices tab.

e Look for the ApacheScriptcase9php81 Or Apache2.4 service and right click on that service, then clickReiniciar.

Creating a Connection in Scriptcase
See below how to create a connection in your Scriptcase project, using the enabled Driver and the Microsoft SQL Server database.
1 - Access a project from your Scriptcase.

2 - Click the New Connection icon to create a connection



or access the Database > New connectionmenu.

After that, a screen will appear with all database connections.

3 - Select the MSSQL Server connection.

Connection

Enter the parameters for connecting to your MSSQL Server database as follows:

Connection name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
DBMS Driver: Select the DB2 Driver to connect. In this example, we use theMSSQL Server NATIVE SRV PDODDriver.

Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed and its instance separated by a backslash.
EX: dominiodoserver.com\SQLEXPRESS Or 192.168.254.170\SQLEXPRESS

Port: Enter the port to connect to the MSSQL Server. By default, the port defined is1433.

Database Name: List and select the database you will connect to.

EX: samples

Username: Inform the user to authenticate the connection to your database.

Password: Enter the password to complete the authentication process.

Test connection: Click this button to get a response to the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending on the owner or not.

Show

It allows the connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are already
selected by Scriptcase.

Tables: Selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option .

Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option .

System Tables: Selecting this option, the system tables of your database will be displayed.

Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.

Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX%% or name of the tables to display.
o By default, Scriptcase leaves this option empty .
o EX:

Owner: Inform the user who sees the tables informed for display.
o User must be capitalized as in the example above .
View: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.

Advanced

In this tab, you have access to specific settings for the connection. The settings made in this session impact the data display and application performance.

Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the. dot is selected as a separator .

Persistent Connection: Define whether connections will be terminated after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option .

Use the schema before the table name: Define whether the database schema will be displayed before the table names.
o By default, Scriptcase enables this option .



Connection to MSSQL Server ODBC

At Scriptcase, we have the following drivers available for connecting to SQL Server on Windows: MSSQL Server NATIVE SRV, MSSQL Server NATIVE SRV PDO and MSSQL
Server ODBC .. If you are using your own PHP, as a pre-configured MSSQL environment, it can be manually configured in PHP.

Requirements

Before proceeding with this documentation, check your PHP architecture. For drivers to be enabled correctly,files must be downloaded according to the architecture used.
e In your Scriptcase, there is the fileinfo.php, access it by the URL: http://127.0.0.1:8092/scriptcase/info.php, where you will find the information regarding the architecture inphpinfo().

NOTE: If you are using Scriptcase’s automatic installer, the PHP architecture will be the same as the one you downloadedDownload Microsoft ODBC Driver 13 For
SQL Server according to your PHP architecture .

e x86 Architecture = 32 bits
e x64 Architecture = 64 bits

File list

Listed below are the necessary files for the drivers to be enabled.

e Download Microsoft ODBC Driver 13 For SQL Server x64
e Download Microsoft ODBC Driver 13 For SQL Server x86
e SQL Server extensions for PHP

Compatibility Table

Server 2016 Serv/e;22012 Windows 10 Windows 8 / 8.1 Server 2(;(;815P2 / R2 Win;l:;ws 7 Windosv;s2 Vista
Native SRV
PDO
Native SRV
ODBC

IMPORTANT: if you need to use Database Identifiers in your tables, we recommend using the double quotation marks(“ ) instead of the brackets([ 1) because of the
conflict with the of Global Variables syntax Scriptcase. Using the brackets as database identifiers may lead to problems in the Scriptcase applications

Configuring and enabling MSSQL Server SRV PDO on Windows

If you are using Scriptcase’s automatic installer,the extensions are already enabled in PHP, requiring only the installation of the client. Proceed to item 3
1 - Extract the .zip file and copy the files from thephp_pdo_sqlsrv_81_nts_x64 and php_sqlsrv_81_nts_x64 .dll extensions previously downloaded to your PHP’s ext folder.
2 - In the php.ini file, located in C:\php, add the lines referring to the MSSQL Server extensions php_pdo_sqlsrv_81_nts_x64 and php_sqlsrv_81_nts_x64. See the example below:

extension=pdo_sqlsrv_81_nts_x64
extension=sqlsrv_81_nts_x64

3 - After downloading the Microsoft ODBC Driver 13 For SQL Server file, run the installer and follow the steps below:

4 - Accept the terms of the license agreement and click Next.

5 - Check the option “ODBC Driver for SQL Server SDK”, because the components that we will need are also in this option.

e In this option, leave the option “Client Components” checked.

6 - Click Install to start the client installation.

7 - The program features you selected are being installed.

8 - Click finish to exit.

9 - Restart Apache service through Task Manager.
e Open the Task Manager and click on theServices tab.

e Look for the ApacheScriptcase9php81 Or Apache2.4 service and right click on that service, then clickReiniciar.

Creating the DSN for connection
To connect to the MSSQL Server ODBC Driver, you need to configure a System DSN. Follow the steps described below to perform this configuration.
ATTENTION: ODBC must be created on the same Server where ScriptCase is installed.

1 - Access your ODBC Data Source Manager and select according to your architecture. We will select the x64 version:



2 - When entering the ODBC Data Sources Administrator, select theDSN System tab and click on_Add to create your connection to your Database.

3 - After that, it is necessary to select the Driver to connect to the MSSQL Server. Select the Driver: ODBC Driver 11 for SQL Server .

4 - Now, you need to define the name of the DSN, the description and the database connection server.

o Name: Enter the name that the DSN will have so that you can use it in Scriptcase.
e Description: Add a description for the DSN.
e Server: inform the database server, port and instance that you will connect to.

4.1 - After entering the data, click on the Next button to enter the user name and password required for connection.

e Login ID: Inform the user to authenticate with the database.
e Password: Enter the corresponding password to authenticate with the informed user.

4.2 - Now, click Next to select the default database.

To finish, click Next and finally, click Finish.

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using the enabled Driver and the Microsoft SQL Server database.
1 - Access a project from your Scriptcase.

2 - Click the New Connection icon to create a connection

or access the menu Database > New connection

After that, a screen will appear with all database connections.

3 - Select the MSSQL Server connection.

Connection

Enter the parameters for connecting to your MSSQL Server database as follows:

e Connection name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the DB2 Driver to connect. In this example, we use theMSSQL Server ODBC Driver.

e Server/Host (Name or IP): Enter the system DSN that was configured in ODBC Manager.

e EX: mssql

e Username: Inform the user to authenticate the connection to your database.

e Password: Enter the password to complete the authentication process.

e Test connection: Click this button to get a response to the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending on the owner or not.

Show

It allows the connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are already
selected by Scriptcase.

e Tables: Selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option .

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option .

e System Tables: Selecting this option, the system tables of your database will be displayed.
e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches



Allows you to define which tables and owners are displayed.

e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX%% or name of the tables to display.
o By default, Scriptcase leaves this option empty .
o EX:

e Owner: Inform the user who sees the tables informed for display.
o User must be capitalized as in the example above .
e View: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The settings made in this session impact the data display and application performance.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the. dot is selected as a separator .

e Persistent Connection: Define whether connections will be terminated after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option .

e Use the schema before the table name: Define whether the database schema will be displayed before the table names.
o By default, Scriptcase enables this option .



Connection to MSSQL Server DBLIB

In Scriptcase installed on Linux, we have the following driver available for connection to MSSQL Server:DBLIB. If you are using your own preconfigured environment, the MSSQL
Server extensions must be manually enabled in the PHP.

IMPORTANT: if you need to use Database Identifiers in your tables, we recommend using the double quotation marks(“ ) instead of the brackets([ 1) because of the
conflict with the of Global Variables syntax Scriptcase. Using the brackets as database identifiers may lead to problems in the Scriptcase applications

Enabling DBLIB on Linux

IMPORTANT: If you are using Scriptcase automatic installer,the extensions are already enabled in PHP, ready for connection. The procedure below is only for
manual installations of Scriptcase.

1 - If you do not have the extension enabled you can install the extension with this command in the terminal:
sudo apt-get install php8.1-pdo-dblib
e If you are unable to execute the above command because you cannot find packages, install the repository below and update.

sudo add-apt-repository ppa:ondrej/php
sudo apt-get update

Install the basic packages using the terminal for this procedure:

Ubuntu\Debian RHEL\CentOS

sudo apt-get install unixodbc unixodbc-dev gcc nano wget make sudo yum install unixODBC unixODBC-devel gcc nano wget make
e Download and Unzip the freeTDS:

wget https://www.freetds.org/files/stable/freetds-0.95.95.tar.gz

tar -zxf freetds-0.95.95.tar.gz
e Access the freeTDS directory and run the following command to compile and install FreeTDS:

sudo ./configure --with-tdsver=7.4 --with-unixodbc=/usr --disable-libiconv --disable-static --disable-threadsafe --enable-msdblib --disable-sspi --with-gnu-Id --enable-sybase-compat && make && make install
e Edit the FreeTDS configuration file:

Ubuntu\Debian RHEL\CentOS
sudo nano/usr/local/etc/freetds.conf sudo vim /usr/local/freetds/freetds.conf
e Add your MSSQL Server connection informations, like this example:
[MSSQLServer] host = 192.18.72.03
port = 1433
tds version = 7.2

2 - Restart the Apache service via the terminal.

sudo service apache?2 restart

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using the Enabled Driver DBLIB and the MSSQL Server database.
1 - Access a project from your Scriptcase.

2 - Click the New Connection icon to create a connection

or access the Database > New connectionmenu.

After that, a screen will appear with all database connections.

3 - Select the MSSQL Server connection.

Connection

Enter the parameters for connecting to your MSSQL Server database as follows:

e Connection name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
o DBMS Driver: Select the MSSQL Server Driver to connect. In this example, we use the DriverDBLIB.

e Server/Host (Name or IP): Enter the name of the data source you have configured on your freetds.conf file.

e EX: MSsQLServer

e Port: Enter the port to connect to the MSSQL Server. By default, the port defined is1433.

« Database Name: List and select the database you will connect to.

o EX: samples

e Username: Inform the user to authenticate the connection to your database.

e Password: Enter the password to complete the authentication process.

e Test connection: Click this button to get a response to the Scriptcase request to find out if the parameters entered are correct.



Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending on the owner or not.

Show

It allows the connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are already
selected by Scriptcase.

e Tables: Selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option .

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option .

e System Tables: Selecting this option, the system tables of your database will be displayed.
e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.

e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX%% or name of the tables to display.
o By default, Scriptcase leaves this option empty .
o EX:

e Owner: Inform the user who sees the tables informed for display.
o User must be capitalized as in the example above .
e View: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The settings made in this session impact the data display and application performance.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the. dot is selected as a separator .

e Persistent Connection: Define whether connections will be terminated after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option .

e Use the schema before the table name: Define whether the database schema will be displayed before the table names.
o By default, Scriptcase enables this option .

Questions or Connection Problems?

Contact our support in case of connection problems or questions regarding this database.



Connection to MSSQL NATIVE SRV PDO

In Scriptcase installed on Linux, we have the following drivers available for connection to MSSQL Server:DBLIB, NATIVE SRV PDO and NATIVE SRV. If you are using your own
preconfigured environment, the MSSQL Server extensions must be manually enabled in the PHP.

IMPORTANT: if you need to use Database Identifiers in your tables, we recommend using the double quotation marks(“ ) instead of the brackets([ 1) because of the
conflict with the of Global Variables syntax Scriptcase. Using the brackets as database identifiers may lead to problems in the Scriptcase applications

Microsoft Driver Installation Tutorial for PHP and SQL Server

IMPORTANT: If you are using Scriptcase automatic installer,the extensions are already enabled in PHP, ready for connection. The procedure below is only for
manual installations of Scriptcase.

1 - Enter the Shell (terminal) as root and install the following packages:

Ubuntu\Debian RHEL\CentOS

sudo apt-get install unixodbc-dev sudo yum install unixODBC-devel
In the linux terminal, you will need to run the following commands to install the drivers:
Ubuntu\Debian

sudo pecl install pdo_sqlsrv

sudo su
printf "; priority=30\nextension=pdo_sqlsrv.so\n" > /etc/php/8.1/mods-available/pdo_sqlsrv.ini

exit

sudo phpenmod -v 8.1 pdo_sqlsrv
RHEL\CentOS

sudo pecl install pdo_sqlsrv
sudo su
echo extension=pdo_sqlsrv.so >> “php --ini | grep "Scan for additional .ini files" | sed -e "s|.*:\s*||""/30-pdo_sqlsrv.ini
exit
e If you are unable to execute the above command because you cannot find packages, install the repository below and update.
sudo su
add-apt-repository ppa:ondrej/php -y
sudo apt-get update
2 - Restart the Apache service via the terminal.
sudo service apache2 restart

Important: Continue to the Microsoft ODBC Driver installation in order to enable the drivers and complete the process.

Installing Microsoft ODBC Driver for SQL Server (Linux)
1 - Using the terminal, run the following commands:

Ubuntu

if ! [[ "16.04 18.04 20.04 22.04" == *"$(Isb_release -rs)"* 1J;
then
echo "Ubuntu $(Isb_release -rs) is not currently supported.”;
exit;
fi

sudo su
curl https://packages.microsoft.com/keys/microsoft.asc | apt-key add -

curl https://packages.microsoft.com/config/ubuntu/$(Isb_release -rs)/prod.list > /etc/apt/sources.list.d/mssql-release.list
exit
sudo apt-get update

sudo ACCEPT_EULA=Y apt-get install -y msodbcsqll7
Debian

sudo su
curl https://packages.microsoft.com/keys/microsoft.asc | apt-key add -

#Download appropriate package for the OS version
#Choose only ONE of the following, corresponding to your OS version

#Debian 9
curl https://packages.microsoft.com/config/debian/9/prod.list > /etc/apt/sources.list.d/mssql-release.list

#Debian 10
curl https://packages.microsoft.com/config/debian/10/prod.list > /etc/apt/sources.list.d/mssql-release.list

#Debian 11
curl https://packages.microsoft.com/config/debian/11/prod.list > /etc/apt/sources.list.d/mssql-release.list

sudo apt-get update

sudo ACCEPT_EULA=Y apt-get install -y msodbcsql17
RHEL\CentOS

sudo su

#Download appropriate package for the OS version
#Choose only ONE of the following, corresponding to your OS version

#RHEL 7 and Oracle Linux 7
curl https://packages.microsoft.com/config/rhel/7/prod.repo > /etc/yum.repos.d/mssql-release.repo



#RHEL 8 and Oracle Linux 8
curl https://packages.microsoft.com/config/rhel/8/prod.repo > /etc/yum.repos.d/mssql-release.repo

#RHEL 9
curl https://packages.microsoft.com/config/rhel/9.0/prod.repo > /etc/yum.repos.d/mssql-release.repo

sudo yum remove unixODBC-utf16 unixODBC-utf16-devel #to avoid conflicts

sudo ACCEPT_EULA=Y yum install -y msodbcsql17
2 - Restart the Apache service via the terminal.

sudo service apache2 restart

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using the enabled Driver and the Microsoft SQL Server database.
1 - Access a project from your Scriptcase.

2 - Click the New Connection icon to create a connection

or access the Database > New connectionmenu.

After that, a screen will appear with all database connections.

3 - Select the MSSQL Server connection.

Connection

Enter the parameters for connecting to your MSSQL Server database as follows:

e Connection name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.

o DBMS Driver: Select the DB2 Driver to connect. In this example, we use theMSSQL Server NATIVE SRV PDODDriver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed and its instance separated by a backslash.
e EX: dominiodoserver.com\SQLEXPRESS OF 192.168.254.170\SQLEXPRESS

e Port: Enter the port to connect to the MSSQL Server. By default, the port defined is1433.

« Database Name: List and select the database you will connect to.

o EX: samples

e Username: Inform the user to authenticate the connection to your database.

e Password: Enter the password to complete the authentication process.

e Test connection: Click this button to get a response to the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending on the owner or not.

Show

It allows the connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are already
selected by Scriptcase.

e Tables: Selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option .

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option .

e System Tables: Selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.

e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX%% or name of the tables to display.
o By default, Scriptcase leaves this option empty .
o EX:

e Owner: Inform the user who sees the tables informed for display.
o User must be capitalized as in the example above .
e View: Choose whether tables for the informed owner are displayed.



NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The settings made in this session impact the data display and application performance.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the. dot is selected as a separator .

e Persistent Connection: Define whether connections will be terminated after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option .

e Use the schema before the table name: Define whether the database schema will be displayed before the table names.
o By default, Scriptcase enables this option .

Questions or Connection Problems?

Contact our support in case of connection problems or questions regarding this database.



Connection to MSSQL NATIVE SRV

In Scriptcase installed on Linux, we have the following drivers available for connection to MSSQL Server:DBLIB, NATIVE SRV PDO and NATIVE SRV. If you are using your own
preconfigured environment, the MSSQL Server extensions must be manually enabled in the PHP.

IMPORTANT: if you need to use Database Identifiers in your tables, we recommend using the double quotation marks(“ ) instead of the brackets([ 1) because of the
conflict with the of Global Variables syntax Scriptcase. Using the brackets as database identifiers may lead to problems in the Scriptcase applications

Microsoft Driver Installation Tutorial for PHP and SQL Server

IMPORTANT: If you are using Scriptcase automatic installer,the extensions are already enabled in PHP, ready for connection. The procedure below is only for
manual installations of Scriptcase.

1 - Enter the Shell (terminal) as root and install the following packages:

Ubuntu\Debian RHEL\CentOS

sudo apt-get install unixodbc-dev sudo yum install unixODBC-devel
In the linux terminal, you will need to run the following commands to install the drivers:

Ubuntu\Debian

sudo pecl install sqlsrv

sudo su
printf "; priority=20\nextension=sqlsrv.so\n" > /etc/php/8.1/mods-available/sqlsrv.ini

exit

sudo phpenmod -v 8.1 sqlsrv
RHEL\CentOS

sudo pecl install sqlsrv
sudo su
echo extension=sqlsrv.so >> "php --ini | grep "Scan for additional .ini files" | sed -e "s|.*:\s*||"*/20-sqlsrv.ini
exit
e If you are unable to execute the above command because you cannot find packages, install the repository below and update.

sudo su
add-apt-repository ppa:ondrej/php -y
sudo apt-get update

2 - Restart the Apache service via the terminal.
sudo service apache2 restart

Important: Continue to the Microsoft ODBC Driver installation in order to enable the drivers and complete the process.

Installing Microsoft ODBC Driver for SQL Server (Linux)
1 - Using the terminal, run the following commands:

Ubuntu

if ! [[ "16.04 18.04 20.04 22.04" == *"$(Isb_release -rs)"* 1];
then
echo "Ubuntu $(Isb_release -rs) is not currently supported.”;
exit;
fi

sudo su
curl https://packages.microsoft.com/keys/microsoft.asc | apt-key add -

curl https://packages.microsoft.com/config/ubuntu/$(Isb_release -rs)/prod.list > /etc/apt/sources.list.d/mssql-release.list
exit
sudo apt-get update

sudo ACCEPT_EULA=Y apt-get install -y msodbcsqll7
Debian

sudo su
curl https://packages.microsoft.com/keys/microsoft.asc | apt-key add -

#Download appropriate package for the OS version
#Choose only ONE of the following, corresponding to your OS version

#Debian 9
curl https://packages.microsoft.com/config/debian/9/prod.list > /etc/apt/sources.list.d/mssql-release.list

#Debian 10
curl https://packages.microsoft.com/config/debian/10/prod.list > /etc/apt/sources.list.d/mssql-release.list

#Debian 11
curl https://packages.microsoft.com/config/debian/11/prod.list > /etc/apt/sources.list.d/mssql-release.list

sudo apt-get update

sudo ACCEPT_EULA=Y apt-get install -y msodbcsql17
RHEL\CentOS

sudo su

#Download appropriate package for the OS version
#Choose only ONE of the following, corresponding to your OS version

#RHEL 7 and Oracle Linux 7
curl https://packages.microsoft.com/config/rhel/7/prod.repo > /etc/yum.repos.d/mssql-release.repo

#RHEL 8 and Oracle Linux 8



curl https://packages.microsoft.com/config/rhel/8/prod.repo > /etc/yum.repos.d/mssql-release.repo

#RHEL 9
curl https://packages.microsoft.com/config/rhel/9.0/prod.repo > /etc/yum.repos.d/mssql-release.repo

sudo yum remove unixODBC-utf16 unixODBC-utf16-devel #to avoid conflicts

sudo ACCEPT_EULA=Y yum install -y msodbcsql17
2 - Restart the Apache service via the terminal.

sudo service apache2 restart

Creating a Connection in Scriptcase

See below how to create a connection in your Scriptcase project, using the enabled Driver and the Microsoft SQL Server database.
1 - Access a project from your Scriptcase.

2 - Click the New Connection icon to create a connection

or access the Database > New connectionmenu.

After that, a screen will appear with all database connections.

3 - Select the MSSQL Server connection.

Connection

Enter the parameters for connecting to your MSSQL Server database as follows:

e Connection name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.

o DBMS Driver: Select the DB2 Driver to connect. In this example, we use theMSSQL Server NATIVE SRV Driver.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed and its instance separated by a backslash.
e EX: dominiodoserver.com\SQLEXPRESS OF 192.168.254.170\SQLEXPRESS

e Port: Enter the port to connect to the MSSQL Server. By default, the port defined is1433.

« Database Name: List and select the database you will connect to.

o EX: samples

e Username: Inform the user to authenticate the connection to your database.

e Password: Enter the password to complete the authentication process.

e Test connection: Click this button to get a response to the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending on the owner or not.

Show

It allows the connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are already
selected by Scriptcase.

e Tables: Selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option .

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option .

e System Tables: Selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.

e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX%% or name of the tables to display.
o By default, Scriptcase leaves this option empty .
o EX:

e Owner: Inform the user who sees the tables informed for display.
o User must be capitalized as in the example above .
e View: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.



Advanced

In this tab, you have access to specific settings for the connection. The settings made in this session impact the data display and application performance.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the. dot is selected as a separator .

e Persistent Connection: Define whether connections will be terminated after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option .

e Use the schema before the table name: Define whether the database schema will be displayed before the table names.
o By default, Scriptcase enables this option .

Questions or Connection Problems?

Contact our support in case of connection problems or questions regarding this database.



Connection to PDO DBLIB

In Scriptcase installed on Linux, we have the following driver available for connection to MSSQL Server:PDO DBLIB . If you are using your own pre-configured environment, MSSQL
Server extensions must be enabled manually in PHP.

IMPORTANT: if you need to use Database Identifiers in your tables, we recommend using the double quotation marks(“ ) instead of the brackets([ 1) because of the
conflict with the of Global Variables syntax Scriptcase. Using the brackets as database identifiers may lead to problems in the Scriptcase applications

Configuring and enabling the DBLIB PDO on macOS

IMPORTANT: If you are using Scriptcase’s automatic installer,the extensions are already enabled in PHP, ready for connection. The procedure below is only for
manual installations of Scriptcase .

If you have installed PHP 8.1 through our documentation using homebrew, PDO DBLIB is already enabled in PHP, requiring only the connection. Check below our documentation
for installing PHP 8.1 with homebrew on macOS.

PHP 8.1 on macOS: click here

Connection to Scriptcase

See below how to create a connection in your Scriptcase project, using the Enabled Driver MSSQL Server NATIVE SRV or MSSQL Server NATIVE SRV PDO and the Azure
MSSQL Server database.

1 - Access a project from your Scriptcase.

2 - Click the New Connection icon to create a connection

or access the Database > New connectionmenu.

After that, a screen will appear with all database connections.

3 - Select the MSSQL Server connection.

Connection

Enter the parameters for connecting to your Azure MSSQL Server database as follows:

e Connection name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.

o DBMS Driver: Select the MSSQL Server Driver to connect. In this example, we use the DriverPDO DBLIB.

e Server/Host (Name or IP): Enter the IP or domain of the server where the database is installed and its instance separated by a backslash.
e EX: dominiodoserver.com\SQLEXPRESS OF 192.168.254.170\SQLEXPRESS

e Port: Enter the port to connect to the MSSQL Server. By default, the port defined is1433.

« Database Name: List and select the database you will connect to.

o EX: samples

e Username: Inform the user to authenticate the connection to your database.

e Password: Enter the password to complete the authentication process.

e Test connection: Click this button to get a response to the Scriptcase request to find out if the parameters entered are correct.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending on the owner or not.

Show

It allows the connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are already
selected by Scriptcase.

e Tables: Selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option .

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option .

e System Tables: Selecting this option, the system tables of your database will be displayed.

e Procedures: By selecting this option, the procedures of your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.

e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX%% or name of the tables to display.
o By default, Scriptcase leaves this option empty .



e Owner: Inform the user who sees the tables informed for display.
o User must be capitalized as in the example above .
e View: Choose whether tables for the informed owner are displayed.

NOTE: By using table filtering, you eliminate unnecessary tables for your project andimproves the performance of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The settings made in this session impact the data display and application performance.

« Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the. dot is selected as a separator .

e Persistent Connection: Define whether connections will be terminated after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option .

e Use the schema before the table name: Define whether the database schema will be displayed before the table names.
o By default, Scriptcase enables this option .

Questions or Connection Problems?

Contact our support in case of connection problems or questions regarding this database.



SQLite with Scriptcase

In Scriptcase, we only have one driver to connect to SQLite: SQLite PDO. If you are using your own pre-configured environment, the SQLite extension must be enabled manually in PHP .
You can check if your driver is enabled by accessing your Scriptcase diagnostics. See below for how to locate your diagnostics:

e henyou go to the top menu Help > Diagnostics, you can easily find it through the interface.

@ WebHelp ..

® Technical Support

e 1, by accessing the url in your browser:
127.0.0.1:8092/scriptcase/diagnosis.php or domain.com/scriptcase/diagnosis.php

If the driver is already enabled, you only need to connect to Scriptcase, click on the link below to be directed to the driver that will be used.

Environment  SQLite PDO

Windows Connect
Linux Connect
macOS Connect

Doubts or Connection Problems?
Contact our Support Team in case of connection problems or questions regarding this database.



Windows

In Scriptcase, we only have one driver to connect to SQLite: SQLite PDO. If you are using your own pre-configured environment, the SQLite extension must be enabled manually in PHP .

Prerequisites

If you are using a manual installation on Windows, you will need to enable the SQLite extension in the ~php.ini file. See below for how to do this.

| NOTE: Ifyou are using an automatic Scriptcase installation, the SQLite driver will be enabled automatically.

1-Inthe php.ini file, located under C:\php , uncomment the line for the SQLite extension pdo_sqlite by removing the ; from the start of the line. See the example below:

2 - Restart the Apache service using the Task Manager.
e pen Task Manager and click on the Services tab.

e ook forthe Apache2.4 or ApacheScriptcase9php73 service and right-click on this service, then Restart.
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Creating a connection in Scriptcase

Here is how to create a connection in your Scriptcase project using the SQLite database.
1 - Access any project from within your Scriptcase.

2 - Click on the New Connection icon to create a connection.

> Project Database  Application

R EI o @
Home New Op! Newr Edit

Project Project project project connection ~ fonnection

or go to the Database > New Connection menu.

BEIELEECE Application  Tools L4

Home
€, Edit connection

Newcont @ Import ACCESS

[@ Import EXCEL

After that, a new page will appear with all the database connections.

3 - Select the SQLite connection.



Create a connection

Select your database system and create a connection for your project.
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Connection

Enter the parameters for connecting to your SQLite database as follows:

e onnection Name: Set the name of your new connection. By default, Scriptcase adds the prefix conn along with the database name.
e  BMS Driver: Select the SQLite Driver used to connect. By default, the driver will be SQLite PDO.

o erver/Host(Name or IP): Enter the full path to your SQLite database file. EX: C:\Apache24\htdocs\client_data

e assword: Enter the password to complete the authentication process if you have it set for your DB file.

o  est Connection: Click this button to get a response from the Scriptcase request to see if the parameters you entered are correct.

Connection Success

[ o | o ]

Filter

By accessing this tab, you can configure which items from the Database will be displayed in the connection, depending on the owner or not.

ADVANCED o

CONNECTION | FILTER

Show Searches
| Tables
Tables Owner Show
w| Views
System tables
No -
Procedures
Show

Allows the SQLite connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the items  Tables and Views are already selected by Scriptcase.

e  ables: By selecting this option, the tables in your database will be displayed.

o ydefault, Scriptcase enables this option.

® iews: By selecting this option, the views of your database will be displayed.

o ydefault, Scriptcase enables this option.

e ystem tables: By selecting this option, the system tables of your database will be displayed.

e rocedures: When you select this option, the procedures from your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.

e ables: You can define in this option which tables will be displayed. The setting can containa PREFIX% or name of the tables to be displayed.



o ydefault, Scriptcase leaves this option empty.

o x
Using the table prefix
Tables Ouner
supx svsTEm
Using the table name
Tables Owner
SUP_ACCOUNT, SUP_ORDEF | SYSTEM

e wner: Inform the user who sees the inserted tables for display.

o ser must be in capital letters, as in the example above

e how: Choose whether tables are displayed for the owner entered.

NOTE: By using table filtering, you eliminate unnecessary tables for your project and improve the performance of your database connection.

Advanced

In this tab, you have access to settings specific to the connection. Changes made in this section impact the data display and performance of the application.

CONNECTION ~ FILTER | ADVANCED

client_encoding

UTF8 - Unicode, 8-bit -

Decimal Separator

Persistent Connection

No -

Use the schema before table name

Yes -

lient_encoding: Select the encoding used in your database. In the example above, we used client_encoding UTF-8.
ecimal separator: Select the separator type for decimal records, between comma and period.

o ydefault, period . is selected as the separator.

ersistent connection: Set whether connections will be closed after your scripts run in Scriptcase applications.
o ydefault, Scriptcase disables this option.

se the schema before table name: Set whether the database schema is displayed before the table names.
o ydefault, Scriptcase enables this option.

o X:

Using the schema before table name | Not using the schema before table name

Connection Connection

conn_oracle N conn_oracle ™
Table Table
"SYSTEM".COL - [%7 CoL - <

Doubts or Connection Problems?
Contact our Support Team in case of connection problems or questions regarding this database.



Linux

In Scriptcase, we only have one driver to connect to SQLite: SQLite PDO. If you are using your own pre-configured environment, the SQLite extension must be enabled manually in PHP .

Prerequisites

If you are using a manual installation on Linux, you will need to install the SQLite php extension. See below for how to do this:

| NOTE: Ifyou are using an automatic Scriptcase installation, the SQLite driver will be enabled automatically.

1 - Log into your Linux terminal and type this line below according to your operating system to install the SQLite PDO driver.
Ubuntu CentOS
sudo apt-get install php8.1-sqlite sudo yum install php-sqlite

2 - Make sure that the SQLite driver is enabled in your Scriptcase diagnostic:

e henyou go to the top menu Help > Diagnostics, you can easily find it through the interface.

© WebHelp

@& Technical Support

® 1, by accessing your Scriptcase installation path:

127.0.0.1/scriptcase/diagnosis.php or domain.com/scriptcase/diagnosis.php

Creating a connection in Scriptcase

Here is how to create a connection in your Scriptcase project using the SQLite database.
1 - Access any project from within your Scriptcase.

2 - Click on the New Connection icon to create a connection.

> Project Database  Application Mo
O m
P ) R )
Home New Op! Newr Edit
Project Project project project connection ~ fronnection
or go to the Database > New Connection menu.
BEIELEECE Application  Tools L4
Home
€, Edit connection
Newconsm @8 Import ACCESS
[ Import EXCEL
After that, a new page will appear with all the database connections.
3 - Select the SQLite connection.
Create a connection
Select your database system and create a connection for your project.

ORACLE )= DB2 Informix @

MySsoL <
ﬁ N = Oracle S wmssaL = Postgres = DB2 = Informix = MS Access
ysaLmeran Server
Po.|bne @ @ A @ O
£ saoLite £ syBase S InterBase £ Firebird £ Microsoft £ Amazon = Google
Azure RDS Cloud
& Generic
é 4‘ ' = opBC
Oracle Progress ODBC
= H s
Cloud

Connection



Enter the parameters for connecting to your SQLite database as follows:

e onnection Name: Set the name of your new connection. By default, Scriptcase adds the prefix conn along with the database name.
®  BMS Driver: Select the SQLite Driver used to connect. By default, the driver will be SQLite PDO.

o erver/Host(Name or IP): Enter the full path to your SQLite database file. EX: C:\Apache24\htdocs\client_data

e assword: Enter the password to complete the authentication process if you have it set for your DB file.

o est Connection: Click this button to get a response from the Scriptcase request to see if the parameters you entered are correct.

Connection Success

# Test Connection m

Filter

By accessing this tab, you can configure which items from the Database will be displayed in the connection, depending on the owner or not.

CONNECTION | FILTER | ADVANCED °

Show Searches
| Tables

Tables Owner Show
| Views

System tables
y NO -
Procedures

Show

Allows the SQLite connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the items ~ Tables and Views are already selected by Scriptcase.

o ables: By selecting this option, the tables in your database will be displayed.

o ydefault, Scriptcase enables this option.

e iews: By selecting this option, the views of your database will be displayed.

o ydefault, Scriptcase enables this option.

e  ystem tables: By selecting this option, the system tables of your database will be displayed.

o rocedures: When you select this option, the procedures from your database will be displayed.

Searches

Allows you to define which tables and owners are displayed.

e ables: You can define in this option which tables will be displayed. The setting can containa  PREFIX% or name of the tables to be displayed.

o ydefault, Scriptcase leaves this option empty.

o x
Using the table prefix
Tables Owner
SUP% SYSTEM
Using the table name
Tables Owner
SUP_ACCOUNT, SUP_ORDEF SYSTEM

e wner: Inform the user who sees the inserted tables for display.

o ser must be in capital letters, as in the example above

o how: Choose whether tables are displayed for the owner entered.




| NOTE: By using table filtering, you eliminate unnecessary tables for your project and _improve the performance of your database connection.

Advanced

In this tab, you have access to settings specific to the connection. Changes made in this section impact the data display and performance of the application.

CONNECTION  FILTER | ADVANCED

client_encoding

UTFS - Unicode, 8-bit -

Decimal Separator

Persistent Connection

No -

Use the schema before table name

Yes -

e lient_encoding: Select the encoding used in your database. In the example above, we used client_encoding UTF-8.
e ecimal separator: Select the separator type for decimal records, between comma and period.
o ydefault, period . is selected as the separator.
e ersistent connection: Set whether connections will be closed after your scripts run in Scriptcase applications.
o ydefault, Scriptcase disables this option.
.

se the schema before table name: Set whether the database schema is displayed before the table names.

o ydefault, Scriptcase enables this option.

o X:

Using the schema before table name | Not using the schema before table name

Connection” Connection”

conn_oracle hd conn_oracle hd
Table Table
"SYSTEM".COL - [+ COoL - (s

Doubts or Connection Problems?
Contact our Support Team in case of connection problems or questions regarding this database.



Mac OS

In Scriptcase, we only have one driver to connect to SQLite: SQLite PDO. If you are using your own pre-configured environment, the SQLite extension must be enabled manually in PHP .

Prerequisites

If you are using a manual installation on MacOS, you will need to install PHP and the SQLite driver will be enabled. Click here to see how to do this.

| NOTE: Ifyou are using an automatic Scriptcase installation, the SQLite driver will be enabled automatically.

1 - Verify that the SQLite driver is enabled in your Scriptcase diagnostic. See below for how to locate your diagnostic:

e  henyou go to the top menu Help > Diagnostics, you can easily find it through the interface.

© WebHelp
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e 1, byaccessing your Scriptcase installation path:

127.0.0.1/scriptcase/diagnosis.php or domain.com/scriptcase/diagnosis.php

Creating a connection in Scriptcase

Here is how to create a connection in your Scriptcase project using the SQLite database.
1 - Access any project from within your Scriptcase.

2 - Click on the New Connection icon to create a connection.

> Project Database Application Tools Layout

P m
AL m
Home New Op!

Project Project project project connection ~ fonnection

or go to the Database > New Connection menu.

ct [EBEIGLEECEN Application Tools L4

€, Edit connection

Newconn @ Import ACCESS

[@ Import EXCEL

After that, a new page will appear with all the database connections.

3 - Select the SQLite connection.

Create a connection °

Select your database system and create a connection for your project.

ORACLE B DBZ Informix @

MySsoL <

ﬁ ) £ oracle £ mssaL = Postgres = pe2 £ Informix = MSAccess

ysaLMariaD Server

B

Po.| b @ @ A ¢ a\

£ salite £ sybaze £ InterBase £ Firebird £ Microsoft S Amazon £ Google

Azure RDS Cloud

@ Generic
—3

é 4' ' == ODBC

= Oracle = Progress = oDEC

Cloud

Connection

Enter the parameters for connecting to your SQLite database as follows:

e onnection Name: Set the name of your new connection. By default, Scriptcase adds the prefix conn along with the database name.



®  BMS Driver: Select the SQLite Driver used to connect. By default, the driver will be SQLite PDO.

o erver/Host(Name or IP): Enter the full path to your SQLite database file. EX: C:\Apache24\htdocs\client_data

e assword: Enter the password to complete the authentication process if you have it set for your DB file.

e est Connection: Click this button to get a response from the Scriptcase request to see if the parameters you entered are correct.

Connection Success

# Test Connection m

Filter

By accessing this tab, you can configure which items from the Database will be displayed in the connection, depending on the owner or not.

CONNECTION FILTER ADVANCED
Show Searches
v| Tables
Tables Owmer Show
| Views
System tables
No -

Procedures

Show
Allows the SQLite connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the items

e ables: By selecting this option, the tables in your database will be displayed.
o ydefault, Scriptcase enables this option.
e iews: By selecting this option, the views of your database will be displayed.
o ydefault, Scriptcase enables this option.
o ystem tables: By selecting this option, the system tables of your database will be displayed.
e rocedures: When you select this option, the procedures from your database will be displayed.
Searches

Allows you to define which tables and owners are displayed.

PREFIX% or name of the tables to be displayed.

o ables: You can define in this option which tables will be displayed. The setting can contain a
o ydefault, Scriptcase leaves this option empty.
o x
Using the table prefix
Tables. Owner
SUP% SYSTEM
Using the table name
Tables Owner
SUP_ACCOUNT, SUP_ORDEF SYSTEM
e waner: Inform the user who sees the inserted tables for display.
o ser must be in capital letters, as in the example above
o how: Choose whether tables are displayed for the owner entered.

NOTE: By using table filtering, you eliminate unnecessary tables for your project and improve the performance of your database connection.

Tables and Views are already selected by Scriptcase.

Advanced



In this tab, you have access to settings specific to the connection. Changes made in this section impact the data display and performance of the application.

CONNECTION  FILTER | ADVANCED

client_encoding

UTFS - Unicode, 8-bit -

Decimal Separator

Persistent Connection

No -

Use the schema before table name

Yes -

e lient_encoding: Select the encoding used in your database. In the example above, we used client_encoding UTF-8.
e  ecimal separator: Select the separator type for decimal records, between comma and period.
o ydefault, period . is selected as the separator.
e ersistent connection: Set whether connections will be closed after your scripts run in Scriptcase applications.
o ydefault, Scriptcase disables this option.
L]

se the schema before table name: Set whether the database schema is displayed before the table names.

o ydefault, Scriptcase enables this option.

o X:

Using the schema before table name | Not using the schema before table name

Connection” Connection”

conn_oracle v

conn_oracle v
Table Table
"SYSTEM".COL - [+ COoL - (s

Doubts or Connection Problems?
Contact our Support Team in case of connection problems or questions regarding this database.
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Windows

The ODBC Generic connection is normally used to create connections with the databases: dBase (.dbf), Dataflex, Paradox, Visual FoxPro, etc.

You only need have the corresponding ODBC driver with the database installed.

If you are using your own previously configured environment, you will need to enable the ODBC extension in PHP.

Generic ODBC

Setting up ODBC on Windows

The automatic installation already comes with the ODBC only needing to connect with the database with ScriptCase.

Creating a Connection with ScriptCase

®  ccess ScriptCase using the URL http://127.0.0.1:8092/scriptcase

e fter accessing ScriptCase, access or create a new project, click on the new connection icon or access “Database > New Connection”

Is  Layout ocales Mo

> Project Database  Application

Y ()

& H g

Home New Opt New Edit
Project Project project project connection fconnection

Creating a new connection

e fter that, you will see a page with all the database connections that you can create. Select a “ODBC” connection

Createa connection
Select your database system and create a connection for your project.

N ORACLE' )2 D BZ Informix

MySsoLU - J soFTwaRe
SQL Server PostoreSQL

MysQL Oracle MSSQL Server Postgres DB2 Informix

i SSvease e @ Firebird .
P InterBase

MS Access SQLite SyBase InterBase Firebird ODBC

Selecting a Windows database connection

e ew connection : You will place the information of the connection to your database here:

Createa connection ODBC

Enter your d e connection details for ODBC 2 (SR LR

CONNECTION  FILTER  ADVANCED

Connection Name DBMS Driver

conn_odbc Generic ODBC v
Specific driver ODBC Name

Generic ODBC v Data_Source
Username Password

e

Connecting with Windows database

onnection Name : Defines the name of your new connection.

BMS Driver : Select the Generic ODBC.

pecific driver : Defined as Generic ODBC, allows you to connect to specific Data Sources: DBF, FileMaker, Progress or Visual FoxPro.
DBC Name : On this option, you will inform the name of the Data Source that you have created.

sername : Inform the username of the Windows database, only if there are any.

assword : Inform the password of the Windows database, only if there are any.

est Connection : Displays a message of the status of the connection if successful or not.

® o 0 0 0 0o o

® or more options on connecting, click on the Advanced tab:



CONNECTION ~ FILTER ~ ADVANCED

Decimal Separator

Persistent Connection

No -

Use the schema before table name

Yes -
# TestConnection E

Advanced setup for the Windows database

e  ecimal Separator - Select the separator type, between a dot or a comma.
e ersistent Connection - Persistent Connection are connections that do not close when finishing a script.
.

se the schema before table name - Allows the use of schema before the name of the tables.

e lter: Accessing this tab, we can setup which tables will be listed on this connection:

CONNECTION | FILTER = ADVANCED

Show Searches
| Tables
Tables Owner Show
| Views
System tables o
Procedures

- o o

Filtering the Windows database

o how - Allows the display of the the filters on the tables, views, System Tables and procedures.
o ables - Allows to setup the display of Tables from your database.
o iews - Allows to setup the display of Views from your database.
o ystem Tables - Allows to setup the display of System Tables from your database.
o rocedures - Allows to setup the display of Procedures from your database.
e earches - Allows to define which tables and Owner will be displayed.
o ables - Allows to define a prefix (prefix%) or name of the tables for display.
o wner - Allows to define the owner of the tables for listing.

o how - Allows to define what will be displayed or not from the table an owner’s setup.

-pPng



Linux

The ODBC Generic connection is normally used to create connections with the databases: dBase (.dbf), Dataflex, Paradox, Visual FoxPro, etc.

You only need have the corresponding ODBC driver with the database installed.

If you are using your own previously configured environment, you will need to enable the ODBC extension in PHP.

Generic ODBC

Setting up ODBC on Linux
The automatic installation already comes with the ODBC only needing to install the UnixODBC driver so that you can do the connection.

UBUNTU\DEBIAN x86_64 CENTOS\RHEL x86_64
- sudo apt-get update - sudo yum update

- sudo apt-get install unixodbc-dev unixodbc - sudo yum install unixODBC

UBUNTU\DEBIAN i386 ( x86 ) CENTOS\RHEL i686 ( x86 )
- sudo apt-get update - sudo yum update

- sudo apt-get install unixodbc-dev unixodbc - sudo yum install unixODBC

| Restart the Apache Server:

sudo /etc/init.d/apachesc9 restart

Creating a Connection with ScriptCase

®  ccess ScriptCase using the URL http://127.0.0.1:8092/scriptcase

e fter accessing ScriptCase, access or create a new project, click on the new connection icon or access “Database > New Connection”

> Project Database  Application

Py ()

al (+ )
Home New Op: Newr Edit
Project Project project project connection jconnection

Creating a new connection

o fter that, you will see a page with all the database connections that you can create. Select a “ODBC” connection

Createa connection
Select your database system and create a connection for your project.

Mgg& ORACLE \ﬁ (@; DB2  Informix

SQL Server PostgreSQL.

MySQL Oracle MSSQL Server Postgres DB2 Informix

i SSvpase 0 (@ Firebird” .
W InterBase

MS Access SQLite SyBase InterBase Firebird ODBC

Selecting a Linux database connection

® ew connection : You will place the information of the connection to your database here:

Create a connection ODBC

Enter your database connection details for ODBC (> Errersirser=iog

CONNECTION  FILTER  ADVANCED

Connection Name DBMS Driver

«conn_odbc Generic ODBC v
Specific driver ODBC Name

Generic ODBC v Data_Source
Username Password

e ]

Connecting with Linux database



onnection Name : Defines the name of your new connection.

BMS Driver : Select the Generic ODBC.

pecific driver : Defined as Generic ODBC, allows you to connect to specific Data Sources: DBF, FileMaker, Progress or Visual FoxPro.
DBC Name : On this option, you will inform the name of the Data Source that you have created.

sername : Inform the username of the Linux database, only if there are any.

assword : Inform the password of the Linux database, only if there are any.

est Connection : Displays a message of the status of the connection if successful or not.

® o o 0 0 o o

e or more options on connecting, click on the Advanced tab:

CONNECTION ~ FILTER ~ ADVANCED

Decimal Separator

Persistent Connection

No -

Use the schema before table name

Yes -
E

Advanced setup for the Linux database

e  ecimal Separator - Select the separator type, between a dot or a comma.
ersistent Connection - Persistent Connection are connections that do not close when finishing a script.
e se the schema before table name - Allows the use of schema before the name of the tables.

Ld

o lter: Accessing this tab, we can setup which tables will be listed on this connection:

CONNECTION | FILTER = ADVANCED

Show Searches
v| Tables
Tables ‘Owmer Show
| Views
System tables No .
Procedures

=

Filtering the Linux database

o how - Allows the display of the the filters on the tables, views, System Tables and procedures.
o ables - Allows to setup the display of Tables from your database.
o iews - Allows to setup the display of Views from your database.
o  ystem Tables - Allows to setup the display of System Tables from your database.
o rocedures - Allows to setup the display of Procedures from your database.
o earches - Allows to define which tables and Owner will be displayed.
o ables - Allows to define a prefix (prefix%) or name of the tables for display.
o wner - Allows to define the owner of the tables for listing.
o how - Allows to define what will be displayed or not from the table an owner’s setup.

-png



Mac OS X

The ODBC Generic connection is normally used to create connections with the databases: dBase (.dbf), Dataflex, Paradox, Visual FoxPro, etc.

You only need have the corresponding ODBC driver with the database installed.

If you are using your own previously configured environment, you will need to enable the ODBC extension in PHP.

Generic ODBC

Settin gup ODBC on MAC

I The automatic installation already comes with the ODBC driver, only needing to create the data source to connect with the database with ScriptCase.

| The path of odbc.ini is: /Applications/Scriptcase/components/apache/bin/unixODBC/etc/

Creating a Connection with ScriptCase

®  ccess ScriptCase using the URL http://127.0.0.1:8092/scriptcase

e fter accessing ScriptCase, access or create a new project, click on the new connection icon or access “Database > New Connection”

Project  Dx ase  Application
1oy m
AN = )
Home New Op New Edit
Project Project project project connection ~feonnection

Creating a new connection

e fter that, you will see a page with all the database connections that you can create. Select a “ODBC” connection

Createa connection
Select your database system and create a connection for your project.

SQL Server PosigreSOL.

u SEJRL ORACLE' \}@ Gj@ D Bz Inform:x

MysQL Oracle MSSQL Server Postgres DB2 Informix

Wi,  Bsmse e @ .

InterBase

MS Access SQlite SyBase InterBase Firebird ODBC

Selecting a Mac OS X database connection

e ew connection : You will place the information of the connection to your database here:

Create a connection ODBC

Enter your se connection details for ODBC (> ElEammiErEnEi

CONNECTION | FILTER  ADVANCED

Connection Name DBMS Driver

conn_odbc Generic ODBC v
Specific driver ODBC Name

Generic ODBC v Data_Source
Username Password

> e | o

Connecting with Mac OS X database

onnection Name : Defines the name of your new connection.

BMS Driver : Select the Generic ODBC.

pecific driver : Defined as Generic ODBC, allows you to connect to specific Data Sources: DBF, FileMaker, Progress or Visual FoxPro.
DBC Name : On this option, you will inform the name of the Data Source that you have created.

sername : Inform the username of the Mac OS X database, only if there are any.

assword : Inform the password of the Mac OS X database, only if there are any.

® o o 0 o o o

est Connection : Displays a message of the status of the connection if successful or not.

e or more options on connecting, click on the Advanced tab:



CONNECTION ~ FILTER ~ ADVANCED

Decimal Separator

Persistent Connection

No -

Use the schema before table name

Yes -

e ] ]

Advanced setup for the Mac OS X database

L]

ecimal Separator - Select the separator type, between a dot or a comma.
ersistent Connection - Persistent Connection are connections that do not close when finishing a script.
se the schema before table name - Allows the use of schema before the name of the tables.

ilter : Accessing this tab, we can setup which tables will be listed on this connection:

CONNECTION | FILTER = ADVANCED

Show Searches
v| Tables
Tables ‘Owmer Show
| Views
System tables o
Procedures

=

Filtering the Mac OS X database

°

-png

how - Allows the display of the the filters on the tables, views, System Tables and procedures.
o ables - Allows to setup the display of Tables from your database.
o iews - Allows to setup the display of Views from your database.
o  ystem Tables - Allows to setup the display of System Tables from your database.
o rocedures - Allows to setup the display of Procedures from your database.
earches - Allows to define which tables and Owner will be displayed.
o ables - Allows to define a prefix (prefix%) or name of the tables for display.
o wner - Allows to define the owner of the tables for listing.

o how - Allows to define what will be displayed or not from the table an owner’s setup.
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Windows

Before proceeding with this tutorial check the architecture of your PHP within the phpinfo (). Accessing the phpinfo of your scriptcase, for example http://127.0.0.1:8092/scriptcase/info.php, you will find the PHP architecture.

System Windows NT DESKTOP-EB1KE!
Build Date Jan 17 2017 13:40:02
ler MSVG14 (Visual G++ 2015)
hitecture x64

Configure Command ‘Gscript /nologo Gonfigure.js "—en:
sdk\oracle\xg4\nstantalient_12_*
sdk\oracle\xg4\nstantalient_12_*
with-merypt=static” "-without-an:

Server APl CGFastGGI

Virtual Directory Support disabled

Configuration File (php.ini) Path | C:\Windows

e rchitecture x86 = 32 bits
e rchitecture x64 = 64 bits

Ifyou are using Scriptcase automatic installer the PHP architecture will be the same as the installer you downloaded.

Progress OpenEdge ODBC

Setting up Progress connection using ODBC on Windows

Requirements

® he Progress Database needs to be installed.
®  aveone or more tables created.
e  river Progress® OpenEdge® ODBC Connector for Windows installed.

Enabling the extension

® irst we must download the Progress® OpenEdge® ODBC Connector for Windows according to the architecture of your PHP.
o o download the 64-bit engine click here
o o download the 32-bit engine click here

e tthe end of the download, follow the Progress OpenEdge ODBC Connector installation wizard.

Progress DataDirect Connect ® and Connect XE for ODBC 7.1 SP6 - X

InstallAnywhere will guide you thraugh the installation of Pragress
DataDirect Connect® and Connect XE for ODBC 7.1 SPE.

DATADIRECT Itis strongly recommended that you quitall programs before

C U N N E CT continuing with this installation.

FO R 0 D B C Click the Next' button to proceed to the next screen. INyou want to
change something on a previous screen, click the ‘Previous’ bution

You may cancel this installation at any time by clicking the ‘Cancel’
button

Previous

Installing the Progress OpenEdge ODBC Connector.

Progress DataDirect Connect @ and Connect XE for QDBC 7.1 SP6

Installation and use of Progress DataDirect Connect ® and Connect
XE for ODBC 7.1 SP6 requires acceptance of the following license

DATADIRECT End User License Agreement ~

CONNECT CAUTION: Y0U SHOULD CAREFULLY READ THE FOLLOVING
FOR ODBC TEFNS AND CONDITIONS OF THIS END USER LICENSE
AGREEMENT BEFORE INSTALLING OR USING THE PRODUCT
AND DOCUMENTATION TO WHICH THIS AGREEMENT RELATES.
BY ACCEPTING THIS AGREEMENT YOU ARE CONSENTING TO
EE BOUND BY THE TERNS AND CONDITIONS CONTAINED
EEREIN AND ACENOWLEDGING YOUR AUTHORITY T DO 50 ON
EEHALF OF YOUR COMPANY (IF APPLICABLE). IF YOU DO
NOT AGREE WITH THESE TERMS AND CONDITIONS, DO HOT
PROCEED WITH THE INSTALLATION OF THE PRODUCT(S) AWD

@i

(0)11do NOT accept the tams of the Licenss Aqreement

Installing the Progress OpenEdge ODBC Connector.



Progress DataDirect Connect ® and Connect XE for ODBC 7.1 3P6

Please choose the type of installation you want to perform.

When Completed Click Next to continue.
@ Evaluation Installation (will expire in 15 days)

DATADIRECT

ESFF{\J glgg-cr (O OEM or Licensed Installation

PROGI

RESS
software

Installing the Progress OpenEdge ODBC Connector.

Progress DataDirect Connect ® and Connect XE for ODBC 7.1 P&

Select the components to install:

DATADIRECT [ Connect for ODBC drivers

[ Connect XE For ODBC drivers

C 0 N N E CT “[~ Legacy and Client Based diivers
FOR ODBC

Installing the Progress OpenEdge ODBC Connector.

Progress DataDirect Connect @ and Connect XE for ODBC 7.1 5PE

[J Replace Existing Drivers

DATADIRECT Removes curtent and previous default DataDirect ODBC driver

definit fr
C U N N ECT HEKE‘LLDSOSC”ADITMACH\NE\SOFTWARE\ODBC\ODBC\NETIN\

FOR ODBC

[ Greate Default Data Sources

Defines a user data source name in
HKEY_CURRENT_USERSOFTWAREWGDBCWIDBC IMI for each
DataDirect driver that you install

IMPORTANT: If you select “Create Default Data Sources”, data
sources currently in your registry with the same DataDirect
default name will be overwritten. To maintain your current
DataDirect default data sources, rename them hefore you
continue.

Installing the Progress OpenEdge ODBC Connector.

Progress DataDirect Connect ® and Connect XE for ODBC 7.1 5P6

Please Review the Following Before Conti

DATADIRECT Product Name:
C U N N ECT Progress DataDirect Cormect 1B and Connect XE for ODBC

FOR ODBC i

Install Folder:
CAProgram Files (236)
‘Progress\DataDirect\C onnect_for_ODBC_71

Shortcut Folder:
o

Users\PorgresshippData Roaming\Microso itWindows\Start

MenuPrograms\Frogress DataDirest Connect ® and Connect

XE for ODBC 7.1

Disk Space Information (for Installation

Installing the Progress OpenEdge ODBC Connector.



Pragress DataDirect Connect ® and Connect XE for ODBC 7.1 SP&

PROGRESS Congratulations! Progress DataDirect Connect ® and
DATADIRECT Connect XE for ODBC 7.1 SPE has been successfully

installed to: C:\Program Files
C O N N ECT (xBE)\Progress\DataDirectiConnect_for_ODBC_T1

FU R 0 D B C Press "Done" to quit the installer.

Launch the Performance Wizard

[ Launch DSN Converter

Cancel Frevioug

Installing the Progress OpenEdge ODBC Connector.

Creating a Data Source (ODBC)

o o to Control Panel> Systems and Security> Administrative Tools> ODBC Data Sources (32 or 64 bits), according to your PHP architecture.
o fyou have a data source configured, proceed to Creating a Connection in ScriptCase .
o elect the System DNS tab and click Add.

ODBL Data Source Administrator 7]

User DM | SysternDSN | File DSM | Drivers | Tracing | Connection Pagling | About |

System Data Sources

Mame | Diiver | [ e ]
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Accessing and Configuring the ODBC Data Source.
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Accessing and Configuring the ODBC Data Source.

o fter selecting the driver, the following screen will be displayed:

o ixfields are required for data source configuration:

= ata Source Name: Name of the data source that will be used when creating the connection in Scriptcase;

escription: A description for your driver;
ost Name: IP from where the database is installed;
ort Number: Port Number;
ata Base Name: Database name that will be used in the connection;
ser ID: User name;
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Creating the Data Source.
e fter selecting the database, click OK to complete the configuration.

e eturning to the ODBC Data Source Administrator screen you can view the already configured connections.

Creating a Connection with ScriptCase

®  ccess ScriptCase using the URL http://127.0.0.1:8092/scriptcase
e fter accessing ScriptCase, access or create a new project, click on the new connection icon or access “Database > New Connection”
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Creating a new connection

e fter that, you will see a page with all the database connections that you can create. Select a *” connection

Selecting a Windows database connection

e ew connection : You will place the information of the connection to your database here:

Connecting with Windows database

e or more options on connecting, click on the Advanced tab:

CONNECTION ~ FILTER | ADVANCED
Decimal Separator
Persistent Connection

No -

Use the schema before table name

Advanced setup for the Windows database

e ilter: Accessing this tab, we can setup which tables will be listed on this connection:

CONNECTION | FILTER = ADVANCED

Show Searches
v| Tables
Tables Owner Show
v| Views
System tables No .
Procedures
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Filtering the Windows database

o how - Allows the display of the the filters on the tables, views, System Tables and procedures.
o ables - Allows to setup the display of Tables from your database.
o iews - Allows to setup the display of Views from your database.
o  ystem Tables - Allows to setup the display of System Tables from your database.
o rocedures - Allows to setup the display of Procedures from your database.
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earches - Allows to define which tables and Owner will be displayed.
o

ables - Allows to define a prefix (prefix%) or name of the tables for display.
wner - Allows to define the owner of the tables for listing.

how - Allows to define what will be displayed or not from the table an owner’s setup.



Microsoft Azure in Scriptcase

At Scriptcase, we have several banks ( MySQL, PostgreSQL and MSSQL Server ) and their respective drivers for connecting to Azure. You must choose the most suitable for your environment and need.
If you do not have an Azure database created from the ones available on Scriptcase, check below how to create a database:

e reation of Azure MySQL database: click here
e reation of Azure PostgreSQL database: click here
e reation of Azure MSSQL Server database: click here

You can check your enabled drivers by accessing your diagnosis. See below on how to locate your diagnosis and check if the driver is enabled.

e ccessing the top menu Help > Diagnosis, you can easily find it through the interface.

© WebHelp

@ Technical Support
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o r, by accessing your browser url:
127.0.0.1:8092/scriptcase/diagnosis.php or dominio.com/scriptcase/diagnosis.php

Check below how to enable each database in Scriptcase according to your operating system:

MySQL

. indows: click here
e inux: click here
e  acOs: click here

PostgreSQL

e indows: click here
e inux: click here
e acOs: click here

MSSQL Server

e indows: click here
e inux: click here
e acOs: click here



Enabling Azure MySQLi

In the Scriptcase, we have the following drivers available for connection to MySQL: MySQL PDO, MySQLi. If you are using your own pre-configured environment, MySQL extensions
must be enabled manually in PHP.

Configuring and enabling the MySQLi on Windows

IMPORTANT: If you are using Scriptcase’s automatic installer,the extensions are already enabled in PHP, ready for connection. The procedure below is only for
manual installations of Scriptcase.

1 - In the php.ini file, located in C:\php, look for lines referring to MySQL extensions: mysqli and pdo_mysql and remove the; from the beginning of the lines for the extension to be
used by PHP. See the example below:

extension=mysqli
extension=pdo_mysq|

2 - Restart the Apache service using theTask Manager.
e Open the Task Manager and click on theServices tab.

e Look for the ApacheScriptcase9php73 or Apache2.4 service and right click on this service, thenRestart.

Connection with Scriptcase
Check below which Driver you want to connect to.
e MySQLi: Click Here
Doubts about connection?

Get in contact with our support in case of connection problems or questions regarding this database.



Enabling Azure MySQL PDO

In the Scriptcase, we have the following drivers available for connection to MySQL: MySQL PDO, MySQLi. If you are using your own pre-configured environment, MySQL extensions
must be enabled manually in PHP.

Configuring and enabling the MySQL PDO

IMPORTANT: If you are using Scriptcase’s automatic installer,the extensions are already enabled in PHP, ready for connection. The procedure below is only for
manual installations of Scriptcase.

1 - In the php.ini file, located in C:\php, look for lines referring to MySQL extensions: mysqli and pdo_mysql and remove the; from the beginning of the lines for the extension to be
used by PHP. See the example below:

extension=mysqli
extension=pdo_mysq|

2 - Restart the Apache service using theTask Manager.
e Open the Task Manager and click on theServices tab.

e Look for the ApacheScriptcase9php73 or Apache2.4 service and right click on this service, thenRestart.

Connection with Scriptcase

Check below which Driver you want to connect to.
e MySQL PDO: Click here
Doubts about connection?

Get in contact with our support in case of connection problems or questions regarding this database.



Connection with Azure MySQL

If you do not have theMySQLi or MySQL PDO drivers enabled, check below our documentation on how to enable both in Scriptcase for connection.

e To enable the MySQLi: Click Here
e To enable the MySQL PDO: Click Here

Attention: If you do not have an Azure MySQL base created, check how to create it by clickinghere.

Creating a connection to Scriptcase

See below how to create a connection in your Scriptcase project, using the enabled Driver MySQLi or MySQL PDO) and the Azure MySQL database.
1 - Access a project from your Scriptcase.

2 - Click the New Connection icon to create a connection.

or access the Database > New connectionmenu.

After that, a screen will appear with all database connections.

3 - Select the Microsoft Azure connection.

4 - And choose the database Azure MySQL.

Connection

Enter the parameters for connecting to your Azure MySQL database as follows:

e Connection name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
e SGDB Driver: Select the MySQL Driver for connection. In this example, we use theMySQL PDO Driver.

e SGDB Server: Enter the domain of the Azure server where the database is installed.

e EX: serverdomain.mysql.database.azure.com

e Port: Enter the port for connection. By default, the defined port is3306.

o Database: List and select the database you will connect to.

o EX: samples

e User: Inform the user to authenticate the connection to your database.

e Password: Enter the password to complete the authentication process.

e Test connection: Click this button to get a response to the Scriptcase request to find out if the parameters entered are correct.

Security

Accessing this tab, you can configure all the security of your Azure MySQL database.

e Use SSL: Choose whether the SSL protocol will be active on the connection.
o By default, Scriptcase disables this option.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending on the owner or not.

Show

It allows the connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.

e System Tables: Selecting this option, the system tables of your database will be displayed.

e Procedures: Selecting this option, the procedures of your database will be displayed.

Filters



Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX%% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o EX:

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.
NOTE: By using table filtering, you eliminate unnecessary tables for your project and __ improve the performance__ of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The settings made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingutf8.
o By default, the utf8 charset is set.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the point. is selected as a separator.

e Persistent Connection: Define whether connections will be terminated after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use the schema before the table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

Doubts about connection?

Get in contact with our support in case of connection problems or questions regarding this database.



Enabling Azure MySQLi

At Scriptcase, we have the following drivers available for connection to MySQL: MySQL PDO, MySQLi . If you are using your own pre-configured environment, MySQL extensions
must be enabled manually in PHP.

Configuring and enabling the MySQLi on Linux

IMPORTANT: If you are using Scriptcase’s automatic installer,the extensions are already enabled in PHP, ready for connection. The procedure below is only for
manual installations of Scriptcase.

1 - On your linux terminal, you only need to run one line to install MySQL extensions. See below for how to proceed.
sudo apt-get install php8.1-mysql
e If you are unable to execute the above command because you cannot find packages, install the repository below and update.

sudo add-apt-repository ppa:ondrej/php
sudo apt-get update

2 - Restart the Apache service via the terminal.

sudo service apache2 restart
Connection to Scriptcase

e MySQLi: Cligue aqui

Doubts about connection?

Get in contact with our support in case of connection problems or questions regarding this database.



Enabling Azure MySQL PDO

At Scriptcase, we have the following drivers available for connection to MySQL: MySQL PDO, MySQLi. If you are using your own pre-configured environment, MySQL extensions
must be enabled manually in PHP.

Configuring and enabling the MySQL PDO on Linux

IMPORTANT: If you are using Scriptcase’s automatic installer,the extensions are already enabled in PHP, ready for connection. The procedure below is only for
manual installations of Scriptcase.

1 - On your linux terminal, you only need to run one line to install MySQL extensions. See below for how to proceed.
sudo apt-get install php8.1-mysql
e If you are unable to execute the above command because you cannot find packages, install the repository below and update.

sudo add-apt-repository ppa:ondrej/php
sudo apt-get update

2 - Restart the Apache service via the terminal.

sudo service apache2 restart

Connection to Scriptcase

e MySQL PDO: Click Here

Questions or Connection Problems?

Contact our support in case of connection problems or questions regarding this database.



Connection with Azure MySQL

If you do not have theMySQLi or MySQL PDO drivers enabled, check below our documentation on how to enable both in Scriptcase for connection.

e To enable the MySQLi: Click Here
e To enable the MySQL PDO: Click Here

Attention: If you do not have an Azure MySQL base created, check how to create it by clickinghere.

Creating a connection to Scriptcase

See below how to create a connection in your Scriptcase project, using the enabled Driver MySQLi or MySQL PDO) and the Azure MySQL database.
1 - Access a project from your Scriptcase.

2 - Click the New Connection icon to create a connection.

or access the Database > New connectionmenu.

After that, a screen will appear with all database connections.

3 - Select the Microsoft Azure connection.

4 - And choose the database Azure MySQL.

Connection

Enter the parameters for connecting to your Azure MySQL database as follows:

e Connection name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
e SGDB Driver: Select the MySQL Driver for connection. In this example, we use theMySQL PDO Driver.

e SGDB Server: Enter the domain of the Azure server where the database is installed.

e EX: serverdomain.mysql.database.azure.com

e Port: Enter the port for connection. By default, the defined port is3306.

o Database: List and select the database you will connect to.

o EX: samples

e User: Inform the user to authenticate the connection to your database.

e Password: Enter the password to complete the authentication process.

e Test connection: Click this button to get a response to the Scriptcase request to find out if the parameters entered are correct.

Security

Accessing this tab, you can configure all the security of your Azure MySQL database.

e Use SSL: Choose whether the SSL protocol will be active on the connection.
o By default, Scriptcase disables this option.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending on the owner or not.

Show

It allows the connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.

e System Tables: Selecting this option, the system tables of your database will be displayed.

e Procedures: Selecting this option, the procedures of your database will be displayed.

Filters



Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX%% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o EX:

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.
NOTE: By using table filtering, you eliminate unnecessary tables for your project and __ improve the performance__ of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The settings made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingutf8.
o By default, the utf8 charset is set.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the point. is selected as a separator.

e Persistent Connection: Define whether connections will be terminated after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use the schema before the table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

Doubts about connection?

Get in contact with our support in case of connection problems or questions regarding this database.



Enabling Azure MySQLi

At Scriptcase, we have the following drivers available for connection to MySQL: MySQL PDO, MySQLi . If you are using your own pre-configured environment, MySQL extensions
must be enabled manually in PHP.

Configuring and enabling the MySQLi on macOS

IMPORTANT: If you are using Scriptcase’s automatic installer,the extensions are already enabled in PHP, ready for connection. The procedure below is only for
manual installations of Scriptcase.

If you have installed PHP 8.1 through our documentation using homebrew, MySQL is already enabled in PHP, requiring only a connection. Check below our documentation for
installing PHP 8.1 with homebrew on macOS.

PHP 8.1 in macOS: Click here

Connection to Scriptcase

e MySQLi: Click here

Doubts about connection?

Get in contact with our support in case of connection problems or questions regarding this database.



Enabling Azure MySQL PDO

At Scriptcase, we have the following drivers available for connection to MySQL: MySQL PDO, MySQLi . If you are using your own pre-configured environment, MySQL extensions
must be enabled manually in PHP.

Configuring and enabling the MySQL PDO on macOS

IMPORTANT: If you are using Scriptcase’s automatic installer,the extensions are already enabled in PHP, ready for connection. The procedure below is only for
manual installations of Scriptcase.

If you have installed PHP 8.1 through our documentation using homebrew, MySQL is already enabled in PHP, requiring only a connection. Check below our documentation for
installing PHP 8.1 with homebrew on macOS.

PHP 8.1 in macOS: Click Here

Connection to Scriptcase

e MySQL PDO: Click Here

Doubts about connection?

Get in contact with our support in case of connection problems or questions regarding this database.



Connection with Azure MySQL

If you do not have theMySQLi or MySQL PDO drivers enabled, check below our documentation on how to enable both in Scriptcase for connection.

e To enable the MySQLi: Click Here
e To enable the MySQL PDO: Click Here

Attention: If you do not have an Azure MySQL base created, check how to create it by clickinghere.

Creating a connection to Scriptcase

See below how to create a connection in your Scriptcase project, using the enabled Driver MySQLi or MySQL PDO) and the Azure MySQL database.
1 - Access a project from your Scriptcase.

2 - Click the New Connection icon to create a connection.

or access the Database > New connectionmenu.

After that, a screen will appear with all database connections.

3 - Select the Microsoft Azure connection.

4 - And choose the database Azure MySQL.

Connection

Enter the parameters for connecting to your Azure MySQL database as follows:

e Connection name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
e SGDB Driver: Select the MySQL Driver for connection. In this example, we use theMySQL PDO Driver.

e SGDB Server: Enter the domain of the Azure server where the database is installed.

e EX: serverdomain.mysql.database.azure.com

e Port: Enter the port for connection. By default, the defined port is3306.

o Database: List and select the database you will connect to.

o EX: samples

e User: Inform the user to authenticate the connection to your database.

e Password: Enter the password to complete the authentication process.

e Test connection: Click this button to get a response to the Scriptcase request to find out if the parameters entered are correct.

Security

Accessing this tab, you can configure all the security of your Azure MySQL database.

e Use SSL: Choose whether the SSL protocol will be active on the connection.
o By default, Scriptcase disables this option.

Filter

Accessing this tab, you can configure which Database items will be displayed on the connection, depending on the owner or not.

Show

It allows the connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.

e System Tables: Selecting this option, the system tables of your database will be displayed.

e Procedures: Selecting this option, the procedures of your database will be displayed.

Filters



Allows you to define which tables and owners are displayed.
e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX%% or name of the tables to display.

o By default, Scriptcase leaves this option empty.
o EX:

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Show: Choose whether tables for the informed owner are displayed.
NOTE: By using table filtering, you eliminate unnecessary tables for your project and __ improve the performance__ of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The settings made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingutf8.
o By default, the utf8 charset is set.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the point. is selected as a separator.

e Persistent Connection: Define whether connections will be terminated after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use the schema before the table name: Define whether the database schema is displayed before the table names.
o By default, Scriptcase enables this option.

Doubts about connection?

Get in contact with our support in case of connection problems or questions regarding this database.



Enabling Azure PostgreSQL PDO

In Scriptcase, we have the following drivers available for connection to PostgreSQL: PostgreSQL PDO, PostgreSQL 7 or above, PostgreSQL 6.4 or above and PostgreSQL 6.3
or below. If you are using your own pre-configured environment, PostgreSQL extensions must be enabled manually in PHP.

Configuring and enabling Azure PostgreSQL PDO on Windows

IMPORTANT: If you are using Scriptcase’s automatic installer,the extensions are already enabled in PHP, ready for connection. The procedure below is only for
manual installations of Scriptcase.

1 - In the php.ini file, located in C:\php, look for lines referring to PostgreSQL extensions: pgsql and pdo_pgsql and remove the; from the beginning of the lines so that the extension
is used by PHP. See the example below:

extension=pgsql
extension=pdo_pgsql

2 - Restart the Apache service using theTask Manager.
e Open the Task Manager and click on theServices tab.

e Look for the ApacheScriptcase9php73 or Apache2.4 service and right click on this service, thenRestart.

Connection to Scriptcase

e PostgreSQL PDO: Click Here
Questions or Connection Problems?

Contact our support in case of connection problems or questions regarding this database.



Enabling Azure PostgreSQL 7 or Above

In Scriptcase, we have the following drivers available for connection to PostgreSQL: PostgreSQL PDO, PostgreSQL 7 or above, PostgreSQL 6.4 or above and PostgreSQL 6.3
or below. If you are using your own pre-configured environment, PostgreSQL extensions must be enabled manually in PHP.

Configuring and enabling Azure PostgreSQL 7 on Windows

IMPORTANT: If you are using Scriptcase’s automatic installer,the extensions are already enabled in PHP, ready for connection. The procedure below is only for
manual installations of Scriptcase.

1 - In the php.ini file, located in C:\php, look for lines referring to PostgreSQL extensions: pgsql and pdo_pgsql and remove the; from the beginning of the lines so that the extension
is used by PHP. See the example below:

extension=pgsql
extension=pdo_pgsql

2 - Restart the Apache service using theTask Manager.
e Open the Task Manager and click on theServices tab.

e Look for the ApacheScriptcase9php73 or Apache2.4 service and right click on this service, thenRestart.

Connection to Scriptcase

e PostgreSQL PDO: Click Here
Questions or Connection Problems?

Contact our support in case of connection problems or questions regarding this database.



Enabling Azure PostgreSQL 6.4 or Above

In Scriptcase, we have the following drivers available for connection to PostgreSQL: PostgreSQL PDO, PostgreSQL 7 or above, PostgreSQL 6.4 or above and PostgreSQL 6.3
or below. If you are using your own pre-configured environment, PostgreSQL extensions must be enabled manually in PHP.

Configuring and enabling Azure PostgreSQL 6.4 on Windows

IMPORTANT: If you are using Scriptcase’s automatic installer,the extensions are already enabled in PHP, ready for connection. The procedure below is only for
manual installations of Scriptcase.

1 - In the php.ini file, located in C:\php, look for lines referring to PostgreSQL extensions: pgsql and pdo_pgsql and remove the; from the beginning of the lines so that the extension
is used by PHP. See the example below:

extension=pgsql
extension=pdo_pgsql

2 - Restart the Apache service using theTask Manager.
e Open the Task Manager and click on theServices tab.

e Look for the ApacheScriptcase9php73 or Apache2.4 service and right click on this service, thenRestart.

Connection to Scriptcase

e PostgreSQL PDO: Click Here
Questions or Connection Problems?

Contact our support in case of connection problems or questions regarding this database.



Enabling Azure PostgreSQL 6.3 ou Below

In Scriptcase, we have the following drivers available for connection to PostgreSQL: PostgreSQL PDO, PostgreSQL 7 or above, PostgreSQL 6.4 or above and PostgreSQL 6.3
or below. If you are using your own pre-configured environment, PostgreSQL extensions must be enabled manually in PHP.

Configuring and enabling Azure PostgreSQL 6.3 on Windows

IMPORTANT: If you are using Scriptcase’s automatic installer,the extensions are already enabled in PHP, ready for connection. The procedure below is only for
manual installations of Scriptcase.

1 - In the php.ini file, located in C:\php, look for lines referring to PostgreSQL extensions: pgsql and pdo_pgsql and remove the; from the beginning of the lines so that the extension
is used by PHP. See the example below:

extension=pgsql
extension=pdo_pgsql

2 - Restart the Apache service using theTask Manager.
e Open the Task Manager and click on theServices tab.

e Look for the ApacheScriptcase9php73 or Apache2.4 service and right click on this service, thenRestart.

Connection to Scriptcase

e PostgreSQL PDO: Click Here
Questions or Connection Problems?

Contact our support in case of connection problems or questions regarding this database.



Connection to Azure PostgreSQL

If you do not have thePostgreSQL PDO, PostgreSQL 7 or above, PostgreSQL 6.4 or above and PostgreSQL 6.3 or belowdrivers enabled, check below our documentation
on how to enable both in Scriptcase for connection.

To enable the PostgreSQL PDO: Click Here

To enable the PostgreSQL 7 or Above: Click Here
To enable the PostgreSQL 6.4 or Above: Click Here
To enable the PostgreSQL 6.3 or Below: Click Here

ATTENTION: If you do not have an Azure PostegreSQL base created, check how to create it by clickinghere.

Creating a connection to Scriptcase

See below how to create a connection in your Scriptcase project, using the enabled Driver (PostgreSQL PDO, PostgreSQL 7 or above, PostgreSQL 6.4 or above and
PostgreSQL 6.3 or below.) and the Azure PostgreSQL database.

1 - Access a project from your Scriptcase.

2 - Click the New Connection icon to create a connection.

or access the Database > New connectionmenu.

After that, a screen will appear with all database connections.

3 - Select the Microsoft Azure connection.

4 - And choose the Azure Postgres database.

Connection

Enter the parameters for connecting to your Azure PostgreSQL database as follows:

e Connection name: Define the name of your new connection. By default, Scriptcase adds the prefixconn along with the database name.
e SGDB Driver: Select the PostgreSQL Driver for connection. In this example, we use thePostgreSQL PDO Driver.

e SGDB server: Enter the domain of the Azure server where the database is installed.

e EX: domain-postgres.postgres.database.azure.com

e Port: Enter the port for connection. By default, the defined port is5432.

e Schema: Enter the schema for connecting to the database.

o Database: List and select the database you will connect to.

o EX: samples

e User: Inform the user to authenticate the connection to your database.

e Password: Enter the password to complete the authentication process.

e Test connection: Click this button to get a response to the Scriptcase request to find out if the parameters entered are correct.

Search

Accessing this tab, you can configure which Database items will be displayed on the connection, depending on the owner or not.

Show

It allows the connection to see tables, views, system tables and procedures depending on the items selected by the user. By default, the itemTables and Views are already
selected by Scriptcase.

e Tables: By selecting this option, the tables in your database will be displayed.
o By default, Scriptcase enables this option.

e Views: By selecting this option, the views of your database will be displayed.
o By default, Scriptcase enables this option.

e System Tables: Selecting this option, the system tables of your database will be displayed.

e Procedures: Selecting this option, the procedures of your database will be displayed.

Filter

Allows you to define which tables and owners are displayed.



e Tables: You can define in this option which tables will be displayed. The configuration can contain aPREFIX%% or name of the tables to display.
o By default, Scriptcase leaves this option empty.
o EX:

e Owner: Inform the user who sees the tables entered for display.
o The user must be in capital letters as in the example above.

e Display: Choose whether tables for the informed owner are displayed.
NOTE: By using table filtering, you eliminate unnecessary tables for your project andimprove the performance of your database connection.
Advanced

In this tab, you have access to specific settings for the connection. The settings made in this session impact the data display and application performance.

e client_encoding: Select the encoding used in your database. In the example above, we use the client_encodingutf8.
o By default, the utf8 charset is set.

o Decimal Separator: Select the type of separator for decimal records, between comma and period.
o By default, the point. is selected as a separator.

e Persistent Connection: Define whether connections will be terminated after the execution of your scripts in Scriptcase applications.
o By default, Scriptcase disables this option.

e Use the schema before the table name: Define whether the database schema will be displayed before the table names.
o By default, Scriptcase enables this option.

Questions or Connection Problems?

Contact our support in case of connection problems or questions regarding this database.



Enabling Azure PostgreSQL PDO

In Scriptcase, we have the following drivers available for connection to PostgreSQL: PostgreSQL PDO, PostgreSQL 7 or above, PostgreSQL 6.4 or above and PostgreSQL 6.3
or below. If